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改訂履歴

次の表に、 この文書の改訂履歴を示します。

http://japan.xilinx.com


UG029 (v12.3) 2010 年 9 月 21 日 japan.xilinx.com ChipScope Pro 12.3 ソフ トウェアおよびコア

 

日付 バージョ ン 改訂内容

2008 年 3 月 24 日 10.1

10.1 ツールと互換性を持たせるためすべての章を更新。

ツールのバージ ョ ン番号を反映させるためバージ ョ ン番号を更新。

ChipScope Core Generator ツールをザイ リ ンクス  CORE Generator ツールに置換。

第 1 章 「概要」 : ザイ リ ンクス  CORE Generator ツールの 15 ページの表 1-1 への追

加、 41 ページの表 1-9 および 42 ページの表 1-10 に記載されている  PC および 
Linux のシステム要件の更新、 および 「Solaris のホス ト  システム要件」 を削除。

第 4 章 「ChipScope Pro Analyzer の使用」 :104 ページの 「プラ ッ ト フォーム ケーブ

ル USB 接続の複数使用」、 121 ページの 「[External Input]」 の追加。 第 5 章
「ChipScope Engine Tcl インターフェイス」 :155 ページの 「必要条件」 および 208 
ページの 「::chipscope::csefpga_get_config_reg」 の更新。

2009 年 4 月 29 日 11.1

11.1 ツールと互換性を持たせるためすべての章を更新。

ChipScope Pro IBERT のサポート を追加。

第 1 章 「概要」 : 37 ページの 「IBERT コア」 を拡張。

第 4 章 「ChipScope Pro Analyzer の使用」 : 121 ページの 「Virtex-4 FPGA GT11 ト
ランシーバ用 IBERT コンソール ウ ィンド ウ」 および 126 ページの 「Virtex-5 
FPGA GTP および GTX ト ランシーバ用 IBERT コンソール ウ ィンド ウ」 の追加。 

第 5 章 「ChipScope Engine Tcl インターフェイス」 : 156 ページの 「CSE/Tcl コマ

ンド  サマリ 」 を拡張。 203 ページの 「CseFpga コマンド」、 218 ページの

「CseCore コマンド」、 および 221 ページの 「CseVIO コマンド」 にコマンド

を追加。

付録 B 「参考資料」 を追加。

2009年 6 月 24 日 11.2

11.2 ツールと互換性を持たせるためすべての章を更新。 Virtex-6 LXT/SXT/CXT 
ファ ミ リのサポート を追加。

次を更新。

37 ページの 「IBERT デザイン フロー」、 229 ページの

「::chipscope::csevio_write_values」、 231 ページの

「::chipscope::csevio_read_values」、 付録 B 「参考資料」

次を追加。

37 ページの 「IBERT の機能」、 42 ページの表 1-10、 71 ページの 「Virtex-6 FPGA 
GTX ト ランシーバ用 IBERT v2.0 コアの生成」、 140 ページの「Virtex-6 FPGA GTX 
ト ランシーバ用 IBERT コンソール ウ ィンド ウ」

2009 年 9 月 16 日 11.3

11.3 アップデート。 Spartan-6 FPGA のサポート を追加。 37 ページの 「IBERT の機

能」、 44 ページの表 1-12、 73 ページの 「Virtex-6 FPGA GTH ト ランシーバ用 
IBERT v2.0 コアの生成」、 143 ページの 「[Sweep Test Settings] パネル」、 148 ペー

ジの 「Spartan-6 FPGA GTP ト ランシーバ用 IBERT コンソール ウ ィンド ウ」、 およ

び付録 A 「ChipScope Pro ツール ト ラブルシューティング ガイ ド」 に Spartan-6 
FPGA GTP ト ランシーバ用 IBERTコア セクシ ョ ンを追加。

2009 年 12 月 2 日 11.4

11.4 ツールと互換性を持たせるためすべての章を更新。 Virtex-6 FPGA HXT デバイ

スのサポート を追加。 37 ページの 「IBERT の機能」 および 43 ページの表 1-11の更

新。 73 ページの 「Virtex-6 FPGA GTH ト ランシーバ用 IBERT v2.0 コアの生成」 を

追加。
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2010 年 4 月 19 日 12.1

• 12.1 ツールと互換性を持たせるためすべての章を更新。

• Virtex-5 FPGA GTX ト ランシーバ用 IBERT v2.0 を追加。

• JTAG プラグインを開くための Analyzer のサポート を追加。

• ByteTools 社 Catapult EJ-1 イーサネッ ト - JTAG接続ケーブルのサポート を追加。

• 第 4 章に 「 ト リガー実行モード」 (単一および反復) を追加。

• 第 4 章に 「 ト リガーおよびキャプチャ  ステータス」 を追加。

• csejtag_target is_connected コマンドの追加。

• csefpga_configure_device_with_file コマンドを追加。

• csefpga_is_configured コマンドの追加。

2010 年 9 月 21 日 12.3 • 12.3 リ リ－スに合わせてアップデート

日付 バージョ ン 改訂内容
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このユーザー ガイドについて

このユーザー ガイ ドでは、 LogiCORE™ IP ChipScope™ Pro コアおよびツールの使用に関する次

の情報が含まれています。 

• ICON (Integrated Controller) コア

• ILA (Integrated Logic Analyzer) コア

• VIO (Virtual Input/Output) コア

• IBERT (Integrated Bit Error Ratio Test ) コア

• ATC2 (Agilent Trace Core 2)

• IBA (Integrated Bus Analyzer) コア

• コア生成ツール (ザイ リ ンクス® CORE Generator™ および IBERT Core Generator)

• コア挿入ツール (ChipScope Pro Core Inserter)

• 解析ツール (ChipScope Pro Analyzer)

こ れらのツールでは、 IP コアおよび主要なハード ウェア  コンポーネント をザイ リ ンク ス  FPGA
デバイスに含まれるターゲッ ト  デザインに統合します。 サポート さ れるデバイスの一覧は、

http://japan.xilinx.com/chipscopepro を参照してく ださ い。

メモ : このユーザー ガイ ドでは、バージ ョ ン 12.3 のザイ リ ンクス  ISE® Design Suite を使用してい

ます。

japan.xilinx.com/chipscopepro
japan.xilinx.com/chipscopepro
http://japan.xilinx.com
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このユーザー ガイ ドについて

ユーザー ガイドの内容

このユーザー ガイ ドには、 次の章が含まれています。

• 第 1 章「概要」では、ChipScope Pro のツールおよび IP コアについて説明します。 これらのツー

ルでは、サポート されるデバイスに含まれるターゲッ ト  デザインに主要なロジッ ク解析ハード

ウェア コンポーネン ト を統合します。 これらのツールは、 これらのコンポーネン ト と通信して

完全なロジッ ク解析を設計者に提供します。 この章では、IBERT コアおよび ChipScope Pro シ
リアル I/O ツールキッ トの関連ソフ ト ウェアについて説明します。

• 第 2 章 「コア生成ツールの使用」 では、 ザイ リ ンクス  CORE Generator ツールおよび IBERT
Core Generator ツールの使用方法を説明します。 

ザイ リ ンクス  CORE Generator ツールは、次の ChipScope Pro コアを生成するのに使用します。

♦ ICON (Integrated Controller) コア

♦ ILA (Integrated Logic Analyzer) コア

♦ VIO (Virtual Input/Output) コア

♦ ATC2 (Agilent Trace Core 2)

♦ Virtex®-6 および Spartan®-6 FPGA に統合されている  V2.0 以降の IBERT (Integrated
Bit Error Ratio Test) コア

コアの作成後、既成のインスタンシエーショ ン  テンプレート を使用して、これらのコアを  VHDL
または Verilog デザインに迅速かつ容易に挿入できます。 インスタンシエーシ ョ ンの完了および

合成の実行後は、ザイ リ ンクス  ISE® のインプ リ メンテーシ ョ ン プロセスを使用してデザイン

をインプ リ メン トできます。

IBERT Core Generator は、Virtex-4 および Virtex-5 FPGA のト ランシーバを使用するシステム

で使用する  IBERT v1.0 コア デザインをカスタマイズ、 生成するのに使用します。

• 第 3 章 「ChipScope Pro Core Inserter の使用」 では、 ユーザー デザインおよびパラ メータを指

定した ICON、 ILA、 ATC2 コアを含んだネッ ト リ ス ト を生成する合成後のツール ChipScope
Pro Core Inserter の使用方法について説明します。 Core Inserter では、デバッグ機能を迅速かつ

容易に使用して HDL をインスタンシエートせずに、 合成されたデザインを解析できます。

• 第 4 章「ChipScope Pro Analyzer の使用」では、ChipScope Pro Analyzer を使用して ChipScope
Pro コアと呼ばれる  ICON、 ILA、 IBA/OPB、 IBA/PLB、 VIO、 IBERT、 および ATC2 コアに

直接インターフェイスする方法を説明します。 このツールでは、 デバイスのコンフ ィギュレー

シ ョ ン、 ト リガーの選択、コンソールの設定、キャプチャ結果の表示が即時に実行できます。 ま
た、 データ表示やト リガーをさまざまな方法で操作可能で、 デザインの機能を容易かつ速やか

に検証できます。 また、 この章では DUT (design-under-test) で IBERT コアと通信する方法も

説明します。

• 第 5 章「ChipScope Engine Tcl インターフェイス」では、基本的な JTAG チェーン機能、FPGA
デバイス  レジスタ、 および FPGA デザインに含まれる  VIO コアにアクセスするための

ChipScope Engine Tcl (CSE/Tcl) スク リプ ト  インターフェイスの使用方法を説明します。 Tcl
コマンドを入力するだけで、標準的なザイ リ ンクス  JTAG ケーブルを使用した JTAG チェーン

のスキャンおよび操作が可能になり ます。

• 付録 A 「ChipScope Pro ツール ト ラブルシューティング ガイ ド」 では、 ChipScope Pro ツール

のインス トールおよび ISE ソフ ト ウェアの統合に関する ト ラブルシュート方法を説明します。

• 付録 B 「参考資料」 では、 このユーザー ガイ ドで使用した リ ファレンスを リ ス ト します。

http://japan.xilinx.com
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その他のリソース

その他のリソース

追加資料はこちらのザイ リ ンクスの Web サイ ト を参照してください。

http://japan.xilinx.com/support/documentation/index.htm

シ リ コン、 ソフ ト ウェア、 IP に関する問題をアンサー データベースで検索したり、 テクニカル サ
ポートのウェブ ケースを開くには、 次のザイ リ ンクス  Web サイ トにアクセスして ください。

http://japan.xilinx.com/support/mysupport.htm

表記規則

このマニュアルでは、 次の表記規則を使用しています。 各規則について、 例を挙げて説明します。

書体

次の規則は、 すべてのマニュアルで使用されています。

表記規則 使用箇所 例

Courier フォン ト

システムが表示する メ ッセージ、

プロンプ ト、プログラム ファ イル

を表示します。

speed grade: - 100

Courier フォン ト  
(太字)

構文内で入力する コマン ド を示

します。
ngdbuild design_name

イタ リ ッ ク  フォン ト
ユーザーが値を入力する必要の

ある構文内の変数に使用します。
ngdbuild design_name

二重/一重かぎかっこ

『 』、 「」

『 』 はマニュアル名を、「 」 はセク

シ ョ ン名を示します。

詳細については、 『開発システム

リ ファレンス  ガイ ド』の「PAR」を

参照して ください。

角かっこ  [  ]

オプシ ョ ン の入力 ま たはパ ラ

メータを示しますが、 bus[7:0]

のよ う なバス仕様では必ず使用

します。 また、GUI 表記にも使用

します。

ngdbuild [option_name]

design_name

[File] → [Open] をク リ ッ ク し

ます。

中かっこ  {  }
1 つ以上の項目を選択するための

リ ス ト を示します。
lowpwr ={on|off}

縦棒  |
選択する リ ス ト の項目を分離し

ます。
lowpwr ={on|off}

縦の省略記号

.

.

.

繰り 返し項目が省略されている

こ とを示します。

IOB #1: Name = QOUT’ 

IOB #2: Name = CLKIN’

.

.

.

横の省略記号 . . .
繰り 返し項目が省略されている

こ とを示します。

allow block  block_name loc1
loc2 ... locn;

http://japan.xilinx.com
http://japan.xilinx.com/support/documentation/index.htm
http://japan.xilinx.com/support/mysupport.htm
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第 1 章

概要

ChipScope Pro ツールについて

FPGA デバイスの集積度が高く なるにつれて、テスト 対象デバイスへのテスト 装置プローブの接続

が困難になってきています。 ChipScope Pro ツールは、 主要なロジッ ク  アナラ イザおよびテスト /
計測ハード ウェア  コンポーネント を  ISE® Design Suite 製品表 [251 ページのリ ファレンス  17 を
参照] にリ ス ト されているザイ リ ンクス  FPGA デバイスに含まれているターゲッ ト  デザインに統

合します。 これらのツールは、 これらのコンポーネン ト と通信してロジッ ク解析を提供します。

ChipScope Pro シ リアル I/O ツールキッ トでは、ザイ リ ンクス  FPGA の高速シ リ アル ト ランシーバ

の I/O 機能を使用してデザインのエラボレーシ ョ ンとデバッグを実行する機能が提供されます。

IBERT (Internal Bit Error Ratio Tester) コアおよび関連するソフ ト ウェアでは、 高速シ リアル ト ラ

ンシーバ (このユーザー ガイ ドでは MGT と呼ぶ) へのアクセスを提供し、これらの MGT で構成さ

れたチャネルでのビッ ト  エラー率の解析を実行します。 IBERT コアでは、ISE Design Suite 製品表

[251 ページのリ ファレンス  17 を参照] にリ ス ト されているザイ リ ンクス  Virtex®-4、 Virtex-5、
Virtex-6、 および Spartan®-6 FPGA デバイスの高速シ リ アル ト ランシーバがサポート されます。

ChipScope Pro ツールの概要

次の表に、 各種 ChipScope Pro ソフ ト ウェア ツールおよびコアの簡単な説明を示します。

表 1-1 : ChipScope Pro ツールの概要

ツール 説明

ザイ リ ンクス  
CORE Generator™

サポート されるすべての FPGA デバイス  ファ ミ リ をターゲッ トにして

ICON、 ILA、 VIO、 および ATC2 コアを生成できます。 また、 Virtex-
5、 Virtex-6、 および Spartan-6 FPGA ファ ミ リ をターゲッ トにして

IBERT v2.0 コアを生成するこ と もできます。 ザイ リ ンクス  CORE
Generator は、ザイ リ ンクス  ISE Design Suite ソフ ト ウェア ツールに含

まれています。

IBERT Core Generator

Virtex-4 および Virtex-5 デバイスをターゲッ ト にして  IBERT v1.0 コア

の完全なデザインを生成できます。 IBERT Core Generator では、 ユー

ザーが選択した MGT およびデザインを制御するパラメ ータに基づき、

ISE Design Suite を使用してコンフィ ギュレーショ ン  ファ イルを生成し

ます。

Core Inserter 合成されたユーザー デザインに ICON、ILA、ATC2 コアを自動的に挿

入します。

http://japan.xilinx.com


16 japan.xilinx.com ChipScope Pro 12.3 ソフ トウェアおよびコア

UG029 (v12.3) 2010 年 9 月 21 日

第 1 章 : 概要

次に、ChipScope Pro ツールを使用して追加したデバッ グ  コアを含むシステムのブロッ ク 図を示しま

す。 CORE Generator を使用してコアを生成し、それらを  HDL ソース  コード にインスタンシエート

するこ と によって、デザインに ICON、 ILA、VIO、および ATC2 コア  (総称 ChipScope Pro コア) を
配置できます。 また、Core Inserter または PlanAhead ツールを使用すると 、ICON、ILA、および ATC2
コアを合成済みデザインのネッ ト リ スト に直接挿入できます。 デザインは、 ISE インプリ メ ンテー

ショ ンツールを使用して配置配線されます。 次に、デバイスにビッ ト スト リ ームをダウンロード して

Analyzer でデザインを解析します。

PlanAhead デザイン

解析ツール

デザインのネッ ト リ ス トに ICON および ILA コアを自動的に挿入しま

す。 この機能の詳細は、 PlanAhead™ デザイン解析ツール [251 ページ

のリ ファレンス  18 を参照] を参照して ください。

Analyzer
ICON、 ILA、 IBA/OPB、 IBA/PLB、 VIO、 および IBERT コアのイン

システム デバイス  コンフ ィギュレーシ ョ ン、 ト リガー設定、 ト レース

表示、 制御、 およびステータスを提供します。

ChipScope Engine Tcl

(CSE/Tcl) スク リプ ト

インターフェイス

CSE/Tcl スク リプ ト  コマンド  インターフェイスによって、Tcl シェルか

ら  JTAG チェーン内のデバイス との通信が可能になり ます(1)。

メモ : 

1. Tcl は Tool Command Language の略です。 CSE/Tcl インターフェイスでは、 ChipScope Pro および ISE 
ツールまたは ActiveState [252 ページのリ ファレンス  25 を参照] の ActiveTcl 8.4 シェルに含まれて
いる  xtclsh と呼ばれる  Tcl シェル プログラムが必要です。

X-Ref Target - Figure 1-1

図 1-1 : ChipScope Pro システムのブロック図

表 1-1 : ChipScope Pro ツールの概要 (続き)

ツール 説明

cs_pro_sys_blk_diag

ChipScope
Pro

ILA Pro

ICON Pro

ILA Pro

ILA Pro
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ChipScope Pro ツールの概要

ChipScope Pro Analyzer では、 コンピュータ と  JTAG バウンダ リ  スキャン チェーン内のデバイス

間通信に、 次のダウンロード  ケーブルを使用できます。

• プラ ッ ト フォーム ケーブル USB

• パラレル ケーブル IV

Analyzer には、ロジッ クを検証する多数の機能が含まれています (表 1-2)。 1 ～ 4,096 までのデータ

チャネル、 256 ～ 131,072 までのサンプル バッファ  ワード数を選択可能です。 また、 ユーザー ロ
ジッ クに影響を与えずに即座にト リガーを変更できます。 Analyzer では、 ト リガー変更からキャプ

チャしたデータの解析までのプロセスを順番に実行できます。

表 1-2 : ChipScope Pro のロジック  デバッグ機能および利点

機能 利点

1 ～ 4,096 までのデータ  チャネルを選択可能 
広範囲のデータ  バスの動作を正確にキャプ

チャします。

256 ～ 131,072 までのサンプル バッファ  ワー

ド数を選択可能

サンプルするワード数を増やすと、精度が高く

な り、不定期に起こるイベン ト をキャプチャす

る確率が高くな り ます。

最大 16 個のト リガー ポート を使用でき、 それ

ぞれに対して 1 ～ 256 までのチャネルを選択

可能 (合計 4096 チャネルまで)

複数の ト リガー ポート を個別に設定できるた

め、 イベン ト検出の柔軟性が増加し、必要にな

るサンプル ス ト レージが減少します。

各ト リガー ポートに最大 16 個までの比較ユ

ニッ ト を使用でき、 ト リガー条件ごとに合計で

16 の異なる比較を実行可能

ト リガー ポート ごとに複数の比較ユニッ トが

あ り、有用な リ ソースを節約する一方で、 イベ

ン ト検出の柔軟性が増加します。

すべてのデータおよび ト リ ガー処理は、 最大

500MHz のユーザー ク ロ ッ クに同期

ト リガー イベン ト検出およびデータ  キャプ

チャを高速で実行できます。

ト リガー条件によ りブール式または最大 16 個
の比較演算子の ト リガー シーケンスをインプ

リ メン ト

ブール式または 16 レベルのト リガー シーケン

サを使用する最大 16 個のト リガー ポートの比

較演算子を組み合わせるこ とができます。

データ  ス ト レージ必要条件で最大 16 個の比較

演算子のブール式をインプリ メン ト

ブール式を使用する最大 16 個のト リガー ポー

トの比較演算子を組み合わせて、キャプチャお

よび格納するデータ  サンプルを決定できます。

ユーザー ロジッ クに影響を与えずに、システム

内で ト リ ガー条件およびス ト レージ必要条件

を変更可能

ロジッ ク解析のためにデザインをシングル ス

テップまたは停止する必要はあ り ません。

操作が容易な GUI を提供 簡単に適切なオプシ ョ ンを選択できます。

各デバイスに、 最大 15 個の ILA、 IBA/OPB、

IBA/PLB、 VIO または ATC2 コアを使用可能

ロジッ クを分割でき、大規模デザインの小セク

シ ョ ンをテス トできるため、高精度の結果を得

るこ とができます。

複数の ト リガー設定
よ り正確かつ柔軟に、 イベン トの一致と範囲、

および時間とその数を記録します。

ザイ リ ンクス  ウェブ サイ トからダウンロード

可能

これらのツールには、ChipScope スイートから

簡単にアクセスできます。[251 ページのリ ファ

レンス  19 を参照]
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デザイン フロー

ChipScope Pro ツールのデザイン フロー (図 1-2) は、一般的な HDL 合成ツールおよび ISE インプ

リ メンテーシ ョ ン ツールを使用するすべての標準的な FPGA デザイン フローの一部と して簡単に

実行できます。

エンベデッ ド  プロセッサおよび DSP ツール フローでの ChipScope Pro 
コアの使用

コア (ICON、 ILA、 IBA、 VIO、 および ATC2) は、 エンベデッ ド  プロセッサおよび DSP デザイン

向けの EDK および System Generator for DSP ツール フローでも使用できます。 ChipScope Pro コ
アの使用方法は、 EDK Platform Studio [251 ページのリ ファレンス  16 を参照] および System
Generator for DSP [251 ページのリ ファレンス  20 を参照]  の資料を参照して ください。

X-Ref Target - Figure 1-2

図 1-2 : ChipScope Pro ツールのデザイン フロー
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ChipScope Pro コアの概要

ICON コア

すべてのコアは、JTAG バウンダ リ  スキャン ポート を使用し、JTAG ダウンロード  ケーブルを介し

てホス ト  コンピュータ と通信します。 ICON コアは、ターゲッ ト  FPGA の JTAG バウンダ リ  スキャ

ン ポート と最大 15 個の ILA、 IBA、 IBA、VIO、および ATC2 コア間の通信パスを提供します (16
ページの図 1-1 を参照)。 

Spartan-3、 Spartan-3E、 Spartan-3A、および Spartan-3A DSP ファ ミ リ  デバイスの場合、 ICON コ
アは BSCAN プリ ミ ティブを介した通信に USER1 または USER2 JTAG バウンダ リ  スキャン命令

を使用します。 また、BSCAN プリ ミ ティブの未使用 USER1 または USER2 スキャン チェーンは、

必要に応じてエクスポート し、 アプ リ ケーシ ョ ンで使用できます。

その他のデバイスの場合、BSCAN プリ ミ ティブを介して使用可能な USER1、USER2、USER3、ま

たは USER4 スキャン チェーンのいずれかを使用します。 各 BSCAM プリ ミ ティブで 1 つのス

キャン チェーンがインプ リ メン ト されるので、 未使用の USER スキャン チェーンをエクスポート

する必要はあ り ません。

ILA コア

ILA コアは、カスタマイズ可能なロジッ ク  アナライザ コアで、デザインに含まれる任意の内部信号

を監視できます。 ILA コアは監視中のデザインに同期しており、このコア内のコンポーネン トにも、

デザインに指定したすべてのクロ ッ ク制約が適用されます。 ILA コアは、 主に 3 つのコンポーネン

トで構成されています。

• ト リ ガー入力および出力ロジッ ク  

♦ ト リ ガー入力ロジッ クは、 ト リガー イベン ト を検出します。

♦ ト リ ガー出力ロジッ クは、 外部テス ト装置およびその他のロジッ クを ト リガーします。

• データ  キャプチャ  ロジッ ク  

♦ オンチップのブロ ッ ク  RAM リ ソースを使用して ト レース データ情報をキャプチャし、そ

の情報を格納します。

• 制御およびステータス  ロジッ ク  

♦ ILA コアの動作を管理します。

http://japan.xilinx.com


20 japan.xilinx.com ChipScope Pro 12.3 ソフ トウェアおよびコア

UG029 (v12.3) 2010 年 9 月 21 日

第 1 章 : 概要

ILA ト リガー入力ロジック

ILA コアの ト リ ガー機能には、 ト リガー イベン ト検出に必要な多くの機能が含まれます。 これらの

機能は、 表 1-3 に記載されています。

表 1-3 : ILA コアのト リガー機能

機能 説明

ワード数の大きな

ト リガー ポート

各ト リガー ポートは 1 ～ 256 ビッ ト幅に設定できます。

複数 の ト リ ガ ー

ポート

各コアで最大 16 個まですのト リガー ポート を使用できます。 複数の比較

ユニッ ト を使用してさまざまな信号またはバスを監視する必要がある複雑

なシステムでは、 複数のト リガー ポート を使用する必要があ り ます。

各ト リガー ポート

に 複数 の 比較 ユ

ニッ ト

各ト リガー ポートは、最大 16 個までの比較ユニッ トに接続できます。 この

機能によ り、 複数のト リガー ポート信号を比較できます。

ブ ール式 の ト リ

ガー条件

ト リガー条件は、最大 16 個の比較ユニッ ト演算子の AND または OR ブー

ル式で表すこ とができます。

複数レベルの ト リ

ガー シーケンサ

ト リガー条件は、最大 16 個の比較ユニッ ト演算子の複数レベルのト リガー

シーケンサで表すこ とができます。

ブ ール式 の ス ト

レージ必要条件

ス ト レージ必要条件は、 最大 16 個の比較ユニッ ト演算子の AND または

OR ブール式で表現できます。
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比較ユニッ ト  
タイプの選択

ト リガー ポートに接続される比較ユニッ トは、 次のいずれかのタイプとな

り ます。

• 基本コンパレータ

♦ = および <> 比較を実行

♦ LUT4a ベースのデバイスでスライスごとに最大 8 ビッ ト まで比較

♦ Virtex-5 および Spartan-6 デバイスでスライスごとに最大 19 ビッ ト

まで比較

♦ LUT6b ベースのデバイスでスライスごとに最大 20 ビッ ト まで比較

• 基本コンパレータ  (エッジ付き)

♦ = および <> 比較を実行

♦ High から  Low および Low から  High のビッ ト遷移を検出

♦ LUT4 ベースのデバイスでスライスごとに最大 4 ビッ ト まで比較

♦ LUT6 ベースのデバイスでスライスごとに最大 8 ビッ ト まで比較

• 拡張コンパレータ

♦ =、 <>、 >、 >=、 <、 および <= 比較を実行

♦ LUT4 ベースのデバイスでスライスごとに最大 2 ビッ ト まで比較

♦ LUT6 ベースのデバイスでスライスごとに最大 8 ビッ ト まで比較

• 拡張コンパレータ  (エッジ付き)

♦ =、 <>、 >、 >=、 <、 および <= 比較を実行

♦ High から  Low および Low から  High のビッ ト遷移を検出

♦ LUT4 ベースのデバイスでスライスごとに最大 2 ビッ ト まで比較

♦ LUT6 ベースのデバイスでスライスごとに最大 8 ビッ ト まで比較

• 範囲コンパレータ

♦ =、 <>、 >、 >=、 <、、 <=、 in range、 および not in rage 比較を実行

♦ LUT4 ベースのデバイスでスライスごとに最大 1 ビッ ト まで比較

♦ LUT6 ベースのデバイスでスライスごとに最大 4 ビッ ト まで比較

• 範囲コンパレータ  (エッジ付き)

♦ =、 <>、 >、 >=、 <、、 <=、 in range、 および not in rage 比較を実行

♦ High から  Low および Low から  High のビッ ト遷移を検出

♦ LUT4 ベースのデバイスでスライスごとに最大 16 ビッ ト まで比較

♦ LUT6 ベースのデバイスでスライスごとに最大 4 ビッ ト まで比較

1 つのト リガー ポートに接続されたすべての比較ユニッ トは、 すべて同一

タイプとな り ます。

表 1-3 : ILA コアのト リガー機能 (続き)

機能 説明
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イベン ト  カウンタ

の比較演算子の

選択

ト リガー ポートのすべての比較ユニッ トは、イベン ト  カウンタ と共にコン

フ ィギュレーシ ョ ンでき、カウンタのサイズは 1 ～ 32 ビッ トで選択可能で

す。 このカウンタは、次の方法でイベン ト をカウン トするよ うに、動作時に

コンフ ィギュレーシ ョ ンできます。

• 厳密に n 回

♦ 厳密に n 回の連続的あるいは非連続的なイベン トが発生する と き

のみ一致

• 最低 n 回発生した場合のみ

♦ 最低 n 回の連続的あるいは非連続的なイベン トが発生する と一致

し、 アサート を保持

• 最低 n 回連続的に発生した場合のみ 

♦ n 回の連続的なイベン トが発生する と一致し、 比較演算子を満た

さなくなるまでアサート を保持

ト リガー出力

ポート

オプシ ョ ンの ト リガー出力ポート を使用する と、 ILA コアの内部ト リガー

条件にアクセスできます。 この信号は、 出力ピンに接続するこ とによって、

外部テス ト装置用のト リガーと して使用できます。

内部ロジッ クの割り込みまたはト リガーと して、 あるいは複数の ILA コア

のカスケード接続用にも使用可能です。

ト リガ出力ポートのレイテンシ量は、 コアによって異なり ます。

• ILA コア = 10 ク ロ ッ ク  サイクル

• IBA/OPB コア = 15 ク ロ ッ ク  サイ クル

• IBA/PLB コア = 10 クロ ッ ク  サイクル

ト リガ出力のレベル/パルスおよびアクティブ エッジ (High または Low)
は、 動作時に制御できます。

a. LUT4 ベースのデバイス  ファ ミ リには、 Spartan-3、 Spartan-3E、 Spartan-3A、 Spartan-3A DSP、 および 
Virtex-4 FPGA が含まれます。

b. LUT6 ベースのデバイス  ファ ミ リには、 Virtex-5、 Virtex-6、 および Spartan-6 が含まれます。

表 1-3 : ILA コアのト リガー機能 (続き)

機能 説明

http://japan.xilinx.com


ChipScope Pro 12.3 ソフ トウェアおよびコア japan.xilinx.com 23
UG029 (v12.3) 2010 年 9 月 21 日

ChipScope Pro コアの概要

複数のト リガー ポートの使用

デザインで異なるタイプの信号またはバスを監視できるよ うにするには、複数の ト リガー ポートが

必要となり ます。 たとえば、 デザインで制御、 アドレス、 およびデータ信号を含む内部システム バ
スを使用している場合、 これらにそれぞれト リガー ポート を割り当てて、各信号グループを監視で

きます (図 1-3)。

これらの信号およびバスを 1 つのト リ ガー ポートに接続する と、アドレス  バスが指定された範囲内

にあるかを確認している間、CE、WE、および OE 信号の各ビッ ト遷移は監視できません。 さまざま

なタイプの比較ユニッ トから選択可能であるため、 最低限のリ ソースを使用しながら、 必要な ト リ

ガー向けに ILA コアをカスタマイズできます。

X-Ref Target - Figure 1-3

図 1-3 : LA コアの接続例
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ト リガー条件およびストレージ必要条件の使用

ILA、 IBA/OPB、 および IBA/PLB コアでは、 ト リガー条件ロジッ クおよびス ト レージ必要条件ロ

ジッ クの両方がインプ リ メン ト されます。 ト リ ガー条件は、 コアの ト リガー ポートに接続されてい

る比較ユニッ ト  コンパレータで検出されるイベン トのブール式またはシーケンシャルな組み合わ

せです。ト リガー条件は、データ  キャプチャ  ウ ィンド ウで明確な開始点を示すために使用され、デー

タ  キャプチャ  ウ ィンド ウの開始点、 終了点、 あるいは任意の位置に指定できます。

同様に、ス ト レージ必要条件も、コアの ト リガー ポートに接続されている比較ユニッ ト  コンパレー

タで検出されるイベン トのブール式組み合わせです。 ただし、 この条件は、 個別のデータ  サンプル

をキャプチャおよび格納するかを決定するために、 ト リガー ポートの比較ユニッ トのイベン ト を評

価する点で ト リガー条件と異なり ます。ト リガー条件およびス ト レージ必要条件を共に使用し、キャ

プチャ  プロセスの開始時とキャプチャするデータを決定できます。

23 ページの図 1-3 の ILA コア例で、 次を実行する と します。

• Address = 0xFF0000 への最初のメモリ書き込みサイクル (CE = 立ち上がりエッジ、 WE = 1、
OE = 0) で ト リガー

• データ値が 0x00000000 ～ 0x1000FFFF の間の場合に、Address = 0x23AACC からのメモ リ読

み出しサイクル (CE = 立ち上がりエッジ、 WE = 0、 OE = 1) のみをキャプチャ

これらの条件を正し く インプ リ メン トするには、TRIG0 および TRIG1 ト リ ガー ポートの両方にそ

れぞれ比較ユニッ ト  2 個 ( ト リ ガー条件用 1 個とス ト レージ必要条件用 1 個) が接続されているこ

とを確認する必要があ り ます。 次に、 ト リガーおよびス ト レージ必要条件の設定方法とそれらの条

件を満たすための各比較ユニッ トの設定方法を示します。

• ト リ ガー条件 = M0 && M2

♦ M0[2:0] = CE、 WE、 OE = “R10” (R は立ち上がりエッジを示す)

♦ M2[23:0] = アドレス = “F0000”

• ス ト レージ必要条件 = M1 && M3 && M4

♦ M1[2:0] = CE、 WE、 OE = “R10” (R は立ち上がりエッジを示す)

♦ M3[23:0] = アドレス = “23AACC”

♦ M4[31:0] = データ  = 範囲は 0x00000000 ～ 0x1000FFFF

ILA、IBA/OPB、および IBA/PLB コアのト リ ガーおよびスト レージ必要条件を設定するこ と により 、

オンチッ プ メ モリ  リ ソースを浪費せずに、 必要な情報のみを正確に検索し、 キャプチャできます。

ILA ト リガー出力ロジック

ILA コアでは TRIG_OUT と呼ばれる ト リガー出力ポートがインプ リ メン ト されます。 TRIG_OUT
ポートは、 Analyzer を使用して動作時に設定される ト リ ガー条件の出力です。 ト リ ガー出力のレベ

ル/パルスおよびアクティブ エッジ (High または Low) は、 動作時に制御できます。 入力ト リガー

ポートに対する  TRIG_OUT のレイテンシは、 10 ク ロ ッ ク  サイクルです。

TRIG_OUT ポートは非常に柔軟性があ り、 多用途に使用できます。 このポート をデバイス  ピンに

接続し、 オシロスコープおよびロジッ ク  アナライザなどの外部テス ト装置を ト リガーできます。 ま
た、デバイスに組み込まれた PowerPC® または MicroBlaze™ プロセッサの割り込みラインに接続

する と、ソフ ト ウェア イベン ト を発生させるこ とができます。 さ らに、別のコアのト リガー入力ポー

トに接続する と、 オンチップ デバッグ ソ リ ューシ ョ ンの ト リガーおよびデータ  キャプチャ機能を

拡張できます。
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ILA データ  キャプチャ  ロジッ ク

各 ILA コアは、オンチップ ブロッ ク  RAM リ ソースを使用して、デザインに含まれるその他すべて

のコアから独立してデータをキャプチャできます。 また、[Window] または [N Samples] のいずれか

のキャプチャ  モードでデータをキャプチャできます。

[Window] キャプチャ  モード

このモードでは、サンプル バッファを 1 つまたは複数の等サイズのサンプル ウ ィンド ウに分割でき

ます。 このモードの場合、 1 つのト リガー条件イベン ト  (個々の ト リガー比較ユニッ ト  イベン トの

ブール式組み合わせ) を使用して、サンプル ウ ィンド ウを満たすのに十分なデータが収集されます。

サンプル ウ ィンド ウのワード数が 131,072 サンプルまでの 2 のべき乗の場合、ト リガー位置はサン

プル ウ ィンド ウの開始点 (最初に ト リガーしてからデータを収集)、終了点 ( ト リ ガー イベン ト まで

データを収集)、 またはそれら  2 点間の任意の位置に設定できます。

ウ ィンド ウのワード数が 2 のべき乗以外の場合、ト リガー位置はサンプル ウ ィンド ウの開始位置に

のみ設定できます。

サンプル ウ ィンド ウが満たされる と、 ILA コアで ト リガー条件が自動的に再設定され、 ト リガー条

件イベン トが継続して監視されます。 このプロセスは、サンプル バッファのすべてのサンプル ウ ィ

ンド ウが満たされるか、 ユーザーが ILA コアを停止するまで繰り返されます。

[N Samples] キャプチャ  モード

このモードは、 ウ ィンド ウ  キャプチャ  モード と類似していますが、 次の 2 点が異なり ます。

• ウ ィンド ウごとのサンプル数は、 1 ～ （サンプル バッファ  サイズ - 1） の範囲で、 任意の整数

N に設定可能

• ト リ ガー位置は常にウ ィンド ウの位置 0 に設定

このモードは、キャプチャ  ス ト レージ リ ソースを浪費せずに、各ト リガーで必要なサンプル数のみ

をキャプチャする場合に役立ちます。

ト リガー マーク

ト リ ガー イベン ト と一致するサンプル ウ ィンド ウ内のデータ  サンプルには、 ト リガー マークが付

けられます。 この ト リガー マークによって、ウ ィ ンド ウ内の ト リガー位置が Analyzer に伝えられま

す。 ト リ ガー マークは、 サンプル バッファ内の 1 サンプルに対して 1 ビッ ト を使用します。

データ  ポート

ト リ ガー機能を実行する ト リガー ポート とは別のポート上のデータをキャプチャできます。 この機

能は、 コアの ト リガーに使用される情報と同じ情報のキャプチャおよび確認が有用ではなく、 キャ

プチャするデータ量を比較的少ない量に制限する際に役立ちます。

ただし、 通常は、 コアの ト リガーに使用されるデータ と同一データのキャプチャおよび確認が有用

です。 このよ う な場合、データが 1 つまたは複数の ト リガー ポートで構成されるよ うに選択できま

す。 この機能によ り、キャプチャに必要な ト リガー情報を選択できる柔軟性を活用しながら、リ ソー

スを節約できます。

ILA 制御およびステータス ロジック

ILA コアには、コアの通常動作を維持するために使用する制御およびステータス ロジッ クが少数含

まれます。 ILA コアを適切に認識し、 通信するのに必要なすべてのロジッ クが制御およびステータ

ス  ロジッ クによってインプリ メン ト されます。
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IBA/OPB コア

IBA/OPB (Integrated Bus Analyzer for the CoreConnect On-Chip Peripheral Bus) コアは、 IBM
CoreConnect OPB (On-Chip Peripheral Bus) を含むエンベデッ ド  システムのデバッグ向けに設計

されたロジッ ク  アナライザ コアです。 IBA/OPB コアは、 主に 4 つのコンポーネン トで構成されて

います。

• プロ ト コル違反モニター 

♦ 最大 32 までの IBM CoreConnect OPB バス  プロ ト コル違反を検出し、 レポート します。

• ト リ ガー入力および出力ロジッ ク

♦ ト リ ガー入力ロジッ クは、OPB バスおよびその他のユーザー定義のイベント を検出します。

♦ ト リ ガー出力ロジッ クは、 外部テス ト装置およびその他のロジッ クを ト リガーします。

• データ  キャプチャ  ロジッ ク  

♦ ブロ ッ ク  RAM リ ソースを使用して ト レース データ情報をキャプチャし、 格納します。

• 制御およびステータス  ロジッ ク  

♦ IBA/OPB コアの動作を管理します。

メモ : エンベデッ ド  プロセッサ デザインで IBA/OPB コアを生成して使用する方法の説明は、

ChipScope OPB IBA のデータシート  [251 ページのリ ファレンス  1 を参照] および EDK Platform
Studio オンライン ヘルプ [251 ページのリ ファレンス  16 を参照] を参照して ください。

IBA/OPB プロ ト コル違反モニター ロジッ ク

IBA/OPB コアには、 32 までの IBM CoreConnect OPB プロ ト コル違反エラーを検出するモニター

があ り ます。 表 1-4 に、 この IBA/OPB コアで検出できるプロ ト コル違反を示します。

表 1-4 : CoreConnect OPB プロ ト コル違反エラー (1)

優先順位 ビッ ト  エンコード エラー 説明

1 011010 1.19.2 OPB_XferAck 信号の受信前、 書き込み処理中に

OPB_DBus 信号のステートが変化 

2 011001 1.19.1 OPB_XferAck 信号の受信前、 処理実行中に OPB_
ABus 信号のステートが変化 

3 001100 1.6.1 OPB_ABus 信号 : M_Select 信号が非アクティブの

と きに OPB_ABus 信号が 0 ではない 

4 001101 1.7.1 OPB_DBus 信号 : M_Select 信号が非アクティブの

と きに OPB_DBus 信号が 0 ではない 

5 010101 1.13.1 OPB_XferAck 信号 : M_Select 信号が非アクティ

ブのと きに OPB_XferAck 信号がアクティブ 

6 010110 1.13.2
OPB_XferAck 信号 : OPB_Select 信号 の 16 サイ

ク ル以内に OPB_XferAck 信号がアク ティ ブにな

らない 

7 010111 1.15.1 OPB_ErrAck 信号 : M_Select 信号が非アクティブ

のと きに OPB_ErrAck 信号がアクティブ 

8 000100 1.4.0 OPB_Retry 信号 : OPB_Retry 信号および OPB_
XferAck 信号が同一サイクルでアクティブ 
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9 000111 1.4.3 OPB_Retry 信号 : OPB_Retry 信号が 2 サイクル間

以上アクティブ 

10 000000 1.2.1 OPB_MGrant 信号 : 複数の OPB_MGrant 信号が同

一サイクルでアクティブ 

11 000001 1.2.2 OPB_MGrant 信号 : OPB_MGrant 信号が別のマス

タに対してアクティブ 

12 000010 1.3.1 OPB_BusLock 信号 : OPB_Select 信号なし、1 つ前

のサイクルでグラン ト なしでアサート  

13 000011 1.3.2 OPB_BusLock 信号 : バスがロ ッ ク し、 バスを使用

しないマスタにグラン トが与えられる  

14 001000 1.4.4 OPB_Retry 信号 : リ ト ラ イ  サイクル後も  OPB_
Select 信号がアクティブ 

15 001001 1.4.5 OPB_Retry 信号 : M_Select 信号が非アクティブの

と きに OPB_Retry 信号がアクティブ 

16 001110 1.8.1
OPB_Select 信号 : M_Select 信号が OPB_
MxGrant 信号または OPB_BusLock 信号によるバ

ス制御なしでアクティブ

17 001111 1.8.2 OPB_Select 信号 : 2 つ以上の M_Select 信号が同一

サイクルでアクティブ 

18 010000 1.9.1 OPB_RNW 信号 : M_Select 信号が非アクティブの

と きに OPB_RNW 信号が High 

19 011011 1.19.3 OPB_XferAck 信号の受信前、 処理実行中に OPB_
RNW 信号のステートが変化 

20 011100 1.19.4 OPB_XferAck 信号の受信前、 処理実行中に OPB_
Select 信号のステートが変更 

21 011101 1.19.5 OPB_XferAck 信号の受信前、 書き込みまたは読み

出し処理中に OPB_BE 信号のステートが変化 

22 011110 1.20.3 バイ ト  イネーブルの遷移がアドレス  オフセッ トに

揃っていない 

23 011111 1.20.4 継続したバイ ト  イネーブルがない場合に、 バイ ト

イネーブル転送が開始

24 000110 1.4.2 OPB_Retry 信号 : リ ト ラ イ したマスタからの

M_Request がリ ト ライ  サイクル後もアクティ ブ 

25 000101 1.4.1 OPB_Retry 信号 : リ ト ラ イ  サイクル後も  OPB_
BusLock がアクティブ 

26 010001 1.11.1
OPB_SeqAddr 信号 : OPB_BusLock 信号が非アク

ティブにも関わらず、 OPB_SeqAddr 信号がアク

ティブ 

27 010010 1.11.2 OPB_SeqAddr 信号 : M_Select 信号が非アクティ

ブのと きに OPB_SeqAddr 信号がアクティブ 

表 1-4 : CoreConnect OPB プロ ト コル違反エラー (1) (続き)

優先順位 ビッ ト  エンコード エラー 説明
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プロ ト コル違反モニターは、 OPB バスで発生したエラーを検出してレポート します。エラーは、優

先度がエンコード された 6 ビッ トの値と してレポート され、 この値は IBA/OPB コアへのト リガー

およびデータの両方と して使用できます。 優先度 1 が最優先であ り、複数のエラーがある場合、優先

度の高いエラーがレポート されます。

IBA/OPB ト リガー入力ロジック

IBM CoreConnect オンチップ ペリ フェラル バス向けの IBA (IBA/OPB) コアは、 エンベデッ ド

MicroBlaze ソフ ト  プロセッサまたは Virtex-4 FX および Virtex-5 FXT ファ ミ リの PowerPC ハー

ド  プロセッサ システムの CoreConnect OPB バスの監視に使用します。 IBA/OPB コアは、 最大 16
個までのト リガー グループを監視できます。 29 ページの表 1-5 に、監視可畔 OPB 信号グループを

示します。

IBA/OPB コアは ILA コアと同様のト リガー条件およびス ト レージ必要条件をインプ リ メン トでき

ます。 これらの機能は、 20 ページの 「ILA ト リ ガー入力ロジッ ク」 に記載されています。 

IBA/OPB ト リガー出力ロジック

IBA/OPB コアは TRIG_OUT と 呼ばれるト リ ガー出力ポート をインプリ メ ント します。 TRIG_OUT
ポート は、 Analyzer を使用して動作時に設定されるト リ ガー条件の出力です。 入力ト リ ガー ポート

に対する  TRIG_OUT のレイテンシは、 15 ク ロッ ク  サイク ルです。

TRIG_OUT ポートは非常に柔軟性があ り、多用途に使用できます。 たとえば、次のよ うに使用でき

ます。

• このポート をデバイス  ピンに接続して、オシロスコープおよびロジッ ク  アナライザなどの外部

テス ト装置を ト リガーできます。

• デバイスに組み込まれた PowerPC または MicroBlaze プロセッサの割り込みラインに接続す

る と、 ソフ ト ウェア イベン ト を発生させるこ とができます。

• TRIG_OUT ポート を別のコアの ト リガー入力ポートに接続する と、 オンチップ デバッグ ソ
リ ューシ ョ ンの ト リガーおよびデータ  キャプチャ機能を拡張できます。

28 010011 1.11.3 OPB_SeqAddr 信号 : OPB_SeqAddr 信号の処理中に

OPB_ABus 信号が適切に増分しない 

29 010100 1.11.4 OPB_SeqAddr 信号 : ト ランザクシ ョ ン境界なしに

OPB_SeqAddr 信号がアサート  

30 011000 1.16.1 OPB_ToutSup 信号 : M_Select 信号が非アクティブ

のと きに OPB_ToutSup 信号がアクティブ 

31 001010 1.5.1 OPB_Timeout 信号 : 16 サイクル間無反応の後、

アービタが OPB_Timeout 信号を送信できない

32 001011 1.5.2 OPB_Timeout 信号 : M_Select 信号が非アクティブ

のと きに OPB_Timeout 信号がアクティブ

33 111111 - エラーなし

メモ : 

1. これらの CoreConnect OPB エラーの詳細は、 IBM の 『OPB Bus Functional Model Toolkit User’s 
Manual』 を参照して ください。

表 1-4 : CoreConnect OPB プロ ト コル違反エラー (1) (続き)

優先順位 ビッ ト  エンコード エラー 説明
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X-Ref Target - Figure 1-4

表 1-5 : OPB 信号グループ

ト リガー グループ名 幅 説明

OPB_CTRL 17

次を含む OPB 組み合わせ制御信号

• SYS_Rst

• Debug_SYS_Rst

• WDT_Rst

• OPB_Rst

• OPB_BE[3]

• OPB_BE[2]

• OPB_BE[1]

• OPB_BE[0]

• OPB_select

• OPB_xferAck

• OPB_RNW

• OPB_errAck

• OPB_timeout

• OPB_toutSup

• OPB_retry

• OPB_seqAddr

• OPB_busLock

OPB_ABUS 32 OPB アドレス  バス

OPB_DBUS 32 OPB 組み合わせデータ  バス  (読み出しおよび書き込

みデータ  バスの論理 OR)

OPB_RDDBUS 32 OPB 読み出しデータ  バス  (スレーブから )

OPB_WRDBUS 32 OPB 書き込みデータ  バス  (スレーブへ)

OPB_Mn_CTRL 11

次を含むマスタ  n からの OPB 制御信号

• Mn_request

• OPB_MnGrant

• OPB_pendReqn

• Mn_busLock

• Mn_BE[3]

• Mn_BE[2]

• Mn_BE[1]

• Mn_BE[0]

• Mn_select

• Mn_RNW

• Mn_seqAddr

n は、 0 ～ 15 のマスタ番号を表します。
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IBA/OPB コアは CoreConnect OPB バス信号だけでなく 、 TRIG_IN ト リ ガー グループを使用して、

汎用のデザイン信号も監視できます。 この機能により 、 CoreConnect OPB でのイベント と デザイン

内のその他の場所でのイベント を関連付けるこ と ができます。さ らに、TRIG_IN および TRIG_OUT
ポート 信号を使用して、 IBA/OPB コアを別のキャプチャ  コアに接続すると 、デザインの異なる部分

を監視しながら 、 ク ロス  ト リ ガーを実行できます。

IBA/OPB データ  キャプチャ  ロジッ ク

IBA/OPB コアのデータ  キャプチャ  ロジッ ク機能は、 ILA コアと同様です。 これらの機能は、 25
ページの 「ILA データ  キャプチャ  ロジッ ク」 に記載されています。

IBA/OPB 制御およびステータス ロジッ ク

IBA/OPB コアには、 コアの通常動作を維持するために制御およびステータス  ロジッ クが少数含ま

れます。 IBA/OPB コアを適切に認識し、 通信するために必要なすべてのロジッ クが制御およびス

テータス  ロジッ クによってインプリ メン ト されます。

IBA/PLB コア

v3.4 IBA/PLB (Integrated Bus Analyzer for the CoreConnect Processor Local Bus) コアは、 IBM
CoreConnect PLB (Processor Local Bus) を含むエンベデッ ド  システムのデバッグ向けに設計され

たロジッ ク  アナライザ コアです。 

メモ : このコアは、PLB v4.6 よ り前のバージ ョ ンの PLB でのみ使用されます。 PLB v4.6 バスの場

合は、カスタマイズした ILA コア (chipscope_plbv46_iba) を Xilinx Platform Studio ツールを使用

して PLB v4.6 バスに接続します。

IBA/PLB コアは、 主に 3 つのコンポーネン トで構成されています。

• ト リ ガー入力および出力ロジッ ク

♦ ト リ ガー入力ロジッ クは、PLB バスおよびその他のユーザー定義のイベント を検出します。

♦ ト リ ガー出力ロジッ クは、 外部テス ト装置およびその他のロジッ クを ト リガーします。

• データ  キャプチャ  ロジッ ク  

♦ ブロ ッ ク  RAM リ ソースを使用して ト レース データ情報をキャプチャし、 格納します。

• 制御およびステータス  ロジッ ク  

♦ IBA/PLB コアの動作を管理します。

OPB_SLm_CTRL 4

次を含むスレーブ m の OPB 制御信号

• Slm_xferAck

• Slm_errAck

• Slm_toutSup

• Slm_retry

m は、 0 ～ 63 のスレーブ番号を表します。

OPB_PV 6 OPB プロ ト コル違反信号

TRIG_IN ユーザー定義 汎用ト リガー入力

表 1-5 : OPB 信号グループ (続き)

ト リガー グループ名 幅 説明
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メモ : エンベデッ ド  プロセッサ デザインで IBA/PLB コアを生成して使用する方法の説明は、

ChipScope PLB IBA のデータシート  [251 ページのリ ファレンス  2 を参照] および EDK Platform
Studio オンライン ヘルプ [251 ページのリ ファレンス  16 を参照] を参照して ください。

IBA/PLB ト リガー入力ロジック

IBM CoreConnect プロセッサ ローカル バス向けの IBA コア (IBA/OPB) は、 エンベデッ ド

MicroBlaze ソフ ト  プロセッサまたは Virtex-4 FX および Virtex-5 FXT ファ ミ リの PowerPC ハー

ド  プロセッサ システムの CoreConnect PLB バスの監視に使用します。 IBA/PLB コアは、 16 まで

の異なる ト リガー グループを監視できます。 32 ページの表 1-6 に、監視可能な OPB 信号グループ

を示します。

IBA/PLB コアは PLB バス信号だけでなく、 TRIG_IN ト リ ガー グループを使用して汎用のデザイ

ン信号も監視できます。 この機能によ り、 PLB でのイベン ト とデザイン内のその他の場所でのイベ

ン ト を関連付けるこ とができます。 さ らに、 TRIG_IN および TRIG_OUT ポート信号を使用して、

IBA/PLB コアを別のキャプチャ  コアに接続する と、デザインの異なる部分を監視しながら、ク ロス

ト リガーを実行できます。

IBA/PLB コアは ILA コアと同様のト リガー条件およびス ト レージ必要条件をインプ リ メン トでき

ます。 これらの機能は、 20 ページの 「ILA ト リ ガー入力ロジッ ク」 に記載されています。
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表 1-6 : PLB 信号グループ

ト リガー グループ名 幅 説明

PLB_CTRL 26

次を含む PLB バス制御信号

• SYS_plbReset

• PLB_abort

• PLB_BE(0)

• PLB_BE(1)

• PLB_BE(2)

• PLB_BE(3)

• PLB_BE(4)

• PLB_BE(5)

• PLB_BE(6)

• PLB_BE(7)

• PLB_busLock

• PLB_masterID(0)

• PLB_masterID(1)

• PLB_masterID(2)

• PLB_masterID(3)

• PLB_Msize(0)

• PLB_Msize(1)

• PLB_PAValid

• PLB_SAValid

• PLB_rdPrim

• PLB_RNW

• PLB_size(0)

• PLB_size(1)

• PLB_size(2)

• PLB_size(3)

• PLB_wrPrim

PLB_ABUS 32 PLB アドレス バス

PLB_RDDBUS 64 PLB 読み出しデータ  バス  (スレーブから )

PLB_WRDBUS 64 PLB 書き込みデータ  バス  (スレーブへ)

http://japan.xilinx.com


ChipScope Pro 12.3 ソフ トウェアおよびコア japan.xilinx.com 33
UG029 (v12.3) 2010 年 9 月 21 日

ChipScope Pro コアの概要

PLB_Mn_CTRL 32

次を含むマスター  n からの PLB 制御信号

• PLB_MnAddrAck

• PLB_Mn_Busy

• PLB_Mn_Err

• PLB_MnRdDAck

• PLB_MnRdWdAddr(0)

• PLB_MnRdWdAddr(1)

• PLB_MnRdWdAddr(2)

• PLB_MnRdWdAddr(3)

• PLB_MnRearbitrate

• PLB_MnSSize(0)

• PLB_MnSSize(1)

• PLB_Mn_WrDAck

• Mn_abort

• Mn_BE(0)

• Mn_BE(1)

• Mn_BE(2)

• Mn_BE(3)

• Mn_BE(4)

• Mn_BE(5)

• Mn_BE(6)

• Mn_BE(7)

• Mn_busLock

• Mn_MSize(0)

• Mn_MSize(1)

• Mn_priority(0)

• Mn_priority(1)

• Mn_request

• Mn_RNW

• Mn_size(0)

• Mn_size(1)

• Mn_size(2)

• Mn_size(3)

n は、 0 ～ 15 のマスター番号を表します。

表 1-6 : PLB 信号グループ (続き)

ト リガー グループ名 幅 説明
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IBA/PLB ト リガー出力ロジック

IBA/PLB コアは TRIG_OUT と 呼ばれるト リ ガー出力ポート をインプリ メ ント します。 TRIG_OUT
ポート は、 Analyzer を使用して動作時に設定されるト リ ガー条件の出力です。 入力ト リ ガー ポート

に対する  TRIG_OUT のレイテンシは、 10 ク ロッ ク  サイク ルです。

TRIG_OUT ポートは非常に柔軟性があ り、 多用途に使用できます。 このポート をデバイス  ピンに

接続し、 オシロスコープおよびロジッ ク  アナライザなどの外部テス ト装置を ト リガーできます。 ま
た、デバイスに組み込まれた PowerPCまたは MicroBlaze プロセッサの割り込みラインに接続する

と、 ソフ ト ウェア イベン ト を発生させるこ とができます。 さ らに、 別のコアのト リガー入力ポート

に接続する と、 オンチップ デバッグ ソ リ ューシ ョ ンの ト リガーおよびデータ  キャプチャ機能を拡

張できます。

IBA/PLB データ  キャプチャ  ロジック

IBA/PLB コアのデータ  キャプチャ機能は、 ILA コアの場合と同様です。 これらの機能は、 25 ペー

ジの 「ILA データ  キャプチャ  ロジッ ク」 に記載されています。

IBA/PLB 制御およびステータス ロジッ ク

IBA/PLB コアには、 コアの通常動作を維持するために制御およびステータス  ロジッ クが少数含ま

れます。 IBA/PLB コアを適切に認識し、通信するために必要なすべてのロジッ クは、制御およびス

テータス  ロジッ クによってインプリ メン ト されます。

PLB_SLm_CTRL 12

次を含むスレーブ m の PLB 制御信号

• Slm_addrAck

• Slm_rdDAck

• Slm_rdWdAddr(0)

• Slm_rdWdAddr(1)

• Slm_rdWdAddr(2)

• Slm_rdWdAddr(3)

• Slm_rearbitrate

• Slm_SSize(0)

• Slm_SSize(1)

• Slm_wait

• Slm_wrComp

• Slm_wrDAck

m は、 0 ～ 15 のスレーブ番号を表します。

TRIG_IN ユーザー定義 汎用ト リガー入力

表 1-6 : PLB 信号グループ (続き)

ト リガー グループ名 幅 説明
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VIO コア

Virtual Input/Output (VIO) は、内部 FPGA 信号を即時に監視および駆動できるカスタマイズ可能な

コアです。 ILA および IBA コアとは違い、オンチップ RAM やオフチップ RAM は必要あ り ません。

VIO コアでは、 次の 4 種類の信号が使用できます。

• 非同期入力

♦ JTAG ケーブルから駆動される  JTAG クロ ッ ク信号を使用してサンプリ ングされます。

♦ 入力値は定期的に読み戻され、 ChipScope Analyzer で表示されます。

• 同期入力

♦ デザイン ク ロ ッ クを使用してサンプリ ングされます。

♦ 入力値は定期的に読み戻され、 ChipScope Analyzer に表示されます。

• 非同期出力

♦ ユーザーが Analyzer で定義する信号で、 コアから周辺デザインへ駆動されます。

♦ 各非同期出力に対して、 ロジッ ク  0 または 1 が定義可能です。

• 同期出力

♦ ユーザーが Analyzer で定義する信号で、 デザイン ク ロ ッ クに動機しており、 コアから周

辺デザインへ駆動されます。

♦ 各同期出力に対して、 ロジッ ク  1 または 0 が定義可能です。 また、 1 および 0 の両方また

はいずれかの 16 ク ロ ッ ク  サイ クル分のパルス列を同期出力に指定できます。

アクテ ィ ビテ ィ検出器

VIO コア入力には、入力の遷移をキャプチャするためのセルが別にあ り ます。 デザイン ク ロ ッ クが

ChipScope Analyzer のサンプル周期よ り も速いこ とがほとんどなので、連続するサンプル間で信号

の遷移を何度も監視できます。 アクティビティ検出器はこの動作を検出し、 結果と値を ChipScope
Analyzer に表示します。 

同期入力の場合は、 非同期イベン ト と同期イベン ト を監視するアクティビティ  セルが使用されま

す。 この機能は、 同期信号上でのグ リ ッチや同期遷移を検出する場合にも使用できます。

パルス列

VIO の同期出力すべてに、スタティ ッ ク  1、スタティ ッ ク  0、または連続する値のパルス列を出力す

る機能があ り ます。 パルス列とは、連続したデザイン ク ロ ッ ク  サイクルでコアから駆動される、16
ク ロ ッ ク  サイクル分の 1 および 0 のシーケンスです。 パルス列シーケンスは、 Analyzer で定義さ

れ、 コアに読み込まれた後 1 度だけ実行できます。
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ATC2 コア

ATC2 (Agilent Trace Core 2) は、 カスタマイズ可能なデバッグ キャプチャ  コアであ り、 最新の

Agilent 社ロジッ ク  アナライザと機能するよ うに設計されています。 ATC2 コアによって、 外部の

Agilent 社ロジッ ク  アナライザから  FPGA デザイン内部のネッ トへアクセスできます (図 1-5)。

ATC2 コアのデータ  パスについて

ATC2 コアのデータ  パスは、 次で構成されています。

• ユーザー FPGA デザインに接続される、 実行時に選択可能な最大 64 個の入力信号バンク

• Agilent 社ロジッ ク  アナライザのプローブ コネクタに接続される最大 64 個の出力データ  ピン

• オプシ ョ ンと して、各出力データ  ピンで使用可能な 2 倍の TDM (Time-Division Multiplexing)
があ り、 これを使用する と個々の信号バンク幅を 64 から  2 倍 の 256 ビッ トにできます。 

• 非同期タイ ミ ングおよび同期ステート  キャプチャ  モードを共にサポート

• それぞれの出力データ  ピンに対して、有効な I/O 規格、駆動電流、および出力スルー レート を

サポート

• Agilent 社のプローブ接続技術をサポート  [252 ページのリ ファレンス  26 を参照]

動作時に使用可能なデータ  プローブ ポイン トの最大数は、 次の式で求められます。 
(64 データ  ポート ) * (データ  ポート ごとに 64 ビッ ト ) * (2x TDM) = 8,192 プローブ ポイン ト

ATC2 コアのデータ  キャプチャおよび実行時の制御

外部の Agilent 社ロジッ ク  アナライザを使用し、 ATC2 コアを通過するデータを ト リガーおよび

キャプチャします。 これによ り、 ATC2 コアが示す内部デザイン ノードがよ りわかりやすくなるだ

けでなく、 Agilent 社ロジッ ク  アナライザの複雑な ト リガー、 ワード数の多い ト レース メモ リ、 お

よびシステム レベルのデータ相関機能を十分に活用できます。 また、 Agilent 社ロジッ ク  アナライ

ザは、 JTAG ポート接続を介して ATC2 コアと通信するこ とによって、動作時にアクティブ データ

ポート選択を制御する場合にも使用されます (図 1-5)。

X-Ref Target - Figure 1-5

図 1-5 : ATC2 コアおよびシステム ブロック図
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IBERT コア

IBERT コアには、 制御、 監視、 ト ランシーバ パラ メータの変更、 およびビッ ト  エラー比率テス ト

を実行するすべてのロジッ クが含まれています。 IBERT コアには、主に 3 つのコンポーネン トがあ

り ます。

• BERT ロジッ ク

♦ BERT ロジッ クはト ランシーバ コンポーネン ト をインスタンシエート し、パターン ジェネ

レータおよびチェッカを含んでいます。 単純なクロ ッ ク  タイプ パターンから  PRBS パ
ターンやフレーム付きカウンタ  パターンまでさまざまなパターンを使用できます。

• ダイナミ ッ ク  リ コンフ ィギュレーシ ョ ン ポート  (DRP) ロジッ ク

♦ 各ト ランシーバには、 ダイナミ ッ ク  リ コンフ ィギュレーシ ョ ン ポート  (DRP) があ り、 ト

ランシーバの属性をシステムで変更できます。 すべての属性および DRP アドレスは

IBERT コアで読み出し /書き込み可能です。 各ト ランシーバの DRP は、個別にアクセスで

きます。

• 制御およびステータス  ロジッ ク

♦ IBERT コアの動作を管理します。

IBERT デザイン フロー

IBERT は内蔵型デザインのため、 デザイン フローは非常に単純です。 ChipScope IBERT Core
Generator を使用して Virtex-4 および Virtex-5 デバイス向けの IBERT コア デザインを生成する

と、デザイン ディ レク ト リおよび BIT ファ イル名が指定され、オプシ ョ ンが選択され、ビッ ト ス ト

リーム生成を含むインプ リ メンテーシ ョ ン フローすべてがワンステップで実行されます。

Virtex-6 および Spartan-6 デバイスの IBERT コア デザインを生成するデザイン フローは、 ザイ リ

ンクス  CORE Generator を使用する という点を除き類似しています。 主な違いは、デザイン ディ レ

ク ト リ とデバイス情報がザイ リ ンクスの CORE Generator プロジェク トで指定される という点で

す。 両方の場合で、IBERT コアのデザイン BIT ファ イルを生成するために別のザイ リ ンクス  ソフ ト

ウェアを実行する必要はあ り ません。

IBERT の機能

IBERT コアの機能は、 ターゲッ トにする  FPGA デバイスのアーキテクチャによって異なり ます。 
サポート される  MGT 機能は、 次のとおりです。

• Virtex-4 FPGA GT11 ト ランシーバ用 IBERT v1.0 コア (39 ページの表 1-7)

♦ 差動スイング、 エンファシス、 および RX イコラ イゼーシ ョ ンを含む PMA の完全制御

♦ 実行時にライン レートおよびリ ファレンス  クロ ッ ク  ソースを変更可能

♦ ループバッ クおよび 8B/10B エンコードのイネーブル/ディ スエーブルを含む PCS サポー

ト  (制限あり )。 ク ロ ッ ク  コレクシ ョ ンおよびチャネル ボンディングはサポート されてい

ません。

• Virtex-5 FPGA GTP および GTX ト ランシーバ用 IBERT v1.0 コア (40 ページの表 1-8)

♦ 差動スイング、エンファシス、 RX イコラ イゼーシ ョ ン、および DFE を含む PMA の完全

制御

♦ 実行時にライン レートおよびリ ファレンス  クロ ッ ク  ソースを変更可能

♦ ループバッ クおよび 8B/10B エンコードのイネーブル/ディ スエーブルを含む PCS サポー

ト  (制限あり )。 ク ロ ッ ク  コレクシ ョ ンおよびチャネル ボンディングはサポート されてい

ません。
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♦ GTP ト ランシーバに 2 バイ ト  ファブリ ッ ク幅、GTX ト ランシーバに 4 バイ ト  ファブ リ ッ

ク幅

• Virtex-5 FPGA GTX ト ランシーバ用 IBERT v2.0 コア (41 ページの表 1-9)

♦ 差動スイング、エンファシス、 RX イコラ イゼーシ ョ ン、および DFE を含む PMA の完全

制御

♦ 実行時にライン レート を変更可能

♦ ループバッ クを含む制限付き  PCS サポート  (8b/10b エンコード、ク ロ ッ ク  コレクシ ョ ン、

およびチャネル ボンディングはサポート されていません。 )

♦ 40 ビッ トのファブ リ ッ ク  データ幅 (4 バイ ト  モード )

• Virtex-6 FPGA GTX ト ランシーバ用 IBERT v2.0 コア (42 ページの表 1-10)

♦ 差動スイング、エンファシス、 RX イコラ イゼーシ ョ ン、および DFE を含む PMA の完全

制御

♦ 実行時にライン レート を変更可能

♦ 生成時にリ ファレンス  ク ロ ッ ク  ソースを設定可能

♦ ループバッ クを含む制限付き  PCS サポート。 パターン エンコード、 ク ロ ッ ク  コレクシ ョ

ン、 およびチャネル ボンディングはサポート されていません。

• Virtex-6 FPGA GTH ト ランシーバ用 IBERT v2.0 コア (43 ページの表 1-11)

♦ 差動スイング、エンファシス、 RX イコラ イゼーシ ョ ン、および DFE を含む PMA の完全

制御

♦ 生成時にリ ファレンス  ク ロ ッ ク  ソースを設定可能

♦ ループバッ クを含む制限付き  PCS サポート。 パターン エンコード、 ク ロ ッ ク  コレクシ ョ

ン、 およびチャネル ボンディングはサポート されていません。

♦ TX 差動スイング

♦ TX プリエンファシスおよびポス トエンファシス

• Spartan-6 FPGA GTP ト ランシーバ用 IBERT v2.0 コア (44 ページの表 1-12)

♦ 差動スイング、エンファシス、 RX イコラ イゼーシ ョ ン、および DFE を含む PMA の完全

制御

♦ 実行時にライン レート を変更可能

♦ 生成時にリ ファレンス  ク ロ ッ ク  ソースを設定可能

♦ ループバッ クを含む制限付き  PCS サポート。 パターン エンコード、 ク ロ ッ ク  コレクシ ョ

ン、 およびチャネル ボンディングはサポート されていません。

♦ TX 差動スイング

♦ TX プリエンファシス
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表 1-7 : Virtex-4 FPGA GT11 ト ランシーバ用 IBERT v1.0 コア

機能 説明

複数のマルチギガビ ッ ト

ト ランシーバ

1 ～ デバイスで使用可能な ト ランシーバ数まで選択可能

パターン ジェネレータ 選択したト ランシーバごと に 1 つのパターン  ジェネレータが使用

されます。基本的なパターン  ジェネレータを選択した場合は、PRBS
7、1/2X、1/10X、および 1/20X のクロッ ク  パターンが使用され、完

全なパターン  ジェネレータを選択した場合は上記のクロッ ク  パ

ターンに加えて、 PRBS 9、 11、 13、 15、 20、 29、 および 31 パター

ンが使用されます。 アイド ル パターン  (+K28.5、 -K28.5) も  1 つあ

り ます。 パターンは、 ランタイム時に各ト ランシーバでそれぞれ選

択できます。

パターン チェッカ 選択した ト ランシーバごとに 1 つのパターン チェッカが使用され

ます。 同じパターン セッ ト をパターン ジェネレータ と して使用で

きます。 パターンは、 ランタイム時に各ト ランシーバでそれぞれ選

択できます。

ファブ リ ッ ク幅 ト ランシーバに対する  FPGA のファブ リ ッ ク幅は、生成時にト ラン

シーバごとでカスタマイズできます。 幅には、 16、 20、 32、 および

40 ビッ ト を選択できます。

BERT パラ メータ 受信したエラーを含むビッ ト数および受信したワード数の合計が

即時に集計されて Analyzer で読み出されます。

極性 各ト ランシーバの TX または RX 側の極性を実行時に変更できます。

8b/10b エンコード /
デコードのサポート

8b/10b エンコード /デコードは、 ト ランシーバごとに実行時にイ

ネーブルにできます。 TX エンコードおよび RX デコードは、 別々

に選択できます。 8B/10B エンコードは、ファブ リ ッ ク幅が 16 また

は 32 ビッ トのと きのみ使用できます。

リセッ ト 各ト ランシーバの PCS/PMA は別々にリセッ ト可能で、 各ト ラン

シーバの BER カウンタも個別にリセッ トできます。 すべてのカウ

ンタ、PCS、および PMA を一度にリセッ トするグローバル リセッ

ト も使用できます。

リ ンクおよびロッ ク  
ステータス

コアに含まれる各ト ランシーバでリ ンク  ステータス、TX PLL ロ ッ

ク  ステータス、 および RX PLL ロ ッ ク  ステータスを集めます。 ア
クティビティ  ビッ ト もあ り、 ステータス  ビッ トが最後に読み出さ

れたと きから変更された場合に示されます。

DRP 読み出し 各ト ランシーバのダイナミ ッ ク  リ コンフ ィギュレーシ ョ ン ポート

(DRP) の内容は、 個別に読み出すこ とができます。

DRP 書き込み 各ト ランシーバの DRP の内容は、実行時にシングル ビッ ト精度で

変更できます。

ステータス コア全体のダイナミ ッ ク  ステータス情報を実行時に読み出すこ と

ができます。
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表 1-8 : Virtex-5 FPGA GTP および GTX ト ランシーバ用 IBERT v1.0 コア

機能 説明

複数のマルチギガビ ッ ト

ト ランシーバ

デザインに最大 8 個の ト ランシーバを選択可能

パターン ジェネレータ 選択したト ラ ンシーバごと に 1 つのパターン  ジェネレータが使用

さ れます。 基本的なパターン  ジェネレータを選択する場合は、

PRBS7 ビッ ト 、 PRBS 23 ビッ ト 、 PRBS 31 ビッ ト 、 およびユー

ザー定義のパターンが使用さ れます。完全なパターン  ジェネレータ

を選択する場合は、上述のパターンに加えて、代替 PRBS 7 ビッ ト 、

PRBS 9 ビッ ト 、PRBS 11 ビッ ト 、PRBS 15 ビッ ト 、PRBS 20 ビッ

ト 、 PRBS 29 ビッ ト 、 フレーム付きカウンタ 、 およびアイ ド ル パ
ターンが使用さ れます。 すべてのト ラ ンシーバで使用可能なパター

ン  セッ ト はコンパイル時に一度選択さ れるのに対し 、そのセッ ト の

特定のパターンは実行時に各ト ラ ンシーバで個別に選択できます。

パターン チェッカ 選択した ト ランシーバごとに 1 つのパターン チェッカが使用されま

す。 同じパターン セッ ト をパターン ジェネレータ と して使用できま

す。 パターンは、ランタイム時に各ト ランシーバでそれぞれ選択でき

ます。

ファブ リ ッ ク幅 GTP ト ランシーバに対する  FPGA ファブリ ッ クのインターフェイ

スは、 2 バイ ト  モードで固定されています。 GTX ト ランシーバに対

する  FPGA ファブリ ッ クのインターフェイスは、 4 バイ ト  モードで

固定されています。

BERT パラ メータ 受信したエラーを含むビッ ト数および受信したワード数の合計が即

時に集計されて Analyzer で読み出されます。

極性 各ト ランシーバの TX または RX 側の極性を実行時に変更できます。

8b/10b エンコード /
デコードのサポート

8b/10b エンコード /デコード は、 デュアルト ランシーバ (GTP_DUAL
または GTX_DUAL タイル) ごと に実行時にイネーブルにできます。

TX エンコード および RX デコード が同時に選択されます。

メモ : 8B/10B エンコード /デコード がイネーブルの場合は、 フレー

ム付きカウンタ  パターンおよびアイド ル パターンのみを使用でき

ます。

リセッ ト 各ト ランシーバおよび各ト ランシーバの BER カウンタは個別にリ

セッ トできます。 すべての ト ランシーバおよび BER カウンタを一度

にリセッ トするグローバル リセッ ト も使用できます。

ステータス 各ト ランシーバのリ ンク、 DCM、 および PLL ロ ッ ク  ステータスを

集めます。

DRP 読み出し 各ト ランシーバのダイナミ ッ ク  リ コンフ ィギュレーシ ョ ン ポート

(DRP) の内容は、 個別に読み出すこ とができます。

DRP 書き込み 各ト ランシーバの DRP の内容は、実行時にシングル ビッ ト精度で変

更できます。

ステータス コア全体のダイナミ ッ ク  ステータス情報を実行時に読み出すこ とが

できます。
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表 1-9 : Virtex-5 FPGA GTX ト ランシーバ用 IBERT v2.0 コア

機能 説明

複数の GTX ト ランシーバ デザインに最大 8 個のト ランシーバを選択可能

パターン ジェネレータ 選択した GTX ト ランシーバごとに 1 つのパターン ジェネ

レータが使用されます。使用できるパターンは、PRBS 7 ビッ

ト、PRBS 15 ビッ ト、PRBS 23-ビッ ト 、PRBS 31 ビッ ト 、Clk
2x、および Clk 10x パターンです。 各 GTX ト ランシーバに対

して、 任意のパターンを実行時に選択できます。

パターン チェッカ 選択した GTX ト ランシーバごとに 1 つのパターン チェッカ

が使用されます。 同じパターン セッ ト をパターン ジェネレー

タ と して使用できます。 パターンは、 ランタイム時に各 GTX
ト ランシーバでそれぞれ選択できます。

ファブ リ ッ ク幅 GTX_DUAL タイルへの FPGA ファブリ ッ ク  インターフェイ

スは、 32 または 40 ビッ ト 幅にでき、 生成時に選択できます。

BERT パラ メータ 受信したエラーを含むビッ ト数および受信したワード数の合

計が即時に集計されて Analyzer で読み出されます。

極性 各 GTX ト ランシーバの TX または RX 側の極性を実行時に

変更できます。

リセッ ト 各 GTX ト ランシーバおよびその BER カウンタを個別にリ

セッ ト できます。 PLL を含む MGT 全体をリ セッ ト するリ セッ

ト もあり ます。

リ ンクおよびロッ ク  ステータス 各 GTX ト ランシーバのリ ンク、DCM、および PLL ロ ッ ク  ス
テータスを集めます。

DRP 読み出し 各 GTX ト ランシーバのダイナミ ッ ク  リ コンフィ ギュレーショ

ン  ポート  (DRP) の内容は、 個別に読み出すこと ができます。

DRP 書き込み 各 GTX ト ランシーバの DRP の内容は、 実行時にシングル

ビッ ト精度で変更できます。

ポートの読み出し GTX ト ランシーバのポート を監視するレジスタの内容を個

別に読み出すこ とができます。

ポートへの書き込み GTX ト ランシーバのポート を制御するレジスタの内容を実

行時に変更できます。

ステータス コア全体のダイナミ ッ ク  ステータス情報を実行時に読み出す

こ とができます。
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表 1-10 : Virtex-6 FPGA GTX ト ランシーバ用 IBERT v2.0 コア

機能 説明

複数の GTX ト ランシーバ デザインに最大 8 個のト ランシーバを選択可能

パターン ジェネレータ 選択した GTX ト ランシーバごとに 1 つのパターン ジェネ

レータが使用されます。使用できるパターンは、PRBS 7 ビッ

ト、 PRBS 15 ビッ ト 、 PRBS 23-ビッ ト 、 PRBS 31 ビッ ト、

Clk 2x、 および Clk 10x パターンです。 各 GTX ト ランシー

バに対して、 任意のパターンを実行時に選択できます。

パターン チェッカ 選択した GTX ト ランシーバごとに 1 つのパターン チェッカ

が使用されます。 同じパターン セッ ト をパターン ジェネ

レータ と して使用できます。 パターンは、 ランタイム時に各

GTX ト ランシーバでそれぞれ選択できます。

ファブ リ ッ ク幅 GTX ト ランシーバへの FPGA ファブ リ ッ ク  インターフェイ

スは、16 または 20 ビッ ト幅にでき、生成時に選択できます。 

BERT パラ メータ 受信したエラーを含むビッ ト数および受信したワード数の

合計が即時に集計されて Analyzer で読み出されます。

極性 各 GTX ト ランシーバの TX または RX 側の極性を実行時に

変更できます。

リセッ ト 各 GTX ト ランシーバおよびその BER カウンタを個別にリ

セッ ト できます。 PLL を含む MGT 全体をリ セッ ト するリ

セッ ト もあり ます。

リ ンクおよびロッ ク  ステータス 各 GTX ト ランシーバのリ ンク、 DCM、 および PLL ロ ッ ク

ステータスを集めます。

DRP 読み出し 各 GTX ト ランシーバのダイナミ ッ ク  リ コンフ ィギュレー

シ ョ ン ポート  (DRP) の内容は、 個別に読み出すこ とができ

ます。

DRP 書き込み 各 GTX ト ランシーバの DRP の内容は、 実行時にシングル

ビッ ト精度で変更できます。

ポートの読み出し GTX ト ランシーバのポート を監視するレジスタの内容を個

別に読み出すこ とができます。

ポートへの書き込み GTX ト ランシーバのポート を制御するレジスタの内容を実

行時に変更できます。

ステータス コア全体のダイナミ ッ ク  ステータス情報を実行時に読み出

すこ とができます。
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表 1-11 : Virtex-6 FPGA GTH ト ランシーバ用 IBERT v2.0 コア

機能 説明

複数の GTH ト ランシーバ デザインに最大 16 個のト ランシーバを選択可能

パターン ジェネレータ 選択した GTH ト ランシーバごとに 1 つのパターン ジェネ

レータ  (QUAD ごとに 4 つ) が使用されます。 使用できるパ

ターンは、 PRBS 7 ビッ ト、 PRBS 15 ビッ ト 、 PRBS 23ビッ

ト、 PRBS 31 ビッ ト 、Clk 2x、および Clk 10x パターンです。

各 GTH ト ランシーバに対して、任意のパターンを実行時に選

択できます。

パターン チェッカ 選択した GTH ト ランシーバごとに 1 つのパターン チェッカ

(QUAD ごとに 4 つ) が使用されます。 同じパターン セッ ト を

パターン ジェネレータ と して使用できます。 パターンは、 ラ

ンタイム時に各 GTH ト ランシーバでそれぞれ選択できます。

ファブ リ ッ ク幅 GTH QUAD への FPGA ファブリ ッ ク  インターフェイスは、

16 または 20 ビッ ト幅にでき、 生成時に選択できます。

BERT パラ メータ 受信したエラーを含むビッ ト数および受信したワード数の合

計が即時に集計されて Analyzer で読み出されます。

極性 各 GTH ト ランシーバの TX または RX 側の極性を実行時に変

更できます。

リセッ ト 各 GTH ト ランシーバの BER カウンタを個別にリセッ トでき

ます。  PLL を含む GTH QUAD を リセッ トする リセッ ト もあ

り ます。

リ ンクおよびロッ ク  ステータス 各 GTH ト ランシーバのリ ンク、DCM、および PLL ロ ッ ク  ス
テータスを集めます。

DRP 読み出し 各 GTH ト ランシーバのダイナミ ッ ク  リ コンフィ ギュレーショ

ン  ポート  (DRP) の内容は、 個別に読み出すこと ができます。

DRP 書き込み 各 GTH ト ランシーバの DRP の内容は、 実行時にシングル

ビッ ト精度で変更できます。

ポートの読み出し GTH ト ランシーバのポート を監視するレジスタの内容を個別

に読み出すこ とができます。

ポートへの書き込み GTH ト ランシーバのポート を制御するレジスタの内容を実行

時に変更できます。

ステータス コア全体のダイナミ ッ ク  ステータス情報を実行時に読み出す

こ とができます。
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表 1-12 : Spartan-6 FPGA GTP ト ランシーバ用 IBERT v2.0 コア

機能 説明

複数の GTP ト ランシーバ デザインに最大 8 個のト ランシーバを選択可能

パターン ジェネレータ 選択した GTP ト ランシーバごとに 1 つのパターン ジェネ

レータ  (DUAL ごとに 2 つ) が使用されます。 使用できるパ

ターンは、 PRBS 7 ビッ ト、 PRBS 15 ビッ ト 、 PRBS 23ビッ

ト、 PRBS 31 ビッ ト 、Clk 2x、および Clk 10x パターンです。

各 GTP ト ランシーバに対して、任意のパターンを実行時に選

択できます。

パターン チェッカ 選択した GTP ト ランシーバごとに 1 つのパターン チェッカ

(DUALごとに 2 つ) が使用されます。 同じパターン セッ ト を

パターン ジェネレータ と して使用できます。 パターンは、 ラ

ンタイム時に各 GTP ト ランシーバでそれぞれ選択できます。

ファブ リ ッ ク幅 GTP ト ランシーバに対する  FPGA のファブ リ ッ ク  インター

フェイス幅は 20 ビッ トです。

BERT パラ メータ 受信したエラーを含むビッ ト数および受信したワード数の合

計が即時に集計されて Analyzer で読み出されます。

極性 各 GTP ト ランシーバの TX または RX 側の極性を実行時に変

更できます。

リセッ ト 各 GTP ト ランシーバの BER カウンタを個別にリセッ トでき

ます。 PLL を含む GTP ト ランシーバ全体を リセッ トする リ

セッ ト もあ り ます。

リ ンクおよびロッ ク  ステータス 各 GTP ト ランシーバのリ ンク、DCM、および PLL ロ ッ ク  ス
テータスを集めます。

DRP 読み出し 各 GTP ト ランシーバのダイナミ ッ ク  リ コンフィ ギュレーショ

ン  ポート  (DRP) の内容は、 個別に読み出すこと ができます。

DRP 書き込み 各 GTP ト ランシーバの DRP の内容は、 実行時にシングル

ビッ ト精度で変更できます。

ポートの読み出し GTP ト ランシーバのポート を監視するレジスタの内容を個別

に読み出すこ とができます。

ポートへの書き込み GTP ト ランシーバのポート を制御するレジスタの内容を実行

時に変更できます。

ステータス コア全体のダイナミ ッ ク  ステータス情報を実行時に読み出す

こ とができます。
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ILA、 IBA、 IBA、 VIO、および ATC2 コアのオプシ ョ ンの多くは、再合成せずに変更できます。 た
だし、データ  ポート幅またはサンプル バッファのワード数などの選択可能なパラ メータの変更後に

は、新規コアでデザインを再合成する必要があ り ます。表 1-13 に、再合成が必要なデザインを示し

ます。

システム要件

OS 要件

ChipScope Pro の OS 要件は、 ISE Design Suite の 『インス トール、 ラ イセンス、 リ リース  ノート 』

[251 ページのリ ファレンス  15 を参照] に記載されています。 

ソフ トウェア要件

ザイ リ ンクス  CORE Generator、 Core Inserter、 IBERT Core Generator、 および CSE/Tcl ツールで

は、 ISE インプ リ メンテーシ ョ ン ツールがシステムにインス トールされているこ とを前提と します

(Tcl とは Tool Command Language の略語であ り、 Tcl シェル は Tcl スク リプ トの実行に使用され

るシェル プログラムです)。 CSE/Tcl では、ChipScope Pro および ISE ツールのインス トールに含ま

れている  Tcl シェル (xtclsh と呼ぶ) が必要です。

メモ : ChipScope Pro のバージョ ンは、ChipScope Pro コアを含むデザインをインプリ メ ント する

と きに使用する  ISE ツールのバージョ ンと 一致さ せる必要があり ます (アッ プデート  リ ビジョ ン

を含む)。

表 1-13 : デザインのパラメータ変更および再合成

デザインで変更するパラメータ 再合成の必要

ト リ ガー パターンの変更 なし

ト リガーの実行および停止 なし

外部ト リガーのイネーブル なし

ト リガー信号のソース変更 なし (1)

データ信号のソース変更 なし (1)

ILA のクロ ッ ク信号の変更 あ り

サンプル バッファのワード数変更 あ り

メモ : 

1. 既存のト リガーおよびデータ信号のソースの両方またはいずれかの変更機能は、 ISE FPGA Editor でサ
ポート されています。
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通信要件

Analyzer ツールでは、PC と  JTAG バウンダ リ  スキャン チェーン内のデバイス との通信用に、次の

ケーブルを使用できます (表 1-14 を参照)。

• プラ ッ ト フォーム ケーブル USB II

• プラ ッ ト フォーム ケーブル USB

• パラレル ケーブル IV

• ByteTools 社 Catapult EJ-1 イーサネッ ト  - JTAG 接続ケーブル [252 ページのリ ファレンス  28
を参照]

メモ : ChipScope Pro Analyzer でデバイス内の ILA コアと通信しながら、iMPACT でデバイスをコ

ンフ ィギュレーシ ョ ンするなど、ケーブルまたはデバイスで競合操作を行う と、DUT (テス ト対象デ

ザイン) が使用できな くなる可能性があ り ます。 競合しているケーブル/デバイス操作の結果が不確

かなと きは、 競合する操作が完了するまで Analyzer のケーブル接続を解除してください。

表 1-14 : ChipScope Pro がサポートするダウンロード  ケーブル

ダウンロード  ケーブル 機能

プラ ッ ト フォーム ケーブル 
USB II およびプラ ッ ト

フォーム ケーブル USB(1)

• USB ポート  (USB 2.0 または USB 1.1) を使用して、テス ト対

象ボードのバウンダ リ  スキャン チェーンと通信

• 最大 12Mb/s スループッ トでダウンロード

• 5V ～ 1.5V で動作するシステムおよびデバイス  I/O との通信

を可能にする調整可能な電圧インターフェイスを含む

• Windows および Red Hat Linux OS のサポート

パラレル ケーブル IV(1)

• プリ ンタ  ポート などのパラレル ポート を使用して、 テス ト対

象ボードのバウンダ リ  スキャン チェーンと通信

• 最大 5Mb/s スループッ トでダウンロード

• 5V ～ 1.5V で動作するシステムおよびデバイス  I/O との通信

を可能にする調整可能な電圧インターフェイスを含む

• Windows および Red Hat Linux OS のサポート

ByteTools 社 Catapult EJ-1 
イーサネッ ト  - JTAG 接続

ケーブル

• イーサネッ ト  ポート を使用して、 テス ト対象ボードのバウン

ダ リ  スキャン チェーンと通信

• 詳細は、 ByteTools 社の Web サイ ト を参照 [252 ページのリ

ファレンス  28 を参照]

メモ : 

1. パラレル ケーブル IV およびプラ ッ ト フォーム  ケーブル USB は、ザイ リ ンクス  オンラ イン ス ト ア [251 
ページのリ ファレンス  21 を参照] から購入可能です ([Buy Online] > [Programming Cables] をクリ ッ
クしてく ださい。 ただし 、 日本のお客様は [購入情報] にリ ス ト されている販売代理店までお問い合わせ
ください)。
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ボード要件

テス ト対象ボードで Analyzer とダウンロード  ケーブルを適切に動作させるには、次のボード  レベ

ル要件を満たす必要があ り ます。

• サポート されているデバイスを TDI、TMS、TCK、および TDO ピンを含む JTAG ヘッダに接

続する必要があ り ます。

• 別のデバイスがターゲッ ト  デバイスを含む JTAG チェーンの TDI、 TMS、 TCK ピンを駆動す

る場合には、これらのソースをディ スエーブルにしてダウンロード  ケーブルでの競合を回避で

きるよ う、 これらの信号にジャンパが必要です。

• ダウンロード  ケーブルと してパラレル ケーブル IV またはプラ ッ ト フォーム ケーブル USB
を使用する場合、 VREF (1.5 ～ 5.0V) および GND ヘッダが、 パラレル ケーブル IV への接続

用に使用可能である必要があ り ます。

ソフ トウェア インストールおよびライセンス

ChipScope Pro Analyzer ソフ ト ウェアは、Analyzer のみが必要なラボ環境などではスタンドアロン

ISE ラボ ツールと して、 または ISE Design Suite ツールの一部と してインス トールできます。 ソフ

ト ウェアのインス トールおよびライセンスの手順は、ISE Design Suite 資料 [251 ページのリ ファレ

ンス  15 を参照] の 『インス トール、 ラ イセンス、 リ リース  ノート 』 を参照してください。
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コア生成ツールの使用

概要 
この章では、ザイ リ ンクス  CORE Generator™ ツールを使用して ChipScope™ Pro コアを生成する

手順を説明します。 次のセクシ ョ ンが含まれています。

• 「ICON コアの生成」

• 「ILA コアの生成」

• 「VIO コアの生成」

• 「ATC2 コアの生成」

• 「Virtex-4 および Virtex-5 FPGA 用 IBERT v1.0 コアの生成」(1)

• 「Virtex-5 FPGA GTX ト ランシーバ用 IBERT v2.0 コアの生成」

• 「Virtex-6 FPGA GTX ト ランシーバ用 IBERT v2.0 コアの生成」

• 「Virtex-6 FPGA GTH ト ランシーバ用 IBERT v2.0 コアの生成」

• 「Spartan-6 FPGA GTP ト ランシーバ用 IBERT v2.0 コアの生成」

これらのコアは総称して ChipScope Pro ロジッ ク  デバッグ コアと言われます。 

コアの生成後、CORE Generator ツールで生成されるインスタンシエーシ ョ ン テンプレート を使用

して、 これらのコアを VHDL または Verilog デザインに迅速かつ容易に挿入できます。 インスタン

シエーシ ョ ンを完了して、 合成を実行した後は、 ISE® インプ リ メンテーシ ョ ン ツールを使用して

デザインをインプ リ メン トできます。

IBA/OPB コアを生成してエンベデッ ド  プロセッサ デザインで使用する方法の詳細は、 ChipScope
OPB IBA データシート  [251 ページのリ ファレンス  1 を参照] および EDK Platform Studio オンラ

イン ヘルプ [251 ページのリ ファレンス  16 を参照] を参照して ください。

IBA/PLB コアを生成してエンベデッ ド  プロセッサ デザインで使用する方法の詳細は、 ChipScope
PLB IBA データシート  [251 ページのリ ファレンス  2 を参照] および EDK Platform Studio オンラ

イン ヘルプを参照して ください。

1.Virtex®-4 FPGA GT11 ト ランシーバおよび Virtex-5 FGPA GTP/GTX ト ランシーバ用

の IBERT v1.0 コアは、 IBERT Core Generator ツールを使用して生成します。
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ザイリンクス CORE Generator での ChipScope Pro コアの使用

ChipScope Pro コアを選択して生成する前に、 CORE Generator ツールでプロジェク ト を設定する

必要があ り ます。 適切な設定でプロジェク ト を設定した後、 左上部のパネルの [View by Function]
タブで [Debug & Verification] → [ChipScope Pro] を展開表示する と  ChipScope Proコアが表示さ

れます。 また、 [View by Name] タブでも  ChipScope Pro コアを検索できます。

メモ : ChipScope Pro コアのコア インスタンシエーシ ョ ン テンプレートは、 .vho ファ イル (VHDL
言語フロー用) と  .veo ファ イル (Verilog 言語フロー用) と して提供され、 コア生成プロセスの一部

と して作成されます。 詳細は、 CORE Generator ヘルプを参照して ください。

メモ : ChipScope Pro コアの本質上、 ザイ リ ンクス  CORE Generator ツールで生成される

ChipScope Pro コア用のシ ミ ュレーシ ョ ン ファ イルはシ ミ ュレーシ ョ ンで使用できません。

ChipScope Pro コアを含むデザインをシ ミ ュレーシ ョ ンする と きは、VHDL には空のブラ ッ ク  ボッ

クス エンティティ  アーキテクチャ、 Verilog にはモジュールを使用する必要があ り ます。

ICON コアの生成

CORE Generator ツールを使用する と、 HDL デザインで任意の数の ILA、 IBA/OPB、 IBA/PLB、

VIO、または ATC2 キャプチャ  コアと共に使用できるよ う  ICON コアをカスタマイズし、生成でき

ます。 制御ポート  (ICON コアに接続するコア数) および JTAG 通信に使用されるバウンダ リ  ス
キャン プリ ミ ティブ コンポーネン ト  (BSCAN_VIRTEX5 など) がカスタマイズ可能です。

CORE Generator でユーザー定義のパラ メータが確認される と、 XST ネッ ト リ ス ト  (*.ngc) および

CORE Generator プロジェク トに関連するその他の HDL 言語および合成ツール用ファイルが生成

され、 通常の FPGA デザイン フローで使用するネッ ト リ ス ト と コード例が簡単に生成できます。

ザイ リ ンクス  CORE Generator ツールの [Debug & Verification] → [ChipScope Pro] で、 [ICON
(ChipScope Pro - Integrated Controller)] を選択して、 ウ ィンド ウ右側の [Customize and Generate]
をク リ ッ ク します。

ICON コアの標準パラメータの設定

ICON コアのパラ メータは、 CORE Generator で設定します。

[Component Name]

[Component Name] には、 英数字の任意の組み合わせとアンダースコア (_) を使用できます。 ただ

し、 アンダースコアはコンポーネン ト名の最初には使用できません。

[Number of Control Ports]

ICON コアは、 常に最大 15 個の ILA、 IBA、 VIO、 および ATC2 キャプチャ  コア ユニッ ト と通信

できます。 ただし、個々のキャプチャ  コア ユニッ トでは別のユニッ ト と制御ポート を共有するこ と

はできません。 このため、ICON コアではこの要件を満たすために最大 15 個の制御ポートが必要で

す。 制御ポート数は [Number of Control Ports] リ ス トから選択できます。

[Disable Boundary Scan Component Instance]

バウンダ リ  スキャン プリ ミ ティブ コンポーネン ト  (BSCAN_VIRTEX5 など) は、 ターゲッ ト

FPGA デバイスの JTAG バウンダ リ  スキャン ロジッ ク との通信に使用されます。 バウンダ リ  ス
キャン コンポーネン ト を使用する と、FPGA デバイスの JTAG テス ト  アクセス  ポート  (TAP) イン

ターフェイスが拡張され、最大 4 個の内部スキャン チェーンが作成できます。 Analyzer では、この
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バウンダ リ  スキャン コンポーネン トで提供される内部スキャン チェーン (USER1、 USER2、
USER3、 または USER4) のいずれかを使用してコアと通信します。

一部の FPGA デバイス  ファ ミ リ  (Spartan®-3、 Spartan-3E、 Spartan-3A、および Spartan-3A DSP)
では、BSCAN インスタンス  1 つに 2 つのユーザー スキャン チェーン (USER1 および USER2) が
あ り ます。 ChipScope Pro デバッグ コアでは、バウンダ リ  スキャン コンポーネン トの内部スキャン

チェーンの片方が使用されるため、 バウンダ リ  スキャン コンポーネン トはユーザー デザイン内の

その他のエレ メン ト と共有できます。 デザイン内のほかのエレ メン ト とバウンダ リ  スキャン コン

ポーネン ト を共有するには、 次のいずれかの方法を使用します。

• バウンダ リ  スキャン コンポーネン ト を ICON コアにインスタンシエート し、 未使用のバウン

ダ リ  スキャン チェーン信号を ICON コア インターフェイスのポート信号と して含めます。

• バウンダ リ  スキャン コンポーネン ト をデザインの別の場所にインスタンシエート し、 USER1
または USER 2 スキャン チェーン信号のいずれかを ICON コア インターフェイスの対応する

ポート信号に接続します。

メモ : この機能は、 Spartan-3、 Spartan-3E、 Spartan-3A、 および Spartan-3A DSP デバイスでのみ

使用できます。

バウンダ リ  スキャン コンポーネン トは、デフォルトで ICON コアにインスタンシエート されます。

バウンダ リ  スキャン コンポーネン ト をインスタンシエート しない場合は、[Disable Boundary Scan
Component Instance] をオンにして ください。

[Boundary Scan Chain]

Analyzer は、USER1、USER2、USER3、または USER4 バウンダ リ  スキャン チェーンのいずれか

を使用してコアと通信できます。 バウンダ リ  スキャン コンポーネン ト を ICON コアにインスタン

シエート した場合は、[Boundary Scan Chain] リ ス トから任意のスキャン チェーンを選択できます。

[Enable Unused Boundary Scan Ports]

Spartan-3、Spartan-3E、Spartan-3A、および Spartan-3A DSP デバイスのバウンダ リ  スキャン プ リ

ミ ティブには、 常に USER1 および USER2 という  2 種類のポートがあ り ます。

Virtex-4、Virtex-5、Virtex-6、および Spartan-6 デバイスのバウンダ リ  スキャン プリ ミ ティブには、

USER1、 USER2、 USER3、 および USER4 とい う  4 種類のポートの 1 つのみを使用できます。 こ
れらのポートは、 FPGA デバイスのバウンダ リ  スキャン TAP コン ト ローラへのインターフェイス

と して機能します。 

ICON コアが通信用と して使用する  USER* スキャン チェーン ポートは 1 つのみであるため、未使

用の各 USER* ポート信号は、 デザインのその他のエレ メン トで使用できます。 バウンダ リ  スキャ

ン コンポーネン ト を ICON コアにインスタンシエート した場合、 [Enable Unused Boundary Scan
Ports] をオンにする と、 バウンダ リ  スキャン コンポーネン トの未使用 USER* スキャン チェーン

インターフェイスを使用できるよ うになり ます。

メモ : バウンダ リ  スキャン ポートは、デザインで必要な場合のみに含めてください。 含めたポート

を使用しないと、合成ツールによっては ICON コアが適切に接続されない場合があ り、合成および

インプ リ メンテーシ ョ ンの段階でエラーが発生します。

メモ : この機能は、 Spartan-3、 Spartan-3E、 Spartan-3A、 および Spartan-3A DSP デバイスでのみ

使用できます。
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コアの生成

ICON コアのパラ メータを設定したら、[Generate] をク リ ッ ク して ICON コア ファ イルを生成しま

す。 ICON コアの生成中は、 進捗バーが表示されます。 ホス ト  コンピュータ  システムによっては、

ICON コアの生成に数分かかる場合があ り ます。 コアが生成されたら、 生成されたファイルのリ ス

トが [Readme (コア名)] ウ ィンド ウに表示されます。 

コアの使用

デザインに ICON コアの HDL サンプル ファ イルをインスタンシエートするには、次の手順に従っ

て ICON コアのポート信号をデザイン内の信号に接続します。

• デザイン内の ILA、 IBA/OPB、 IBA/PLB、 VIO、 または ATC2 コア インスタンスの 1 つのみ

に、 ICON コアの未使用 CONTROL ポート信号の 1 つを接続します。

• ICON コアの未使用 CONTROL ポート を未接続のままにする と、 インプ リ メンテーシ ョ ン

ツールでエラーが発生するため、必ず接続して ください。 または、 ILA、 IBA/OPB、 IBA/PLB、

VIO または ATC2 コアの制御ポート と同数の CONTROL ポート を持つ ICON コアを使用し

てください。

ILA コアの生成

CORE Generator を使用する と、HDL デザインで使用する  ILA キャプチャ  コアをカスタマイズし、

生成できます。 このコアは、ト リガー ポートの数、幅および機能がカスタマイズ可能です。 また、ILA
コアに格納されるデータ  サンプルの最大数をカスタマイズした り、 データ  サンプル幅がト リガー

ポート と異なる場合、 この幅もカスタマイズできます。

CORE Generator でユーザー定義のパラ メータが確認される と、 XST ネッ ト リ ス ト  (*.ngc) および

CORE Generator プロジェク トに関連するその他の HDL 言語および合成ツール用ファイルが生成

され、 通常の FPGA デザイン フローで使用するネッ ト リ ス ト と コード例が簡単に生成できます。

ザイ リ ンクス  CORE Generator ツールの [Debug & Verification] → [ChipScope Pro] で、 [ILA
(ChipScope Pro - Integrated Logic Analyzer)] を選択して、 ウ ィ ンド ウ右側の [Customize and
Generate] をク リ ッ ク します。

ILA コアのト リガーおよびス ト レージ パラメータの設定

CORE Generator を使用して、汎用ト リガーとス ト レージ パラ メータおよびト リガー ポートのパラ

メータを含む ILA コアのパラ メータを設定します。

[Component Name]

[Component Name] には、 英数字の任意の組み合わせとアンダースコア (_) を使用できます。 ただ

し、 アンダースコアはコンポーネン ト名の最初には使用できません。

[Number Of Trigger Ports]

各 ILA コアには、それぞれ設定可能な ト リガー ポート を最大 16 個まで使用できます。 [Number Of
Trigger Ports] リ ス トからポート数を選択する と、 各ト リガー ポート用のオプシ ョ ン グループが表

示されます。 各ト リガー ポートのオプシ ョ ン グループには TRIGn という グループ名が付いていま

す (n は 0 ～ 15 までのト リガー ポート番号です)。このオプシ ョ ンには、ト リガー幅、ト リガー ポー

トに接続する比較ユニッ ト数、 比較ユニッ ト  タイプなどがあ り ます。
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[Max Sequence Levels]

ト リ ガー条件シーケンサは、 ブール式または [Max Sequence Levels] で制御されるオプシ ョ ンの ト

リ ガー シーケンサのいずれかに設定できます。 図 2-1 に、ト リガー シーケンサのブロ ッ ク図を示し

ます。

ト リガー シーケンサは、循環型のステート  マシンと してインプリ メン ト され、 ト リガー条件が満た

されるまで最大 16 ステート  (段) まで遷移可能です。 ステート遷移は、 ト リガー シーケンサと接続

されている比較ユニッ トのイベン トによって発生します。 どの比較ユニッ ト も、 ステート遷移する

よ う実行時に段ごとに選択できます。 ト リ ガー シーケンサは、 比較関数イベン トのシーケンスが連

続または不連続のどちらの場合でも、 実行時にステート遷移を設定できます。

[Use RPMs]

通常、 ILA コアは相対配置マクロ  (RPM) を使用して、 パフォーマンスを向上させます。 RPM の使

用は、[Use RPMs] をオフにする とディ スエーブルにできます。 ただし、このオプシ ョ ンはイネーブ

ルにしておく こ とを推奨します。 

[Enable Trigger Output Port]

オンにする と、 ILA コアの ト リガー条件モジュールの出力をポート信号に出力できます。 この ト リ

ガー出力ポートの信号を HDL デザイン内のデバイス  ピンに接続する と、 外部テス ト装置を ト リ

ガーできます。 また、ト リガー出力ポート をデザイン内のほかのロジッ クまたはコアに接続し、ト リ

ガー、 割り込み、 またはその他の制御信号と して使用可能です。 ト リ ガー出力のレベル/パルスおよ

びアクティブ エッジ (High または Low) は、 Analyzer でも実行時に制御できます。 ト リ ガー入力

ポートに対する  ILA ト リ ガー出力ポートのレイテンシは、クロ ッ ク  (CLK) の 10 サイクルです。 ト
リ ガー出力ポートは、 ILA データのアップロードが正し く完了したと きや ILA コアの ト リガー ロ
ジッ クが再設定されたと きに リセッ ト されます。

[Sample On]

ILA ユニッ トは、CLK 信号の立ち上がりエッジまたは立ち下がりエッジのいずれかを使用して、 ト

リ ガーおよびデータ  キャプチャを実行します。 [Sample On] リ ス トから  ILA コアのクロ ッ ク  ソー

ス と して CLK 信号に使用するク ロ ッ ク  エッジを選択します。

[Sample Data Depth]

ILA コアがサンプル バッファに格納できるデータ  サンプルの最大ワード数を選択します。 この

ワード数によ り、 ILA ユニッ トで使用される各ブロ ッ ク  RAM のデータ幅ビッ トが決定します。

X-Ref Target - Figure 2-1

図 2-1 : ト リガー シーケンサのブロック図 (16 段、 16 比較ユニッ ト )
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[Enable Storage Qualification]

ILA コアでは、 ト リガー条件のほかにス ト レージ必要条件の設定も可能です。 ス ト レージ必要条件

は、比較関数イベン トのブール式の組み合わせです。 これらの比較関数イベン トは、コアの ト リガー

ポートに接続されている比較ユニッ ト  コンパレータで検出されます。 ス ト レージ必要条件は、 ト リ

ガー条件とは異なり、 ト リガー ポートの比較ユニッ トのイベン ト を検証し、 各データ  サンプルの

キャプチャまたは格納を決定します。ト リガー条件とス ト レージ必要条件を併用する と、キャプチャ

プロセスを開始するタイ ミ ングやキャプチャするデータを定義できます。 このス ト レージ必要条件

をイネーブルにする場合は、 [Enable Storage Qualification] をオンにします。

[Data Same As Trigger]

ILA ト リ ガー ポートでキャプチャできるデータのソースは 2 種類あり、 [Data Same as Trigger]
チェッ ク  ボッ クスで制御します。

• [Data Same as Trigger] がオンの場合

♦ データ  ポート と ト リ ガー ポート が同一です。 このモード は、コアのト リ ガーに使用するすべ

てのデータをキャプチャできるため、 ほと んどのロジッ ク  アナライザでよく 使用されます。

♦ データ  ポートから除外する ト リガー ポート を選択できます。 この設定の場合、ILA コアの

ポート  マップに DATA 入力ポートは含まれません。

♦ このモードは、ILA コアで使用する  CLB および配線リ ソースを節約できますが、最大デー

タ  サンプル ワード幅は 4096 ビッ ト  (Spartan-3、 Spartan-3E、 Spartan-3A、 Spartan-3A
DSP、 および Virtex-4 デバイスでは 256 ビッ ト ) に制限されます。

• [Data Same as Trigger] がオフの場合

♦ データ  ポートは、 ト リガー ポートから完全に独立しています。

♦ このモードは、 キャプチャするデータ量を制限する場合に便利です。

♦ データ  ポート幅がト リ ガー ポート幅と異なる場合は、 [Data Port Width] で指定する必要

があ り ます。

[Data Port Width]

データ幅とは、ILA コアに格納されている各データ  サンプル ワード幅を指します。 データ  ワード と

ト リガー ワードがそれぞれ独立している場合、 最大許容データ幅はターゲッ ト  デバイス  タイプお

よびワード数によって異なり ます。 ただし、 最大許容ワード幅はいずれでも  4096 ビッ ト  (Spartan-
3、 Spartan-3E、 Spartan-3A、 Spartan-3A DSP、 および Virtex-4 デバイスでは 256 ビッ ト ) に制限

されます。

ILA コアのト リガー ポートのパラ メータの設定

ILA コアの ト リガーおよびス ト レージのオプシ ョ ンの設定が終了したら、 [Next] をク リ ッ ク しま

す。 次のページでは、ト リガー ポートのオプシ ョ ンを設定します。 [Number of Trigger Ports] リ ス ト

でイネーブルにされた数のト リガー ポートそれぞれに個別のページが表示されます。

[Trigger Port Width]

各ト リガー ポートは、信号またはビッ トで構成されるバスです。 ト リ ガー ポート を構成するビッ ト

数を、 ト リ ガー幅といいます。 ト リ ガー ポートの幅は、それぞれ [Trigger Port Width] で設定できま

す。 ト リ ガー ポート幅には、 1 ～ 256 を設定できます。
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[Match Units]

比較ユニッ トは、 ト リガー ポートに接続されているコンパレータであ り、 ト リガー ポートのイベン

ト を検出します。 1 つまたは複数の比較ユニッ トの結果を結合して総体的な ト リガー条件が形成さ

れ、データ  キャプチャが制御されます。 各ト リガー ポート  (TRIGn) には 1 ～ 16 個の比較ユニッ ト

数を接続でき、 この値は [Match Units] リ ス トから選択します。

比較ユニッ ト数を 1 に設定する場合は、 ト リガー イベン トの検出での柔軟性を多少残しながら、 リ

ソースを節約できます。 2 以上に設定する場合は、その結合数が大きいほど、よ り柔軟性の高いト リ

ガー条件を形成できます。 ただし、 各ト リガー ポートの比較ユニッ ト数を増やすと、 ロジッ ク  リ
ソース使用数も増加します。

メモ : 1 つの ILA コアで使用する比較ユニッ トの総計数は、 使用する ト リガー ポート数に関係な

く、 最大 16 個までです。

[Counter Width]

比較ユニッ ト  カウンタは、ト リガー ポートの各比較ユニッ トの出力に接続されているコンフ ィギュ

レーシ ョ ン可能なカウンタです。 このカウンタは実行時に設定でき、 比較ユニッ トのイベン ト数を

カウン ト します。 ト リ ガー ポートの各比較ユニッ トに比較カウンタを含めるには、[Counter Width]
でカウンタ幅を 1 ～ 32 の中から選択します。 [Counter Width] を [Disabled] に設定する と、比較ユ

ニッ トに比較カウンタは含まれません。 デフォルト設定は、 [Disabled] です。

[Match Type]

ト リ ガー ポートの比較ユニッ トが実行する比較または比較関数は、比較ユニッ ト  タイプによって異

なり ます。 ILA コアでは、 6 個の比較ユニッ ト  タイプがサポート されています (表 2-1)。

表 2-1 : ILA のト リガー比較ユニッ ト  タイプ

タイプ ビッ ト値(1) 比較関数
スライスごとの

ビッ ト数 (2) 説明

[basic] 0、 1、 X =、 <>

LUT 4 ベース  : 8

Virtex-5、
Spartan-6 : 19

その他の LUT 6 
ベース  : 20

遷移検出が重要ではないデー

タ 信号を比較するために使用

します。 最もビッ ト を節約でき

る比較ユニッ ト  タイプです。

[basic with 
edges]

0、 1、 X、

R、 F、 B、 N
=、 <>

LUT 4 ベース  : 4

LUT 6 ベース  : 8

遷移検出 (例 : Low から  High、
High から  Low など) が重要と

なる制御信号の比較に使用し

ます。

[extended] 0、 1、 X
=、 <>、 >、
>=、 <、 <=

LUT 4 ベース  : 2

LUT 6 ベース  : 16

大きさ  (大小) が重要となるア

ド レスまたはデータ信号の比

較に使用します。

[extended 
with 
edges]

0、 1、 X、

R、 F、 B、 N
=、 <>、 >、
>=、 <、 <=

LUT 4 ベース  : 2

LUT 6 ベース  : 8

大きさ  (大小) が重要となるア

ド レスまたはデータ信号の比

較に使用します。

[range] 0、 1、 X

=、 <>、 >、
>=、 <、 <=、
in range、not 
in range

LUT 4 ベース  : 1

LUT 6 ベース  : 8

値の範囲が重要となるア ド レ

スまたはデータ信号の比較に

使用します。
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[Match Type] リ ス トでその ト リガー ポートに接続されているすべての比較ユニッ トに適用する比

較タイプを選択してください。 比較ユニッ トの機能性が高くなる と、 機能のインプ リ メン トに必要

な リ ソースも増加するこ とに注意してください。 このよ うに設定に柔軟性があるこ とから、 リ ソー

ス使用量を確認しながら ト リガー モジュールの機能をカスタマイズできます。

[Exclude Trigger Port from Data Storage]

[Data Same As Trigger] をオンにする と、 ト リガー オプシ ョ ン設定ページで [Exclude Trigger Port
from Data Storage] のチェッ クボッ クスが表示されます。 このチェッ ク  ボッ クスをオンにする と、

この ト リガー ポートがデータ  ポートから除外されます。 デフォルトではこのチェッ ク  ボッ クスが

オフになっており、 ト リガー ポートはデータ  ポートに含められています。 最大データ幅の 4096
ビッ ト  (Spartan-3、 Spartan-3E、 Spartan-3A、 Spartan-3A DSP、および Virtex-4 デバイスでは 256
ビッ ト ) がすべてのト リガー ポートに適用されます。

コアの生成

ILA コアのパラ メータを設定したら、[Generate] をク リ ッ ク して ILA コア ファ イルを生成します。

ILA コアの生成中は、進捗バーが表示されます。 ホス ト  コンピュータ  システムによっては、ILA コ
アの生成に数分かかる場合があ り ます。 コアが生成されたら、 生成されたフ ァ イルの リ ス ト が

[Readme (コア名)] ウ ィンド ウに表示されます。 

コアの使用

デザインに ILA コアの HDL サンプル ファ イルをインスタンシエートするには、次の手順に従って

ILA コアのポート信号をデザイン内の信号に接続します。

• ILA コアの CONTROL ポート信号は、 デザイン内の ICON コア インスタンスの未使用制御

ポートに接続します。

• ILA コアのデータおよびト リ ガー ポート信号の未使用ビッ トは、すべて 0 に接続します。 この

よ うに接続するこ とで、マップ時に未使用ト リガー /データ信号が削除されなくな り、インプ リ

メンテーシ ョ ン プロセス中の DRC エラーの発生を回避できます。

• データおよびト リ ガー ソ ース信号が ILA ク ロ ッ ク 信号 (CLK) に同期しているこ と を確認し

ます。

[range 
w/edges]

0、 1、 X、

R、 F、 B、 N

=、 <>、 >、
>=、 <、 <=、
in range、not 
in range

LUT 4 ベース  : 1

LUT 6 ベース  : 4

値の範囲と遷移検出が重要と

なるア ド レスまたはデータ信

号の比較に使用します。

メモ : 

1. ビッ ト値 : 0 = 論理値 0; 1 = 論理値 1、 X = ドン ト ケア; R = 0 から  1 に遷移; 
F = 1 から  0 に遷移; B = 任意の遷移; N = 遷移なし

2. スライスごとのビッ ト数は、 各比較ユニッ ト  タイプの相対的な リ ソース使用数を示すための概算値です。 
正確な概算値と して使用しないでください。 LUT4 ベースのデバイス  ファ ミ リには、 Spartan-3、 Spartan-
3E、 Spartan-3A、 Spartan-3A DSP、 および Virtex-4 FPGA が含まれます。 LUT6 ベースのデバイス  ファ
ミ リには、 Virtex-5、 Virtex-6、 および Spartan-6 FPGA が含まれます。

表 2-1 : ILA のト リガー比較ユニッ ト  タイプ (続き)

タイプ ビッ ト値(1) 比較関数
スライスごとの

ビッ ト数 (2) 説明
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VIO コアの生成

CORE Generator ツールを使用する と、HDL デザインに仮想入力および出力を追加するための VIO
コアをカスタマイズして生成できます。 仮想入力および出力は、 デザイン内の特定のクロ ッ クに同

期するよ うに、または任意のクロ ッ ク  ド メ インに対して完全に非同期になるよ うにカスタマイズで

きます。 また、 VIO コアで使用される入力および出力信号数もカスタマイズできます。

CORE Generator でユーザー定義のパラ メータが確認される と、 XST ネッ ト リ ス ト  (*.ngc) および

CORE Generator プロジェク トに関連するその他の HDL 言語および合成ツール用ファイルが生成

され、 通常の FPGA デザイン フローで使用するネッ ト リ ス ト と コード例が簡単に生成できます。

ザイ リ ンクス  CORE Generator ツールの [Debug & Verification] → [ChipScope Pro] で、 [VIO
(ChipScope Pro - Virtual Input/Output)] を選択して、ウ ィンド ウ右側の [Customize and Generate] を
ク リ ッ ク します。

VIO コアの標準オプシ ョ ンの設定

VIO コアのパラ メータは、 CORE Generator で設定します。

[Component Name]

[Component Name] には、 英数字の任意の組み合わせとアンダースコア (_) を使用できます。 ただ

し、 アンダースコアはコンポーネン ト名の最初には使用できません。

[Enable Asynchronous Input Port] 

オンにする と、 VIO コアに非同期入力ポートが含まれます。 オンのと き、 [Width] に最大 256 ビッ

ト までのポート幅を指定できます。 非同期入力ポートは VIO コアへの入力で、クロ ッ ク  ド メ インに

関係なくデザインに含まれる任意の信号を監視するのに使用できます。

[Enable Asynchronous Output Port] 

オンにする と、 VIO コアに非同期出力ポートが含まれます。 オンのと き、 [Width] に最大 256 ビッ

ト までのポート幅を指定できます。 非同期出力ポートは VIO コアからの出力で、クロ ッ ク  ド メ イン

に関係なくデザインに含まれる任意の信号を駆動するのに使用できます。

[Enable Synchronous Input Port]

オンにする と、 VIO コアに同期入力ポートが含まれます。 オンのと き、 [Width] に最大 256 ビッ ト

までのポート幅を指定できます。 同期入力ポートは VIO コアへの入力で、VIO コアの CLK 入力に

同期している任意の信号を監視するのに使用できます。

[Enable Synchronous Output Port]

オンにする と、 VIO コアに同期出力ポートが含まれます。 オンのと き、 [Width] に最大 256 ビッ ト

までのポート幅を指定できます。 同期出力ポートは VIO コアからの出力で、VIO コアの CLK 入力

に同期している任意の信号を駆動するのに使用できます。

[Invert Clock Edge]

VIO コアは、CLK 信号の立ち上がりエッジまたは立ち下がりエッジのいずれかを使用して、同期入

力および出力信号のデータを取得し、 生成できます。 [Invert Clock Edge] をオンにする と、 VIO コ
アに入力される  CLK 信号のエッジを反転できます。

メモ : ク ロ ッ クは、 同期入力/出力が使用される場合のみ反転できます。
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コアの生成

VIO コアのパラ メータを設定したら、[Generate] をク リ ッ ク して VIO コア ファ イルを生成します。

VIO コアの生成中は、進捗バーが表示されます。 ホス ト  コンピュータ  システムによっては、VIO コ
アの生成に数分かかる場合があ り ます。 コアが生成されたら、 生成されたフ ァ イルの リ ス ト が

[Readme (コア名)] ウ ィンド ウに表示されます。

コアの使用

デザインに VIO コアの HDL サンプル ファ イルをインスタンシエートするには、次の手順に従って

VIO コアのポート信号をデザイン内の信号に接続します。

• VIO コアの CONTROL ポート信号をデザイン内の ICON コア インスタンスの未使用制御

ポートに接続します。

• VIO コアの非同期および同期入力ポート信号の未使用ビッ ト をすべて 0 に接続します。 このよ

うに接続するこ とで、マップ時に未使用ト リガー /データ信号が削除されなくな り、インプ リ メ

ンテーシ ョ ン プロセス中の DRC エラーの発生を回避できます。

• 最良の結果を得るには、 同期入力ソース信号および同期出力シンク信号が VIO ク ロ ッ ク信号

(CLK) に同期しているこ とを確認します。

ATC2 コアの生成

CORE Generator を使用する と、HDL デザイン外部に Agilent 社ロジッ ク  アナライザ キャプチャ機

能を追加するための ATC2 コアをカスタマイズして生成できます。必要な入力データ  ポート数に加

え、外部でのキャプチャに使用されるピン数およびその特性をカスタマイズできます。 また、使用す

るキャプチャ  モード  ( [State] または [Timing]) および TDM の圧縮モード  (1x または 2x) も選択可

能です。

CORE Generator でユーザー定義のパラ メータが確認される と、 XST ネッ ト リ ス ト  (*.ngc) および

CORE Generator プロジェク トに関連するその他の HDL 言語および合成ツール用ファイルが生成

され、 通常の FPGA デザイン フローで使用するネッ ト リ ス ト と コード例が簡単に生成できます。

ザイ リ ンクス  CORE Generator ツールの [Debug & Verification] → [ChipScope Pro] で、 [ATC2
(ChipScope Pro - Agilent Trace Core 2)] を選択して、 ウ ィ ンド ウ右側の [Customize and Generate]
をク リ ッ ク します。

ATC2 コアのキャプチャおよびステート  パラメータの設定

ATC2 コアのパラ メータは、 CORE Generator で設定します。

[Component Name]

[Component Name] には、 英数字の任意の組み合わせとアンダースコア (_) を使用できます。 ただ

し、 アンダースコアはコンポーネン ト名の最初には使用できません。

[Acquisition]

ATC2 コアのキャプチャ  モードには、[Timing - Asynchronous Sampling] (非同期データ  キャプチャ

用) または [State - Synchronous Sampling] (CLK 入力信号に対する同期データ  キャプチャ用) のい

ずれかを設定できます。 State モードの場合、ATC2 コアを通るデータ  パスでパイプライン化された

フ リ ップフロ ップが使用され、 CLK 入力ポート信号でクロ ッ クが供給されます。 Timing モードの
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場合、 ATC2 コアを通るデータ  パスは、 出力ピンに到達するで組み合わせロジッ クのみで構成され

ています。 Timing モードでは、 ATCK ピンが追加のデータ  ピンと して使用されます。

[Max Frequency Range]

[Max Frequency Range] リ ス トから、ATC2 コアの最大動作周波数を指定します。 ATC2 コアのイン

プ リ メンテーシ ョ ンは、選択した最大周波数範囲に最適化されます。 選択可能な最大周波数範囲は、

[0 ～ 100 MHz]、 [101 ～ 200 MHz]、 [201 ～ 300 MHz]、 および [301 ～ 500 MHz] です。 最大周

波数範囲の選択は、 [State - Synchronous Sampling] モードを選択した場合のみ指定できます。

[TDM Rate]

ATC2 コアは、 キャプチャした ト レース  データの格納にオンチップ メモ リ  リ ソースを使用しませ

ん。 その代わりに、専用のプローブ コネク タを使用して FPGA ピンに接続されている  Agilent 社の

ロジッ ク  アナライザへデータを送信します。 TDM レート を 1x に設定する と、データがデバイス  ピ
ンへ伝送される速度と  DATA ポートへの入力速度は同一になり、 2x に設定する と  DATA ポートへ

の入力速度の 2 倍になり ます。 TDM のレート を 2x に設定できるのは、 [State - Synchronous
Sampling] モードに設定されている と きのみです。

ATC2 コアのピンおよび信号のパラメータの設定

ATC2 のキャプチャ  モード と ステート  オプシ ョ ンを設定したら、 [Next] をク リ ッ ク します。 2 ペー

ジ目では、 ATC2 ピンと信号のパラ メータを設定します。

[Enable Auto Setup]

オンにする と、 Agilent 社のロジッ ク  アナライザによ り ロジッ ク  アナライザのポッ ド接続に最適な

ATC2 ピンを自動的に設定できます。 また、各 ATC2 ピンに最適な位相および電圧サンプリ ング オ
フセッ ト も自動的に決定されます。 このオプシ ョ ンは、 デフォルトでイネーブルにされています。

[Enable Always On Mode]

[Enable Always On Mode] をオンにする と、 ATC2 コアの内部ロジッ クおよび出力バッファが常に

イネーブルにされます。 このモードをオンにする と、 FPGA デバイスのコンフ ィギュレーシ ョ ン時

に信号バンク  0 によ り  ATD ピンが駆動されます。 このモードでは、最初に ATC2 コアを手動で設定

せずに、 デバイス  コンフ ィギュレーシ ョ ン直後に発生するイベン ト をキャプチャできます。 この機

能はデフォルトではオフにされており、 [Timing - Asynchronous Sampling] モードを選択した場合

のみ指定可能です。

[ATD Pin Count]

ATC2 コアは、 ATD 出力ピンを 4 ～64 個の範囲内でインプリ メン トできます。

[Driver Endpoint Type]

ATCK および ATD 出力ピンの出力ド ライバ タイプにシングルエンドまたは差動のいずれかを選択

します。すべての ATCK および ATD ピンは同一のド ライバ終端タイプを使用する必要があ り ます。

[ATD drivers same as ATCK]/[ATD drivers different than ATCK]

3 ページ目では、個別のピンまたはピン グループの I/O 規格、駆動電流、およびスルー レート を効

率よ く変更できます。 2 ページ目で [ATD drivers same as ATCK] を選択する と、ATCK ピンのパラ

メータを変更して、 すべての ATD ピンに同じ設定を反映させるこ とができます。 [ATD drivers
different than ATCK] を選択する と、各ピンのパラ メータを個別に変更できます。 この設定に関わら

ず、 各ピンのロケーシ ョ ンを設定する必要があ り ます。
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[Signal Bank Count]

ATC2 コアには、実行時に設定可能なデータ信号バンク  マルチプレクサが含まれています。 [Signal
Bank Count] には、このマルチプレクサでインプ リ メン トするデータ入力ポート数/信号バンク数を

入力します。 入力可能な値は、 1、 2、 4、 8、 16、 32、 または 64 のいずれかです。

[Signal Bank Width]

ATC2 コアの各入力信号バンクのデータ  ポート幅は、キャプチャ  モードおよび TDM レートによっ

て異なり ます。 [State - Synchronous Sampling] モードの場合、 各信号バンクのデータ  ポート幅は、

(ATD ピン数) * (TDM レート ) の値になり ます。 [Timing - Asynchronous Sampling] モードの場合、

ATCK ピンが追加のデータ  ピンと して使用されるため、 (ATD ピン数 + 1) * (TDM レート ) が、 各

データ  ポート幅とな り ます。

ATC2 コアの ATCK および ATD ピンのパラ メータの設定

ATC2 のコアのピンおよび信号のパラ メータを設定したら、[Next] をク リ ッ ク します。 3 ページ目で

は、 ATCK および ATD ピンのパラ メータを設定します。 

出力クロ ッ ク  (ATCK) およびデータ  (ATD) ピンは、あらかじめ ATC2 コアにインスタンシエート さ

れています。 つま り、ATCK および ATD ピンは、ほかのデザイン階層から最上位に手動で移動する

必要はあ り ませんが、 CORE Generator でこれらのピンのロケーシ ョ ンおよび特性を指定する必要

があ り ます。 これらのピン属性は、 ATC2 コアの *.ncf ファ イルに追加されます。 [Pins] 表を使用し

て、ATCK および ATD ピンのロケーシ ョ ン、 I/O 規格、駆動電流、およびスルー レート を設定でき

ます。

[Pin Name]

ATC2 コアの出力ピンには ATCK および ATD の 2 種類があ り ます。 ATCK ピンは、State モードに

設定した場合はクロ ッ ク  ピンと して、 Timing モードに設定した場合はデータ  ピンと して使用され

ます。 ATD ピンは、 常にデータ  ピンと して使用されます。 ピン名は変更できません。

[Pin Loc]

ATCK または ATD ピンのロケーシ ョ ンを設定します。

[IO Standard]

各 ATCK または ATD ピンの I/O 規格を設定します。 設定可能な I/O 規格は、デバイス  ファ ミ リお

よびド ライバの終端タイプによって異なり ます。 I/O 規格名は、 ザイ リ ンクス ソフ ト ウェア マニュ

アル [251 ページのリ ファレンス  15 を参照] の 『制約ガイ ド』 の 「IOSTANDARD」 セクシ ョ ンに

含まれている名前と一致しています。

[Drive]

[Drive] 列には、出力ピンの最大駆動電流が 2mA ～ 24mA の範囲で表示され、これらの値は選択し

た I/O 規格によって異なり ます。

[Slew Rate]

各 ATCK または ATD ピンのスルー レート を [FAST] または [SLOW] のいずれかに設定できます。
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コアの生成

ATC2 コアのパラ メータを設定したら、[Generate] をク リ ッ ク して ATC2 コア ファ イルを生成しま

す。 ATC2 コアの生成中は、 進捗バーが表示されます。 ホス ト  コンピュータ  システムによっては、

ATC2 コアの生成に数分かかる場合があ り ます。 コアが生成されたら、 生成されたファイルのリ ス

トが [Readme (コア名)] ウ ィンド ウに表示されます。

コアの使用

デザインに ATC2 コアの HDL サンプル ファ イルをインスタンシエートするには、次の手順に従っ

て ATC2 コアのポート信号をデザイン内の信号に接続します。

• ATC2 コアの CONTROL ポート信号をデザイン内の ICON コア インスタンスの未使用制御

ポートに接続します。

• ATC2 コアの非同期および同期入力ポート信号の未使用ビッ ト を、 すべて 0 に接続します。 こ
のよ うに接続するこ とで、マップ時に未使用ト リガー /データ信号が削除されなくな り、インプ

リ メンテーシ ョ ン プロセス中の DRC エラーの発生を回避できます。

• 最良の結果を得るには、State モードの入力データ  ポート信号が ATC2 クロ ッ ク信号 (CLK) に
同期しているこ とを確認します。 この設定は、 Timing モードでは重要ではあ り ません。

Virtex-4 および Virtex-5 FPGA 用 IBERT v1.0 コアの生成

IBERT Core Generator を使用する と、 Virtex-4 FPGA GT11 ト ランシーバおよび Virtex-5 FPGA
GTP/GTX ト ランシーバ用の IBERT v1.0 コアをカスタマイズして、 生成できます。 IBERT のパラ

メータをすべて設定する と、ビッ ト ス ト リームを含む完全デザインが生成されます。 この IBERT コ
アは、 スタンドアロン デザインでのみ生成でき、ユーザー デザインに含めるこ とはできません。 デ
ザインのネッ ト リ ス ト  ファ イル (.ngc または .edn) は生成されず、代わりに IBERT Core Generator
によ り  ISE が実行されてビッ ト ス ト リーム ファ イル (.bit) が生成されます。

IBERT Core Generator の 1 ページ目で生成するコアのタイプに IBERT を選択します。 [IBERT
(Integrated Bit Error Ratio Tester)] を選択して [Next]  をク リ ッ ク します。

IBERT コアの標準オプシ ョ ンの設定

標準オプシ ョ ンは、 IBERT Core Generator の 2 ページ目で設定します。

ファイル保存先の選択

IBERT ビッ ト ス ト リーム ファ イル (ibert.bit) の保存先は、 [Output Bitstream] に表示されます。 デ
フォルトのディ レク ト リは、IBERT Core Generator のインス トール パスになっていますが、任意の

ディ レク ト リに変更するこ と もできます。デザインが生成されたら、すべてのインプ リ メンテーシ ョ

ン ファ イルが自動的にこのディ レク ト リに含められます。

ターゲッ ト  デバイスの選択

IBERT コアを生成する場合、 デザインが ISE ツールで完全にインプリ メ ント されるため、 デバイス、

パッ ケージ、 およびスピード  グレード を選択する必要があり ます。 ChipScope Pro IBERT Core
Generator ツールでは、Virtex-4 FX および Virtex-5 LXT/SXT/FXT ファ ミ リ がサポート されています。
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シリ コン リビジ ョ ン (ステッピング レベル) の選択

デバイス、 パッケージ、 およびスピード  グレードの情報に加えて、 次の表に示されている  Virtex-4
FX FPGA ファ ミ リの適切なシ リ コン リ ビジ ョ ンを選択する必要があ り ます。 シ リ コン リ ビジ ョ ン

を選択するこ とで、Virtex-4 FX ファ ミ リの IBERT コアに含めるキャ リブレーシ ョ ン ブロ ッ クのタ

イプを決定できます。 

Virtex-4 ファ ミ リのステッピング レベルを確認する方法は、 シ リ コン ステッピング [251 ページの

リ ファレンス 22 を参照] やアンサー レコードを参照してください。

次に、 Virtex-5 LXT/SXT/FXT ファ ミ リで使用できるシ リ コン リ ビジ ョ ンを示します。

IBERT クロック  オプシ ョ ンの選択

IBERT コアの標準オプシ ョ ンを選択したら、 [Next] をク リ ッ ク します。 3 ページ目に表示されるク

ロ ッ ク  オプシ ョ ンは、使用するデバイス  ファ ミ リ  (Virtex-4 FX または Virtex-5 LXT/SXT/FXT) で
異なり ます。

Virtex-4 FX 用 IBERT のクロック  オプシ ョ ン

Virtex-4 FX ファ ミ リの [MGT Clock Source Settings] フ ィールドは 2 列の MGTCLK 列に分割され

ています。

♦ 左の列は X 座標 0 です。

表 2-2 : Virtex-4 FX ファ ミ リのシリコン リビジ ョ ン (ステッピング レベル)

シリコン デバイス リビジ ョ ン 選択するシリコン リビジ ョ ン

CES2

[CES2* or CES3*]

CES2L

CES2R

CES3

CES3L

CES3R

CES2V2

CES2L2

CES2R2

CES3V2

CES3L2

CES3R2

CES4
[Production or CES4]

Production

表 2-3 : Virtex-5 LXT/SXT/FXT ファ ミ リのシリコン リビジ ョ ン (ステッピング レベル)

シリコン デバイス リビジ ョ ン 選択するシリコン リビジ ョ ン

すべてのエンジニア リ ング サンプル (ES) 
リ ビジ ョ ン 

[CES]

すべての製品リ ビジ ョ ン [Production]
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♦ 右の列は X 座標 1 です。

列で MGTCLK がイネーブルにされないと、 その列で MGT は使用できません。

MGTCLK の選択

Virtex-4 FX ファ ミ リでは、 4 個の MGTCLK を使用できます。 左側に MGTCLK105 と

MGTCLK102、右側に MGTCLK110 と  MGTCLK113 があ り ます。 ク ロ ッ クをイネーブルにするに

は、 チェッ ク  ボッ クスをオンにします。 各クロ ッ クには、 有効な最大クロ ッ ク周波数 (106 MHz ～
644 MHz) を入力する必要があ り ます。

MGT (64 ページの 「MGT/GTP/GTX オプシ ョ ンの選択」 を参照) を使用するには、 任意の列で

MGTCLK をイネーブルにする必要があ り ます。

システム クロックの設定

IBERT コアでは、 IBERT 制御ロジッ クのファブ リ ッ ク部分を駆動するのにフ リーランニングのシ

ステム クロ ッ クが必要です。 Virtex-4 デバイスでは 32MHz ～ 210MHz、 Virtex-5 デバイスでは

10MHz および 100MHz がシステム ク ロ ッ ク  ソースの周波数に必要です。 ク ロ ッ クは、内部で分周

または倍周されて、 50 ～ 100MHz になり ます。 

メモ : システム クロ ッ クはユーザー定義のクロ ッ クで、MGT クロ ッ クの設定から独立しています。

このク ロ ッ クは、 ト ランシーバに関連するク ロ ッ クから派生しません。

システム ク ロ ッ クのオプシ ョ ンは、 次の手順に従い設定します。 

1. [System Clock Settings] フ ィールドを確認します。

2. [I/O Standard] で I/O 規格を選択します。

3. [P Source Pin] にシステム ク ロ ッ クのピン ロケーシ ョ ンを入力します。 

メモ : 差動システム クロ ッ クの入力には、P ピンのロケーシ ョ ンのみ入力します。 N のピン ロ
ケーシ ョ ンは、 ISE インプ リ メンテーシ ョ ン ツールで自動的に決定されます。

4. [Frequency] にシステム ク ロ ッ クの周波数 (MHz) を入力します。

メモ : システム ク ロ ッ クの周波数は、 IBERT デザインが正し く動作するよ う正し く入力する

必要があ り ます。

Virtex-5 LXT/SXT/FXT ファ ミ リ用 IBERT のクロッ ク  オプシ ョ ン

Virtex-5 LXT/SXT/FXT ファ ミ リの IBERT クロ ッ ク  オプシ ョ ンは、 Virtex-4 FX ファ ミ リのオプ

シ ョ ンに比べて比較的単純です。 Virtex-5 LXT/SXT/FXT ファ ミ リの IBERT コア デザインで唯一

必要なクロ ッ ク  オプシ ョ ンは、63 ページの 「システム クロ ッ クの設定」 に記載されている  [System
Clock Setting] のみです。

Virtex-5 LXT/SXT/FXT ファ ミ リの GTP ト ランシーバ クロ ッ ク構造は、 現段階では図 2-2 に示す

よ うに固定されています。 クロ ッ ク構造は、Virtex-5 LXT/SXT/FXT ファ ミ リの IBERT コア デザイ

ンでイネーブルにされている各 GTP_DUAL/GTX_DUAL タイルで複製されます。
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MGT/GTP/GTX オプシ ョ ンの選択

IBERT コアのクロ ッ ク  オプシ ョ ンを選択したら、[Next]  をク リ ッ ク して MGT/GTP/GTX オプシ ョ

ン設定ページに進みます。 このページに表示されるオプシ ョ ンは、 使用するデバイス  ファ ミ リが

Virtex-4 FX か Virtex-5 LXT/SXT/FXT かによって異なり ます。

Virtex-4 FX ファ ミ リ用 IBERT の MGT オプシ ョ ン

Virtex-4 FX ファ ミ リの [IBERT MGT Options] ページの [MGT Settings] フ ィールドは 2 列の MGT
列に分割されています。

♦ 左の列は X 座標 0 です。

♦ 右の列は X 座標 1 です。

IBERT コアでは、デバイス内のどの組み合わせの MGT でも含めるよ うに設定できます。 MGT をイ

ネーブルにするには、任意の MGT の横のチェッ ク  ボッ クスをオンにします。 その MGT に対する情

報およびパラ メータが有効になり ます。 MGT ペアのうち 1 つをイネーブルする と、 も う  1 つもイ

ネーブルにする必要があ り ます。 チェッ ク  ボッ クスがオンになっていない MGT は、アイ ドル MGT
と してデザインに含まれますが、 パターン ジェネレータやチェッカ ロジッ クは含まれません。

[MGTCLK Source]

MGT の各列には、MGTCLK が 2 つあり、各 MGT ペアでデータの送受信に使用するク ロ ッ クを選

択できます。 MGT ペアに含まれる  MGT の両方で同じク ロ ッ ク設定にする必要があ り ます。 この

MGTCLK ソース と乗算器の値は、 ChipScope Pro Analyzer で実行時に変更できます。

[Max Line Rate]

MGT のライン レートは、 MGTCLK ソースの周波数を逓倍したもので、 Mb/s で表現されます。 設
定できる逓倍率は、 8、 10、 16、 20、 32、 または 40 です。 たとえば、 MGT で MGTCLK102 をク

X-Ref Target - Figure 2-2

図 2-2 : Virtex-5 LXT/SXT/FXT ファ ミ リ用 IBERT の GTP_DUAL/GTX_DUAL タイル

のクロック構造
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ロ ッ ク  ソース と して選択する と きに、 MGTCLK102 に 312.5MHz が指定されている場合、 [Max
Line Rate] には、 2500、 3125、 5000、 6250、 および 10000 が表示されます。

[Max VCO Rate]

一部のライン レートには、複数の VCO （Voltage Controlled Oscillator）設定があ り ます。 このボッ

クスには、 選択可能な値が表示されます。 ほとんどのライン レートでは、 選択できる  VCO 設定が

1 つしかあ り ません。

[TX User CLK Source]

IBERT コアに含まれるアクティ ブな  MGT にはそれぞれ、PRBS パターン  ジェネレータ /チェッ カお

よびその他のロジッ クをインプリ メ ント するロジッ クが接続されています。 RX 側のロジッ クは、常

に GT11 コンポーネント の RXRECCLK1 ピンから入力される復元ク ロッ クにより ク ロッ クが供給

されます。 この復元クロッ ク は、グローバル バッ ファ  (BUFG) を通ってパターン  チェッ カ  ロジッ ク

に供給されます。 TX 側のロジッ クは、TXOUTCLK1 ピンからク ロッ クが供給されます。 ただし、ア

プリ ケーショ ンで複数の MGT が同じク ロッ ク  レート で動作するよう に呼び出される場合は、 別の

MGT の TXOUTCLK1 ソースから  TX ロジッ ク にク ロッ クを供給するこ と によって  BUFG を節約

できます。 ユーザーは、どの MGT の TXOUTCLK1 を使用してパターン  ジェネレータ  ロジッ クにク

ロッ ク を供給するかを選択できます。 ただし、 デバイスの同じ側にある  MGT のみ使用できます。

[Fabric Data Width]

各 MGT には、FPGA ロジッ クへのデータ  インターフェイスがあ り、こ こにパターン ジェネレータ

およびチェッカ ロジッ クがインプ リ メン ト されます。 このデータ  インターフェイスのビッ ト幅は、

16、20、32、または 40 にできます。 8B/10B エンコードは 16 および 32 ビッ ト幅でのみサポート さ

れます。 

メモ : 16 および 20 ビッ ト幅は、 6.25Gb/s を超えるライン レートではサポート されていません。

[Pattern Type]

MGT に対して生成、 検出できるパターンが表示されます。 [Basic] を選択する と、 CLK1/2X、

CLK1/10X、CLK1/20X、および PRBS 7 (X7 + X6 + 1) のみを使用できます。 [Full] を選択する と、

すべての [Basic] パターンに加え、 PRBS 9、 11、 15、 20、 23、 29、 31、別の PRBS 7 パターン (X7

+ X + 1)、 アイ ドル パターン、およびカウンタ  パターンを使用できます。 ただし、デザイン サイズ

が非常に大き くなり、 生成時間が長くなり ます。

[Resource Usage]

[IBERT Options] ページの上部には、IBERT コアでのリ ソース使用量が表示されます。 MGT をオン

にする度に、その分が使用量に追加されます。 BUFG (グローバル クロ ッ ク  バッファ ) の使用数も表

示されます。 BUFG の最大使用可能数は 32 です。 

Virtex-5 LXT/SXT/FXT ファ ミ リ用 IBERT の GTP/GTX オプシ ョ ン

Virtex-5 LXT/SXT/FXT ファ ミ リ用 IBERT の GTP/GTX オプシ ョ ンには、 次の 3 つのセクシ ョ ン

があ り ます。

• [Resource Usage]

• [Pattern Settings]

• [GTP Settings]/[GTX Settings]
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[Resource Usage]

[IBERT Options] ページの上部には、 IBERT コアでのリ ソース使用量が表示されます。

GTP_DUAL/GTX_DUAL タイルをオンにする度に、 その分が使用量に追加されます。 デジタル ク
ロ ッ ク  マネージャ  (DCM) の使用数も表示されます。 DCM は、FPGA デバイスで使用可能な DCM
数までしか使用できません。 

[Pattern Settings]

[Pattern Settings] には、すべての GTP_DUAL/GTX_DUAL タイルに対して生成、検出できるパター

ンが表示されます。 使用できるパターン タイプは、PRBS 7 ビッ ト  (X7 + X6 + 1)、別の PRBS 7 ビッ

ト  (X7 + X + 1)、 PRBS 9 ビッ ト 、PRBS 11 ビッ ト 、 PRBS 15 ビッ ト、 PRBS 20 ビッ ト、 PRBS 23
ビッ ト 、 PRBS 29 ビッ ト 、 PRBS 31 ビッ ト、 ユーザー パターン (ク ロ ッ ク  パターンを含む、 任意

の 20 ビッ ト  データ  パターンの生成に使用可能)、フレーム付きカウンタ、およびアイ ドル パターン

です。 デフォルトでは、PRBS 7 ビッ ト 、PRBS 23-ビッ ト 、PRBS 31 ビッ ト、およびユーザー パター

ンが選択されています。

[GTP Settings]/[GTX Settings]

GTP/GTX ト ランシーバ設定セクシ ョ ンでは、 Virtex-5 LXT/SXT/FXT ファ ミ リ  デバイスの各

GTP_DUAL/GTX_DUAL タイルをイネーブルにして、 それぞれ設定できます。 GTP_DUAL/
GTX_DUAL タイルをオンにする場合、最大ライン レートおよびリ ファレンス  ク ロ ッ ク周波数を指

定する必要があ り ます。 最大ライン レート を設定する と有効な リ ファレンス  クロ ッ ク周波数 (FB、

REF、 および DIVSEL PLL 設定) のみが [Ref Clock Freq] に表示されます。

汎用 I/O (GPIO) オプシ ョ ンの選択

IBERT コアの GTP/GTX オプシ ョ ンを選択したら、 [Next]  をク リ ッ ク して GPIO オプシ ョ ン設定

ページに進みます。  GPIO オプシ ョ ンでは、VIO コアで制御される、SFP 光モジュールなどの FPGA
外部のデバイスの制御に使用可能な同期出力ピンのみを設定できます。 これらの出力は、 IBERT シ
ステム ク ロ ッ クに同期しています。

[Add VIO Controlled Output Pins]

オンにする と、 VIO 制御の出力ピンを IBERT デザインに追加できます。 これによ り、 その他の

GPIO 出力ピンの設定オプシ ョ ンも表示されます。

[Number of Output Pins]

デザインに追加する  VIO 制御の同期出力ピン数を 1 ～ 256 で入力します。

[Edit Output Pin Types Individually]

GPIO 出力ピンのロケーシ ョ ンおよびその他の特性は、IBERT Core Generator で指定する必要があ

り ます。 [Edit Output Pin Types Individually] をオンにする と、各 GPIO_OUT ピンのロケーシ ョ ン、

I/O 規格、出力電流、およびスルー レート を制御できます。 オフのままにする場合は、個別の出力ピ

ンではなくすべてのピンに同じ設定を反映させるこ とができます。

[Pin Name]

IBERT コアでは、 GPIO_OUT[n] という名前の GPIO 出力ピンのみがサポート されています (n は
GPIO_OUT とい う名前のバスのビッ ト  インデッ クスです)。 ピン名は変更できません。

[Pin Loc]

[Pin Loc] 列では、 GPIO_OUT ピンのロケーシ ョ ンを設定します。
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[IO Standard]

各 GPIO_OUT ピンの I/O 規格を設定します。 使用できる  I/O 規格は、 デバイス  ファ ミ リによって

異なり ます。 現段階では、 IBERT GPIO 出力ピンではシングルエンドの I/O 規格のみがサポート さ

れています。 I/O 規格名は、 ザイ リ ンクス  ソフ ト ウェア マニュアル[251 ページのリ ファレンス  15
を参照] の 『制約ガイ ド』 の 「IOSTANDARD」 セクシ ョ ンに含まれている名前と一致しています。

[VCCO]

[VCCO] 列には、 ピン ド ラ イバの出力電圧が表示されます。 この値は、選択した I/O 規格によって

異なり ます。

[Drive]

[Drive] 列には、出力ピンの最大駆動電流が 2mA ～ 24mA の範囲で表示され、これらの値は選択し

た I/O 規格によって異なり ます。

[Slew Rate]

[Slew Rate] 列では、 各 GPIO_OUT ピンのスルー レート を [FAST] または [SLOW] のいずれかに

設定できます。

サンプルおよびテンプレート  オプシ ョ ンの選択

IBERT コアの GPIO オプシ ョ ンを選択したら、 [Next]  をク リ ッ ク して [Example and Template
Options] ページに進みます。

[Generate Batch Mode Argument Example File (.arg)] をオンにする と、バッチ モードの引数サンプ

ル ファ イル (ibert.arg など) を作成できます。 この ibert.arg ファ イルは、generate と呼ばれるコマ

ンド  ラ イン プログラムで使用されます。 また、このファ イルには、IBERT Core Generator ツールを

使用せずに、 IBERT デザインを作成するために必要なすべての引数が含まれています。

IBERT コアは、Windows の場合はコマンド  プロンプ トで「ibertgenerate.exe <ibert_type> -
f=ibert.arg」 と入力し、 Linux の場合は UNIX シェル プロンプ トで 「ibertgenerate.sh

<ibert_type> -f=ibert.arg」 と入力する と生成できます。 <ibert_type> は、 使用するデバイス

ファ ミ リに従い ibert、 ibertgtp、 または ibertgtx に置き換えてください。 

[Output Log File Settings] では、 出力ログ ファ イルを生成するかど うかを決定します。 また、 この

出力ログ ファ イルに加えて、 ISE インプ リ メンテーシ ョ ン ツール (ngdbuild、 map、 par) でも個々

にレポート  ファ イルが生成されます。 設定可能なオプシ ョ ンは、 次のとおりです。

• [Generate Output Log File]オンにする と、 <design name>.log とい う名前の出力ログ ファ イ

ルが生成されます。 このファ イルには、IBERT デザイン生成プロセス中にメ ッセージ ペインに

表示されたすべてのメ ッセージが含まれます。

♦ オフの場合は、 出力ログ ファ イルは生成されません。

• [Verbose Log File]

♦ オンにする と、 生成プロセス中に ISE インプ リ メンテーシ ョ ン ツールから メ ッセージ ペ
インに出力されたメ ッセージすべてが含まれます。

♦ オフの場合は、 ツールによる出力が圧縮され、 通常は生成にかかるランタイムが短縮され

ます。
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デザインの生成

IBERT コアのパラ メータの入力が終了したら、[Generate Design] をク リ ッ ク し、カスタマイズした

FPGA デザインを作成するのに必要なすべてのファイルを実行します。 メ ッセージ ウ ィンド ウが開

き、 進捗情報が表示されます。 「IBERT Design Generation Completed」 と表示される と、 コア作成

プロセスの完了です。 この後、 前の画面に戻り、 異なるオプシ ョ ンを指定してコアを生成し直した

り、 または [Start Over] をク リ ッ ク して、 新規コアを生成できます。

メモ : IBERT の生成では、ISE ツールすべてが実行されるため、その他の ChipScope コアにかかる

生成時間よ り も長くなり ます。 多くの GTP/GTX を使用するデザインでは、 使用するコンピュータ

の速度によっては生成に何時間もかかる場合があ り ます。
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Virtex-5 FPGA GTX ト ランシーバ用 IBERT v2.0 コアの生成

ザイ リ ンクス  CORE Generator ツールでは、Virtex-5 FPGA GTX ト ランシーバ用 IBERT v2.0 コア

をカスタマイズして、 生成できます。 IBERT のパラ メータをすべて設定する と、 ビッ ト ス ト リーム

を含む完全デザインが生成されます。 この IBERT コアは、 スタンドアロン デザインでのみ生成で

き、 ユーザー デザインに含めるこ とはできません。 デザインのネッ ト リ ス ト  ファ イル (.ngc または

.edn) は生成されず、 代わりにザイ リ ンクス  CORE Generator によ り  ISE が実行されてビッ ト ス ト

リーム ファ イル (.bit) が生成されます。

ザイ リ ンクス  CORE Generator ツールの [Debug & Verification] → [ChipScope Pro] で、 [IBERT
Virtex5 GTX (ChipScope Pro - IBERT)] を選択して、 ウ ィ ンド ウ右側の [Customize and Generate]
をク リ ッ ク します。

IBERT コアの標準オプシ ョ ンの設定

標準オプシ ョ ンは、 1 ページ目で設定します。

[Component Name]

[Component Name] には、 英数字の任意の組み合わせとアンダースコア (_) を使用できます。 ただ

し、 アンダースコアはコンポーネン ト名の最初には使用できません。

[Number of Line Rates (protocols)]

IBERT コアには複数の MGT を含めるこ とが可能で、これらの MGT は同じライン レートで動作し

たり、同じ リ ファレンス ク ロ ッ クを使用する必要があ り ません。 [Number of Line Rates (protocols)]
からライン レート / リ ファレンス  クロ ッ ク  レートの数を選択します。

ライン レート設定の選択

各ライン レートの [Protocol] から、 カスタム設定 ([Start from scratch]) または定義済みプロ ト コル

設定を選択します。 定義済みプロ ト コルのいずれかを選択した場合、 [Max Rate]、 [Data Width]、お

よび [REFCLK] の値が自動的に更新されます。 カスタム プロ ト コルを指定する場合は、その値を直

接入力してください。

GTX_DUAL およびリファレンス クロックの選択

IBERT コアのプロ ト コル オプシ ョ ンを選択したら、 [Next] をク リ ッ ク して、 [GTXs and Reference
Clocks for Line Rate 1] ページに進みます。 このページでの設定が済んだら  [Next] をク リ ッ ク して

すべてのライン レートのオプシ ョ ンを設定します。

GTX_DUAL の選択

使用可能な GTX_DUAL (このセクシ ョ ンでは略して 「DUAL」 と も言及) のリ ス トがそのロケー

シ ョ ンと共に表示されます。 DUAL の横にあるチェッ ク  ボッ クスが淡色表示の場合は、そのト ラン

シーバが別のライン レートで設定されているこ とを意味します。 そのライン レートで使用する

DUAL を確認して ください。 生成時には DUAL 内のト ランシーバをすべて同じライン レートでコ

ンフ ィギュレーシ ョ ンする必要があ り ます。

REFCLK ソースの選択

[REFCLK] で MGT に供給する リ ファレンス  クロ ッ クを選択します。DUAL では使用できる リ ファ

レンス  ク ロ ッ クが 1 つあり、 また隣接する  DUAL から も リ ファレンス  ク ロ ッ クを使用できます。
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ク ロ ッキング ト ポロジの詳細は、 『Virtex-5 FPGA GTX Transceiver User Guide』 [251 ページのリ

ファレンス  5 を参照] を参照して ください。

RXRECCLK プローブの使用

IBERT コアのすべてのライン レートで GTX ト ランシーバおよび REFCLK オプシ ョ ンを設定した

ら、 [Next] をク リ ッ ク して RXRECCLK プローブ オプシ ョ ン ページに進みます。

使用する  GTX ト ランシーバのそれぞれで、 RXRECCLK (復元クロ ッ ク ) をピンに供給して外部測

定に使用する こ と ができ ます。 このオプシ ョ ンを使用するには、 任意の復元ク ロ ッ クの横の

[Enable] をオンにします。 次に、[Location]にピン ロケーシ ョ ンを入力し、[IO Standard] から  I/O 規
格を選択します。 差動規格の場合は、 P ピン ロケーシ ョ ンを指定します。

システム クロック  ソースの選択

RXRECCLK プローブ オプシ ョ ンを選択したら、 [Next] をク リ ッ ク してシステム ク ロ ッ ク  オプ

シ ョ ンのページに進みます。

IBERT では、内部通信ロジッ クにク ロ ッ クが必要です。 ク ロ ッ クは外部ピンから入力されるのが理

想ですが、 GTX の TXOUTCLK からも入力できます。 ピンから クロ ッ クを入力するには、 [Use
External Clock source] をオンにし、[Frequency (MHz)] に周波数を、[Location] にピン ロケーシ ョ

ンを入力し、 [Input Standard] で入力規格を選択します。 差動規格の場合は、P ピン ロケーシ ョ ンを

指定します。

内部クロ ッ クを指定するには、[Use MGT TXOUTCLK] をオンにして、[Use TXOUTCLK from] で
GTX ト ランシーバを選択します。

デザインの生成

IBERT コアのパラ メータの入力が終了したら、[Next] をク リ ッ ク して、IBERT コアのサマ リ を表示

します。 このサマ リには、 使用する  GTX ト ランシーバ、 システム クロ ッ ク、 およびグローバル ク
ロ ッ ク  リ ソースの詳細が含まれています。 [Generate] をク リ ッ ク して、 デザインを生成します。
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Virtex-6 FPGA GTX ト ランシーバ用 IBERT v2.0 コアの生成

ザイ リ ンクス  CORE Generator ツールでは、Virtex-6 LXT/SXT/CXT/HXT FPGA GTX ト ランシー

バ用 IBERT v2.0 コアをカスタマイズして、 生成できます。 IBERT のパラ メータをすべて設定する

と、ビッ ト ス ト リームを含む完全デザインが生成されます。 この IBERT コアは、スタンドアロン デ
ザインでのみ生成でき、 ユーザー デザインに含めるこ とはできません。 デザインのネッ ト リ ス ト

ファ イル (.ngc または .edn) は生成されず、 代わりにザイ リ ンクス  CORE Generator によ り  ISE が
実行されてビッ ト ス ト リーム ファ イル (.bit) が生成されます。

ザイ リ ンクス  CORE Generator ツールの [Debug & Verification] → [ChipScope Pro] で、 [IBERT
Virtex6 GTX (ChipScope Pro - IBERT)] を選択して、 ウ ィ ンド ウ右側の [Customize and Generate]
をク リ ッ ク します。 

IBERT コアの標準オプシ ョ ンの設定

標準オプシ ョ ンは、 1 ページ目で設定します。

[Component Name]

[Component Name] には、 英数字の任意の組み合わせとアンダースコア (_) を使用できます。 ただ

し、 アンダースコアはコンポーネン ト名の最初には使用できません。

システム クロッ ク  ソースの選択

IBERT では、 内部通信ロジッ クにクロ ッ クが必要です。 ピンから クロ ッ クを入力するには、 [Use
External Clock source] をオンにし、 [Frequency (MHz)] に周波数を、 [Pin Location] にピン ロケー

シ ョ ンを入力し、[Pin Input Standard] で入力規格を選択します。 差動規格では、P ピンのロケーシ ョ

ンを指定します。

プロ ト コルの設定

[Number of Protocols]

IBERT コアには複数の MGT を含めるこ とが可能で、これらの MGT は同じライン レートで動作し

たり、同じ リ ファレンス ク ロ ッ クを使用する必要があ り ません。 [Number of Protocals] からライン

レート / リ ファレンス クロ ッ ク  レートの数を選択します。

ライン レート設定の選択

各ライン レートの [Protocol] から、 カスタム設定または定義済みプロ ト コル設定を選択します。

[Name Protocol] から  1 つ定義済みプロ ト コルを選択した場合は、 [Max Rate]、 [Data Width]、およ

び [REFCLK] がそのプロ ト コルに従って自動的に入力されます。 カスタム プロ ト コルを指定する

場合は、 その値を直接入力してください。

GTX ト ランシーバおよびリファレンス クロックの選択

IBERT コアのプロ ト コル オプシ ョ ンを選択したら、 [Next]  をク リ ッ ク して GTX ト ランシーバ オ
プシ ョ ン設定ページに進みます。 

GTX の選択

使用可能な GTX ト ランシーバのリ ス トがそのロケーシ ョ ンと共に表示されます。 [Protocol
Selected] で使用する  GTX にプロ ト コルを選択します。  
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REFCLK ソースの選択

[Refclk Source] から、 GTX ト ランシーバに供給する リ ファレンス  ク ロ ッ クを選択します。 

RXRECCLK プローブの使用

使用する  GTX で、 RXRECCLK (復元クロ ッ ク ) をピンに供給して外部測定に使用するこ とができ

ます。 オンにするには、 [GTX Location] のリ ス トから  1 つ選択します。 次に、 [Output Standard] か
ら出力規格を選択して、[Pin Location] にピン ロケーシ ョ ンを入力します。 差動規格では、P ピンの

ロケーシ ョ ンを指定します。このページは、[Add RXRECCLK probe] がオンのと きのみに表示され

ます。

デザインの生成

IBERT コアのパラ メータの入力が終了したら、[Next] をク リ ッ ク して、IBERT コアのサマ リ を表示

します。 このサマ リには、 使用する  GTX ト ランシーバ、 システム クロ ッ ク、 およびグローバル ク
ロ ッ ク  リ ソースの詳細が含まれています。 [Generate] をク リ ッ ク して、 デザインを生成します。
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Virtex-6 FPGA GTH ト ランシーバ用 IBERT v2.0 コアの生成

ザイ リ ンクス  CORE Generator ツールでは、Virtex-6 FPGA GTH ト ランシーバ用 IBERT v2.0 コア

をカスタマイズして、 生成できます。 IBERT のパラ メータをすべて設定する と、 ビッ ト ス ト リーム

を含む完全デザインが生成されます。この IBERT コアは、スタンドアロン デザイン ビッ ト ス ト リー

ム (.bit) およびデザイン ネッ ト リ ス ト ス ト  ファ イル (.ngc または .edn) の両方を生成できます。

ザイ リ ンクス  CORE Generator ツールの [Debug & Verification] → [ChipScope Pro] で、 [IBERT
Virtex6 GTH (ChipScope Pro - IBERT)] を選択して、 ウ ィ ンド ウ右側の [Customize and Generate]
をク リ ッ ク します。 

IBERT コアの標準オプシ ョ ンの設定

標準オプシ ョ ンは、 1 ページ目で設定します。

[Component Name]

[Component Name] には、 英数字の任意の組み合わせとアンダースコア (_) を使用できます。 ただ

し、 アンダースコアはコンポーネン ト名の最初には使用できません。

[Generate Bitstream]

オンにする と、 [Generate] をク リ ッ ク した後にインプリ メンテーシ ョ ン ツールで IBERT デザイン

が完全にインプ リ メン ト されます。 オフにする と、 ネッ ト リ ス ト  ファ イルおよび後でデザインをイ

ンプ リ メン トするスク リプ トが生成されます。

[Add RXUSERCLK probe]

オンにする と、FPGA ピンに配線する  RXRECCLK 信号およびこれらのピンのパラ メータを選択す

るページがウ ィザード後半で表示されます。

[GTH Naming Style]

各 GTH ト ランシーバは、 XY 座標 (XmYn GTHd) または GTH ト ランシーバ番号 (MGTm n) のい

ずれかで識別されます。 こ こで選択した命名規則がすべての GTH ト ランシーバに反映されます。

[System Clock]

IBERT デザインでは、内部通信ロジッ クに外部クロ ッ ク  ソースが必要です。 このクロ ッ クは、外部

ピンから入力される必要があ り ます。 外部クロ ッ クを設定するには、 [Frequency] に周波数、 [Pin
Location] にピン ロケーシ ョ ンを入力し、[Pin Input Standard] で入力規格を選択します。 差動規格で

は、 P ピンのロケーシ ョ ンを指定します。

プロ ト コルの設定

標準オプシ ョ ンを設定したら  [Next] をク リ ッ ク して、 プロ ト コル オプシ ョ ン ページに進みます。

プロ ト コル数の選択

IBERT コアには複数の GTH を含めるこ とが可能で、 これらの GTH は同じライン レートで動作し

たり、同じ リ ファレンス クロ ッ クを使用する必要があ り ません。 [Number of Protocols ] からライン

レート / リ ファレンス クロ ッ ク  レートの数を選択します。
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ライン レート設定の選択

各ライン レートの [Protocol] から、 カスタム設定 ([Name Protocol]) または定義済みプロ ト コル設

定を選択します。 [Name Protocol] から  1 つ定義済みプロ ト コルを選択した場合は、 [Max Rate]、
[Data Width]、および [REFCLK] がそのプロ ト コルに従って自動的に入力されます。 カスタム プロ

ト コルを指定する場合は、 その値を直接入力してください。

GTH ト ランシーバの割り当て

IBERT コアのプロ ト コル オプシ ョ ンを選択したら、 [Next]  をク リ ッ ク して GTH ト ランシーバ オ
プシ ョ ン設定ページに進みます。 各ト ランシーバでプロ ト コルに [None] または 1 ページ前で定義

したプロ ト コルのいずれかを選択します。 [Next] をク リ ッ ク して次のページに表示される ト ラン

シーバでも同様に選択します。

REFCLK ソースの選択

ト ランシーバを選択したら  [Next] をク リ ッ ク して、 REFCLK ソース  オプシ ョ ン ページに進みま

す。 各ト ランシーバでリ ファレンス  ク ロ ッ ク  ソースを選択します。

RXRECCLK プローブの選択 (オプシ ョ ン)
各ト ランシーバで REFCLK ソースを選択したら、[Next] をク リ ッ ク して RXRECCLK プローブ オ
プシ ョ ン ページに進みます。 このページは、[Add RXUSERCLK probe] がオンのと きのみに表示さ

れます。

デザインの生成

IBERT コアのパラ メータの入力が終了したら、[Next] をク リ ッ ク して、IBERT コアのサマ リ を表示

します。 このサマ リには、 使用する  GTP ト ランシーバ、 システム クロ ッ ク、 およびグローバル ク
ロ ッ ク  リ ソースの詳細が含まれています。 [Generate] をク リ ッ ク して、 デザインを生成します。
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Spartan-6 FPGA GTP ト ランシーバ用 IBERT v2.0 コアの生成

CORE Generator を使用する と、Spartan-6 FPGA GTP ト ランシーバ用 IBERT v2.0 をカスタマイズ

して生成できます。 IBERT のパラ メータをすべて設定する と、 ビッ ト ス ト リームを含む完全デザイ

ンが生成されます。 この IBERT コアは、 スタンドアロン デザインでのみ生成でき、 ユーザー デザ

インに含めるこ とはできません。 デザインのネッ ト リ ス ト  ファ イル (.ngc または .edn) は生成され

ず、 代わりにザイ リ ンクス  CORE Generator によ り  ISE が実行されてビッ ト ス ト リーム ファ イル

(.bit) が生成されます。

ザイ リ ンクス  CORE Generator ツールの [Debug & Verification] → [ChipScope Pro] で、 [IBERT
Spartan6 GTP (ChipScope Pro - IBERT)] を選択して、ウ ィンド ウ右側の [Customize and Generate]
をク リ ッ ク します。

IBERT コアの標準オプシ ョ ンの設定

標準オプシ ョ ンは、 ウ ィザードの 1 ページ目で設定します。

[Component Name]

[Component Name] には、 英数字の任意の組み合わせとアンダースコア (_) を使用できます。 ただ

し、 アンダースコアはコンポーネン ト名の最初には使用できません。

[Number of Line Rates (protocols)]

IBERT コアには複数の MGT を含めるこ とが可能で、これらの MGT は同じライン レートで動作し

たり、同じ リ ファレンス ク ロ ッ クを使用する必要があ り ません。 [Number of Line Rates (protocols)]
からライン レート / リ ファレンス  クロ ッ ク  レートの数を選択します。

[Line Rate Settings]

各ライン レートの [Protocol] から、 カスタム設定 ([Start from scratch]) または定義済みプロ ト コル

設定を選択します。 定義済みプロ ト コルのいずれかを選択した場合、 [Max Rate]、 [Data Width]、お

よび [REFCLK] の値が自動的に更新されます。 カスタム プロ ト コルを指定する場合は、その値を直

接入力してください。

GTPA1_DUAL およびリファレンス クロックの選択

IBERT コアのプロ ト コル オプシ ョ ンを選択したら、[Next] をク リ ッ ク して、[Select GTP Duals and
Reference Clocks for Line Rate 1] ページに進みます。 このページでの設定が済んだら  [Next] をク

リ ッ ク してライン レート  2 のオプシ ョ ンを設定します。

GTPA1_DUAL の選択

使用可能な GTPA1_DUAL (このセクシ ョ ンでは略して 「DUAL」 と も言及) のリ ス トがそのロケー

シ ョ ンと共に表示されます。 DUAL 内の ト ランシーバを 1 つだけ選択するこ とはできず、 両方のト

ランシーバを使用する必要があ り ます。 チェッ ク  ボッ クスが淡色表示の場合は、 そのト ランシーバ

が別のライン レートで設定されているこ とを意味します。 そのライン レートで使用する  DUAL を
確認してください。 生成時には、DUAL の両方が同じライン レートでコンフ ィギュレーシ ョ ンされ

る必要があ り ますが、 実行時に変更可できます。

REFCLK ソースの選択

[GTP1 REFCLK] で各ト ランシーバに供給する リ ファレンス  クロ ッ クを選択します。 DUAL では

使用できる リ ファレンス  ク ロ ッ クが 1 つあり、また隣接する  DUAL からも リ ファレンス ク ロ ッ ク
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を使用できます。 ク ロ ッキング ト ポロジの詳細は、『Spartan-6 FPGA GTP Transceivers User Guide』
[251 ページのリ ファレンス  8 を参照] を参照してください。

RXRECCLK プローブの使用

IBERT コアのすべてのライン レートで GTP ト ランシーバおよび REFCLK オプシ ョ ンを設定した

ら、 [Next] をク リ ッ ク して RXRECCLK プローブ オプシ ョ ン ページに進みます。

使用する  GTP ト ランシーバのそれぞれで、RXRECCLK (復元クロ ッ ク ) をピンに供給して外部測定

に使用するこ とができます。 このオプシ ョ ンを使用するには、 任意の復元クロ ッ クの横の [Enable]
をオンにします。 続いて、 [Location] にピン ロケーシ ョ ンを入力し、 [IO Standard] から  I/O 規格を

選択します。 差動規格の場合は、 P ピン ロケーシ ョ ンを指定します。

システム クロック  ソースの選択

RXRECCLK プローブ オプシ ョ ンを選択したら、 [Next] をク リ ッ ク してシステム ク ロ ッ ク  オプ

シ ョ ンのページに進みます。

IBERT では、 内部通信ロジッ クにク ロ ッ クが必要です。 このク ロ ッ クのソースには、 外部ピンまた

は IBERT デザインでイネーブルにした GTP ト ランシーバの TXOUTCLK を使用できます。 ピン

からク ロ ッ クを入力するには、[Use External Clock source] をオンにし、[Frequency (MHz)] に周波

数を、 [Location] にピン ロケーシ ョ ンを入力し、 [Input Standard] で入力規格を選択します。 差動規

格の場合は、 P ピン ロケーシ ョ ンを指定します。

内部クロ ッ クを指定するには、[Use MGT TXOUTCLK] をオンにして、[Use TXOUTCLK from] で
GTP ト ランシーバを選択します。

デザインの生成

IBERT コアのパラ メータの入力が終了したら、[Next] をク リ ッ ク して、IBERT コアのサマ リ を表示

します。 このサマ リには、 使用する  GTP ト ランシーバ、 システム クロ ッ ク、 およびグローバル ク
ロ ッ ク  リ ソースの詳細が含まれています。 [Generate] をク リ ッ ク して、 デザインを生成します。
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Core Inserter の概要

ChipScope™ Pro Core Inserter は合成後に使用し、パラ メータ化した ICON、ILA、および ATC2 コ
アを必要に応じてデザインに挿入してネッ ト リ ス ト を生成するツールです。 Core Inserter では、 デ

バッグ機能を迅速かつ容易に使用して HDL をインスタンシエートせずに、 合成されたデザインを

解析できます。

メモ : IBA、 VIO、 および IBERT コアは、 Core Inserter でサポート されていません。 

PlanAhead での Core Inserter の使用 
Core Inserter は、 PlanAhead™ ソフ ト ウェアと組み合わせて使用するよ うには設計されていませ

ん。 その代わり、Core Inserter に含まれるデバッグ コア挿入機能に類似した機能が PlanAhead ソフ

ト ウェア環境に組み込まれています。 Core Inserter ツールから  ISE® PlanAhead ソフ ト ウェア環境

に簡単に移行できるよ う、 PlanAhead には CDC インポート  コマンドが提供されており、 このコマ

ンドによ り  Core Inserter の CDC プロジェク ト  ファ イルを PlanAhead プロジェク トにインポート

できます。 PlanAhead の ChipScope コアの挿入に関する詳細は、 『PlanAhead ユーザー ガイ ド』

[251 ページのリ ファレンス  18 を参照] を参照してください。

ISE Project Navigator での Core Inserter の使用

このセクシ ョ ンは、 Windows または Linux バージ ョ ンの ChipScope Pro および ISE ツールを使用

しているユーザーを対象にしています。

Core Inserter の CDC ファ イルは、Project Navigator のソース  ファ イル リ ス トに新規ソース  ファ イ

ルと して追加できます。 また、 Project Navigator では、 インプ リ メンテーシ ョ ン フローの適切なタ

イ ミ ングで Core Inserter ツールを認識し起動させるこ とが可能です。 Project Navigator と  Core
Inserter の統合に関する詳細は、 ISE ソフ ト ウェア マニュアル [251 ページのリ ファレンス  15 を参

照] の Project Navigator セクシ ョ ンを参照して ください。
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ChipScope の定義および接続ソース ファイル

Core Inserter ツールを使用して Project Navigator で処理されるデザインにコアを挿入するには、次

の手順に従います。

1. CDC (ChipScope Definition and Connection) ファ イルをプロジェク トに追加し、該当するデザ

イン モジュールと関連付けます。

a. 新規の CDC ファ イルを作成するには、[Project] → [New Source] → [ChipScope Definition
and Connection File] をク リ ッ ク し、 ファ イル名を入力します。 [Next] をク リ ッ ク して

[Summary] ページに進み、 [Finish] をク リ ッ ク してファ イルを作成します。

メモ : Project Navigator で同一バージョ ンの ChipScope Pro のインスト ールが認識された場

合のみ、 ソース  タイプと して [ChipScope Definition and Connection File] が表示されます。

b. 既存の CDC ファ イルを追加するには、[Project] → [Add Source] または [Project] → [Add
Copy of Source] をク リ ッ ク して、 既存の CDC ファ イルを参照します。

CDC ファ イルをブラウザで選択して [開く ] をク リ ッ ク し、 [Adding Source Files] ダイア

ログ ボッ クスで [OK] をク リ ッ ク します。 ソース  ウ ィンド ウで CDC ファ イルが関連付け

たデザイン モジュールの下に表示されます。

2. コアを作成し、 信号接続を完了するには、 [Design] パネルに表示されるこの CDC ファ イルを

ダブルク リ ッ ク します。 この後、 必要な場合は合成と変換が実行され、 ChipScope Pro Core
Inserter で CDC ファ イルが開きます。

3. 必要に応じてコアおよび接続を修正して (82 ページの「ChipScope Pro Core Inserter の機能」で

説明) ツールを終了します。

4. Project Navigator で関連する最上位デザインがインプ リ メン ト される と、 変換フローの一部と

してコアが自動的にデザインのネッ ト リ ス トに挿入されます。 この操作を実行するために、 プ

ロパティを設定する必要はあ り ません。 コアは、CDC ファ イルがプロジェク ト内にあ り、 イン

プ リ メン ト されるデザイン モジュールに関連付けられている と自動的に挿入されます。

有用な Project Navigator の設定

次の Project Navigator 設定を使用する と、 コアをデザインにインプリ メン トする際に役立ちます。

1. XST 合成ツールを使用している場合は、[Keep Hierarchy] オプシ ョ ンを [Yes] または [Soft] に
設定し てデザイ ン階層を維持し、 デザイ ンすべての階層の最適化を回避し ます。 [Keep
Hierarchy] オプシ ョ ンを使用した場合、 コアの挿入フロー中のネッ ト名およびその他のコン

ポーネン ト名を維持できます。 [Keep Hierarchy] オプシ ョ ンを使用しない場合は、 ネッ ト /コン

ポーネン トがほかのロジッ ク と結合されて新しいコンポーネン トが作成されるか、 または最適

化されて削除される可能性があ り ます。 デザイン階層を維持するには、 次の手順に従います。 

a. [Processes] ペインで [Synthesize - XST] を右ク リ ッ ク して [Process Properties] をク リ ッ

ク します。

a. [Synthesis Options] ページで [Keep Hierarchy] を [Soft] または [Yes] に設定して、[OK] を
ク リ ッ ク します。

2. Analyzer を使用して、デバイスにビッ ト ス ト リームをダウンロードする前に、適切なビッ ト ス

ト リーム生成オプシ ョ ンを設定します。

a. Project Navigator で [Generate Programming File] を右ク リ ッ ク して、[Process Properties]
を選択します。

b. [Startup Options] ページを表示します。

c. [FPGA Start-Up Clock] に [JTAG Clock] を選択します。
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コマンド  ライン インプリ メンテーシ ョ ンでの Core Inserter の使用

コマンド  ライン フローの概要

Core Inserter では、バッチ コア挿入の基本的なコマンド  ラインがサポート されています。 図 3-1 に
示すよ うに、 Core Inserter のコマンド  ラ イン フローは、 次の手順で構成されています。 

1. CDC プロジェク トの作成

2. CDC プロジェク トの変更

3. コアの挿入

Core Inserter は NGDBuild の前に実行され、デザインにデバッグ コアがインスタンシエート されま

す。 デバッグするネッ トは CDC プロジェク ト変更ステップで選択して GUI に表示し、 プロジェク

トに保存できます。 デザインを正し く インプ リ メン ト し、 そのビッ ト ス ト リームを使用してザイ リ

ンクス  デバイスをコンフ ィギュレーシ ョ ンした後には、Analyzer を使用して回路デザインのデバッ

グおよび検証を実行します。 コンフ ィギュレーシ ョ ン後にデバッグ ネッ トの選択およびコアの設定

を変更する場合は、CDC プロジェク トの変更ステップに戻ってフローを実行し直して、新しいビッ

ト ス ト リームを生成し、 デバッグおよび検証を実行してください。

X-Ref Target - Figure 3-1

図 3-1 : Core Inserter のコマンド  ライン フロー
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CDC プロジェク トの作成

図 3-2 に示すよ うに、 空の CDC プロジェク ト ファ イルを作成します。 コマンド  ラインに次のよ う

に入力します。

inserter -create <project.cdc>

メモ : この手順では、 Core Inserter の GUI は起動しません。

CDC プロジェク トの変更

この手順では、 Core Inserter の GUI を起動して既存の CDC プロジェク ト を変更します (図 3-3 を
参照)。 この手順では、 NGCBuild ツールが特定の引数と共に呼び出されます。 NGCBuild ツールで

は、デザインに関連するネッ ト リ ス トすべてが 1 つの NGC ネッ ト リ ス ト  ファ イルに統合されます。

これによ り、 Core Inserter でデザイン内のすべてのレベルおよびノードに対して完全にデバッグを

実行できます。 

コマンド  ラ インに次のよ うに入力します。

inserter -edit <project.cdc> -ngcbuild [-p <partname>] [{-sd

<source_dir>}] [-dd <output_dir>] [-i] <inputdesign.{edn|ngc}>

<outputdesign.ngc>

X-Ref Target - Figure 3-2

図 3-2 : CDC プロジェク トの作成手順

inserter_create_mode_ch3_04_121306

ChipScope Pro
Core Inserter Project.cdc

X-Ref Target - Figure 3-3

図 3-3 : CDC プロジェク トの変更手順

inserter_edit_mode_ch3_05_121306

ChipScope Pro
Core Inserter Project.cdc

Project.cdc

InputDesign

Project.cdc

Project.cdcCores

OutputDesign
Cores

ngcbuild
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コアの挿入

この手順では、 既存の CDC プロジェク トに基づきデザインにコアを挿入します (図 3-4 を参照)。 
この手順では、NGCBuild ツールが特定の引数と共に呼び出されます。 NGCBuild ツールでは、デザ

インに関連するネッ ト リ ス トすべてが 1 つの NGC ネッ ト リ ス ト  ファ イルに統合されます。 コア

は、 1 つの完全ネッ ト リ ス トに挿入されます。

コマンド  ラ インに次のよ うに入力します。

inserter -insert <project.cdc> -ngcbuild [-p <partname>] [{-sd

<source_dir>}] [-dd <output_dir>] [-i] <inputdesign.{edn|ngc}>

<outputdesign.ngc>

X-Ref Target - Figure 3-4

図 3-4 : コアの挿入手順

inserter_insert_mode_ch3_06_121306

ChipScope Pro
Core Inserter

Project.cdc

InputDesign

Project.cdc

Project.cdcCores

OutputDesign
+

Cores
+

ChipScope
Cores
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ChipScope Pro Core Inserter の機能

プロジェク トでの作業

Core Inserter で保存したプロジェク トには、 ソース  ファ イル、デスティネーシ ョ ン ファ イル、 コア

のパラ メータ、およびコアの設定に関連する情報がすべて含まれます。 このため、このファ イルを使

用して、 コアの挿入に関する情報を保存および再現できます。 また、 プロジェク ト  ファ イル (.cdc)
を、 Analyzer への入力と して使用して、 信号名をインポートできます。

ChipScope Core Inserter を起動したと きに表示される初期画面はすべて空欄になっています。また、

[File] → [New] をク リ ッ ク しても同じ画面を表示できます。

既存のプロジェク ト を開く

既存のプロジェク ト を開く場合、 最近開いたプロジェク ト  リ ス トから、 または [File] → [Open
Project] をク リ ッ ク して [Browse] でプロジェク ト  ディ レク ト リに移動します。プロジェク ト を選択

してダブルク リ ッ クするか、 または [開く ] をク リ ッ ク します。

プロジェク トの保存

プロジェク ト を変更した場合、 Core Inserter を終了する前にプロジェク トの保存を尋ねるダイアロ

グ ボッ クスが表示されるので、 保存して ください。 また、 [File] →[Save] からも保存できます。 現

在のプロジェク ト名を変更または別の名前で保存するには、[File] → [Save As] をク リ ッ ク して、新

しい名前を入力し、 [保存] をク リ ッ ク します。

ネッ ト リス トの更新

Core Inserter で前回読み込んだと きからネッ ト リ ス トが変更されている場合は、 自動的にリ ロード

されます。 ただし、 [File] → [Refresh Netlist] をク リ ッ クする と、 手動でネッ ト リ ス ト を リ フレッ

シュするこ と もできます。

ユニッ トの挿入および削除

プロジェク トに新規ユニッ ト を挿入する場合は、 [Edit] → [New ILA Unit] または [Edit] → [New
ATC2 Unit] をク リ ッ ク します。 ユニッ ト を削除する場合は、ユニッ ト を選択して [Edit] → [Remove
Unit] をク リ ッ ク します。

プリファレンスの設定

ChipScope Core Inserter プロジェク トのプ リ ファレンスを設定する場合は、 [Edit] → [Preferences]
をク リ ッ ク します。 設定ウインド ウは、 [Tools]、 [ISE Integration]、 および [Miscellaneous] の 3 つ
に分かれています。 プリ ファレンスの設定の詳細は、 92 ページの 「プロジェク トのプ リ ファレンス

設定」 を参照してください。

コアの挿入

ICON、ILA、および ATC2 コアの挿入は、フロー完了後に実行されます。または、[Insert] → [Insert
Core] をク リ ッ ク します。 キャプチャしたすべてのコアが有効な信号に接続されていない場合は、エ

ラー メ ッセージが表示されます。

Core Inserter の終了

ChipScope Core Inserter を終了するには、 [File] → [Exit] をク リ ッ ク します。
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入力および出力ファイルの指定

ChipScope Core Inserter は、 次の手順で実行します。 

1. [Input Design Netlist] で入力デザイン ネッ ト リ ス ト を指定します。

2. [Browse] をク リ ッ ク してネッ ト リ ス トのディレク ト リ を参照します。

3. 必要に応じて、[Output Design Netlist] および [Output Directory] を変更します。 これらフ ィー

ルドは、 デフォルトで自動的に入力されています。

メモ : Core Inserter を Project Navigator から起動した場合、[Input Design Netlist]、[Output Design
Netlist]、 [Output Directory and Device Family] フ ィールドは自動的に入力されます。 この場合、 こ

れらのフ ィールドは Project Navigator でのみ変更でき、 Core Inserter では変更できません。

プロジェク ト  レベルのパラメータ

プロジェク トでは、 3 つのパラ メータ  (デバイス  ファ ミ リ 、 SRL 使用の有無、 RPM 使用の有無) を
設定する必要があ り ます。

ターゲッ ト  デバイス ファ ミ リの選択

[Device Family] でターゲッ ト  デバイス  ファ ミ リ を指定します。 こ こで選択したデバイス  ファ ミ リ

用に、ICON およびキャプチャ  コアの構造が最適化されます。 プルダウン リ ス トからデバイス  ファ

ミ リ を選択してください。

デフォルトでは、 [Virtex5] が選択されています。

SRL の使用

[Use SRLs] では、コア生成での SRL16/SRL32 コンポーネン トの使用の有無を選択します。 このオ

プシ ョ ンをオフにした場合は、 SRL16/32 コンポーネン トの代わりにフ リ ップフロ ップおよびマル

チプレクサが使用されます。この場合、生成されたコアのサイズやパフォーマンスに影響が出ます。

デフォルトでは、 [Use SRLs] がオンになっており、 SRL を使用してコアが生成されます。

RPM の使用

[Use RPMs] をオンにする と、 コアが相対配置マクロ  (RPM) にされます。 オンのと きは配置配線

ツールで、 コアのすべてのロジッ クが最適化されて 1 つのエリ アに配置されます。 デバイスのほと

んどのリ ソースを使用するデザインでは、 これらの配置制約は満たされない可能性があ り ます。 デ
フォルトでは、[Use RPMs]  がオンになっており、配置が最適化されたコアが生成されます。 すべて

設定したら、 [Next] をク リ ッ ク します。

コアのリソース使用量

Core Inserter の左側にある  [Core Utilization] パネルでは、 デザインのネッ ト リ ス トに挿入する

ChipScope コアで消費されるルッ クアップ テーブル (LUT)、フ リ ップフロ ップ (FF)、およびブロ ッ

ク  RAM (BRAM) の概算数が表示されます。 コアのリ ソース使用量は、 コアの構成に影響するパラ

メータの設定に基づいて更新されます。

メモ : [LUT Count] および [FF Count] は、Spartan®-3、Spartan-3E、Spartan-3A、Spartan-3A DSP、
および Virtex-4 デバイス  ファ ミ リでのみ表示されます。 [BRAM Count] は、すべてのデバイス  ファ

ミ リで表示されます。

http://japan.xilinx.com


84 japan.xilinx.com ChipScope Pro 12.1 ソフ トウェアおよびコア

UG029 (v12.3) 2010 年 9 月 21 日

第 3 章 : ChipScope Pro Core Inserter の使用

ICON オプシ ョ ンの選択

最初に指定する必要があるオプシ ョ ンは、 ICON コアです。 ICON コアは、 すべての ILA コアおよ

び ATC2 コアを JTAG バウンダ リ  スキャン チェーンと接続するコン ト ローラ  コアです。

[Boundary Scan Chain]

Analyzer では、USER1、USER2、USER3、または USER4 のいずれかのバウンダ リ  スキャン チェー

ンを使用してコアと通信できます。 [Boundary Scan Chain] リ ス トから任意のスキャン チェーンを

選択してください。 このオプシ ョ ンは、Spartan-3、Spartan-3E、Spartan-3A、および Spartan-3A DSP
デバイス  ファ ミ リ を使用する場合は使用できません。

ILA のト リガー オプシ ョ ンおよびパラメータの選択

[New ILA Unit] ボタンをク リ ッ クする と、 新しい ILA ユニッ トが左側のデザイン階層に追加され

ます。 次に ILA ユニッ ト を設定する必要があ り ます。 最初のタブ パネル ([Trigger Parameters]) で
は、 ILA コアの ト リ ガー オプシ ョ ンを設定します。

[Number Of Trigger Ports]

各 ILA コアには、 個別に設定可能な ト リ ガー ポート を最大 16 個まで使用できます。 [Number of
Input Trigger Ports] のプルダウン リ ス トから ト リガー ポート数を選択する と、各ポートのオプシ ョ

ン グループが表示されます。 各ト リガー ポートに関連するオプシ ョ ン グループには TRIGn という

グループ名が付いています (n は 0 ～ 15 までのト リ ガー ポート番号です)。このオプシ ョ ンには、ト

リ ガー幅、 比較ユニッ ト数、 比較ユニッ ト  タイプなどがあ り ます。

[Trigger Width]

各ト リガー ポートは、信号またはビッ トで構成されるバスです。 ト リ ガー ポート を構成するのに使

用するビッ ト数を、ト リガー幅といいます。 各ト リガー ポートの幅は、TRIGn グループ オプシ ョ ン

の [Trigger Width] で設定できます。 ト リ ガー ポート幅には、 1 ～ 256 を設定できます。

[# Match Units]

比較ユニッ トは、 ト リガー ポート と接続しているコンパレータであ り、 ト リガー ポートのイベン ト

を検出します。 1 つまたは複数の比較ユニッ トの結果を結合して総体的な ト リガー条件が形成され、

データ  キャプチャが制御されます。 各ト リガー ポート  (TRIGn) に接続する比較ユニッ ト数は、 [#
Match Units] リ ス トから設定できます。

比較ユニッ ト数を 1 に設定する場合は、 ト リガー イベン トの検出での柔軟性を多少残しながら、 リ

ソースを節約できます。 2 以上に設定する場合は、その結合数が大きいほど、よ り柔軟性の高いト リ

ガー条件を形成できます。 ただし、 各ト リガー ポートの比較ユニッ ト数を増やすと、 ロジッ ク  リ
ソース使用量も増加します。

メモ : 1 つの ILA コアで使用する比較ユニッ トの総計数は、 使用する ト リガー ポート数に関係な

く、 最大 16 個までです。
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[Match Type]

ト リ ガー ポートの比較ユニッ トで実行される比較または比較関数は、比較ユニッ ト  タイプによって

異なり ます。 ILA コアでは、 6 個の比較ユニッ ト  タイプをサポート しています (表 3-1)。

TRIGn の [Match Type] リ ス トから比較ユニッ トのタイプを選択する と、 この ト リガー ポートに接

続されるすべての比較ユニッ トにこの設定が適用されます。比較ユニッ トの機能性が高くなる と、機

能のインプ リ メン トに必要な リ ソースも増加するこ とに注意してください。 このよ うに設定に柔軟

性があるこ とから、 リ ソース使用量を確認しながら ト リガー モジュールの機能をカスタマイズでき

ます。

表 3-1 : ILA のト リガー ポートの比較ユニッ ト  タイプ

タイプ ビッ ト値1 比較関数
スライスごとの

ビッ ト数2 説明

[Basic] 0、 1、 X =、 <>

LUT4 ベース  : 8

Virtex-5、 Spartan-6 : 19

その他の LUT6 
ベース  : 20

遷移検出が重要ではない

データ信号を比較するため

に使用します。 最もビッ ト

を節約できる比較ユニッ ト  
タイプです。

[Basic 
w/edges]

0、 1、 X、

R、 F、
B、 N

=、 <>
LUT4 ベース  : 4

LUT6 ベース  : 8

遷移検出 (例 : Low から  
High、High から  Low など ) 
が重要と なる制御信号の比

較に使用します。

[Extended] 0、 1、 X
=、 <>、 >、
>=、 <、 <=

LUT4 ベース  : 2

LUT6 ベース  : 16

大きさ  (大小) が重要となる

アドレスまたはデータ信号

の比較に使用します。

[Extended 
w/edges]

0、 1、 X、

R、 F、
B、 N

=、 <>、 >、
>=、 <、 <=

LUT4 ベース  : 2

LUT6 ベース  : 8

大きさ  (大小) が重要となる

アドレスまたはデータ信号

の比較に使用します。

[Range] 0、 1、 X

=<>、 >、
>=、 <、 <=、
in range、
out of range

LUT4 ベース  : 1

LUT6 ベース  : 8

値の範囲が重要となるアド

レスまたはデータ信号の比

較に使用します。

[Range 
w/edges]

0、 1、 X、

R、 F、
B、 N

=、 <>、 >、
>=、 <、 <=、
in range、
out of range

LUT4 ベース  : 1

LUT6 ベース  : 4

値の範囲と 遷移検出が重要

と なるアド レスまたはデー

タ信号の比較に使用します。

メモ : 

1. ビッ ト値 : 0 は論理値 0、 1 は論理値 1、X はドン ト ケア、R は 0 から  1 への遷移、 F は 1 から  0 への遷移、
B は任意の遷移、 N は遷移なしを指します。

2. スライスごとのビッ ト数は、 各比較ユニッ ト  タイプの相対的な リ ソース使用数を示すための概算値です。 
正確な概算値と して使用しないでください。 LUT4 ベースのデバイス  ファ ミ リには、 Spartan-3、 Spartan-
3E、 Spartan-3A、 Spartan-3A DSP、 および Virtex-4 FPGA が含まれます。 LUT6 ベースのデバイス  ファ
ミ リには、 Virtex-5、 Virtex-6、 および Spartan-6 FPGA が含まれます。
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[Counter Width]

比較ユニッ ト  カウンタ  は、ト リ ガー ポート の各比較ユニッ ト の出力に接続されているコンフィ ギュ

レーショ ン可能なカウンタです。このカウンタは実行時に設定でき、比較ユニッ ト のイベント 数をカ

ウント します。 ト リ ガー ポート の各比較ユニッ ト に比較カウンタを含めるには、 [Counter Width] で
カウンタ幅を  1 ～ 32 の中から選択します。[Counter Width] を  [Disabled] に設定すると 、比較ユニッ

ト に比較カウンタは含まれません。 デフォルト 設定は、 [Disabled] です。

[Enable Trigger Sequencer]

ト リ ガー条件シーケンサは、 一般的なブール式のト リ ガー条件であ り、 [Enable Trigger Sequencer]
をオンにする と、オプシ ョ ンの ト リ ガー シーケンサと共に使用できます。図 3-5 に、 ト リガー シー

ケンサのブロ ッ ク図を示します。

ト リガー シーケンサは、循環型のステート  マシンと してインプリ メン ト され、 ト リガー条件が満た

されるまで最大 16 ステート  (レベル) まで遷移可能です。 ステート遷移は、 ト リガー シーケンサと

接続されている比較ユニッ トのイベン トによって発生します。どの比較ユニッ ト も、実行時にステー

ト遷移をレベルごとに選択できます。 ト リ ガー シーケンサは、 比較関数イベン トのシーケンスが連

続または不連続のどちらの場合でも、 実行時にステート遷移を設定できます。

[Enable Storage Qualification]

ILA コアは、 ト リガー条件に加えて、 ス ト レージ必要条件の設定も可能です。 ス ト レージ必要条件

は、比較関数イベン トのブール式の組み合わせです。 これらの比較関数イベン トは、コアの ト リガー

ポートに接続されている比較ユニッ ト  コンパレータで検出されます。 ス ト レージ必要条件は、 ト リ

ガー条件とは異なり、 ト リガー ポートの比較ユニッ トのイベン ト を検証し、 各データ  サンプルの

キャプチャまたは格納を決定します。ト リガー条件とス ト レージ必要条件を併用する と、キャプチャ

プロセスを開始するタイ ミ ングやキャプチャするデータを定義できます。 このス ト レージ必要条件

をイネーブルにする場合は、 [Enable Storage Qualification] をオンにします。

[Enable Trigger Output Port]

ILA コアの ト リ ガー条件モジュールのト リ ガー出力ポートは、Core Inserter ではイネーブルにでき

ません。 このポートは、CORE Generator でのみイネーブルにできます (52 ページの「ILA コアの生

成」 を参照)。

X-Ref Target - Figure 3-5

図 3-5 : ト リガー シーケンサのブロック図 (16 ステート、 16 比較ユニッ ト )
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ILA コアのキャプチャ  パラ メータの設定

ILA コアのキャプチャ  パラ メータは、Core Inserter の 2 番目のタブ ([Capture Parameters]) で設定

します。

[Data Depth]

ワード数とは、ILA コアがサンプル バッファに格納できる最大データ  サンプル ワードを指します。

このワード数によ り、 ILA ユニッ トで使用される各ブロ ッ ク  RAM のデータ幅が決定します。

CORE Generator および Core Inserter には、 リ ソース使用概算機能があ り、特定のデータ幅および

ワード数設定で使用されるブロ ッ ク  RAM リ ソース数が示されます。

[Data Width]

データ幅と は、ILA コアに格納されている各データ  サンプル ワード 幅を指します。 データ  ワード と ト

リ ガー ワード がそれぞれ独立している場合、 最大許容データ幅はターゲッ ト  デバイス  タイプおよび

ワード 数によって異なり ます。ただし、どの組み合わせでも最大許容データ幅は 4096 ビッ ト  (Spartan-
3、 Spartan-3E、 Spartan-3A、 Spartan-3A DSP、 および Virtex-4 デバイスでは 256 ビッ ト ) です。

[Data Same As Trigger]

ILA ト リ ガー ポートでは、 次のよ うにデータがキャプチャされます。

• オフの場合 :

♦ データ  ポート と ト リガー ポートが互いに独立しています。

♦ このモードは、 キャプチャするデータ量を制限する場合に役立ちます。

• オンの場合

♦ データ  ポート と ト リガー ポートは同一です。 このモードは、 コアの ト リガーに使用する

データをキャプチャ /修正できるため、 ロジッ ク解析ツールでよ く使用されます。

♦ データ  ポートに各ト リガー ポート を含むよ うに選択できます。 この設定の場合、ILA コア

のポート  マップに DATA 入力ポートは含まれません。

♦ このモードでは、 ILA コアで使用する  CLB および配線リ ソースを節約できますが、 最大

データ  サンプル ワード幅は 4096 ビッ ト  (Spartan-3、 Spartan-3E、 Spartan-3A、 Spartan-
3A DSP、 および Virtex-4 デバイスでは 256 ビッ ト ) に制限されます。

[Trigger Ports Used As Data]

[Data Same As Trigger] をオンにする と、データ  オプシ ョ ン画面に各 TRIGn ポートのチェッ クボッ

クスが表示されます。 データ  ポートに含める場合は、これらの ト リガー ポートのチェッ クボッ クス

をオンにします。 最大データ幅の 4096 ビッ ト  (Spartan-3、 Spartan-3E、 Spartan-3A、 Spartan-3A
DSP、 および Virtex-4 デバイスでは 256 ビッ ト ) がすべての ト リガー ポートに適用されます。
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ATC2 のデータ  キャプチャ設定

ATC2 コアを挿入する場合は、次の ATC2 データ  キャプチャ  オプショ ンを設定する必要があり ます。

[Capture Mode]

ATC2 コアのキャプチャ  モード は 2 種類あり 、CLK 入力信号に対して同期データをキャプチャする

STATE モード と 、 非同期データをキャプチャする  TIMING モード のいずれかを設定できます。

STATE モード の場合、ATC2 コアを通るデータ  パスでパイプライン化されたフリ ッ プフロッ プが使

用され、 これらのフリ ッ プフロッ プのクロッ クは、 CLK 入力ポート 信号により 供給されます。

TIMING モード の場合、 ATC2 コアを通るデータ  パスは出力ピンに至るまで完全に組み合わせロ

ジッ ク で構成されます。 また、TIMING モード の ATCK ピンは追加データ  ピンと して使用されます。

[Max Frequency Range]

[Max Frequency Range] で ATC2 コアの動作周波数範囲を選択します。 ATC2 コアのインプ リ メン

テーシ ョ ンは、選択した最大周波数範囲に最適化されます。選択可能な周波数範囲は、0 ～ 100MHz、
101～ 200MHz、201 ～ 300MHz、および 301 ～ 500MHz です。最大周波数範囲の選択は、[Capture
Mode] で [STATE] を選択した場合のみ、 コアのインプ リ メンテーシ ョ ンに影響します。

[Enable Auto Setup]

オンにする と、 Agilent 社のロジッ ク  アナライザによ り ロジッ ク  アナライザのポッ ド接続に最適な

ATC2 ピンを自動的に設定できます。 また、各 ATC2 ピンに最適な位相および電圧サンプリ ング オ
フセッ ト も自動的に決定されます。 このオプシ ョ ンは、 デフォルトでイネーブルにされています。

[Enable "Always On" Mode]

オンにする と、ATC2 コアの内部ロジッ クおよび出力バッファが常にイネーブルにされます。オンの

場合、 FPGA デバイスのコンフ ィギュレーシ ョ ン時に信号バンク  0 によ り  ATD ピンが駆動されま

す。 このモードでは、最初に ATC2 コアを手動で設定せずに、デバイス コンフ ィギュレーシ ョ ン直

後に発生するイベン ト をキャプチャできます。 このオプシ ョ ンは、 デフォルトでディ スエーブルに

設定されており、 キャプチャ  モードが [TIMING] モードの場合のみ使用できます。

[Pin Edit Mode]

ピンの I/O 規格ピン、駆動電流、およびスルー レート を個別に設定するか、 またはグループと して

設定するかを選択できます。 [Individual] に設定する と、 各ピンのパラ メータを個別に設定できま

す。 [Same as ATCK] に設定する と、すべての ATCK ピンが同じパラ メータにな り ます。 各ピンの配

置は、 [Pin Edit Mode] の設定に関わらず、 それぞれ設定する必要があ り ます。

[ATD Pin Count]

ATC2 コアは、 ATD 出力ピンを 4 ～64 個の範囲内でインプリ メン トできます。

[Endpoint Type]

[Endpoint Type] では、ATCK および ATD 出力ピンでシングル エンド  ([SINGLE-ENDED]) または

差動出力 ([DIFFERENTIAL]) ド ライバのいずれかを選択します。 すべての ATCK および ATD ピ
ンは同一のド ライバ終端タイプを使用する必要があ り ます。

[Signal Bank Count]

ATC2 コアには、実行時に設定可能なデータ信号バンク  マルチプレクサが含まれています。 [Signal
Bank Count] には、このマルチプレクサでインプ リ メン トするデータ入力ポート数/信号バンク数を

入力します。 選択可能な値は、 1、 2、 4、 8、 16、 32、 64 です。
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[TDM Rate]

TDM (時分割多重) レートの設定では、各データ  ピンに伝送されるデータ量を 200% に増加させる

こ とができます。 ATC2 コアは、キャプチャした ト レース  データの格納にオンチップ メモ リ  リ ソー

スを使用しません。 その代わりに、専用のプローブ コネクタを使用して FPGA ピンに接続されてい

る  Agilent 社のロジッ ク  アナライザへデータを送信します。 TDM レート を 1X に設定した場合、

データがデバイス  ピンへ伝送される速度は、 DATA ポートへの入力と同一ですが、 2X に設定する

と、DATA ポートの 2 倍速になり ます。 TDM レートは、キャプチャ  モードが [STATE] の場合のみ

2X に設定できます。

[Data Width]

ATC2 コアの各入力データ  ポート幅は、 キャプチャ  モードおよび TDM レートによって異なり ま

す。 STATE モードの場合、各データ  ポート幅は、(ATD ピン数) * (TDM レート ) です。 TIMING モー

ドの場合、ATCK ピンは追加データ  ピンと して使用されるため、各データ  ポート幅は、 (ATD ピン

数 + 1) * (TDM レート ) になり ます。

[Individual Pin Settings]

[Individual Pin Settings] 表では、 各 ATCK および ATD ピンのロケーシ ョ ン、 I/O 規格、 出力駆動

電流、およびスルー レート を設定します。 出力クロ ッ ク  (ATCK) およびデータ  (ATD) ピンは、あら

かじめ ATC2 コアにインスタンシエート されています。 このため、ATCK および ATD ピンは、ほか

のデザイン階層から最上位に手動で移動する必要はあ り ませんが、 CORE Generator でこれらのピ

ンのロケーシ ョ ンおよび特性を指定する必要があ り ます。 これらのピン属性は、ATC2 コアの *.ncf
ファ イルに追加されます。

[Pin Name]

ATC2 コアの出力ピンには ATCK および ATD の 2 種類があ り ます。 ATCK ピンは、 キャプチャ

モードが [STATE] の場合はクロ ッ ク  ピンと して使用され、 [TIMING] の場合はデータ  ピンと して

使用されます。 ATD ピンは、 常にデータ  ピンと して使用されます。 ピン名は変更できません。

[Pin Loc]

[Pin Loc] では、 ATCK または ATD ピンのロケーシ ョ ンを設定します。

[IO Standard]

[IO Standard] では、 各 ATCK または ATD ピンの I/O 規格を設定します。 設定可能な I/O 規格は、

デバイス  ファ ミ リおよびド ライバの終端タイプによって異なり ます。 I/O 規格名は、 ザイ リ ンクス

ソフ ト ウェア マニュアル [251 ページのリ ファレンス  15 を参照] の 『制約ガイ ド』 の

「IOSTANDARD」 セクシ ョ ンに含まれている名前と一致しています。

[VCCO]

[VCCO] 列には、 ピン ド ラ イバの出力電圧が表示されます。 この値は、選択した I/O 規格によって

異なり ます。

[Drive]

[Drive] には、 ピン ド ライバの最大出力駆動電流が 2 ～ 24mA の範囲内で示されており、 この値は

選択した I/O 規格に依存しています。
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[Slew Rate]

[Slew Rate] では、各 ATCK または ATD ピンのスルー レート を [FAST] または [SLOW] のいずれ

かに設定できます。

[Core Utilization]

ATC2 コア ジェネレータには、 コアのリ ソース使用量を監視する機能があ り、 ATC2 コアが使用す

るルッ クアップ テーブル (LUT) 数およびフ リ ップフロ ップ数が概算されます。この値は、パラ メー

タ設定に依存しています。 ATC2 コアは、 ブロ ッ ク  RAM または追加クロ ッ ク  リ ソース  (BUFG、

DCM コンポーネン ト など) を使用しません。

ILA 信号のネッ ト接続の選択

[Net Connections] タブでは、ILA コアに接続する信号を選択します。 ト リ ガーとデータが異なる場

合は、 ク ロ ッ ク、 ト リガー、 データ  ポート をそれぞれ指定する必要があ り ます。 ト リ ガーとデータ

が同じ場合は、クロ ッ ク と ト リガー /データ  ポート を指定します。 [CLOCK PORT] をダブルク リ ッ

クまたはプラス記号 (+) マークを展開します。 未接続の場合は、 赤色で表示されます。

ATC2 の [Net Connections] タブでは、ATC2 コアに接続する信号を選択できます。 ク ロ ッ クおよび

データ  ポート を指定する必要があ り ます。 [Clock Net] を展開表示します。 未接続の場合は、赤色で

表示されます。

コア接続を変更する場合は、[Modify Connections] をク リ ッ ク します。 [Select Net] ダイアログ  ボッ ク

スが表示されます。 このダイアログ  ボッ クスは、ILA または ATC2 コアに接続するネッ ト を簡単に選

択できるインターフェイスです。 [Select Net] ダイアログ  ボッ クスの左上にある  [Structure/Nets] ペイ

ンで、デザインの階層構造を確認できます。 左下ペインには、選択した階層レベルのすべてのネッ ト

が表示されます。 この表に含まれる情報は次のとおりです。

• [Net Name] : ネッ ト名が EDIF ネッ ト リ ス トでの記載と同様に表示されます。 このネッ ト名

は、合成プロセスでの名前変更または最適化の結果、HDL ソースの対応する信号名と異なる場

合があ り ます。

• [Source Instance] : 現在の階層のネッ トが駆動される下位階層にあるコンポーネン トのインス

タンス名です。 このソース  インスタンスは、 必ずしもネッ トのド ライバ元を示しているのでは

あ り ません。

• [Source Component] : ソース  インスタンスで定義されたコンポーネント  タイプが表示されます。

• [Base Type] : ネッ ト を駆動する最下位のコンポーネン トが表示されます。 この列には、 プ リ ミ

ティブかブラ ッ クボッ クス  コンポーネン トのいずれかが表示されます。

表の上に表示されている ド ロ ップダウンから検索対象を選択し、 [Pattern] ボッ クスに検索するネッ

ト識別子の文字列を入力してから  [Filter] をク リ ッ クする と、検索対象のみを表に表示できます。 ま
た、表中の各コラム (ネッ ト識別子) のヘッダをク リ ッ クする と、ネッ ト識別子の順番が降順/昇順に

切り替わり ます。

メモ : ネッ ト名はアルファベッ ト順またはバス  エレ メン ト順に並べ替えられます。 バス  エレ メン ト

を認識するには、 かっこ  “(“ および各かっこ  “[“ などの区切り文字を使用します。

[Select Net] ダイアログ  ボッ クスの右上には、ILA コアのクロッ ク信号、ト リ ガー信号、およびデータ

信号を示すタブがあり ます。 ATC2 コアの [Select Net] ダイアログ  ボッ クスを開いている場合は、デー

タ信号タブのみが表示されます。ト リ ガーまたはデータ  ポート が複数ある場合は、[Net Selections] ペ
インの下部に複数のタブが表示されます。 階層レベルで選択されたネッ トは、ILA または ATC2 キャ

プチャ  コアの入力と接続できます。 手順は次のとおりです。

1. [Select Net] ダイアログ  ボッ クスの左下の表で、キャプチャ  コアに接続するネッ ト を選択します。
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メモ : キャプチャ  コア入力接続と同数のネッ ト を選択できます。 ネッ ト を連続して選択する場

合は Shift キーを押しながら、左ク リ ッ ク します。 ネッ ト を不連続に選択する場合は、Ctrl キー

を押しながらク リ ッ ク します。 また、ネッ ト  1 つと複数のキャプチャ  コア ポート信号を選択し

て、 このネッ ト を複数のキャプチャ  コア入力信号に接続するこ と も可能です。

2. [Select Net] ダイアログ ボッ クスの右上ペインで、 キャプチャ  コア入力カテゴ リ  ([Clock
Signals]、 [Trigger Signals]、 または [Data Signals] ( ト リ ガーとデータが同一の場合は、

[Trigger/Data Signals]) を選択します。

3. 右側のキャプチャ  コア入力の表で、 選択したネッ ト と接続するチャネルを選択します。

メモ : ネッ ト数と同数のキャプチャ  コア入力を選択できます。 ILA コア入力を連続して選択す

る場合は Shift キーを押しながら、 左ク リ ッ ク します。 ILA コア入力を不連続に選択する場合

は、Ctrl キーを押しながら ク リ ッ ク します。 また、ネッ ト  1 つと複数のキャプチャ  コア ポート

信号を選択して、 このネッ ト を複数のキャプチャ  コア入力信号に接続するこ と も可能です。

4. [Select Net] ダイアログ ボッ クスの右下にある  [Make Connections] をク リ ッ クする と、選択し

たネッ ト とキャプチャ  コアが接続されます。

既存の接続を削除する場合は、 [Remove Connections] をク リ ッ ク します。 また、選択した接続の順

序を変更する場合は、[Move Nets Up] または [Move Nets Down] を使用します。 ネッ ト接続終了後、

[OK] をク リ ッ ク して Core Inserter の画面に戻り ます。

このよ う な手順で、 すべての ト リガーおよびデータ  ネッ ト を接続します。 すべてのネッ トがバスに

接続される と、 ILA または ATC2 バス名の色が赤から黒に変わり ます。

ク ロ ッ ク、 ト リガー、 データ  ネッ ト を指定したら、 [Insert] をク リ ッ ク します。 

Core Inserter をスタンドアロンで起動している場合、 Core Insertion の実行を尋ねるダイアログ

ボッ クスが表示されます。 [はい] をク リ ッ ク した場合、コアが生成されてネッ ト リ ス トに挿入され、

EDIF2NGD ツールで NGO ファ イルが生成されます。 プロセスの詳細は、下部のメ ッセージ ウイン

ド ウに表示されます。 ChipScope でコア挿入が正常に完了した場合は、「Core Generation Complete」
と表示されます。

Project Navigator から  Core Inserter を起動している場合は、Project Navigator へ戻るこ とを確認す

るダイアログ ボッ クスが表示されます。 [はい] をク リ ッ ク した場合、 Core Inserter の設定が保存さ

れて、Project Navigator の画面が表示されます。 実際のコア生成およびコア挿入プロセスは、Project
Navigator で適切な順序で実行されます。

ユニッ トの追加

各デバイスは、 使用できるブロ ッ ク  RAM 数とパラ メータに従い、 最大 15 個までの ILA または

ATC2 ユニッ ト をサポートできます。

• ILA ユニッ ト をプロジェク ト に追加する場合は、 [Edit] → [New ILA Unit] をク リ ッ ク します。

または、ウインド ウ左のツリ ーにある  ICON をク リ ッ ク し、[New ILA Unit] をク リ ッ ク します。

• ATC2 ユニッ ト をプロジェク トに追加する場合は、 [Edit] → [New ATC2 Unit] をク リ ッ ク しま

す。 または、 ウインド ウ左のツ リーにある  ICON をク リ ッ ク し、 [New ATC2 Unit] をク リ ッ ク

します。

追加したユニッ トのパラ メータ設定方法は、 前述した手順と同じです。 

ネッ ト リス トへのコアの挿入

コアを挿入するには、 [Insert] → [Insert Core] をク リ ッ クするか、 またはツールバーの [Insert Core
Into Design] をク リ ッ ク します。
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メモ : ISE Project Navigator で Core Inserter フローを使用している場合は、[Insert] → [Insert Core]
をク リ ッ クせずに [Return to Project Navigator] をク リ ッ ク します。 これによ り、 Project Navigator
の変換プロセスで自動的にコアが挿入されます。 詳細は、 77 ページの 「ISE Project Navigator での

Core Inserter の使用」 を参照してください。

プロジェク トのプリファレンス設定

プリ ファレンスの設定には、3 つのカテゴリ  ([Tools]、[ISE Integration]、[Miscellaneous]) があり ます。

[Tools] では、Core Inserter が EDIF2NGD ツールを起動する と きに使用するコマンド ライン引数を

設定します。 

[ISE Integration] では、 Core Inserter と  ISE Project Navigator の統合方法を設定します。 ISE 統合

オプシ ョ ンがイネーブル (デフォルト ) の場合、Core Inserter で ISE の一時的ネッ ト リ ス ト  ディ レク

ト リ  (_ngo) の作業ディ レク ト リが自動的に検索されます。 有効な _ngo ディ レク ト リが確認される

と、Core Inserter のプロジェク トで ISE プロジェク トの中間 NGD ファ イルが自動的に上書きされ

ます。 中間 NGD ファ イルが上書きされる前にポップアップ ウ ィンド ウを表示するには、 [Prompt
then Backup] を選択します。

[Miscellaneous] では、Core Inserter のその他の動作を設定します。 たとえば、[Select Net] ダイアロ

グ ボッ クスでポート を表示するよ うに設定できます。 これは、コアを最上位ではなく、下位の EDIF
ネッ ト リ ス トに挿入する場合などに有効です。 これらのポートのネッ トは、[Select Net] ダイアログ

ボッ クスで灰色表示されます。 また、 違反している接続を [Select Net] ダイアログ ボッ クスに表示

するオプシ ョ ンもあ り ます。 このオプシ ョ ンをオンにする と、[Select Net] ダイアログ ボッ クスには

違反している接続が赤色表示されます。 

また、 ソース  コンポーネン トのインスタンス名、 ソース  コンポーネン ト  タイプ、ベース  ネッ ト  ド
ライバ タイプを [Select Net] ダイアログ ボッ クスに表示しないよ うに設定できます。 Core Inserter
のプロジェク トのプ リ ファレンス設定をデフォルトに戻す場合は、 [Reset] をク リ ッ ク します。
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Analyzer の概要

ChipScope™ Pro Analyzer は、ChipScope Pro コアと総称される  ICON、 ILA、 IBA、VIO、および

IBERT コアと直接インターフェイスするツールです。

メモ : Analyzer ツールでは、 ATC2 コアを認識できますが、実際に ACT2 コアと通信して制御する

には、 アジレン ト社のロジッ ク  アナライザと  JTAG ケーブルを接続する必要があ り ます。

このツールでは、 デバイスのコンフ ィギュレーシ ョ ン、 ト リガーの選択、 コンソールの設定、 キャ

プチャ結果の表示が即時に実行できます。 また、 データ表示やト リガーをさまざまな方法で操作可

能で、 デザインの機能を容易かつ速やかに検証できます。

Analyzer ツールは、サーバーと ク ラ イアン トの 2 つのアプリ ケーシ ョ ンで構成されています。 サー

バーは、 コマンド ライン アプリ ケーシ ョ ンで、 46 ページの表 1-14 に含まれている  JTAG ダウン

ロード  ケーブルを使用してターゲッ ト システムの JTAG チェーンに接続します。 ク ライアン トは

GUI ベースのアプリケーシ ョ ンで、 JTAG チェーンで接続されたデバイスや、 それらのデバイス内

のコアを操作できます。

ローカル ホス ト  モードでは、同じマシン上でサーバーと ク ラ イアン トが実行でき、リモート  モード

であれば、 別々のマシン上でも動作します。 リモート  モードは、 次の場合に便利です。 

• 別のロケーシ ョ ンにあるシステムのデバッグ

• ほかのチーム メ ンバーとの 1 つのシステム リ ソースの共有

• 別の場所にいる相手への機能や問題のデモ
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サーバーのインターフェイス

JTAG ダウンロード  ケーブルを介して、 直接ローカル マシンに接続したターゲッ ト  システムをデ

バッグする場合には、 サーバーを手動で起動する必要はあ り ません。 リモート  ク ライアン トから

サーバーに通信する場合にのみ、 手動でサーバー アプリ ケーシ ョ ンを起動します。

メモ : Analyzer サーバーのアプリ ケーシ ョ ンが一度に接続できるク ラ イアン トの数は 1 つです。

サーバーは、 次のコマンドで起動できます。

• 32 ビッ ト  Windows マシンの場合 :

<XILINX_ISE_INSTALL>\bin\nt\cse_server.exe <コマンド ライン オプシ ョ ン>

• 64 ビッ ト  Windows マシンの場合 :

<XILINX_ISE_INSTALL>\bin\nt64\cse_server.exe <コマンド ライン オプシ ョ ン>

• 32 ビッ ト  Linux マシンの場合 :

<XILINX_ISE_INSTALL>/bin/lin/cse_server <コマンド ラ イン オプシ ョ ン>

• 64 ビッ ト  Linux マシンの場合 :

<XILINX_ISE_INSTALL>/bin/lin64/cse_server <コマンド ラ イン オプシ ョ ン>

<XILINX_ISE_INSTALL> はザイ リ ンクス  ISE® Design Suite ツールのインス トール ディ レク ト

リ を指します。 サーバー アプリ ケーシ ョ ンには、表 4-1 に示すよ う な複数の <コマンド  ラ イン オプ

シ ョ ン> があ り ます。 サーバーのスク リプ トは、 必要に応じてカスタマイズできます。

ク ライアン ト  アプリ ケーシ ョ ンからサーバー アプリ ケーシ ョ ンに接続する方法の詳細は、102 ペー

ジの 「サーバー ホス トの接続設定」 を参照して ください。

表 4-1 : ChipScope Pro Analyzer サーバーのコマンド  ライン オプシ ョ ン

コマンド  ライン オプシ ョ ン 説明

-port <portnumber> ク ラ イアン トからサーバーへの接続を確立する場合に、TCP/IP の
ポート番号を指定します。 デフォルトのポート番号は 50001 です。

-password <password> 権限のないアクセスからサーバーを保護します。 パスワードは、デ

フォルトでは設定されていません。

-l <logfile>

ログ ファ イルの場所を保存指定します。 デフォルトのディレク ト

リは次のとおりです。

$HOME/.chipscope/cs_analyzer_<portnumber>.log

$HOME は、 ユーザーのホーム ディ レク ト リ 、 <portnumber> は
サーバーで使用する  TCP/IP のポート番号です。
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クライアン トのインターフェイス

Analyzer のクライアン トの GUI は、 次の 4 つで構成されています。

• プロジェク ト  ツ リー : ウ ィンド ウの左側で、 上下に分かれた上側のウ ィンド ウ

• 信号ブラウザ : ウ ィンド ウの左側で、 上下に分かれた下側のウ ィンド ウ

• メ ッセージ ペイン : ウ ィンド ウの下部

• メ イン ウ ィンド ウ  エリア

プロジェク ト  ツ リーと信号ブラウザとに分割されたペイン、およびメ ッセージ ペインは、[View] メ
ニューで選択を解除する と非表示にできます。 また、それぞれの大きさは、ウ ィンド ウの端を任意の

位置までド ラ ッグして調整できます。 各ウ ィンド ウの境界にあるスクロール バーの矢印をク リ ッ ク

する と、 ウ ィ ンド ウのサイズを最小または最大に調整できます。

プロジェク ト  ツリー

プロジェク ト  ツ リーには、 JTAG チェーンと、 そのチェーンに接続されたデバイスのコアがグラ

フ ィ ッ クで表示されます。チェーン内のデバイスすべてがツ リーに表示されますが、有効なターゲッ

ト  デバイス と コアのみに操作を実行できます。プロジェク ト  ツ リーでさ らに操作が実行可能である

場合には、 階層ノードが表示されます。 たとえば、 コアが挿入されているビッ ト  ス ト リームでデバ

イスをコンフ ィギュレーシ ョ ンした場合、 各ユニッ トの階層ノードが表示されます。 ツ リーの各階

層では、文脈依存のメニューを使用できます。 メニューにアクセスするには、ツ リー内のノードで右

ク リ ッ ク します。 デバイスやユニッ ト を別名に変更する、 サブ ウ ィンド ウを開く、 デバイスをコン

フ ィギュレーシ ョ ンする、 またはプロジェク ト を操作するなどの操作は、 すべてこれらのメニュー

から実行できます。

プロジェク ト  ツ リーのデバイスやコア ユニッ トのノードを別名で保存するには、 ノード上で右ク

リ ッ ク して、 [Rename] をク リ ッ ク します。 編集を終了するには、 Enter キーか上下の矢印キー、 ま

たはツ リー内の他のノードをク リ ッ ク します。

信号ブラウザ

信号ブラウザには、プロジェク ト  ツ リーで選択した ILA、IBA、または VIO コアの信号がすべて表

示されます。 信号は別名に変更したり、バスにグループ化したり、信号ブラウザの文脈依存メニュー

を使用してさまざまななデータ  ビューに追加できます。

信号名、 バス名、 ト リガー ポート名の変更

信号ブラウザで信号名、 バス名、 ト リガー ポート名を変更するには、 それぞれをダブルク リ ッ クす

るか、 または右ク リ ッ ク して [Rename] をク リ ッ ク します。 編集を終了するには、Enter キーか上下

の矢印キー、 またはツ リー内の他のノードをク リ ッ ク します。

ビューでの信号の追加/削除

[Waveform] または [Listing] ビューからすべての信号を削除するには、 信号ブラウザのデータ信号

またはバスを右ク リ ッ ク し、[Clear All] → [Waveform] または [Clear All] → [Listing] をク リ ッ ク し

ます。VIO コアでコンソールの信号をすべて削除する場合は、VIO コンソールの信号またはバス上

で右ク リ ッ ク して [Clear All] → [Console] をク リ ッ ク します。また、[Add All to View] メニューを

ク リ ッ ク して、 すべての信号とバスを [Waveform] または [Listing] ビューに追加できます。 選択し

た信号やバスは、 [Add to View] メニューで追加します。

信号やバスを連続して複数選択する場合は、 最初の信号をク リ ッ ク してから  Shift キーを押したま

まグループ最後の信号をク リ ッ ク します。 信号やバスを非連続に複数選択するには、 Ctrl キーを押
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したまま信号やバスを順にク リ ッ ク します。 この方法を使用する と、 バス内の信号の順序は選択し

た順になり ます。

バスに信号を組み合わせる、 または追加するには

ILA および IBA コアで組み合わせてバスに含めるこ とが可能な信号は、データ信号のみです。 VIO
コアの場合、 特定のタイプの信号をグループ化してバスを構成できます。 信号を組み合わせてバス

に含めるには、前述の方法と同様に、Shift キーまたは Ctrl キーを使用して信号を選択します。 Shift
キーを使用する場合、 ツ リー内の一番上の信号が生成したバスの LSB (最下位ビッ ト ) になり ます。

Ctrl キーを使用する場合、 バス内の信号順序はク リ ッ ク した順序になり、 最初にク リ ッ ク した信号

が LSB になり ます。

選択後は、信号上で右ク リ ッ クし、 [Add to Bus] → [New Bus] をク リ ッ ク します。 ILA コアや IBA
コアの場合、[Data Signals and Buses] の一番上に新しいバスが生成され、VIO コアの場合は特定の

サブツ リーの一番上に追加されます。 既存のバスに 1 つまたは複数の信号を追加するには、 まず信

号を右ク リ ッ ク し、 [Move to Bus] のサブメニューでバス名を選択します。 信号は常にバスの MSB
(最上位ビッ ト ) 側に追加されます。 このコマンド  を実行する と、信号はバスに含められた後に、信

号リ ス トから削除されます。

バス内の配列順序の並べ替え

LSB を MSB にするなど、 バス内のビッ ト順序を並べ替えるには、 バス上で右ク リ ッ ク して

[Reverse Bus Order] をク リ ッ ク します。 信号ブラウザおよびバスを含むすべてのデータ  ビューに

は変更がすぐに反映され、 バスの値が再計算されます。

バスの基数

各バスは、 次の基数のいずれかでデータ  ビューに表示されます。

• ASCII

• 2 進数

• 16 進数

• 8 進数

• 符号付き  10 進数

• トークン

• 符号なし  10 進数

ASCII は、 バスのビッ ト数がちょ う ど  8 で割り切れる場合に使用できます。 基数を変更する と、 各

データ  ビューに含まれるバスの基数も変わり ます。

符号付き 10 進数と符号なし  10 進数

バスの値は、次の等式を使用して符号付き  10 進数と符号なし  10 進数のいずれかに置き換えるこ と

ができます。

バス値 = (<scale factor> * Data) + <offset>)

精度 = <precision>

• 「* Data」 の前のテキス ト  ボッ クスには、データ値を乗算するのに使用する定数のスケール係数

を入力します。 デフォルトのスケール係数は 1.0 です。

• 2 番目のテキス ト  ボッ クスには、 スケール係数処理されたバスの値に追加されるオフセッ ト値

を入力します。 デフォルトのオフセッ ト値は 0 です。
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• 3 番目のテキス ト  ボッ クスには、 精度を小数点以下の桁数で入力します。 デフォルトの精度は

0 です。

たとえば、 小数点以下 10 桁の精度で -0.5 ～ 1.5 の範囲のサイン波を表した 16 ビッ ト  バスを表示

する場合、 次のよ うにパラ メータを設定します。

• スケール係数 = 3.0517578125E-5 (1/215 と同一)

• オフセッ ト  = 0.5

• 精度 = 10

トークン

トークンは、別の ASCII ファ イルで定義された文字列のラベルで、特定のバス値に割り当てるこ と

ができます。 このラベルは、 アドレスのデコードやステート  マシンなどのアプリケーシ ョ ンで便利

です。 トークン ファ イル (拡張子は .tok) は単純なフォーマッ ト なので、どのテキス ト  エディ タでも

作成や編集ができます。 トークンは NAME=VALUE という形式になっており、NAME はトークン

名、 VALUE はトークン値 (16 進数、 2 進数、 または 10 進数) を指します。 値はデフォルトで 16 進
数になっています。 値の基数を指定する場合は、 値に \b (2 進数)、 \u (符号なし  10 進数)、 \h (16 進
数) を付けてください。

デフォルト  トークンは、 VALUE の一致が見つからないと きにデフォルトの トークン値を設定する

のに使用できます。 @DEFAULT_TOKEN キーを使用する と、デフォルトの トークン名を設定でき

ます。 @DEFAULT_TOKEN 行が使用されている場合、トークン名 HEX が使用されます。 トークン

ファ イルのコ メン トは # で始ま り ます。 トークン ファ イルの最初のコ メン ト以外の行は、

@FILE_VERSION=1.0.0 である必要があ り ます。 

メモ : = は予約文字で、 TOKEN 文字列に使用できません。

次に、 トークン ファ イルの例を示します。

#File version
@FILE_VERSION=1.0.0

# Default token value
@DEFAULT_TOKEN=ERROR

# Explicit token values
ZERO=00
ONE=01
TWO=02
THREE=11\b
FOUR=4\h
FIVE=101\b
SIX=6
SEVEN=111\b
EIGHT=1000\b
NINE=9\h
TEN=A\h

トークンは、バスを右ク リ ッ ク して [Bus Radix] → [Token] をク リ ッ クする と選択できます。 トーク

ン ファ イルを選択するダイアログ ボッ クスが表示されます。 バスが 8 ビッ ト幅で指定した トーク

ン値が 4 ビッ ト幅しかないと きなど、 バス幅がトークン値よ り大きい場合、 バスと同じ幅にするよ

う トークンの最上位ビッ ト側に 0 が挿入されます。
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バスの削除

バスを削除するには、 バス上で右ク リ ッ ク し、 [Delete Bus] をク リ ッ ク します。 選択されたバスは、

関連するすべてのデータ  ビューからすぐに削除されます。

[Type] と  [Activity Persistence] (VIO のみ)

VIO 信号には 2 つの付加プロパティ、 [Type] と  [Activity Persistence] があ り ます。 これらのプロパ

ティの詳細は、 117 ページの 「VIO コアのバスおよび信号のアクティビティ持続時間」 を参照して

ください。

[Message] ペイン

[Messages] ペインには、ステータス  メ ッセージのリ ス トが表示されます。 エラー メ ッセージは赤で

表示されます。 ウ ィンド ウの境界をド ラ ッグして任意の位置まで移動させる と、 [Message] ペイン

のサイズを変更できます。 プロジェク ト  ツ リー /信号ブラウザのペインの境界も変更できます。

メ イン ウィンドウ

メ イン ウ ィンド ウでは、 同時に複数のサブ ウ ィンド ウ  ([Trigger]、 [Waveform]、 [Listing]、 [Plot])
が表示されます。 各ウ ィンド ウ  サイズは、 必要に応じて変更できます。

Analyzer の機能

プロジェク トでの作業

プロジェク トには、 信号名、 信号の順序、 バス構成、 ト リガー条件など、 Analyzer プログラムの内

容に関する重要な情報が含まれています。 これらの情報は、Analyzer の使用中に自由に読み出した

り保存できます。

Analyzer ツールを最初に起動したと き、 「new project」 という名前の新規プロジェク トが自動で生

成されます。 既存のプロジェク ト を開くには、 [File] → [Open Project] をク リ ッ クするか、 [File] メ
ニューから最近使用したプロジェク ト をク リ ッ ク します。 Analyzer のタイ トル バーとプロジェク

ト  ツ リーには、 プロジェク ト名が表示されます。 新規プロジェク ト を保存せずに終了しよ う とする

と、 プロジェク ト を保存するかど うかを尋ねるダイアログ ボッ クスが表示されます。

新規プロジェク トの作成と保存

新規プロジェク ト を作成するには、[File] → [New Project] をク リ ッ ク します。 「 new project」 と いう

新規プロジェク ト が作成され、プロジェク ト がアク ティ ブになり ます。 プロジェク ト を別名で保存す

るには、 [File] → [Save Project] をク リ ッ ク します。 プロジェク ト  ファ イルの拡張子は .cpj です。

プロジェク トの保存

作業中のプロジェク ト名を変更したり、 またはファイルを別名で保存するには、 [File] → [Save
Project As] をク リ ッ ク し、 新しいファイル名を入力後、 [保存] をク リ ッ ク します。
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波形を印刷する

ChipScope Pro の特長の 1 つに、 [File] → [Print] を実行する と計測したデータの波形が印刷できる

という点があ り ます。 [File] → [Print] をク リ ッ ク して、 Print Wizard を起動します。

Print Wizard は、 次の 3 つの連続ウ ィンド ウで構成されています。

1. (1 of 3) は、 印刷オプシ ョ ンと設定のウ ィンド ウです。

2. (2 of 3) は、 印刷波形のプレビューのナビゲータ  ウ ィンド ウです。

3. (3 of 3) は、 印刷を確認するウ ィンド ウです。

Print Wizard (1 of 3) ウィンドウ

最初の [Print Wizard] ウ ィンド ウでは、さまざまな波形印刷のオプシ ョ ン設定ができます。 これらの

波形印刷オプシ ョ ンの詳細を説明します。

[Horizontal Scaling]

ページのカラムに印刷されるの波形データの量は、 次の 2 つの方法のいずれかで調節できます。

• [Fit To] : 波形を指定のページ内に収めます。

• [Fixed] : 指定した数の波形サンプルを各ページに収めます。

デフォルトでは、 波形全体が 1 ページに印刷されます。

[Signal/Bus Selection]

印刷する波形の信号やバスは、 次の 3 つの方法のいずれかで調節できます。

• [Current View] : 作業中の [Waveform] ウ ィンド ウで表示されているすべての信号とバスの波

形データを印刷します。

• [All] : コア ユニッ ト全体で使用可能なすべての信号とバスの波形データを印刷します。

• [Selected] : [Waveform] ウ ィンド ウで選択した信号とバスのみの波形データを印刷します。

デフォルトでは、 [Current View] で印刷されます。

[Time/Sample Range]

印刷時の単位やサンプル数は、 次の 4 つの方法のいずれかを用いて設定できます。

• [Current View] : 現在表示されている波形と同じ範囲やサンプル設定で波形を印刷します。

• [Full Range] : サンプル バッファ全体に含まれるすべてのサンプルを範囲とする波形データを

印刷します。

• [Between X/O Cursors] : X カーソルから  O カーソルまでをサンプリ ング範囲と した波形デー

タを印刷します。

• [Custom View] : 次で定義されるサンプル範囲を使用して波形データを印刷します。

♦ 開始ウ ィンド ウ番号

♦ 開始ウ ィンド ウ内のサンプル数

♦ 終了ウ ィンド ウ番号

♦ 終了ウ ィンド ウ内のサンプル数

デフォルトでは、 [Current View] で印刷されます。
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[Print Signal Names]

信号名を、各ページに印刷するか、または最初のページにのみ印刷するかを選択します。 [Show X/O
Cursor values] がオンのと きは、 こ こでの設定が X/O カーソル値の表示にも反映されます。

[X/O Cursor Values]

X/O カーソル値を印刷に含めるかど うかも選択できます。 X/O カーソル値を表示して印刷する場

合、 [Print Signal Names] の設定によって、全ページに表示されるか、最初のページだけに表示され

るかが決ま り ます。 X/O カーソル値を最初のページだけに印刷する と、複数の印刷ページを  1 つに

組み合わせ、 大きな多次元波形にする場合に便利です。

[Footer]

[Show Footer] をオンにする と、 各ページの下部にフッタを含めるこ とができます。 フッ タには、

Analyzer のプロジェク ト名、 波形設定、 印刷設定、 およびページ番号など、 役立つ情報が表示され

ます。

ナビゲーシ ョ ン ボタン

[Print Wizard (1 of 3)] ウ ィンド ウの下部のボタンで、 次の操作を実行できます。

• [Page Setup] : [ページ設定] ウ ィンド ウを開きます。

• [Next] : [Print Wizard (2 of 3)] ウ ィンド ウを開きます。

• [Cancel] : 印刷をキャンセルして [Print Wizard] ウ ィンド ウを閉じます。

[Next] をク リ ッ クする と、 [Print Wizard (2 of 3)] ウ ィンド ウが表示されます。

Print Wizard (2 of 3) ウィンドウ

この [Print Wizard (2 of 3)] ウ ィンド ウでは、 印刷する波形のプレビューが表示されます。

ページ プレビュー ボタン

次に示すよ うに、 ページ上部のボタンで印刷する波形をプレビューします。

• [<<] および [>>] で、 プレビュー ページの先頭ページ、 最終ページにそれぞれ移動します。

• [<] および [>] で、 前のページ、 次のページにそれぞれ移動します。

• 中央のテキス ト  ボッ クスでは、 指定したページのプレビューに移動します。

ナビゲーシ ョ ン ボタン

[Print Wizard (2 of 3)] ウ ィンド ウの下部のボタンで、 次の操作を実行できます。

• [Back] : [Print Wizard (1 of 3)] ウ ィンド ウに戻り ます。

• [Send to PDF] : [Print Wizard (3 of 3)] ウ ィンド ウを開き、 PDF ファ イルと して印刷します。

• [Send to Printer] : [Print Wizard (3 of 3) ウ ィンド ウ] を開き、 プ リ ンタに送信します。

• [Close] :  印刷をキャンセルして [Print Wizard] ウ ィンド ウを閉じます。

バスの展開表示と非表示

印刷プレビューで、バスを展開表示したり非表示したり して、波形の操作ができます。 たとえば、バ

スを展開表示する と、 そのページの信号やバスが次のページに移動して、 ページ上部の印刷プレ

ビューの合計ページ数が変わり ます。
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Print Wizard (3 of 3) ウィンドウ

[Print Wizard (2 of 3)] ウ ィンド ウで、[Send to PDF] をク リ ッ クする と、[Print Wizard (3 of 3): PDF]
の確認ウ ィンド ウが表示されます。 [Yes] をク リ ッ クする と、 波形が PDF ファ イルに印刷され、

[No] をク リ ッ クする と、[Print Wizard (2 of 3)] ウ ィンド ウに戻り ます。 [Change File] をク リ ッ クす

る と、 ファ イルのブラウザ ウ ィンド ウが起動し、 PDF ファ イルを新規作成したり選択できます。

[Print Wizard (2 of 3)] ウ ィンド ウで、 [Send to Printer] をク リ ッ クする と、 [Print Wizard (3 of 3):
Printer] の確認ウ ィンド ウに移動します。 [はい] をク リ ッ クする と波形データがプリ ンタに送信さ

れ、 [いいえ] をク リ ッ クする と、 [Print Wizard (2 of 3)] ウ ィンド ウに戻り ます。

ページ設定

[ページ設定] ウ ィンド ウは、 [Print Wizard (1 of 3)] ウ ィンド ウまたは [File] → [Page Setup] メ
ニューから開く こ とができます。

メモ : Analyzer では、デフォルトのシステム プリ ンタでのみ印刷できます。 印刷設定ウ ィンド ウで

プ リ ンタを変更しても反映されません。 プリ ンタを変更するには、Analyzer プログラムを終了し、デ

フォルトのシステム プリ ンタを変更してから  Analyzer を再起動します。

信号名のインポート

プロジェク トの開始時は、 各コアの信号名はすべて一般名称です。 信号名は 95 ページの 「信号名、

バス名、 ト リガー ポート名の変更」 に示すよ うにそれぞれ変更するか、 または 1 つまたは複数のコ

アに含まれる名称すべてが含まれているファ イルをインポー ト します。 このよ う なファ イルは、

CORE Generator、 Core Inserter、 EDK Platform Studio、 System Generator for DSP、 PlanAhead、
および FPGA Editor ツールで作成できます。 ファ イルから信号名をインポートするには、 [File] →
[Import] をク リ ッ ク し、 [Signal Import] ダイアログ ボッ クスを表示します。

[Select New File] をク リ ッ ク して、信号名のインポート  ファ イルを選択します。 [Open Signal File]
ダイアログ ボッ クスでインポート  ファ イルを選択します。 ファ イルを選択する と、ファ イルに含ま

れるコアのタイプに従って [Unit/Device] の値が更新されます。 インポート  ファ イルに複数のコア

の信号名が含まれる場合、ChipScope Pro キャプチャ  コアのみを含むデバイスすべてのデバイス番

号が表示されます。

インポート  ファ イルに含まれる信号名が、1 つのコアのものである場合、信号名のインポート  ファ

イルで指定したタイプに合致する個別のコア名を示したウ ィンド ウが表示されます。 

信号名をインポートするには、[OK] をク リ ッ ク します。 ファ イルのパラ メータがターゲッ ト  コアの

パラ メータ と異なる場合は、警告メ ッセージが表示されます。 続行する場合は、信号名はコアに規定

通りに適用されます。
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データのエクスポート

ILA または IBA コアを使用してキャプチャしたデータをファ イルにエクスポート し、後から表示や

編集ができます。 データをエクスポートするには、[File] → [Export] をク リ ッ ク し、 [Export Signals]
ダイアログ ボッ クスを表示します。

エキスポートには、3 つのフォーマッ ト、 [VCD] (value change dump) フォーマッ ト、タブ区切りの

[ASCII] フォーマッ ト、 アジレン ト  テク ノ ロジー社の [FBDF] (Fast Binary Data Format) があ り ま

す。 フォーマッ ト を選択するには、 ラジオ ボタンをオンにします。 [Core] ボッ クスからエクスポー

トするコアを選択します。

別の信号やバスのセッ ト もエクスポートできます。 [Signals to Export] の選択肢は次の通りです。

• [All Signals/Buses] : 特定コアのすべての信号およびバス

• [Waveform Signals/Buses] : [Waveform] ビューに表示されているすべての信号とバス

• [Listing Signals/Buses] : [Listing] ビューに表示されているすべての信号とバス

• [Bus Plot Buses] : コアの [Bus Plot] ビューに含まれるすべての信号とバス

信号をエクスポートするには、 [Export] をク リ ッ ク し、 表示されるダイアログ ボッ クスでターゲッ

ト  ディ レク ト リ とファ イル名を指定します。

Analyzer を閉じる、 または終了する

[File] → [Exit] をク リ ッ ク して Analyzer を終了します。 終了時には、作業中のプロジェク トが自動

的に保存されます。

オプシ ョ ンの確認

Analyzer ウ ィンド ウ左側ペインおよび下部の [Message] ペインは、 表示/非表示を切り替えるこ と

ができます。 デフォルトでは、 いずれのウ ィンド ウも初回起動時に表示されます。 プロジェク ト  ツ
リー /信号ブラウザ ペインを非表示にするには、 [View] → [Project Tree] をク リ ッ ク します。

[Message] ペインを非表示にするには、 [View] → [Messages] をク リ ッ ク します。

サーバー ホストの接続設定

Analyzer ク ラ イアン トの GUI アプリケーシ ョ ンを実行するには、 ローカルまたはリモート  システ

ムで動作中の Analyzer サーバー アプリ ケーシ ョ ンに接続する必要があ り ます。 [JTAG Chain] →
[Server Host Setting] をク リ ッ ク し、 サーバーを設定するダイアログ ボッ クスを表示します。

ローカル モードで作業する場合、[Server] は常に 「localhost:<port>」 に設定する必要があ り ま

す。デフォルトの <port> 番号は 50001 です。ローカル モードでは、[Password] の入力は不要です。

メモ : ローカル モードでは、 サーバーは自動的に起動します。

リモート  モードで作業する場合、 [Server] に IP アドレス  (または適切なシステム名) およびポート

番号を 「192.168.0.1:50001」 (または 「servername:50001」 ) の形式で設定する必要があ り ます。

[Password] には、リモート  システムでサーバー起動時に使用したパスワードを入力する必要があ り

ます。 リモート  モードでは、JTAG ダウンロード  ケーブルで接続を開始するまで実際の接続が確立

されません。

メモ : 94 ページの「サーバーのインターフェイス」で説明したとおり、リモート  モードではサーバー

を手動で起動する必要があ り ます。
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パラレル ケーブルで接続する

パラレル ケーブルで接続するには、ケーブルが PC のパラレル ポートに接続されているかど うかを

確認します。 [JTAG Chain] → [Xilinx Parallel Cable] をク リ ッ ク し、 パラレル ケーブルを選択する

ダイアログ ボッ クスを表示します。 [Xilinx Parallel III] または [Xilinx Parallel IV] 選択するか、

[Auto Detect Cable Type] を選択してケーブルを自動検出します。 

[Xilinx Parallel IV] または [Auto Detect Cable Type] オプシ ョ ンを選択した場合、 ケーブルの速度

は 10MHz、 5MHz (デフォルト )、 2.5MHz、 1.25MHz、 625kHz から選択できます。 その場合は、被

試験ボードで最も適切な速度を選択します。 次に [Port] でプリ ンタ  ポート名を選択し  (通常はデ

フォルトの LPT1 が適切) 、 [了解] をク リ ッ ク します。 その後、 Analyzer で バウンダ リ  スキャン

チェーンの構成が確認されます (105 ページの「バウンダ リ  スキャン (JTAG) チェーンの設定」 を参

照)。

「Failed to Open Communication Port」 というエラー メ ッセージが表示された場合は、 ケーブルが

LPT ポートに接続されているかど うかを確認します。 パラレル ケーブル ド ライバをインス トール

していない場合は、 ChipScope Pro ソフ ト ウェアのインス トール プログラム手順に従って、 デバイ

ス  ド ラ イバ ソフ ト ウェアをインス トールしてください。

プラッ ト フォーム ケーブル USB で接続する

プラ ッ ト フォーム ケーブル USB で接続するには、 ケーブルが PC のパラレル ポートに接続されて

いるかど うかを確認します。 [JTAG Chain] → [Xilinx Platform USB Cable] をク リ ッ ク し、プラ ッ ト

フォーム ケーブル USB を設定するダイアログ ボッ クスを表示します。

プラッ ト フォーム ケーブル USB のクロッ ク速度

ケーブルの速度は、 12MHz、6MHz、3MHz (デフォルト )、1.5MHz、 または 750KHz から選択でき

ます。 その場合は、 被試験ボードで最も適切な速度を選択します。 

プラッ ト フォーム ケーブル USB ポート番号

[Port] には、選択可能なUSB ポートが USB2<n> とい う形式で表示されます。<n> は 1 ～ 127 の整

数値で、 デフォルトのポートは USB21 に設定されています。 USB ポート番号は、 プラ ッ ト フォー

ム ケーブル USB ダウンロード  ケーブルがシステムの USB ポートに接続される順番に基づいてい

ます。 たとえば、 システムに接続されている最初プラ ッ ト フォーム ケーブル USB ダウンロード

ケーブルが USB21 に割り当てられる場合、 次のケーブルは USB22 に割り当てられます。

メモ : この列挙は、システムの電源が投入される と きは予約されていない場合があ り ます。  また、特

定の順番にケーブルをシステムに接続しない限り、 プラ ッ ト フォーム ケーブル USB を識別できま

せん。
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プラッ ト フォーム ケーブル USB 接続の複数使用

Analyzer で複数のケーブルを使用するには、 次の 3 つが必要です。

1. 1 つのマシンに接続されている複数のザイ リ ンクス  JTAG ケーブル

2. 1 つのマシンで実行されている  cs_server アプリケーシ ョ ンの複数インスタンス  (それぞれが異

なるポート と通信)

3. 同じマシンまたはリモート  サーバー機能を使用して別のマシンで実行されている  Analyzer の
複数インスタンス

1 つのマシンに複数のザイリンクス JTAG ケーブルを接続する

同じマシンに接続されている複数の JTAG ケーブルと通信するには、複数のプラ ッ ト フォーム ケー

ブル USB、 パラレル ケーブル III、 またはパラレル ケーブル IV をマシンに接続できるこ とを確認

する必要があ り ます。 プラ ッ ト フォーム ケーブル USB では、 必要なケーブル数に応じて 1 つまた

は複数の USB ハブを使用する必要がある場合があ り ます。 パラレル ケーブル III またはパラレル

ケーブル IV では、 1 つまたは複数のパラレル ポート拡張カードが必要になる場合があ り ます。

メモ : 現時点では、 特定の物理的プラッ ト フォーム  ケーブル USB と 列挙が関連付けられていませ

ん。 このため、マシンを再起動すると 、列挙と 物理ケーブルの関連付けが異なる結果になる場合があ

り ます。 すべてのケーブルの接続を解除し、任意の列挙順に接続し直すと 、この問題を回避できます。

cs_server の複数インスタンスを使用できるように Analyzer を設定する

複数のケーブルを使用できるよ うに設定するには、まず同じマシン上で cs_server.exe (Windows ア
プリケーシ ョ ン) または cs_server.sh (Linux アプリ ケーシ ョ ン) の複数インスタンスを別々のポー

ト を使用して起動します。 次は、 Linux で異なる  2 つのポート を使用して 2 つのサーバーを起動す

る例です。

# cs_server.sh -port 50001
# cs_server.sh -port 50002

Analyzer の複数インスタンスを開始/設定する

複数の Analyzer ク ラ イエン ト  インスタンスを起動、設定します (表 4-2)。 Analyzer のインスタンス

はそれぞれ異なる  cs_server と  USB ポートに接続します。

表 4-2 : 複数のクライエン ト  インスタンスの設定

Analyzer 

インスタンス番号
サーバー ホスト設定

プラッ ト フォーム ケーブル USB 
ポート番号

1 <IP Address>:50001 USB21

2 <IP Address>:50002 USB22
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JTAG チェーン プラグインに接続する

Analyzer では、[JTAG Chain] → [Open Plugin] コマンドを使用して JTAG チェーンのプラグイン接

続を実行できます。 各 JTAG チェーンのプラグインには特定のパラ メータがあ り、 これらの値は

[Open Plug-in] ダイアログ ボッ クスの [Plug-in Parameters] に表示されます。 プラグイン パラ メー

タを選択した後に [了解] をク リ ッ ク して、 JTAG プラグインへの接続を開きます。

自動コアのステータスのポーリング

コアを搭載する と、インターフェイス  ケーブルによ り定期的にコアでのキャプチャのステータスが

確認されます。 Analyzer とほかのプログラムで同時にケーブルを使用する場合は、 ポーリ ングをオ

フにした方がいいこ とがよ くあ り ます。 オフにするには、 [JTAG Chain] → [Auto Core Status Poll]
でチェッ ク  ボッ クスをオフにします。オフの場合、 [Run] または [Trigger Immediate] を実行したと

きに、 Analyzer でコアのステータスは自動的に確認されません。 

これによってケーブルとの通信が完全に不可能になるのではなく、 コアを搭載した場合に限り、 定

期的なポーリ ングが実行できなくなり ます。 ポーリ ングのディ スエーブル後に1 つまたは複数のコ

アを ト リガする と、 [Auto Core Status Poll] オプシ ョ ンをオンにしない限り、 キャプチャ  バッファ

がデバイスからダウンロードができず、 データ  ビューに表示されません。

ターゲッ ト  デバイスのコンフ ィギュレーシ ョ ン

Analyzer ソフ ト ウェアは、複数のターゲッ ト  デバイスに使用できます。 まず、バウンダ リ  スキャン

チェーンですべてのデバイスを設定します。

バウンダリ  スキャン (JTAG) チェーンの設定

Analyzer でダウンロード  ケーブルとの通信を確立する と、バウンダ リ  スキャン (JTAG) チェーンの

構成が自動的に確認されます。すべてのザイ リ ンクス  FPGA、CPLD、PROM、および System ACE™
デバイスが自動的に検出されます。 有効なターゲッ ト  デバイスに対し  IDCODE 全体を検証できま

す。 チェーンの構成を確認するには、[JTAG Chain] → [JTAG Chain Setup] をク リ ッ ク します。 ダイ

アログ ボッ クスに検出されたすべてのデバイスが順に表示されます。

自動的に検出されないデバイスは、コアと確実に通信できるよ う  IR (命令レジスタ) の長さを指定す

る必要があ り ます。 この情報は、デバイスの BSDL ファ イルに記述されています。 USERCODE は、

[Read USERCODEs] をク リ ッ ク してターゲッ ト  FPGA デバイスから読み出すこ とができます。

Analyzer ツールでは、 デフォルトで JTAG チェーンに接続されたデバイスのテス ト  アクセス ポー

ト  (TAP) のステータスが自動的に記録されます。 Analyzer を System ACE CompactFlash (CF) コ
ン ト ローラやプロセッサのデバッグ ツールなど、 ほかの JTAG コン ト ローラ と併用する場合には、

ターゲッ ト  デバイスの実際の TAP ステートは、 Analyzer の記録コピーとは異なり ます。 この場合

JTAG ト ランザクシ ョ ン シーケンスの実行前に、 Analyzer で TAP コン ト ローラを [Run-Test] や
[Idle] などの既知ステートにしておく必要があ り ます。 [JTAG Chain Device Order] ダイアログ

ボッ クスで [Advanced] をク リ ッ クする と、ダイアログ ボッ クスに JTAG ト ランザクシ ョ ンの開始

と終了を制御するパラ メータが表示されます。 JTAG  チェーンをほかの JTAG コン ト ローラ と併用

する場合は、 [Start transactions in Test-Logic/Reset, End in Run-Test/Idle] を選択します。
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デバイスのコンフ ィギュレーシ ョ ン

Analyzer では、 JTAG モードに限り、プラ ッ ト フォーム ケーブル USB、パラレル ケーブル III、お

よびパラレル ケーブル IV ダウンロード  ケーブルを使用してターゲッ ト  FPGA デバイスのコン

フ ィギュレーシ ョ ンを実行できます。

JTAG ポート経由でダウンロード  ケーブルを使用してターゲッ ト  デバイスをプログラムする場合

には、 [Device] メニューからコンフ ィギュレーシ ョ ンするデバイス名を選択し、 [Configure] をク

リ ッ ク します。 有効なターゲッ ト  デバイスのみコンフ ィギュレーシ ョ ン可能とな り、[Configure] オ
プシ ョ ンが使用できます。 プロジェク ト  ツ リーのデバイス上で右ク リ ッ ク しても、 [Device] と同じ

メニューを表示できます。 

[Configure] をク リ ッ クする と、JTAG コンフ ィギュレーシ ョ ンを設定するダイアログ ボッ クスが表

示されます。 このダイアログ ボッ クスには、JTAG デバイス  コンフ ィギュレーシ ョ ン ファ イルを選

択するセクシ ョ ンと、 デザイン レベルの CDC ファ イルを選択するセクシ ョ ンがあ り ます。 デバイ

スにダウンロードするコンフ ィギュレーシ ョ ン ファ イルを選択するには、[JTAG Configuration] セ
クシ ョ ンで [Select New File] をク リ ッ ク します。 [Open Configuration File] ダイアログ ボッ クスが

開くので、 ブラウザからターゲッ ト  デバイスのコンフ ィギュレーシ ョ ンに使用するデバイス  コン

フ ィギュレーシ ョ ン ファ イルを選択します。 適切な BIT ファ イルを選択したら、[開く ] をク リ ッ ク

して元のダイアログ ボッ クスに戻り ます。 また、[Clean previous project setting] をオンにする と、デ

バイスをコンフ ィギュレーシ ョ ンする前に既存のプロジェク ト設定を消去するこ と も可能です。

メモ : オンにした場合、プロジェク トに含まれるすべての信号名、バス、およびその他の設定が削除

されます。 この操作は、 元に戻すこ とができません。

メモ : 適切な BitGen 設定を使用して生成された BIT ファ イルを選択するこ とが重要です。 特に、

BitGen で -g StartupClk:JtagClk オプシ ョ ンが使用されるこ とを確認して ください。

Core Inserter または PlanAhead™ ツールで生成されたデザイン レベルの CDC ファ イルを選択す

るには、 [Import Design-level CDC File] をオンにしてから  [Select New File] をク リ ッ ク します。

[Open CDC File] ダイアログ ボッ クスが開くので、 ブラウザからターゲッ ト  デバイスで使用する

CDC ファ イルを選択します。 適切な CDC ファ イルを選択したら、 [開く ] をク リ ッ ク して元のダイ

アログ ボッ クスに戻り ます。 [Auto-create buses] をオンにする と、CDC ファ イルに含まれる信号名

から自動的にバスが作成されます。 Analyzer では、バス  エレ メン トの識別にアルゴ リズムが使用さ

れます。 エレ メン ト番号は信号名の最後に表示され、 ( )、 [ ]、 または { } で囲まれるか、 またはア

ンダースコアを挟んで表示されます。

メモ : デザイン レベルの CDC ファ イルがコンフ ィギュレーシ ョ ン BIT ファ イルと同じディ レク ト

リにある場合、 CDC ファ イルが自動的に選択されます。

BIT とオプシ ョ ンの CDC ファ イルを選択したら  [OK] をク リ ッ ク してデバイスをコンフ ィギュ

レーシ ョ ンします。

コンフ ィギュレーシ ョ ン進捗状況の確認

デバイスのコンフ ィギュレーシ ョ ン中、 Analyzer のウ ィンド ウ下部にステータスが表示されます。

DONE ステータスが表示されない場合は、コンフ ィギュレーシ ョ ン中に発生した問題を示すダイア

ログ ボッ クスが表示されます。 ダウンロードが正し く完了した場合、 ターゲッ ト  デバイスで

ChipScope Pro コアが自動的に検索され、存在するコアの数だけプロジェク ト  ツ リーが更新されま

す。 各コア ユニッ トにフォルダが 1 つ作成され、 そのユニッ トには下位ノードが表示されます。
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JTAG ユーザーと  ID コードの表示

ターゲッ ト  デバイスが正し く コンフ ィギュレーシ ョ ンされたこ とを確認する方法の 1 つは、 ター

ゲッ ト  デバイスからユーザー定義の ID コード とデバイス  ID コードをアップロードするこ とです。

ユーザー定義の ID コードは 8 桁の 16 進数コードで、 BitGen オプシ ョ ン -g UserID を使用して設

定できます。

特定デバイスのユーザー定義 ID コードをアップロード して表示するには、 特定のデバイスを右ク

リ ッ ク して [Device] → [Show USERCODE] をク リ ッ ク します。 特定のデバイスの固定デバイス

ID を表示する場合は、 特定のデバイスを右ク リ ッ ク して [Device] → [Show IDCODE] をク リ ッ ク

します。 これらのクエ リ結果は、メ ッセージ ペインに表示されます。 IDCODE および USERCODE
は、 [JTAG Chain] → [JTAG Chain Setup] で表示される  [JTAG Chain Device Order] ダイアログ

ボッ クスにも表示されます。

コンフ ィギュレーシ ョ ン ステータスの表示

32 ビッ トのコンフ ィギュレーシ ョ ン ステータス  レジスタには、 コンフ ィギュレーシ ョ ン ピンとそ

の他の内部信号のステータスの情報などが含まれています。 コンフ ィギュレーシ ョ ンで問題が発生

した場合は、 ターゲッ ト  デバイスを右ク リ ッ ク して [Device] → [Show Configuration Status] をク

リ ッ ク してメ ッセージ ペインを確認します。

メモ : すべてのターゲッ ト  デバイスには、1) コンフ ィギュレーシ ョ ン ステータス  レジスタ  (32 ビッ

ト ) と  2) JTAG 命令レジスタ  (デバイスによって長さは異なる) という ステータス情報を含んだ内部

レジスタが 2 つあり ます。 有効なターゲッ ト  デバイスにのみにコンフ ィギュレーシ ョ ン ステータ

ス  レジスタがあ り ます。 すべてのデバイスに読み出し可能な JTAG 命令レジスタがあ り ますが、ス

テータスが表示されるかど うかは、 特定デバイスのインプ リ メンテーシ ョ ンで決定されます。 各コ

ンフ ィギュレーシ ョ ン ステータス  ビッ トの定義は、 特定の FPGA デバイスのコンフ ィギュレー

シ ョ ンに関する資料を参照してください。

デバイスによっては、JTAG 命令レジスタにステータス情報も保持されます。 JTAG チェーンに接続

されているどのデバイスでも  [Device] → [Show JTAG Instruction Register] をク リ ッ ク して、 その

情報をメ ッセージ ペインに表示できます。

[Trigger Setup] ウィンドウ

ILA コアまたは IBA コアで ト リガーを設定するには、[Window] → [New Unit Windows] からコア

を選択します。 コアのダイアログ ボッ クスが表示され、[Trigger Setup]、[Waveform]、[Listing]、[Bus
Plot] およびコンソール ウ ィンド ウを任意の組み合わせで表示できます。 このダイアログ ボッ クス

からはウ ィンド ウを閉じるこ とはできません。

ト リ ガーの設定は、プロジェク ト  ツリ ーの [Trigger Setup] をダブルク リ ッ クするか、または [Trigger
Setup] を右ク リ ッ ク して  [Open Trigger Setup] をク リ ッ ク するこ と でも同様に実行できます。

各 ILA コアおよび IBA コアにはそれぞれト リガーを設定できる  [Trigger Setup] ウ ィンド ウがあ り

ます。 各コア内部のト リガーは、 デザインをコンパイルし直さずに実行時に編集できる機能を備え

ています。 次に、 ト リガー機能の 3 つのコンポーネン トの編集方法を説明します。 

• [Match Functions] : 各比較ユニッ トでの一致または比較を定義します。

• [Trigger Conditions] : バイナリ式または 1 つあるいは複数の比較演算子のシーケンスに基づい

て、 全体のト リガー条件を定義します。

• [Capture Settings] : キャプチャするサンプル数、ウ ィンド ウ数、ウ ィ ンド ウ内のト リガーの位置

を定義します。
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[Trigger Setup] ウ ィンド ウでは、 各コンポーネン トの表示を展開/非展開できます。 展開するには、

ウ ィンド ウ下部のボタンをク リ ッ ク します。 非展開するには、 展開しているコンポーネン ト左側の

ボタンをク リ ッ ク します。

[Capture Settings]

[Trigger Setup] ウ ィンド ウの [Capture Settings] で、 ト リガー イベン ト を発生させるウ ィンド ウ数

と、ウ ィンド ウ中のイベン トの位置を定義します。 ウ ィンド ウ とは、1 度の ト リガー イベン ト を含む

連続したサンプル シーケンスを指します。 パラ メータに無効な数が入力される と、テキス ト  フ ィー

ルドが赤になり ます。

[Type]

使用するウ ィンド ウのタイプを定義します。 [Window] を選択した場合は、各ウ ィンド ウのサンプル

数は 2 のべき乗にする必要があ り ます。 ただし、 ト リガーはウ ィンド ウのどの位置にでも設定でき

ます。 [N Samples] を選択した場合には、バッファにはト リガーごとに定義したサンプル数に対して

可能な限りのウ ィンド ウ数が含められます。 このオプシ ョ ンを選択した場合、 ト リガーは常にウ ィ

ンド ウの最初のサンプルとなり ます。

[Windows]

[Type] で [Window] を選択した場合のみ、このテキス ト  フ ィールドが使用できます。 このフ ィール

ドで定義できる値は、 正の整数 1 ～ キャプチャ  バッファのワード数です。

[Depth]

[Type] で [Window] を選択した場合のみ、このテキス ト  フ ィールドが使用できます。 このボッ クス

では、各キャプチャ  ウ ィンド ウのワード数を定義します。 [Windows] に入力した値に基づいて、 こ

のボッ クスに選択肢が自動的に含められます。 選択可能な値は、 2 のべき乗数のみです。

メモ : ト リ ガー条件全体で、[Occurring in at least n cycles] または [Lasting for at least n consecutive
cycles] が設定されているカウンタを含む比較ユニッ トが 1 つでも含まれる場合、ウ ィンド ウのワー

ド数またはト リガーごとのサンプル数を  8 以上にする必要があ り ます。 これは、ILA、IBA/OPB、お

よび IBA/PLB コアに含まれる ト リガー ロジッ クがパイプライン化されているためです。 

[Position]

[Type] で [Window] を選択した場合のみ使用できます。 このボッ クスでは、 各ウ ィンド ウの ト リガ

発生地点を定義します。 0 ～ キャプチャ  バッファのワード数 - 1 の値までの整数を入力できます。

[Samples Per Trigger]

[Type] で [N Samples] を選択した場合のみ使用できます。 このボッ クスでは、 ト リガー条件が発生

した後にキャプチャするサンプル数を定義します。 1 ～ キャプチャ  バッファのワード数 － 1 の正

の整数を入力できます。 ト リ ガー マークは、ウ ィンド ウに sample 0 と して常に表示されます。 表示

可能なサンプル ウ ィンド ウ数は、全体のサンプル ワード数を前提と して、キャプチャ可能な限りの

数となり ます。

メモ : 最低 n サイ クルまたはは n 回の連続サイクルを比較ユニッ トに選択した場合で、比較ユニッ

トが全体のト リガー条件の一部となる場合、 [Window] の [Depth] あるいは [Samples Per Trigger]
は、 ILA あるいは IBA コア内部のパイプライン化によ り、 8 未満には設定できません。 

[Strage Qualification]

ス ト レージ必要条件とは、コアの ト リガー ポートに接続されている比較ユニッ トのコンパレータで

検出されたイベン トのブール式の組み合わせです。 この条件では、各々のデータ  サンプルのキャプ
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チャ と保存の実行を決定する ト リガー ポートに接続されている比較ユニッ トのイベン トが評価さ

れます。 ト リガー条件とス ト レージ必要条件を併用し、 キャプチャ  プロセスの開始と終了、 キャプ

チャするデータをそれぞれ定義できます。

[Storage Condition] ダイアログ ボッ クスには、 すべての比較ユニッ トが表示されます。 比較ユニッ

トはそれぞれ表中に 1 行ずつ表示されます。 [Enable] 列には、 比較ユニッ トが ト リガー条件の一部

かど うかが示されます。 [Negate] 列では、ト リガー条件で比較ユニッ トが個別にネゲート  (ブール式

の NOT) されるかど うかが示されます。

ス ト レージ必要条件では、 すべてのデータをキャプチャするよ う設定するか、 またはイネーブルに

されている比較ユニッ トすべてをブール式の AND または OR で組み合わせたものを満たすデータ

のみをキャプチャするよ う設定できます。 表の右上もある  [Negate Whole Equation] をク リ ッ クす

る と、 全体のブール式をネゲー ト する こ と もでき ます。 最終的な関数式は、 ウ ィ ン ド ウ下部の

[Storage Condition Equation] に表示されます。

[Match Functions]

比較演算子では、 1 つの比較ユニッ トに対する ト リガー値を定義します。 すべての比較演算子は、

[Trigger Setup] ウ ィンド ウの [Match Functions] セクシ ョ ンで定義します。 [Trigger Conditions] セ
クシ ョ ンでは、1 つまたは複数の比較演算子をブール式またはシーケンスで定義し、ChipScope Pro
コア全体のト リガー条件を指定できます。

[Match Unit]

このフ ィールドには、 比較演算子が適用される比較ユニッ トが示されます。 比較ユニッ ト番号横の

アイコンをク リ ッ ク  (またはフ ィールドをダブルク リ ッ ク ) して、比較ユニッ ト を展開し、 ツ リー構

造で各ト リガー ポート  ビッ ト を表示します。 その後、 各ビッ トの値の確認および設定ができます。

[Function]

このボッ クスでは、比較のタイプを選択します。 コンパレータは、比較ユニッ トで使用可能なと きの

み表示されます。

[Value]

このフ ィールドでは、比較ユニッ トに適用する ト リガー値を選択します。 この値は、 [Radix] フ ィー

ルドに基づいて表示されます。 ダブルク リ ッ クする と、編集できるよ うにな り ます。 変更する値の前

にカーソルを置いて値を入力する と、値を上書きできます。 または、フ ィールドを一度ク リ ッ ク した

後に、 入力します。 各種基数で使用可能な文字は、 次のとおりです。

• [Hex] : X、0 ～ 9、A ～ F。X は、そのニブルの 4 ビッ トすべてがドン ト ケア (don’t care) であ

るこ とを示します。 クエスチョ ン マーク  (?) は、 1、 0、 X、 R、 F、 および B を組み合わせたニ

ブルであるこ とを示します。

• [Octal] : X、 ?、 0 ～ 7。

• [Binary] : X (ドン ト ケア)、 0、 1、 R (立ち上がり )、 F (立ち下がり )、 B (いずれかの遷移)、およ

び N (遷移なし ) です。 R、F、B、および N は、比較ユニッ トが遷移 ([Basic w/edges]、[Extended
w/edges]、 [Range w/edges]) を検出できる場合にのみ有効です。

• [Unsigned] : 0 ～ 9 (1 つの n ビッ ト  バスに対して、 0 ～ 2n-1)

• [Signed] : 0 ～ 9 (1 つの n ビッ ト  バスに対して、 -2n-1 ～ 2n-1-1)

また、[Bin] を基数に選択した場合、特殊文字にマウス  ポインタを置く と、ビッ ト名や位置を示した

ツールのヒン トが表示されます。
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[Radix]

[Value] に表示する基数を選択します。 選択肢は、 [Hex]、 [Octal]、 [Bin]、 [Signed] ([In Range] 比較

および [Out of Range] 比較の場合は使用不可)、 [Unsigned] です。

[Counter]

このフィ ールド では、比較演算子イベント を何度発生させるか選択します。 比較ユニッ ト に比較カウ

ンタがある場合は、 [Counter] 列のテキスト 文字が黒になり ます。カウンタがない場合は、 [Counter]
列のテキスト が淡色表示になり ます。 比較カウンタの値を変更するには、 カウンタ  セルをク リ ッ ク

し、 比較ユニッ ト  カウンタのダイアログ ボッ クスを表示させます。

• [Occurring in exactly n clock cycles] を選択した場合は、n 回の連続または n 回の断続イベン ト

が比較演算子カウンタの条件を満たします。

• [Occurring in at least n clock cycles] を選択した場合は、n 回の連続または n 回の断続イベン ト

が、 比較演算子カウンタの条件を満たし、 全体のト リガー条件が満たされるまでこの状態を維

持します。

• [Occurring for at least n consecutive cycles] を選択した場合は、n 回の連続イベン トが、比較演

算子カウンタの条件を満たし、 全体のト リガー条件が満たされるか、 比較演算子の値が満たさ

れなくなるまでこの状態を維持します。

メモ : ト リ ガー条件全体で、[Occurring in at least n cycles] または [Lasting for at least n consecutive
cycles] が設定されているカウンタを含む比較ユニッ トが 1 つでも含まれる場合、ウ ィンド ウのワー

ド数またはト リガーごとのサンプル数を  8 以上にする必要があ り ます。 これは、ILA または IBA コ
アに含まれる ト リガー ロジッ クがパイプライン化されているためです。

[Trigger Conditions]

ト リ ガー条件は、ブール式または 1 つ以上の比較演算子のシーケンスです。 コアでは、ト リガー条件

に基づいてデータがキャプチャされます。 ト リ ガー条件は、複数設定できます。 ト リ ガー条件を新規

に追加する場合は、[Add] をク リ ッ ク します。 ト リ ガー条件を削除する場合には、セルをハイライ ト

して、[Del] をク リ ッ ク します。 １  つのコアに対して複数のト リガー条件が定義できますが、1 回に

選択 (アクティブに) できる  ト リ ガー条件は 1 つだけです。

[Active]

[Active] 列には、 現在アクティブな ト リガー条件を示すボタンが表示されます。

[Trigger Condition Name]

[Trigger Condition Name] 列には、特定の ト リガー条件の名前が表示されます。 デフォルトでは、デ

フォルトの 「Trigger Condition n」 と表示されます。

[Trigger Condition Equation]

[Trigger Condition Equation] には、全体のト リガー条件を構成するブール式または比較演算子のス

テート  シーケンスが表示されます。デフォルトの ト リガー条件は、存在するすべての比較演算子の

論理 AND (各比較ユニッ トに対して 1 つの比較演算子) です。 ト リガー条件を変更するには、

[Condition Equation] をク リ ッ ク して、 [Trigger Condition] ダイアログ ボッ クスを表示します。
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[Trigger Condition] ダイアログ ボックス

コアに ト リガーのシーケンスが含まれる場合、 [Trigger Condition] ダイアログ ボッ クスに

[Boolean] と  [Sequencer] の 2 つのタブが表示されます。 [Boolean] タブを選択する と、 ト リガー条

件と して使用可能な比較ユニッ トのブール式を使用できます。 [Sequencer] タブを選択する と、ト リ

ガー条件はステート  マシンとな り、比較演算子を満たす場合にそれぞれのステート遷移で ト リガー

されます。

[Boolean] タブには、すべての比較ユニッ トが表形式で表示されます。 比較ユニッ トは 1 行ずつ表示

されます。 [Enable] 列には、 比較ユニッ トが ト リ ガー条件の一部かど うかが示されます。 [Negate]
列では、 ト リガー条件で比較ユニッ トが個別にネゲート  (ブール式の NOT) されるかど うかが示さ

れます。 

イネーブルにしたすべての比較ユニッ トは、 [AND Equation] または [OR Equation] を選択して、

ブール式の AND または OR に組み合わせて含めるこ とができます。また、[Negate Whole Equation]
をオンにする と、全体のブール式をネゲートするこ と もできます。 最終的な関数式は、ウ ィンド ウ下

部の [Trigger Condition Equation] に表示されます。

[Trigger Condition] ウ ィンド ウの [Sequencer] タブでは、 ト リガー シーケンスに含めるレベル数を

選択するコンボ ボッ クス と全レベルを示した表が表示されます。 シーケンサはレベル 1 から始ま

り、 レベル 1 で指定した比較ユニッ トが満たされる とレベル 2 に進みます。 レベル数はコアのパラ

メータで、最大 16 レベルまで設定できます。 各レベルでは、比較ユニッ トが満たされたかど うかが

確認されます。 特定の比較演算子が存在しないこ とを確認する場合など、 レベルをネゲートするに

は、 [Negate] をオンにします。 シーケンスは、 ウ ィンド ウ下部の [Trigger Condition Equation] に表

示されます。

M0 => M1 => M3 で定義されている ト リガー シーケンスは、比較ユニッ トのイベン ト  M0、M1、M3
が順に発生するこ とで (これらのイベン ト間にイベン トが発生したかど うかに関わらず) 満たすこ

とができます。 [Use Contiguous Match Events Only] をオンにする と、M0、M1、M3 の順に連続的

に遷移する場合にのみト リガー シーケンスが満たされます。つま り、M0 の後に M1、 !M1、M3 に
遷移する場合は、 ト リガー シーケンスは満たされません。

[Output Enable]

コアに ト リガー出力がある場合、 [Output Enable] 列の設定ができます。 この列のボッ クスで、 ILA
または IBA コアの trig_out ポートで駆動する信号タイプを選択します。

• [Disabled] : 出力は常に定数 0 です。

• [Pulse (High)] : ロジッ ク  1 の 1 クロ ッ ク  サイクルのパルスで、 ト リガー イベン トから  10 ク
ロ ッ ク  サイクル後に出力されます。

• [Pulse (Low)] : ロジッ ク  0 の 1 クロ ッ ク  サイ クルのパルスで、 ト リガー イベン トから  10 ク
ロ ッ ク  サイクル後に出力されます。

• [Level (High)] : 出力は、 ト リ ガー イベン トから  10 サイ クル後に 0 から  1 に遷移します。

• [Level (Low)] : 出力は、 ト リガー イベン トから  10 サイクル後に 1 から  0 に遷移します。

ト リガー設定の保存と再利用

[Trigger Setup] ウィ ンド ウのすべての情報は、ファ イルに保存して、作業中のプロジェク ト またはほ

かのプロジェク ト で再利用できます。 作業中のト リ ガー設定を保存するには、 [Trigger Setup] →

[Save Trigger Setup] をク リ ッ ク し、 [Save Trigger Setup As File] ダイアログ  ボッ クスで任意の場所

に .ctj と いう 拡張子で保存します。 作業中のプロジェク ト にト リ ガー設定ファ イルを読み込むには、

[Trigger Setup] → [Read Trigger Setup] をク リ ッ ク し、 [Read Trigger Setup File] ダイアログ  ボッ ク

スでト リ ガー設定ファイル (拡張子は .ctj を選択します。 ト リ ガー設定ファイルを選択した後に [開
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く ] をク リ ッ ク すると 、ファ イルに保存されている設定が [Trigger Settings] ウィ ンド ウに読み込まれ

ます。

ト リガーの実行と待機

ト リ ガーを設定した後は、 [Trigger Setup] → [Run] をク リ ッ ク して ト リガーを作動する状態にしま

す。 ト リ ガーは、 ト リガー条件が満たされるか解除されるまで作動する状態のままに保持されます。

ト リガー条件が満たされる と、 キャプチャ設定に従ってデータがコアにキャプチャされます。 サン

プル バッファがフルになる と、 データのキャプチャが停止します。 その後、 コアからデータが読み

込まれ、[Waveform] ウ ィンド ウおよび [Listing] ウ ィンド ウ、またはそのいずれかに表示されます。

ト リガーを強制実行するには、[Trigger Setup] → [Trigger Immediate] をク リ ッ ク します。 これで、ユ

ニッ トで ト リガー条件とス ト レージ必要条件が無視され、 ト リガー位置がサンプル 0 に設定されて

いるサンプル ウ ィンド ウ  1 つを使用して ト リガーがすぐに実行されます。

ト リガーの中止と解除

ト リ ガーを解除するには、[Trigger Setup] → [Stop Acquisition] をク リ ッ ク します。 [Trigger Setup]
→ [Run] を続けてク リ ッ クする と、 ト リガーが再設定されます。

メモ : データ取得を中止する と、アクティブな ト リガーが解除され、その時点までにキャプチャされ

たデータが失われます。

ト リガー実行モード

Analyzer ツールでは、ILA および IBA コアで 2 つの ト リガー実行モードがサポート されています。

• [Single]

• [Repetitive]

ト リ ガー実行モードは、 [Trigger Setup] → [Trigger Run Mode] または [Trigger Run Mode] ツール

バー ボタン ([Trigger Setup] ウ ィンド ウがアクティブなと きのみイネーブル) で選択できます。 

シングル ト リガー実行モード

シングル ト リ ガー実行モードでは、ILA/IBA コアの ト リガーを設定し、[Trigger Setup] ウ ィンド ウ

での指定に従いデータをキャプチャし、キャプチャしたデータをアップロード /表示して、停止しま

す。 停止後は、ユーザーが通信する と きのみ、 ト リガーが再設定されてプロセスが繰り返されます。

反復ト リガー実行モード

反復ト リ ガー実行モード はシングル ト リ ガー実行モード と 類似しますが、 ト リ ガーが実行されて

キャプチャされたデータがアッ プロード /表示された後に停止する代わり に ILA/IBA コアのト リ

ガーが自動的に再設定されます。 直前のト リ ガー イベント でキャプチャされたデータは、後続のト リ

ガーが発生しない限り 、継続してデータ  ビューア  ([Waveform]、 [Listing]、 [Bus Plot]) に表示されま

す。 後続のト リ ガーが発生し、データ  キャプチャ  バッ ファ がÃŸになると 、データ  ビューアには新し

いデータが表示されます。 このプロセスは、 手動でト リ ガーを停止しない限り 繰り 返されます。

反復ト リガーの記録

各反復ト リ ガー実行でキャ プチャ さ れたデータ は、 ファ イ ルに記録できます。 記録する場合は、

[Trigger Setup] → [Setup Repetitive Trigger Logging] をク リ ッ ク してダイアログ  ボッ ク スを開きま

す。 [Browse] ボタンをク リ ッ ク して、 ログ  ファ イルの保存場所を選択します。 Analyzer で生成され

る各ファイルには、反復ト リ ガー実行の繰り 返しに対応するシーケンス番号が含まれています。 以前

に使用したデータ  ログ  ファ イルに上書きする場合は、[Overwrite any existing files] をオンにします。
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データ  ログ ファ イルのフォーマッ トは、 VCD (Value Change Dump)、 ASCII (タブ区切り )、 また

は Agilent Technologies 社の FBDF (Fast Binary Data Format) から選択できます。 使用するフォー

マッ トのラジオ ボタンをオンにします。

[Signals to Export] ボッ クスからエクスポートする信号およびバスのセッ ト を選択します。次に、エ

クスポート可能な信号を示します。

• [All Signals/Buses] : 特定コアのすべての信号およびバス

• [Waveform Signals/Buses] : [Waveform] ビューに表示されているすべての信号とバス

• [Listing Signals/Buses] : [Listing] ビューに表示されているすべての信号とバス

• [Bus Plot Buses] : コアの [Bus Plot] ビューに含まれるすべての信号とバス

シングル ト リ ガー実行モードの信号の記録またはエクスポートについては、 「データのエクスポー

ト 」 を参照してください。

ト リガーおよびキャプチャ  ステータス

各 ILA/IBA コアの ト リガー ロジッ クのステータスは、 [Trigger Setup] ウ ィンド ウ下部のステータ

ス  バーに表示されます。 次の情報が表示されます。

• 「Waiting for trigger」 ( ト リ ガー待機中)、 「Capture started」 (キャプチャ開始)、 または 「Slow or
stopped clock」 (低速またはクロ ッ クの停止) などのト リ ガー ステートがステータス  バー左側

に表示されます。 

• キャプチャしたサンプル数を示すキャプチャ  バッファ  ステート もスタータス  バー左側に表示

されます。 

• 「SINGLE RUN」 (シングル実行)、 「REPETITIVE RUN」 (反復実行)、 または 「IDLE」 (アイ ド

ル) は、 ステータス  バー右側に表示されます。

また、 アイコンも  ILA/IBA コアの ト リガーおよびキャプチャ  ロジッ クのステート を示すのに使用

されます。

• 半分塗りつぶされた円は、 ト リガーとキャプチャ  ロジッ クの片方または両方がアクティブであ

るこ とを示します。

• 完全に塗りつぶされた円は、キャプチャ  バッファがフルで ト リガー ロジッ クがアイ ドルである

こ とを示します。

ト リ ガー ステータス  アイコンは、最小化表示されている  [Trigger Setup] ウィ ンド ウのタイ ト ル バー

にも表示されます。 この表示は、複数の ILA/IBA コアのト リ ガー ステータスを監視すると きに便利

です。

ト リガーおよびキャプチャ  ステータス情報の詳細は、 メ ッセージ ペインにも表示されます。

[Waveform] ウィンドウ

特定の ILA または IBA コアの波形を表示するには、[Window] → [New Unit Windows] をク リ ッ ク

してそのコアを選択します。 そのコア ユニッ ト向けにダイアログ ボッ クスが表示され、 [Trigger
Setup]、[Waveform]、[Listing]、[Bus Plot] ウ ィンド ウのすべてまたはいずれの組み合わせでも選択

して、 表示できます。 このダイアログ ボッ クスからはウ ィンド ウを閉じるこ とはできません。 プロ

ジェク ト  ツ リーの [Waveform] をダブルク リ ッ クするか、または右ク リ ッ ク して [Open Waveform]
をク リ ッ ク しても、 波形を表示できます。

[Waveform] ウ ィンド ウには、多くのロジッ ク  アナライザやシ ミ ュレータ同様にサンプル バッファ

の波形が表示されます。 [Waveform] ウ ィンド ウでは、 バスの作成、基数選択、名前の変更など、す
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べての信号ブラウザ操作を実行できます。 信号で操作を実行するには、[Bus/Signal] 列の信号または

バスを右ク リ ッ ク します。

バスおよび信号の並べ替え

バスや信号は [Waveform] ウ ィンド ウで並べ替えるこ とができます。 信号やバスを 1 つまたは複数

選択し、 任意の位置にド ラ ッグする と移動可能な位置に赤線が表示されます。

メモ : 信号は、内で移動できます。 この場合、 まずバス内の信号を 1 つまたは複数選択し、Alt + ↑
キーと  Alt + ↓ キーを押します。

信号およびバスの切り取り、 コピー、 貼り付け、 削除

信号またはバス上で右ク リ ッ ク して表示される メニューから、 信号やバスの切り取り、 コピー、 貼

り付け、削除を実行できます。 1 つまたは複数の信号とバス、あるいはそのいずれかを選択して右ク

リ ッ ク し、 メニューから任意の作業を実行します。 この作業は、 Windows のキー操作でも実行でき

ます (Ctrl + X キーで切り取り、Ctrl + C キーでコピー、Ctrl + V キーで貼り付け、Del キーで削除)。

ズーム機能

[Waveform] → [Zoom] → [Zoom In] をク リ ッ ク して表示された波形の中央を拡大するか、波形部分

で右ク リ ッ ク し、 [Zoom] → [Zoom In] をク リ ッ ク します。 波形を縮小表示するには [Waveform]→
[Zoom] → [Zoom Out] をク リ ッ クするか、 波形部分で右ク リ ッ ク し、 [Zoom] → [Zoom Out] をク

リ ッ ク します。

波形全体を表示するには、 [Waveform] → [Zoom] → [Zoom Fit] をク リ ッ クするか、 波形部分で右

ク リ ッ ク し、 [Zoom] → [Zoom Fit] をク リ ッ ク します。

波形を部分的に拡大するには、拡大するエリ アをド ラ ッグして四角形で囲み、ポップアップ ウ ィン

ド ウで [Zoom Area] をク リ ッ クて拡大します。

X 軸または O 軸で設定した部分を拡大するには、 [Waveform] → [Zoom] → [Zoom X] または

[Zoom O] をク リ ッ クするか、波形部分で右ク リ ッ クして [Zoom] → [Zoom X] または [Zoom O] を
ク リ ッ ク します。 その他のズーム機能と して、 直前の拡大倍数で拡大するには、 [Zoom] → [Zoom
Previous] をク リ ッ ク し、その次の拡大倍数で拡大するには [Zoom] → [Zoom Forward] をク リ ッ ク

します。また、特定のサンプル範囲を拡大するには、 [Zoom] → [Zoom Sample] をク リ ッ ク します。

波形の中央寄せ

特定のポイント で波形を中央寄せにする場合は、[Waveform] → [Go To] → [Go To X Cursor] または

[Go To O Cursor] をク リ ッ ク して、 X マーカーおよび O マーカーを軸にするか、 [Go To Trigger] か
ら直前のト リ ガー位置 ([Previous])、 次のト リ ガー位置 [(Next)]、 または指定のウィ ンド ウ番号

([Window #]) をク リ ッ ク して、波形を中央寄せにできます。この操作は波形を右ク リ ッ ク しても実行

できます。

カーソル

[Waveform] ウ ィンド ウでは、2 つのカーソル、X および O が使用できます。 カーソルを挿入する場

合には、波形上で右ク リ ッ ク し、[Place X Cursor] または [Place O Cursor] をク リ ッ ク します。 垂直

線はカーソルの位置を示します。 また、 その地点の信号やバスのステータスは、 X または O 列に示

されます。 両カーソルの位置とその差異は、 [Waveform] ウ ィンド ウ下部に表示されます。 両カーソ

ルは、 初期値と してサンプル 0 に配置されています。

カーソルを移動する場合には、波形の別の位置で右ク リ ッ クするか、波形フォームのヘッダで X ま
たは O ラベルのハンドルをド ラ ッグするか、または波形上でカーソルの線そのものをド ラ ッグしま

す。 マウスをカーソルに合わせる と、 ド ラ ッグ アイコンが表示されます。
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サンプルの表示数

波形の横軸に、サンプル ウ ィンド ウ  (デフォルト ) に対するサンプル数、またはバッファの総サンプ

ル数が表示されます。 各ウ ィンド ウで 0 からサンプル数を表示するには、 右ク リ ッ ク してメニュー

を表示させ、[Ruler] → [Sample # in Window] をク リ ッ ク します。 バッファの総サンプル数をサンプ

ル数と して表示するには、 右ク リ ッ ク してメニューを表示させ、 [Ruler] → [Sample # in Buffer] を
ク リ ッ ク します。 また、右ク リ ッ ク  メニューの [Ruler] → [Negative Time/Samples] をク リ ッ クする

と、 ト リガー マーカーの直前に発生するサンプルのルーラでの表示方法 (マイナスまたはプラスの

いずれか) を切り替えるこ とができます。

マーカーの表示

ト リ ガーの各地点には、 固定された赤い線が垂直方向に表示されます。 サンプルがキャプチャされ

なかった期間を示すウ ィンド ウでは、 ウ ィ ンド ウ と ウ ィ ンド ウの間に固定された黒い線が表示され

ます。これらマーカーのいずれかを非表示する場合は、右ク リ ッ クでメニューを表示させ、[Markers]
→ [Window Markers] または [Markers] → [Trigger Markers] をク リ ッ ク してオフにします。

データ  キャプチャ  タイム スタンプ

キャプチャされたデータがアップロード され表示された日付および時間を示すタイム スタンプは

[Waveform] ウ ィンド ウの左下に表示されます。 反復ト リガー実行モードを使用する場合は、

ILA/IBA コアが ト リガーされデータがアップロード された回数を示すシーケンス番号も表示され

ます。

[Listing] ウィンドウ

特定の ILA または IBA コアの [Listing] ウ ィンド ウを表示するには、 [Window] → [New Unit
Windows] をク リ ッ ク してそのコアを選択します。 そのコア ユニッ ト向けにダイアログ ボッ クスが

表示され、 [Trigger Setup]、 [Waveform]、 [Listing]、 [Bus Plot] ウ ィンド ウのすべてまたはいずれの

組み合わせでも選択して、 表示できます。 このダイアログ ボッ クスからはウ ィンド ウを閉じるこ と

はできません。 プロジェク ト  ツ リーの [Listing] をダブルク リ ッ クするか、[Listing] を右ク リ ッ ク し

て [Open Listing] をク リ ッ ク しても、 [Listing] ウ ィンド ウを表示できます。

[Listing] ウ ィンド ウには、サンプル バッファの値一覧が表形式で表示されます。 個々の信号および

バスが列に表示されます。 [Listing] ウ ィンド ウでは、バスの作成、基数選択、名前の変更などのすべ

ての信号ブラウザ操作を実行できます。 信号で操作を実行するには、 列のヘッダで信号またはバス

を右ク リ ッ ク します。

バスおよび信号の並べ替え

バスや信号は [Listing] ウ ィンド ウで並べ替えるこ とができます。 表の信号あるいはバスのヘッダ

をク リ ッ ク し、 任意の位置にド ラ ッグします。

信号およびバスの削除

信号やバスは、 それぞれ列の任意の位置で右ク リ ッ ク し、 [Remove] をク リ ッ クする と、 [Listing]
ウ ィンド ウから削除できます。 [Remove All] をク リ ッ クする と、すべての信号およびバスが削除さ

れます。

カーソル

[Listing] ウ ィンド ウでも、[Waveform] ウ ィンド ウ同様にカーソルを使用できます。 カーソルを配置

するには、 [Listing] ウ ィンド ウのデータ部分で右ク リ ッ ク し、 [Place X Cursor] または [Place O
Cursor] をク リ ッ ク します。 表には、 カーソルと同様の色の線が表示されます。 表の任意の位置に
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カーソルを移動させる場合には、 前述と同じ要領でマウスを任意の位置で右ク リ ッ クするか、 最初

の列でカーソルのハンドルを右ク リ ッ ク して任意の位置にド ラ ッグします。

Go To カーソル 

カーソルの位置まで自動的に [Listing] ウ ィンド ウをスク ロールするには、右ク リ ッ ク してメニュー

を表示させ、[Go To] → [Go To X Cursor] または 、[Go To] → [Go To O Cursor] をク リ ッ ク します。

[Bus Plot] ウィンドウ

ILA バスまたは IBA バスの特定のセッ ト を [Bus Plot] ウ ィンド ウで確認するには、 [Window] →
[New Unit Windows] をク リ ッ ク して適切なコアを選択します。 そのコア ユニッ ト向けにダイアロ

グ ボッ クスが表示され、 [Trigger Setup]、 [Waveform]、 [Listing]、 [Bus Plot] ウ ィンド ウのすべて

またはいずれの組み合わせでも選択して、 表示できます。 このダイアログ ボッ クスからはウ ィンド

ウを閉じるこ とはできません。 プロジェク ト  ツ リーの [Bus Plot] をダブルク リ ッ クするか、 または

[Bus Plot] を右ク リ ッ ク して [Open Bus Plot] をク リ ッ ク しても同様に [Bus Plot] ウ ィンド ウを表示

できます。

特定のコアのバスはいずれも  [Bus Plot] ウ ィンド ウで表示できます。 [Bus Plot] ウ ィンド ウで、時間

軸で見たバスの値、 またはバスの値同士をグラフ化できます。

[Plot]

ウ ィンド ウ左上のボタンで 2 つのプロ ッ ト  タイプ、 [data vs. time] と  [data vs. data] を選択できま

す。 [data vs. time] をオンにする と、任意の数のバスをま とめて表示できます。 [data vs. data] をオン

にする場合は 2 つのバスを選択する必要があ り、プロ ッ トの x 座標が特定の時間の片方のバスの値

を表し、 y 座標が同じ時間のも う一方のバスの値を表します。

バスはそれぞれ基数によ り色別表示されます (16 進数、2 進数、8 進数、 トークン、および ASCII 基
数は、 スケール係数が 1.0、 精度が 0 の符号なし  10 進数と して表示)。

[Display]

バスのグラフは、 [lines]、 [points]、 [lines & points] で表示できます。 選択した [Display] のタイプ

は、 表示されるすべてのバスの値に反映されます。

[Bus Selection]

[Bus Selection] で、 座標に示すバスを個別に選択して波形を表示するか (data vs. time モード )、 ま

たはバス同士を互いに選択 (data vs. data モード ) できます。 各バスの色は、 バス名の隣のカラー

ボッ クスをク リ ッ クする と変更できます。

[Min/Max]

[Min/Max] で、 表示中のバスの軸の最小値および最大値が表示されます。

カーソルのト ラ ッキング

[X:] および [Y:] ボッ クスは、 バス  グラフの下部にあ り、 [Bus Plot] ウ ィンド ウ表示中はマウスの

カーソルの現在の x 座標と  y 座標の位置を示します。
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VIO コアのコンソール ウィンドウ

VIO コアのコンソール ウ ィンド ウを開くには、[Window] → [New Unit Windows] をク リ ッ ク して

コアを選択します。 そのコア ユニッ ト向けにダイアログ ボッ クスが表示されるので、 [Console] を
選択します。 このダイアログ ボッ クスからはウ ィンド ウを閉じるこ とはできません。

コンソール ウ ィンド ウは VIO コア用です。 特定の VIO コアのコンソールを開くには、 プロジェク

ト  ツ リーの [VIO Console] をダブルク リ ッ ク します。 このウ ィンド ウでは、VIO コアの入力信号の

ステータスや動作確認および VIO コアの出力信号のステータスを変更できます。 

このウ ィンド ウでは、 信号またはバスを右ク リ ッ ク して、 バスの作成、 基数の選択、 名前の変更な

どの信号ブラウザ操作をすべて実行できます。 ウ ィンド ウは、[Bus/Signal] と  [Value] の 2 列で構成

されています。

[Bus/Signal] 列

[Bus/Signal] には、VIO コアのバス名および信号名が含まれます。 バスの場合は、バスを構成する信

号の展開/非展開表示、 または非表示にできます。 さまざまな信号管理に加え、 マウスの右ク リ ッ ク

でさ らに 2 種類のパラ メータ、 [Type] と  [Activity Persistence] を設定できます。 

VIO コアのバスおよび信号のタイプ

信号のタイプによってコンソール ウ ィンド ウの [Value] 列での表示方法が異なり ます。 VIO 信号の

タイプに応じて、 表示されるタイプが異なり ます。

• VIO 入力信号には、 次のよ う な表示タイプがあ り ます。

♦ テキス ト  : ASCII 文字

♦ LED

- LED は、 赤、 青、 緑から選択。

- アクティブ High または アクティブ Low のいずれか。

• VIO 入力バスの表示タイプは 1 種類のみ : テキス ト

• VIO 出力信号には、 次のよ う な制御タイプがあ り ます。

♦ テキス ト  : ASCII 形式のテキス ト  フ ィールド

♦ プッシュ  ボタン (アクティブ High か アクティブ Low のいずれか)

♦ ト グル ボタン

♦ パルス列 (同期出力のみ)

♦ シングル パルス  (同期出力のみ)

• VIO 出力バスには 2 種類の制御タイプがあ り ます。

♦ テキス ト

♦ パルス列 (同期出力バスのみ)

VIO コアのバスおよび信号のアクテ ィビテ ィ持続時間

信号の持続時間では、 [Value] に表示させる信号のアクティビティ時間を示します (信号のアクティ

ビティについては 118 ページの 「[Value] 列」 を参照)。

[Activity Persistence] では次を設定できます。

• [Infinite] : アクティビティが永久的に表示されます。

• [Long] : サンプル周期 80 回分のアクティビティが表示されます。
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• [Short] : サンプル周期 8 回分のアクティビティが表示されます。

設定時間を過ぎる と、 新規のアクティビティが表示されます。 最後のサンプル周期中にアクティ ビ

ティが発生しなかった場合には、 [Value] にアクティ ビティは表示されません。

バスおよび信号の並べ替え

バスや信号は [Waveform] ウ ィンド ウで並べ替えるこ とができます。 信号やバスを選択し、 任意の

位置にド ラ ッグする と、 [Bus/Signal] 列の移動可能な位置に赤線が表示されます。

信号およびバスの切り取り、 コピー、 貼り付け、 削除

マウスを右ク リ ッ ク してメニューを表示させ、 信号とバスのそれぞれで切り取り、 コピー、 貼り付

け、削除を実行できます。 信号またはバスにマウスを合わせて右ク リ ッ クし、メニューから任意の動

作を選択するか、標準の Windows のキーの組み合わせを使用します (Ctrl + X キーで切り取り、Ctrl
+ C キーでコピー、 Ctrl + V キーで貼り付け、 Del キーで削除)。

[Value] 列

[Value] 列には、 コンソール ウ ィンド ウに含まれる各信号の現在値が表示されます。 VIO コアの入

力では、これらのセルは編集できません。また、バスは選択した基数に基づいて表示されます。 VIO
コアの入力値は、 [JTAG Scan Rate] の選択に従い定期的に更新されます。 VIO コアの各入力では、

信号の現在値の変化によって、 前回の入力確認後のアクティビティ情報がキャプチャされます。 高
速デザインの場合には、 信号が 0 のと きにサンプリ ングされ、 0 から  1 に遷移し、 再びサンプリ ン

グが実行される前に信号が 0 に戻るこ とが考えられます。

同期入力の場合には、デザイン クロ ッ クに対してアクティビティが検知され、 グ リ ッチを検知する

際に有効です。 0 から  1 への遷移が検出された場合、 値と共に上向きの矢印が表示されます。 また、

1 から  0 への遷移が検出された場合には、下向きの矢印が表示されます。 その両方を検知する と、両

方向矢印が表示されます。 表に示されたアクティビティの時間を、信号の持続時間と呼びます。 持続

時間は、 右ク リ ッ クで表示される  [Activity Persistence] メニューから、 個別に選択するこ と もでき

ます。

メモ : アクティビティを示す矢印は、 同期の場合は黒、 非同期の場合は赤で示されます。

VIO 信号やバスの値のタイプは、 それぞれ右ク リ ッ ク し、 [Type] から選択できます。

[Text Field]

[Type] に [Text Field] を選択した場合は、 次の文字のみを使用して入力します。

• 信号およびバイナリ  バスには 0 または 1

• 16 進数のバスには 0 ～ 9 および A ～ F

• 8 進数のバスには 0 ～ 7

• 有効な符号付きまたは符号なしの整数

[Push Button]

[Type] に [Push Button] を選択した場合は、PCB の実際のプッシュ  ボタンがシ ミ ュレーシ ョ ンされ

ます。 アクティブ High のと きに 0、 アクティブ Low のと きに 1 が押されないと、 無効な値が設定

されます。 ボタンが押されている間は、 VIO コアから有効な値が出力されます。

[Toggle Button]

[Type] に [Toggle Button] を選択した場合は、 ク リ ッ クごとに 1 や 0 に変換できます。
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[Pulse Train] (同期出力のみ)

[Type] に [Pulse Train] を選択した場合は、同期出力を制御できます。 パルス列は 1 および 0 で構成

された 16 サイクル列で、 ユーザーが定義します。 パルス列を変更するには、 [Edit] をク リ ッ ク し、

[Pulse Train] ダイアログ ボッ クスを表示します。 パルス列の各サイクルごとにテキス ト  フ ィール

ドが 1 つあり ます。 テキス ト  フ ィールドは、 前のバスまたは信号の値に基づいて、 デフォルトで割

り当てられます。 バスの場合には、このフ ィールドは常にバイナリで表示され、個別の信号を明示的

に制御します。

[Run] をク リ ッ クする と、パルス列が一度に実行されます。 これによ り、デザイン ク ロ ッ クに対する

出力制御の精度が高ま り ます。

[Single Pulse] (同期出力のみ)

[Signal Pulse] は、特殊なプッシュ  ボタンです。 ボタンが押される と、コアがその間一定の有効な値

を 1 つ駆動する代わりに High サイクルを 1 つ含むパルス列が一度だけ実行されます。

VIO コア用のメニューとツールバー

VIO コンソールの使用中は、 VIO コア専用メニューおよびツールバーを使用して、 必要に応じて

VIO コアの入出力動作を変更できます。 ツールバーの左から右方向へ順に説明します。

[JTAG Scan Rate]

VIO コアの入力を読み出す際の [JTAG Scan Rate] は、 プルダウン リ ス トで選択できます。 デフォ

ルトのスキャン レートは、 250ms です。 サンプ リ ング周期には、 [500ms]、 [1 s]、 [2 s]、 [5 s]、 ま

たは [Manual Scan] も設定できます。 [Manual Scan] を選択した場合、[Sample Once (S!)] を使用で

きます。 VIO コアの入力を読み出すだけの場合は、ツールバーで [Sample Once （S!)] をク リ ッ クす

るか、 または [VIO] → [Sample Once] をク リ ッ ク します。

[Update Static Outputs]

デフォルトでは、VIO コアの出力のいずれかを変更する と、その出力設定情報がすぐに VIO コアに

送信されます。 パルス列以外のすべての出力を一度に更新するには、 ツールバーで [Update Static
Outputs (U!)] をク リ ッ クするか、 または [VIO]  → [Update Static Outputs] をク リ ッ ク します。

[Reset All Outputs]

すべての出力をデフォルト設定にリセッ トする  (テキス ト  フ ィールド と ト グル ボタンは 0、 パルス

列はすべて 0 ) には、 ツールバーで [Reset All Outputs] をク リ ッ クするか、 [VIO] → [Reset All
Outputs] をク リ ッ ク します。

[Clear All Activity]

VIO コアのすべての入力を表示し、 アクティビティを リセッ トするには、 ツールバーで [Clear All
Activity] をク リ ッ クするか、または [VIO] → [Clear All Activity] をク リ ッ ク します。 設定してある

持続時間にかかわらず、 すべての入力のアクティビティが リセッ ト されます。

システム モニター

Virtex®-5 および Virtex-6 デバイスには、システム  モニターと いう 機能が含まれています。 この機能

は、 10 ビッ ト 、 200-kSPS (キロ  サンプル/秒) のアナログ /デジタル コンバータ  (ADC) に対応するよ

う 構築されています。 ADC は、 多数のオンチッ プ センサーと 組み合わせると 、 オンチッ プ電源電圧

およびチッ プ温度などの FPGA の物理的な動作パラ メ ータを計測できます。 詳細は、Virtex-5 FPGA

http://japan.xilinx.com


120 japan.xilinx.com ChipScope Pro 12.1 ソフ トウェアおよびコア

UG029 (v12.3) 2010 年 9 月 21 日

第 4 章 : ChipScope Pro Analyzer の使用

システム  モニター ユーザー ガイド  [251 ページのリ ファレンス  23 を参照] および Virtex-5 FPGA シ
ステム  モニター ユーザー ガイド  [251 ページのリ ファレンス  24 を参照] を参照してく ださい。

Analyzer では、 システム モニター プリ ミ ティブのオンチップ電圧および温度センサーに JTAG を
介して リアル タイムでアクセスできます。 すべてのオンチップ センサーは、Virtex-5 または Virtex-
6 デバイスが有効なビッ ト ス ト リームでコンフ ィギュレーシ ョ ンされる前後で使用できます。 シス

テム モニターシステム モニターの機能を使用するのに、デザインにシステム モニター プリ ミ ティ

ブ ブロッ クをインスタンシエートする必要はあ り ません。 ただし、Virtex-5 デバイスのシステム モ
ニター特有のピンがシステム ボードに正し く接続されている必要があ り ます。

Analyzer のプロジェク ト  ツ リーでは、 JTAG チェーンに含まれる  Virtex-5 および Virtex-6 デバイ

スに [System Monitor] ノードが表示されます。 このノードを右ク リ ッ クする と、 [System Monitor
Console] ビューアを表示するオプシ ョ ンが表示されます。 左ク リ ッ クする と、 信号ブラウザのさま

ざまなセンサーが表示されます。 信号ブラウザでセンサー名や表示単位を変更できます。

[System Monitor Console]

各システム モニター センサーの値は、[System Monitor Console] の [History] タブに表示するか、ま

たはログ ファ イルに書き出すこ とができます。 各センサーで次の表示値を表示できます。

• システム モニターのセンサーから直接読み出される現在の値

• システム モニターのセンサー ピーク検出器によ り直接読み出されるデバイスの最小/最大値

• JTAG ケーブル接続を開いたと き、 または最後にシステム モニターを リセッ ト したと きから

Analyzer で収集されたすべてのセンサー値から派生するサンプリ ング最大/最小値

• JTAG ケーブル接続を開いたと き、 または最後にシステム モニターを リセッ ト したと きから

Analyzer で収集されたすべてのセンサー値のスライディング ウ ィンド ウから算出されるウ ィ

ンド ウごとの平均/最大/最小値

[System Monitor Console] で算出されるサンプリ ング値またはウ ィンド ウごとの値は、 ツールバー

の [Reset] をク リ ッ クする と リセッ トできます。

メモ : システム モニターで有効なセンサー データがレポート されない場合は、 [System Monitor
Console] に 「Invalid Data」 とい う メ ッセージが表示されます。

[System Monitor Console] のツールバー

[System Monitor Console] のツールバーおよび右ク リ ッ ク  メニューを使用する と、[System Monitor
Console] をカスタマイズしたり通信できます。

[JTAG Scan Rate]

システム モニター センサーのデータを読み出す際の [JTAG Scan Rate] は、プルダウン リ ス トで選

択できます。 デフォルト値は [1 s] ですが、 [2 s]、[5 s]、[10 s]、[30 s]、[1 min]、または [Manual Scan]
も設定できます。 [Manual Scan] を選択した場合、[Sample Once (S!)] を使用できます。 システム モ
ニターのデータを読み出す場合は、ツールバーの [Sample Once] をク リ ッ クするか、または [System
Monitor] → [Sample Once] をク リ ッ ク します。

[Window Depth]

[System Monitor] ビューアでのスラインディング ウ ィンド ウの計算で使用されるウ ィンド ウの深

さは、ツールバーの [Windows Depth] ボッ クスに入力するか、または [System Monitor] → [Window
Depth] から設定できます。 サンプリ ング ウ ィンド ウの深さは、 ２、 4、 8、 16、 32、 64、 128 サンプ

ルに設定できます。
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[External Input]

System Monitor コンポーネン トでは、外部センサーの電圧レベルが監視されます。 [External Input]
を使用する と、 どの外部センサー入力でも一度に １  つずつ確認できます。 有効な外部入力には、次

が含まれています。

• 16 個のユーザー定義 VAUXP/VAUXN 外部センサーのいずれか

• V_P/V_N 専用外部センサー

• V_REFP 参照電圧入力

• V_REFN 参照電圧入力

外部入力の表示をディ スエーブルにするには [No Input] を選択します (デフォルト )。

[Reset]

ク リ ッ クする と、 [System Monitor Console] の表示がリセッ ト されます。

[Enable Logging]

ツールバーの [Enable Logging] ボタンおよび [System Monitor] → [Enable Logging] メニュー コマ

ンドでは、 オフライン解析で使用する  System Monitor センサーのデータをテキス ト  ファ イルに保

存するファイル記録機能を使用できます。

システム モニターのデータ記録

[System Monitor] → [Setup Logging] をク リ ッ クする と、 ダイアログ ボッ クスが表示されます。 
このダイアログ ボッ クスを使用して記録機能の設定をカスタマイズします。

[Log File]

[Browse] ボタンをク リ ッ ク して、 システム モニターのログ ファ イルの保存場所を選択します。 デ
フォルトの保存場所は、 <CHIPSCOPE_INSTALL>/bin/<PLATFORM>/system_monitor.log

で、<CHIPSCOPE_INSTALL> はインス トール ディ レク ト リ、<PLATFORM> はオペレーシングシ

ステムのプラ ッ ト フォーム (nt、 nt64、 lin、 lin64、 または sol) を指します。

[Log File Format]

システム モニターのログ ファ イルはテキス ト  ファ イルで、 マシン処理向け CSV (カンマ区切り )
ファ イルと可読形式のファイルの 2 種類のフォーマッ トにするこ とができます。

[Log File Limit]

システム モニターの記録システムでは、ディ スク容量を多く消費するデータが生成される可能性が

あ り ます。 この問題を回避するため、ログ ファ イル制限に基づいて複数のファイルに分割できます。

ログ ファ イル制限は、 特定のサンプル数またはファイル サイズ (kb) に基づく こ とができます。

Virtex-4 FPGA GT11 ト ランシーバ用 IBERT コンソール ウィンドウ

Virtex-4 FPGA GT11 ト ランシーバ用の IBERT コアのコンソール ウ ィンド ウを開くには、

[Window] → [New Unit]  → [Windows] でコアを選択します。 このコア ユニッ ト向けのダイアログ

ボッ クスが表示されるので [IBERT Console] を選択します。 このダイアログ ボッ クスからはウ ィ

ンド ウを閉じるこ とはできません。 プロジェク ト  ツ リーの [IBERT Console] をダブルク リ ッ クす

るか、 または [IBERT Console] を右ク リ ッ クして [Open IBERT Console] をク リ ッ ク してもコン

ソール ウ ィンド ウを表示できます。
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IBERT のコンソール ウ ィンド ウは、縦列と水平セクシ ョ ンで構成されています。 各列には、デバイ

スに含まれる特定のアクティブ マルチ ギガビッ ト  ト ランシーバ (MGT) が表示されます。 表の列お

よび行の順序は、ド ラ ッグアンド ド ロ ップで並べ替えるこ とができます。 行は、そのセクシ ョ ン内で

のみ並べ替えるこ とが可能で、 別のセクシ ョ ンにはド ラ ッグできません。

水平セクショ ンは、 「[MGT Settings]」 、 124 ページの 「[BERT Settings]」 、 124 ページの 「[TX
Settings]」、 および 125 ページの 「[RX Settings]」 で構成されています。 各セクショ ンのヘッダをク

リ ッ クすると 、セクショ ンを展開表示または非表示にできます。列のヘッダ  タイ ト ルには、MGT105B
などの MGT 番号が表示され、 ヘッ ダの色でリ ンク  ステータスが表されます (表 4-3 を参照)。 

[MGT Settings]

このセクシ ョ ンには、 MGT の基本制御およびステータス情報が含まれています。 

[MGT Alias]

MGT のユーザー定義名が表示されます。 デフォルトでは MGT 番号になっていますが、ク リ ッ ク し

て変更できます。

[MGT Location]

デバイスに含まれる  MGT の X および Y 座標が表示されます。 この値は変更できません。 X、 Y 位
置は、 UCF ファ イルで MGT デザインを制約する際に使用します。

[MGT Link Status]

受信側ロジッ クのステータスが表示されます。 リ ンク  ステータスでは、MGT の受信ロジッ クで予期

するデータ  レートでデータが予期どおり受信されているかど うかが示されます。 緑色はリ ンクが安

定しているこ とを示し、 黄色はリ ンクが不安定であるこ とを示し、 赤色はリ ンク されていないこ と

を示します。

[TX Lock]/[RX Lock]

TX および RX の PLL のロ ッ ク  ステータスを示します。 緑色はロッ ク されているこ とを示し、黄色

はロ ッ ク  ステータスが変化しているこ とを示し、赤色は PLL がロ ッ ク していないこ とを示します。 

[MGT Loopback Mode]

MGT ループバッ ク設定を変更する制御です。 デザインは、この制御が [Serial] に設定されている と

きに初期化されます。 [Serial] に設定する と、MGT で PCS および PMA の両方の内部ループバッ ク

が実行されます。 [Fabric] に設定する と、 MGT は受信したものをそのまま送信します。 この設定で

は、 外部テキス ト装置を使用してシ リアル リ ンク解析が実行されます。

表 4-3 : MGT リンク  ステータス

色 リンク  ステータス

緑 MGT がリ ンク されています (有効なデータを受信しています)。

黄色
リ ンクは不安定で、 リ ンク されているステータス と リ ンク されてい

ないステータス間を行き来しています。

赤 リ ンク されていません。
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[MGT Channel Reset]

PLL を含む PCS および PMA のリセッ トが実行されます。 TX の PLL はタイルに含まれる両 MGT
(MGT103A と  MGT103B など) で共有されているので、[MGT Channel Reset] を実行する と両方の

MGT に影響します。

[Edit DRP]

MGT のすべての属性を DRP から表示して変更できます。 このボタンをク リ ッ クする と、その MGT
の [Edit DRP] ダイアログ ボッ クスが表示されます。

[Attribute] タブの [DRP Attribute] から表示または変更する属性を選択します。属性はアルファベッ

ト順に表示されます。 属性を選択する と、 その時点の DRP が読み出され、 その属性の現在の値が

[Current Value] に表示されます。 ダイアログ ボッ クス右下にあるラジオ ボタンでは、 2 つの値

フィールドの基数が示されています。 新しい値を入力するには [Hex] または [Binary] フ ィールドに

値を入力してから  [Apply] をク リ ッ ク します。 特定の属性ではなく特定の DRP アドレスを変更す

る場合は、 [DRP Address] タブをク リ ッ ク します。 このタブは、 上級ユーザー向けです。

[Address] から変更するアドレスを選択します。 ラジオ ボタン ([Hex]/[Binary]) の選択に従い現在

の値が 16 進数または 2 進数で表示されます。 値を変更するには、[New Value] に新しい値、[Mask]
にマスクを入力します。 どのビッ トの組み合わせでもマスク されます。 マスク  ビッ ト  1 ではその

ビッ トが変更され、 マスク  ビッ ト  0 ではそのビッ トが変更されません。 値とマスクの入力後に

[Apply] をク リ ッ ク します。 ダイアログ ボッ クスを閉じるには [Cancel] をク リ ッ ク します。

[Dump DRP]

各 MGT の属性は、 ダイナミ ッ ク  リ コンフ ィギュレーシ ョ ン ポート  (DRP) から制御できます。

[Dump DRP] をク リ ッ クする と、MGT の DRP が読み出され、[Messages] ペインにその結果が表示

されます。 DRP 読み出し結果は、 cs_analyzer ログ ファ イルにも含まれます。

[Export UCF]

[Dump DRP] を実行する と、 MGT のすべての属性が画面に表示されますが、 バイナリ  フォーマッ

トで表示されるため、一部の属性をデザインで使用できません。 [Export UCF] をク リ ッ ク し、 ファ

イルの保存場所を指定する と、 UCF ファ イルが必要なフォーマッ トで書き出されます。

[Edit Clock Settings]

各 MGT のライン レート設定は、 実行時にシステムで変更できます。 この設定には [Edit Clock for
<MGT 名>] ダイアログ ボッ クスを使用します。 ラ イン レート を変更する と、すべての PLL ク ロ ッ

ク分周器の設定に影響します。 [Edit] をク リ ッ ク し  [Edit Clock for <MGT 名>] ダイアログ ボッ ク

スを開きます。

[Target Line Rate (MHz)] でライン レート を MHz で入力し、 [Set] をク リ ッ ク します。 [Preferred
VCO] および [REFCLK Freq] に値が表示されるので、 VCO レート  (ほとんどの場合で有効な VCO
レートは 1 つのみ) および REFCLK 周波数を選択します。 REFCLK 周波数は、選択した MGTCLK
コンポーネン トに入力されるボード上の外部クロ ッ クです。 ライン レートでは、 最大 6 個の

REFCLK 周波数を使用できます。 使用する周波数がリ ス トに含まれていない場合、『Virtex-4 FPGA
RocketIO Multi-Gigabit Transceiver User Guide』 [251 ページのリ ファレンス  3 を参照] で有効なラ

イン レートおよび分周器設定の情報を参照して ください。

すべてのフ ィールドを入力したら  [Apply] をク リ ッ ク して TX および RX の PLL 両方に新しい設

定を反映させます。 TX の PLL は 2 つの MGT ペアで共有されるため、 1 つのライン レート を変更

する と も う一方のリ ンク  ステータスにも反映されます。 
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[Fabric Width]

MGT とその周辺の FPGA ファブ リ ッ ク間のデータ  インターフェイス幅を示すステータス  フ ィー

ルドです。 また、パターン ジェネレータの幅も示します。 値は、 16、 20、 32、 または 40 ビッ トのい

ずれかに設定できます。 6 Gb/s 以上のライン レートは、16 または 20 ビッ トのファブ リ ッ ク幅では

サポート されていません。

[BERT Settings]

このセクシ ョ ンには、 ビッ ト  エラー レート  テスタ  (BERT) を制御する行が含まれています。

[RX Bit Error Ratio]

MGT に対して算出されたビッ ト  エラー率が表示されます。 この値は指数で表現されます。 たとえ

ば、 1.000E-12 は 1 兆ビッ ト受信するたびに 1 ビッ ト  エラーが発生するこ とを意味します。

[RX Line Rate]

MGT 向けに算出されたライン レートが表示されます。 デザインの時間を計測するのにユーザー ク
ロ ッ クが使用されるため、不正確または不安定なユーザー クロ ッ クを使用する と、 この値が不正に

なったり または変動します。 リ ンクがない場合は、 「N/A」 と表示されます。

[RX Received Words]

受信したワード数の総計が表示されます。 ワード  サイズは、[Fabric Width] と同じ値になり ます。 こ
のカウン トは、 [BERT Counter Reset] をク リ ッ ク したと きにリセッ ト されます。

[RX Total Bit Errors]

このフ ィールドには、検出されたビッ ト  エラー数の総計が表示されます。 このカウン トは、 [BERT
Counter Reset] をク リ ッ ク したと きに リセッ ト されます。

[BERT Reset]

このボタンをク リ ッ クする と、 ビッ ト  エラー カウンタおよび受信ワード  カウンタが リセッ ト され

ます。 MGT がリ ンク され安定したら  BERT カウンタを リセッ ト してください。

[TX Settings]

このセクシ ョ ンでは、 MGT の送信側の情報を表示して制御します。

[TX User Clock Source]

ト ランシーバの TXOU では、自己の TX ロジッ クだけでなく、その他のト ランシーバの TX ロジッ

クにも ク ロ ッ クを供給できます。この情報は、コアの生成時に保存されて、[TX User Clock Source]
に表示されます。

[TX PMA Clock Select]

TX の PLL にクロ ッ クを供給する  MGTCLK を選択します。 デバイスの両側でそれぞれ MGTCLK
コンポーネン ト を 2 つのみ使用できるため、 こ こでも選択肢は 2 つのみになり ます。

[TX Data Pattern]

どのパターンを送信するかを選択します。 基本パターン ジェネレータでは、 1/2X クロ ッ ク、 1/10X
ク ロ ッ ク、 1/20X クロ ッ ク、 および 7 Bit PRBS (X7 + X6 + 1 多項式を使用) を選択できます。 フル

パターン ジェネレータにはすべての基本パターンに加えて、9、11、15、20、23、29、および 31 ビッ

トの PRBS パターン、代替 PRBS 7 ビッ ト  (X7 + X + 1 多項式を使用)、アイ ドル (K28.5 ±) パター
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ン、およびフレーム付きカウンタ  パターンが含まれます。基本パターン ジェネレータ とフル パター

ン ジェネレータの選択は、 コアの生成時に決定します。

[TX Encoding]

MGT の [Fabric Width] が 16 または 32 ビッ ト のいずれかで、MGT がリ ンク されている場合、8B/10B
エンコード /デコード を使用できます。 使用する場合は [8B/10B] を選択します。

[Invert TX Polarity]

MGT には、 送受信したデータすべての極性を制御するポートがあ り ます。 MGT の TX 側の極性を

反転するには、 このチェッ ク  ボッ クスをオンにします。

[Inject TX Error]

[Inject TX] をク リ ッ クすると 、 1 つの送信ワード に含まれる  1 ビッ ト のみの極性が反転されます。

MGT ト ランスミ ッ タに接続されている  MGT レシーバでは、1 ビッ ト  エラーが検出されるはずです。

[RX Settings]

このセクシ ョ ンでは、 MGT の受信側の情報を表示して制御します。

[RX User Clock Source]

RX ユーザー ク ロ ッ クは、MGT の RXRECCLK1 ピンで常に駆動されます。 このク ロ ッ クは、受信

データのリカバリ  ク ロ ッ クです。 

[RX PMA Clock Select]

RX の PLL にクロッ クを供給する  MGTCLK を選択します。デバイスの両側ではそれぞれ MGTCLK
コンポーネント が 2 つのみ使用できるため、 こ こでも選択肢は 2 つのみになり ます。

[RX Data Pattern]

レシーバ (RX) で受信して確認するパターンを制御します。 基本パターン ジェネレータでは、 1/2X
ク ロ ッ ク、 1/10X ク ロ ッ ク、 1/20X クロ ッ ク、および 7 Bit PRBS (X7 + X6 + 1 多項式を使用) を選

択できます。 フル パターン ジェネレータにはすべての基本パターンに加えて、 9、 11、 15、 20、 23、
29、 および 31 ビッ トの PRBS パターン、 代替 PRBS 7 ビッ ト  (X7 + X + 1 多項式を使用)、 アイ ド

ル (K28.5 ±) パターン、およびフレーム付きカウンタ  パターンが含まれます。基本パターン ジェネ

レータ とフル パターン ジェネレータの選択は、 コアの生成時に決定します。

[RX Decoding]

MGT の [Fabric Width] が 16 または 32 ビッ トのいずれかで、 MGT がリ ンク されている場合、

8B/10B エンコード /デコードを使用できます。 使用する場合は、 [8B/10B] を選択します。

[Invert RX Polarity]

MGT には、送受信したデータすべての極性を制御するポートがあ り ます。 RX 側の極性を反転する

には、 このチェッ ク  ボッ クスをオンにします。

IBERT のツールバーおよびメニュー

[Reset All]

IBERT コアのすべてのチャネルを リセッ トするには、[IBERT] → [Reset All] をク リ ッ クするか、ま

たはツールバーの [Reset All] をク リ ッ ク します。
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[IBERT Console Options]

[IBERT Console Options] ダイアログ ボッ クスを開くには、 [IBERT] → [IBERT Console Options]
をク リ ッ クするか、 またはツールバーの [IBERT Console Options] をク リ ッ ク します。

[JTAG Scan Rate] および [Scan Now]

ツールバーの [JTAG Scan Rate] および [IBERT] → [JTAG Scan Rate] メニューをク リ ッ クする と、

Analyzer ソフ ト ウェアで IBERT コアのステータス情報を確認する頻度を選択できます。 デフォル

トは [1 s] ですが、[250 ms]、[500 ms]、[2 s]、[5 s]、または [Manual Scan] も選択できます。 [Manual
Scan] を選択した場合、[IBERT] → [Scan Now] またはツールバーの [Scan Now] ([S!]) をク リ ッ ク

する と、 IBERT コアのクエリ を実行できます。

[IBERT Console Options] ダイアログ ボックス

[IBERT Cosole Options] ダイアログ ボッ クスを開くには、[IBERT] → [IBERT Console Options] を
ク リ ッ クするか、 ツールバーで [IBERT Console Options] をク リ ッ ク します。

[MGT On/Off Options]

各 MGT 列の横にあるチェッ ク  ボッ クスをオフにする と、非表示にできます。 アイ ドル チャネルが

このリ ス トに表示されますが、 イネーブルにするこ とはできません。 [All] をク リ ッ クする とすべて

の MGT がオンになり、 [None] をク リ ッ クする とすべての MGT がオフになり ます。

[Parameter On/Off Options]

各行はその横にあるチェッ ク  ボッ クスをオン/オフにして表示/非表示にできます。 [All] をク リ ッ ク

する とすべてのパラ メータがオンになり、[None] をク リ ッ クする とすべてのパラ メータがオフにな

り ます。 特定のセクシ ョ ンのすべてのパラ メータをディ スエーブルにするには、 セクシ ョ ン タイ ト

ルの横のチェッ ク  ボッ クスをオフにします。 これで、 そのセクシ ョ ンに含まれるすべてのパラ メー

タがオフになり ます。 特定のセクシ ョ ンのすべてのパラ メータをイネーブルにするには、 そのセク

シ ョ ン タイ トルの横のチェッ ク  ボッ クスを一度オフにしてから、 オンにします。

Virtex-5 FPGA GTP および GTX ト ランシーバ用 IBERT コンソール ウィン
ドウ

Virtex-5 FPGA GTP および GTX ト ランシーバ用の IBERT コアのコンソールを開くには、

[Window] → [New Unit]  → [Windows] でコアを選択します。 このコア ユニッ ト向けのダイアログ

ボッ クスが表示されるので [IBERT Console] を選択します。 このダイアログ ボッ クスからはウ ィ

ンド ウを閉じるこ とはできません。

プロジェク ト  ツ リーの [IBERT Console] をダブルク リ ッ クするか、または [IBERT Console] を右ク

リ ッ ク して [Open IBERT Console] をク リ ッ ク してもコンソール ウ ィンド ウを表示できます。

Virtex-5 FPGA GTP および GTX 用の IBERT コンソール ウ ィンド ウは、「[Clock Settings] パネル」、

129 ページの 「[MGT/BERT Settings] パネル」、 および 132 ページの 「[Sweep Test Settings] パネ

ル」 で構成されています。

[Clock Settings] パネル

このパネルには、 複数の列と行を含むテーブルが表示されます。 各列では特定のア ク テ ィ ブ

GTP_DUAL/GTX_DUAL が表示され、 各行では特定の GTP_DUAL/GTX_DUAL 制御またはス

テータス設定が表示されます。
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[CLKP/CLKN Settings]

[CLKP/CLKN Settings] では、特定の GTP_DUAL/GTX_DUAL のリ ファレンス  クロ ッ ク  ピンを表

示して制御します。

[GTP_DUAL/GTX_DUAL Alias] には、 GTP_DUAL/GTX_DUAL の MGT 番号に初期設定されて

いますが、 新しい値を入力できます。 

[GTP_DUAL/GTX_DUAL Location] には、デバイスに含まれる  GTP_DUAL/GTX_DUAL の X/Y
座標が表示されます。

[GTP_DUAL/GTX_DUAL Power] では、 GTP_DUAL/GTX_DUAL のリ ファレンス  ク ロ ッ ク回路

の電源を制御します。 GTP_DUAL/GTX_DUAL 機能を使用するには、この電源制御を [On] にする

必要があ り ます。 また、この電源制御はリ ファレンス  クロ ッ ク  ソースまたは中間の通過タイルと し

て リ ファレンス  クロ ッ クの共有に関わっているいずれの GTP_DUAL/GTX_DUAL でも  [On] にす

る必要があ り ます。

[CLKP/CLKN Coupling] では、 GTP_DUAL/GTX_DUAL リ ファレンス クロ ッ ク  ピンで使用され

るカップ リ ングのタイプを制御します。 有効な設定は [AC] または [DC] です。 

[CLKP/CLKN Freq (MHz)] には、特定の GTP_DUAL/GTX_DUAL コンポーネン トの CLKP およ

び CLKN ピンに接続されている リ ファレンス  クロ ッ ク  ソースの周波数が表示されます。 デフォル

ト値は、IBERT コアの生成時に指定された リ ファレンス  ク ロ ッ クの周波数になり ます。 周波数を変

更するには、 セルに別の値を入力します。

[REFCLK Settings]

[REFCLK Settings] では、 特定の GTP_DUAL/GTX_DUAL のリ ファレンス  ク ロ ッ ク入力ソース

およびその他の関連パラ メータを表示して、 制御します。

[REFCLK Input] では、 システムに含まれている有効な GTP_DUAL/GTX_DUAL から特定の

GTP_DUAL/GTX_DUAL のリ ファレンス  ク ロ ッ ク  ソースを選択できます。 リ ファレンス  ク ロ ッ

ク入力を選択する と き、 次の規則に従う必要があ り ます。

1. リ ファ レンス  ク ロッ ク  ソースは、デスティ ネーショ ン  GTP_DUAL/GTX_DUAL から上下タイ

ル 3 個以内の  GTP_DUAL/GTX_DUAL にする必要があり ます。 たと えば、GTP_DUAL_X0Y5
のリ ファレンス  ク ロッ クは、3 タイル離れている  GTP_DUAL_X0Y2 に設定できても 、4 タイル

離れている  GTP_DUAL_X0Y1 には設定できません。

2. リ ファレンス  ク ロ ッ ク  ソース  GTP_DUAL/GTX_DUAL、 デスティネーシ ョ ン GTP_DUAL/
GTX_DUAL、およびそれらの間のすべての GTP_DUAL/GTX_DUAL に同じ  REFCLK 入力を

選択する必要があ り ます。 たとえば、GTP_DUAL_X0Y2 で GTP_DUAL_X0Y0 を リ ファレン

ス  クロ ッ ク入力ソース と して使用するには、GTP_DUAL_X0Y1 でも  GTP_DUAL_X0Y0 を リ

ファレンス  ク ロ ッ ク入力ソース と して使用する必要があ り ます。

3. リ ファレンス  ク ロ ッ ク  ソース  GTP_DUAL/GTX_DUAL、 デスティネーシ ョ ン GTP_DUAL/
GTX_DUAL、 およびその間にあるすべての GTP_DUAL/GTX_DUAL で [GTP_DUAL/
GTX_DUAL Power] を [On] にする必要があ り ます。

[GTP_DUAL/GTX_DUAL PLL Status] では、 GTP_DUAL/GTX_DUAL コンポーネン トに含まれ

る  PLL のロ ッ ク  ステータスが表示されます。 このステータス  インジケータの有効なステートは、

LOCKED (緑色) または NOT LOCKED (赤色) です。

[REFCLKOUT Freq (MHz)] では、 GTP_DUAL/GTX_DUAL の REFCLKOUT ポートのク ロ ッ ク

周波数の概算値が MHz で表示されます。 このステータスの正確度は、コンパイル時に指定されたシ

ステム ク ロ ッ クの周波数によって異なり ます。
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[CH0 Clock Status]

[CH0 Clock Status] : 特定の GTP_DUAL/GTX_DUAL のチャネル 0 のさまざまな TX および RX
ク ロ ッ ク出力のステータスが表示されます。

[TXOUTCLK0 DCM Status] : GTP_DUAL/GTX_DUAL の TXOUTCLK0 ポートに接続されてい

る  DCM のロッ ク  ステータスが表示されます。 このステータス  インジケータの有効なステートは、

LOCKED (緑色) または NOT LOCKED (赤色) です。

[TXOUTCLK0 Freq (MHz)] : GTP_DUAL/GTX_DUAL の TXOUTCLK0 ポートのク ロ ッ ク周波

数の概算値が MHz で表示されます。 このステータスの正確度は、コンパイル時に指定されたシステ

ム ク ロ ッ クの周波数によって異なり ます。

[TXUSRCLK0 Freq (MHz)] : GTP_DUAL/GTX_DUAL の TXUSRCLK0 ポートのク ロ ッ ク周波数

の概算値が MHz で表示されます。 このステータスの正確度は、コンパイル時に指定されたシステム

ク ロ ッ クの周波数によって異なり ます。

[TXUSRCLK20 Freq (MHz)] : GTP_DUAL/GTX_DUAL の TXUSRCLK20 ポートのク ロ ッ ク周

波数の概算値が MHz で表示されます。 このステータスの正確度は、コンパイル時に指定されたシス

テム ク ロ ッ クの周波数によって異なり ます。

[RXRECCLK0 DCM Status] : GTP_DUAL/GTX_DUAL の RXRECCLK0 ポートに接続されてい

る  DCM のロッ ク  ステータスが表示されます。 このステータス  インジケータの有効なステートは、

LOCKED (緑色) または NOT LOCKED (赤色) です。

[RXRECCLK0 Freq (MHz)] : GTP_DUAL/GTX_DUAL の RXRECCLK0 ポートのク ロ ッ ク周波

数の概算値が MHz で表示されます。 このステータスの正確度は、コンパイル時に指定されたシステ

ム ク ロ ッ クの周波数によって異なり ます。

[RXUSRCLK0 Freq (MHz)] : GTP_DUAL/GTX_DUAL の RXUSRCLK0 ポートのク ロ ッ ク周波

数の概算値が MHz で表示されます。 このステータスの正確度は、コンパイル時に指定されたシステ

ム ク ロ ッ クの周波数によって異なり ます。

[RXUSRCLK20 Freq (MHz)] : GTP_DUAL/GTX_DUAL の RXUSRCLK20 ポートのク ロ ッ ク周

波数の概算値が MHz で表示されます。 このステータスの正確度は、コンパイル時に指定されたシス

テム ク ロ ッ クの周波数によって異なり ます。

[CH1 Clock Status]

[CH1 Clock Status] : 特定の GTP_DUAL/GTX_DUAL のチャネル 1 のさまざまな RX ク ロ ッ ク出

力のステータスが表示されます。

[RXRECCLK1 DCM Status] : GTP_DUAL/GTX_DUAL の RXRECCLK1 ポートに接続されてい

る  DCM のロッ ク  ステータスが表示されます。 このステータス  インジケータの有効なステートは、

LOCKED (緑色) または NOT LOCKED (赤色) です。

[RXRECCLK1 Freq (MHz)] : GTP_DUAL/GTX_DUAL の RXRECCLK1 ポートのク ロ ッ ク周波

数の概算値が MHz で表示されます。 このステータスの正確度は、コンパイル時に指定されたシステ

ム ク ロ ッ クの周波数によって異なり ます。

[RXUSRCLK1 Freq (MHz)] : GTP_DUAL/GTX_DUAL の RXUSRCLK1 ポートのク ロ ッ ク周波

数の概算値が MHz で表示されます。 このステータスの正確度は、コンパイル時に指定されたシステ

ム ク ロ ッ クの周波数によって異なり ます。

[RXUSRCLK21 Freq (MHz)] : GTP_DUAL/GTX_DUAL の RXUSRCLK21 ポートのク ロ ッ ク周

波数の概算値が MHz で表示されます。 このステータスの正確度は、コンパイル時に指定されたシス

テム ク ロ ッ クの周波数によって異なり ます。
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[MGT/BERT Settings] パネル

このパネルには、 複数の列と行を含むテーブルが表示されます。 各列では、 特定のアクテ ィブな

GTP/GTX ト ランシーバ チャネルが表示されます。各行では特定の GTP/GTX または GTP_DUAL/
GTX_DUAL 制御またはステータス設定が表示されます。

[MGT Settings]

[MGT Settings] では、特定の GTP_DUAL/GTX_DUAL チャネルのさまざまな設定を表示して制御

します。

[MGT Alias] は、GTP/GTX ト ランシーバ チャネルの MGT 番号およびチャネル番号に初期設定され

ていますが、 新しい値を入力できます。 

[GTP_DUAL/GTX_DUAL Location] には、デバイスに含まれる  GTP_DUAL/GTX_DUAL の X/Y
座標が表示されます。

[MGT Link Status] には、 特定の GTP/GTX ト ランシーバ チャネルのレシーバに接続されている リ

ンク検出ロジッ クのステータスが表示されます。 このステータス  インジケータの有効なステート

は、 LOCKED (緑色) または NOT LOCKED (赤色) です。

[REFCLKOUT PLL Status] には、GTP_DUAL/GTX_DUAL の REFCLKOUT ポートに接続されて

いる  PLL のロ ッ ク  ステータスが表示されます。このステータス  インジケータの有効なステートは、

LOCKED (緑色) または NOT LOCKED (赤色) です。

[Loopback Mode] では、特定の GTP/GTX ト ランシーバ チャネルのループバッ ク  モードを制御しま

す。 次にループバッ ク  モードの選択肢を示します。

• [None] : フ ィードバッ ク  パスは使用されません。

• [Near-End PCS] : 回路は近端 GTP/GTX ト ランシーバ チャネルに完全に含まれています。 TX
ファブ リ ッ ク  インターフェースから開始して、PCS を通過し、GTP/GTX ト ランシーバ チャネ

ルの PMA 側を通過せずに RX ファブ リ ッ クに戻り ます。

• [Near-End PMA] : 回路は近端 GTP/GTX ト ランシーバ チャネルに完全に含まれています。 TX
ファブ リ ッ ク  インターフェイスから開始して、 PCS、PMA、PCS を通過し、RX ファブ リ ッ ク

インターフェイスに戻り ます。

• [Far-End PMA] : 回路は、 テス ト装置やほかのデバイスの一部などの外部チャネルのエンドポ

イン トから始ま り、GTP/GTX ト ランシーバ チャネルを通過して元に戻り ます。 この GTP/GTX
ト ランシーバ ループバッ ク  モードでは、信号が RX ピンに入力され、PMA 回路を通過して TX
ピンに戻り ます。

• [Far-End PCS] : 回路は、テス ト装置やほかのデバイスの一部などの外部チャネルのエンドポイ

ン トから始ま り、 GTP/GTX ト ランシーバ チャネルを通過して元に戻り ます。 この GTP/GTX
ト ランシーバ ループバッ ク  モードでは、信号が RX ピンに入力され、 PMA、 PCS、 PMA を通

過して TX ピンに戻り ます。

• [Far-End Fabric] : 回路は、テス ト装置やほかのデバイスの一部などの外部チャネルのエンドポ

イン トから始ま り、GTP/GTX ト ランシーバ チャネルおよび関連するファブ リ ッ ク  ロジッ クを

通過して元に戻り ます。 この GTP/GTX ト ランシーバ ループバッ ク  モードでは、信号が RX ピ
ンに入力され、PMA、PCS、 ワード数が少ないファブリ ッ ク  ベースの FIFO、PCS、PMA を通

過して TX ピンに戻り ます。

[Channel Reset] ボタンをク リ ッ クする と、内部 PMA および PCS 回路に加え関連するファブ リ ッ ク

インターフェイスがク リ ア、 リセッ ト され、GTP/GTX ト ランシーバ チャネルがリセッ ト されます。
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MGT のすべての属性をダイナミ ッ ク  リ コンフ ィギュレーシ ョ ン ポート  (DRP) から表示して変更

できます。 [Edit DRP] ボタンをク リ ッ クする と、その GTP_DUAL/GTX_DUAL の [Edit DRP] ダイ

アログ ボッ クスが表示されます。

[By Attribute Name] タブの [Attribute Name] から表示または変更する属性を選択します。 属性はア

ルファベッ ト順に表示されます。 属性を選択する と、その時点の DRP が読み出され、その属性の現

在の値が [Current Value] に表示されます。 ダイアログ ボッ クス下部にあるラジオ ボタンでは、2 つ
の値フィールドの基数が示されています。 新しい値を入力するには、 基数タイプ ([Binary Value]、
[Hex Value]、[UCF Value]) を選択してから  [New Value] にテキス ト を入力して、[Apply] をク リ ッ

ク します。

特定の属性ではなく特定の DRP アドレスを変更する場合は、[By DRP Address] タブをク リ ッ ク し

ます。 このタブは、 上級ユーザー向けです。 [Address] から変更するアドレスを選択します。 ラジオ

ボタンの選択に従い現在の値が 2 進数または 16 進数で表示されます。 値を変更するには、 [New
Value] に新しい値を入力して、 [Apply] をク リ ッ ク します。 ダイアログ ボッ クスを閉じるには

[Close] をク リ ッ ク します。

[Show Settings] をク リ ッ クする と、 関連する  GTP/GTX ト ランシーバ チャネル ポートの現在の設

定および DRP 属性設定が表示されます。 [Export Settings] をク リ ッ クする と、これらの設定がファ

イルにエクスポート されます。

[TX/RX Termination] では、GTP チャネルの終端を選択します。 選択できる設定は [50W] と  [75W]
です。 この設定は、 Virtex-5 LXT/SXT ファ ミ リの GTP ト ランシーバでのみ使用できます。 Virtex-
5 FXT ファ ミ リの GTX ト ランシーバでは使用できません。

[Edit Line Rate] ボタンをク リ ッ クすると 、GTP_DUAL/GTX_DUAL のライン  レート およびさまざま

な PLL 設定に関連しているパラメ ータを指定できます。 ライン  レート を編集すると 、 GTP_DUAL/
GTX_DUAL コンポーネント 内の両チャネルにその設定が適用されます。[ GTP_DUAL/GTX_DUAL]
ボッ クスは、GTP_DUAL/GTX_DUAL コンポーネン ト を選択するのに使用します。[REFCLK Input
Freq (MHz)] は読み取り専用フ ィールドで、 入力リ ファレンス  クロ ッ クの周波数が表示されます。

[Internal Data Width] は、 GTP_DUAL コンポーネン トでは [10 bit]、 GTX_DUAL コンポーネン ト

では [20 bit] に固定されています。 [Target Line Rate (Mb/s)] には、REFCLK 入力周波数から派生し

た有効なライン レート と関連する  PLL 設定 ([FB]、[REF]、および [DIVSEL]) がすべて表示されま

す。 [PLL VCO Freq (MHz)] には、 PLL の電圧制御オシレータ  (VCO) の出力周波数が表示されま

す。 [Edit Line Rate] ウ ィンド ウ下部には、GTP_DUAL/GTX_DUAL のライン レートに関するすべ

ての属性が表示されます。

[Coding] では、GTP/GTX ト ランシーバ チャネルの TX 側および RX 側それぞれで使用されるエン

コードおよびデコードのタイプを選択します。 選択肢は、 [None] および [8B/10B] です。

メモ : 8B/10B エンコード /デコードがイネーブルの場合は、フレーム付きカウンタ  パターンおよび

アイ ドル パターンのみを使用できます。

[TX Settings]

[TX Settings] では、 特定の GTP/GTX ト ラ ンシーバ チャネルのさまざまな  TX 設定を表示して制御

します。

[TXOUTCLK0 DCM Status] には、 GTP_DUAL/GTX_DUAL の TXOUTCLK0 ポートに接続され

ている  DCM のロッ ク  ステータスが示されます。 このステータス  インジケータの有効なステート

は、 LOCKED (緑色) または NOT LOCKED (赤色) です。

[Invert TX Polarity] では、 GTP/GTX ト ランシーバ チャネルの TX ピンから送信されたデータの極

性を制御します。 GTP/GTX ト ランシーバの TX 側の極性を反転するには、[Invert TX Polarity] をオ

ンにします。
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[Inject TX Bit Error] をク リ ッ クする と、1 つの送信ワードに含まれる  1 ビッ トの極性が反転されま

す。 この ト ランス ミ ッ タに接続されているチャネルのレシーバ エンドポイン トでは、 1 ビッ ト  エ
ラーが検出されるはずです。

[TX Diff Boost] では、TX_DIFF_BOOST 属性のステータスを制御します。 この属性は、GTP/GTX
ト ランシーバ チャネルの [TX Diff Output Swing] (TXDIFFCTRL および TXBUFDIFFCTRL ポー

トで制御される ト ランス ミ ッ タの差動出力幅と しても知られる) および [TX Pre-Emphasis]
(TXPREEMPHASIS ポートで制御される ト ランス ミ ッ タのプリエンファシス と しても知られる)
ポート設定を向上させるために使用します。 [TX Diff Boost] は、 Virtex-5 LXT/SXT ファ ミ リの

GTP ト ランシーバでのみ使用できます。 Virtex-5 FXT ファ ミ リの GTX ト ランシーバでは使用でき

ません。 これらの設定で値の有効な組み合わせは、『Virtex-5 FPGA RocketIO GTP Transceiver User
Guide』 [251 ページのリ ファレンス  4 を参照] または 『Virtex-5 FPGA RocketIO GTX Transceiver
User Guide』 [251 ページのリ ファレンス  5 を参照] を参照して ください。

[RX Settings]

[RX Settings] では、特定の GTP/GTX ト ランシーバ チャネルのさまざまな RX 設定を表示して制御

します。

[RXOUTCLK DCM Status] では、GTP/GTX ト ランシーバ チャネルの RXOUTCLK ポートに接続

されている  DCM のロッ ク  ステータスが表示されます。 このステータス  インジケータの有効なス

テートは、 LOCKED (緑色) または NOT LOCKED (赤色) です。

[Invert RX Polarity] では、GTP/GTX チャネルの RX ピンから受信したデータの極性を制御します。

GTP/GTX の RX 側の極性を反転するには、 [Invert RX Polarity] をオンにします。

[RX Coupling] および [RX Termination Voltage] を共に使用して GTP/GTX チャネル レシーバの

カップ リ ングおよび終端ネッ ト ワークを制御します。 これらの設定で値の有効な組み合わせは、

『Virtex-5 FPGA RocketIO GTP Transceiver User Guide』 [251 ページのリ ファレンス  4 を参照] また

は[251 ページのリ ファレンス  5 を参照] 『Virtex-5 FPGA RocketIO GTX Transceiver User Guide』
を参照してください。

[Enable RX EQ] は、 GTP/GTX チャネルのレシーバのイコライゼーシ ョ ンをイネーブルにします。

レシーバのイコライゼーシ ョ ンをイネーブルにする と、[RX EQ WB/HP Ratio] および [RX EQ HP
Pole Loc] を使用して、 GTP/GTX チャネル レシーバの広帯域/ハイ  パス  フ ィルタ率とハイ  パス

フ ィルタの極位置を制御できます。 これらの設定で値の有効な組み合わせは、 『Virtex-5 FPGA
RocketIO GTP Transceiver User Guide』 [251 ページのリ ファレンス  4 を参照]または[251 ページの

リ ファレンス 5 を参照] 『Virtex-5 FPGA RocketIO GTX Transceiver User Guide』 を参照してくだ

さい。

[RX Sampling Point] スライダでは、 PMA_CDR_SCAN 属性を変更するこ とで ト ランシーバのク

ロ ッ ク  データ  リ カバリ  (CDR) ユニッ トの水平サンプリ ング ポイン ト を制御します。 スライダ制御

の整数値は、 現在の設定が表示され、 0 ～ 127 の値を指定できます。 0 は UI (ユニッ ト  インターバ

ル) の最も左のサンプル位置、127 は UI の最も右のサンプル位置を意味します。 UI の位置は、スラ

イダ制御の右側にも表示されます。

メモ : [RX Sampling Point control] は、GTP_DUAL/GTX_DUAL チャネルの PLL_RXDIVSEL_OUT
属性が 1 に設定されていると きのみイネーブルにされます。

[BERT Settings]

[BERT Settings] では、特定の GTP/GTX ト ランシーバ チャネルのさまざまなビッ ト  エラー率設定

を表示し制御します。

[TX/RX Data Pattern] では、 ト ランス ミ ッ タのパターン ジェネレータおよびレシーバのパターン

チェッカで使用するデータ  パターンを選択します。 使用できるパターン タイプは、IBERT コアの生
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成中にイネーブルにされるパターンによって異なり ますが、 PRBS 7 ビッ ト  (X7 + X6 + 1)、 代替

PRBS 7 ビッ ト  (X7 + X + 1)、 PRBS 9 ビッ ト、 PRBS 11 ビッ ト 、 PRBS 15 ビッ ト、 PRBS 20 ビッ

ト 、 PRBS 23 ビッ ト、 PRBS 29 ビッ ト 、 PRBS 31 ビッ ト、 ユーザー パターン (クロ ッ ク  パターン

を含む、任意の 20 ビッ ト  データ  パターンの生成に使用可能)、 フレーム付きカウンタ、およびアイ

ドル パターンが含まれます。

メモ : 8B/10B エンコード /デコードがイネーブルの場合は、フレーム付きカウンタ  パターンおよび

アイ ドル パターンのみを使用できます。

[RX Bit Error Ratio] には、GTP/GTX ト ランシーバ チャネルに対して算出されたビッ ト  エラー率が

含まれています。 この値は指数で表現されます。 たとえば、1.000E-12 は 1 兆ビッ ト受信するたびに

1 ビッ ト  エラーが発生するこ とを意味します。

[RX Line Rate] には、GTP/GTX ト ランシーバ チャネル向けに算出されたライン レートが表示され

ます。デザインの時間を計測するのにシステム クロ ッ クが使用されるため、不正確または不安定な

システム ク ロ ッ クを使用する と、この値が不正になったり または変動します。リ ンクがない場合は、

[N/A] と表示されます。

[RX Received Bit Count] には、受信したビッ ト数の総計が示されています。このカウン トは、[BERT
Reset] をク リ ッ ク したと きに リセッ ト されます。

[RX Bit Error Count] には、検出されたビッ ト  エラー数の総計が示されています。このカウン トは、

[BERT Reset] をク リ ッ ク したと きにリセッ ト されます。

[BERT Reset] をク リ ッ クする と、ビッ ト  エラー カウンタおよび受信ビッ ト  カウンタが リセッ ト さ

れます。 GTP/GTX ト ランシーバ チャネルがリ ンク され安定したら、 BERT カウンタを リセッ ト し

てください。

[Sweep Test Settings] パネル

このパネルでは、 Virtex-5 FPGA GTP および GTX ト ランシーバのさまざまな設定をスイープする

チャネル テス ト を設定します。 この機能は、Virtex-4 FPGA FX ト ランシーバでは使用できません。

TX および RX 設定は、同じ ト ランシーバ向けです。 TX および RX の両方の設定のスイープは、 ト

ランシーバが近端または外部ループバッ ク  モードのいずれかに設定されている と きのみ機能しま

す。 RX パラ メータのスイープは、リ ンクの対応する  TX エンドポイン トが別のデバイスまたは同じ

デバイスに含まれる別のト ランシーバに含まれる と きのみ実行できます。

このパネルは [Sweep Test Setup] および [Sweep Test Results] サブパネルの 2 つのセクシ ョ ンから

構成されています。

[Sweep Test Setup]

[Sweep Test Setup] では、 スイープ対象、 スイープ テス ト結果ファイルの設定、 およびスイープ実

行時間を設定します。

スイープ パラメータの設定

次に、 スイープに使用する ト ランシーバのパラ メータを示します。

• [TX Diff Boost] (GTP のみ)

• [TX Diff Output Swing]

• [TX Pre-Emphasis]

• [RX EQ Enable]

• [RX EQ WB/HP Ratio]

• [RX EQ HP Pole Loc]
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• [RX Sampling Point]

スイープ パラ メータは、 次のいずれかの方法で初期化できます。

• [Clear All Parameters] をク リ ッ ク してすべてのパラ メータをク リ アします。 

• [Set Parameters to Current Values] をク リ ッ ク して、 [MGT/BERT Settings] パネルの現在の値

にパラ メータを設定します。

[Sweet Parameter] 表のパラ メータの順序は、パラ メータのスイープ順序を示しています。 表上部の

パラ メータの値は、表下部のパラ メータに比べスイープされる頻度が低くなり ます。 つま り、表上部

のパラ メータはスイープ アルゴ リズムの外側ループにあ り、表下部のパラ メータはスイープ アルゴ

リ ズムの内側ループにある という こ とです。 表のパラ メータの順序は変更できません。 

各パラ メータで開始値と終了値を設定する必要があ り ます。 パラ メータの順序は変更できません。

開始値を選択する と、 その値に対して有効な終了値が自動的に表示されます。 パラ メータでスイー

プの設定を希望しない場合は、開始値と終了値を同じ値にします。 [Sweep Value Count] 列では、特

定のパラ メータでスイープされる値の数が示されます。 すべてのスイープ パラ メータに有効な開始

値と終了値が設定される と、 スイープ実行回数が [Total Iterations] に表示されます。

スイープ テスト結果ファイルの設定

スイープテス トの結果は、 [Sweep Test Status] パネルに表示されます。 またスイープ テス ト結果

ファイルに書き出すこ と もできます。 [Sweep Test Result File Settings] をク リ ッ クする と、ダイアロ

グ ボッ クスが表示されます。

このダイアログ ボッ クスでは、ファ イルの保存場所と各ファイルに含めるスイープ実行回数を設定

できます。 スイープ実行回数がファイルの制限を越える場合は、 最初の結果ファイルと同じディ レ

ク ト リにベース ファ イル名の開始実行番号が付けられた複数のファイルが作成されます。 

スイープ テスト結果

スイープ テス ト を設定したら、 [Start] をク リ ッ ク してテス ト を開始します。 ク リ ッ ク した後は、 ス

イープ パラ メータ表がディ スエーブルになりテス トが実行されます。

スイープ テス トの実行の過程で現在のスイープ結果ファイル、 現在の実行回数、経過時間、および

概算残り時間ステータスが表示されます。 スイープ結果は、 画面下のテキス ト  エリアに表示されま

す。 スイープ テス トは [Pause] をク リ ッ ク して一時停止したり、[Reset] をク リ ッ ク して完全に停止

するこ とができます。

IBERT のツールバーおよびメニュー

[Reset All]

IBERT コアのすべてのチャネルを リセッ トするには、 [IBERT_V5GTP/GTX] → [Reset All] をク

リ ッ クするか、 またはツールバーの [Reset All] をク リ ッ ク します。

[JTAG Scan Rate] および [Scan Now]

ツールバーの [JTAG Scan Rate] および [IBERT_V5GTP/GTX] → [JTAG Scan Rate] メニューをク

リ ッ クする と、 Analyzer ソフ ト ウェアで IBERT コアのステータス情報を確認する頻度を選択でき

ます。 デフォルトは [1 s] ですが、 [250 ms]、 [500 ms]、 [2 s]、 [5 s]、 または [Manual Scan] を選択

できます。 [Manual Scan] を選択した場合、[IBERT_V5GTP/GTX] → [Scan Now] またはツールバー

の [Scan Now] ([S!]) をク リ ッ クする と、 IBERT コアのクエ リ をすぐに実行できます。
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Virtex-5 FPGA GTX ト ランシーバ用 IBERT v2.0 コンソール ウィンドウ

Virtex-5 FPGA GTX ト ランシーバ用の IBERT v2.0 コアのコンソールを開くには、 [Window] →
[New Unit Windows] でコアを選択します。 このコア ユニッ ト向けのダイアログ ボッ クスが表示さ

れるので [IBERT V5 GTX Console] を選択します。 このダイアログ ボッ クスからはウ ィンド ウを閉

じるこ とはできません。

プロジェク ト  ツ リーの [IBERT V5 GTX Console] をダブルク リ ッ クするか、 または [IBERT V5
GTX Console] を右ク リ ッ ク して [Open IBERT V5 GTX Console] をク リ ッ ク してもコンソール

ウ ィンド ウを表示できます。

Virtex-5 FPGA GTX ト ランシーバ用 IBERT v2.0 コンソール ウィ ンド ウは、次から構成されています。 

• [MGT/BERT Settings] パネル

• [DRP Settings] パネル

• [Port Settings] パネル

• [Sweep Test Settings] パネル

• IBERT v2.0 Virtex-5 FPGA GTX ト ランシーバのツールバーおよびメニュー オプシ ョ ン

[MGT/BERT Settings] パネル

このパネルには、複数の列と行を含むテーブルが表示されます。各列では、特定のアクティブな GTX
ト ランシーバが表示されます。 各行では特定の制御またはステータス設定が表示されます。

[MGT Settings]

[MGT Alias] は、GTX ト ランシーバ MGT 番号に初期設定されていますが、新しい値を入力できます。

[Tile Location] では、 デバイスに含まれる  GTX ト ランシーバの X/Y 座標が表示されます。

[MGT Link Status] では、特定の GTX ト ランシーバ チャネルのレシーバに接続されている リ ンク検

出ロジッ クのステータスが表示されます。 チャネルがリ ンク されている場合は緑色で計測されたラ

イン レートが表示され、 リ ンク されていない場合は 「NOT LOCKED」 (赤色) と表示されます。

[Edit Line Rate] では、GTX ト ランシーバのライン レートおよびさまざまな PLL 設定に関連するパ

ラ メータを指定します。 REFCLK 周波数および内部 PLL 分周器設定に基づいて現在の設定が表示

されています。 ライン レート を変更する と きは、 MGT の TX および RX の両方に適用されます。

[MGT] では、GTX ト ランシーバ コンポーネン ト を選択します。  [REFCLK Input Freq (MHz)] は読

み取り専用フ ィールドで、 入力リ ファレンス  ク ロ ッ クの周波数が表示されます。 [Target Line Rate
(Mbps)] には、 REFCLK 入力周波数から派生した有効なライン レート と関連する  PLL 設定 ([FB]、
[REF]、 および [DIVSEL]) すべてが表示されます。 [Edit Line Rate] ウ ィンド ウ下部には、 GTX ト
ランシーバのライン レートに関するすべての属性が表示されます。

[PLL Status] には GTX ト ラ ンシーバに接続されている  PLL のロッ ク  ステータスが表示されます。

このステータス  インジケータの有効なステート は、 LOCKED (緑色) または NOT LOCKED (赤色)
です。

[Loopback Mode] では、 特定の GTX ト ランシーバ チャネルのループバッ ク  モードを制御します。

次にループバッ ク  モードの選択肢を示します。

• [None] : フ ィードバッ ク  パスは使用されません。

• [Near-End PCS] : 回路は近端 GTX ト ランシーバ チャネルに完全に含まれています。 TX ファ

ブ リ ッ ク  インターフェースから開始して、PCS を通過し、GTX ト ランシーバ チャネルの PMA
側を通過せずに RX ファブリ ッ クに戻り ます。
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• [Near-End PMA] : 回路は近端 GTX ト ランシーバ チャネルに完全に含まれています。 TX ファ

ブ リ ッ クから開始して、PCS、PMA、PCS を通過し、RX ファブ リ ッ ク  インターフェイスに戻

り ます。

• [Far-End PMA] : 回路は、外部テス ト装置やほかのデバイスの一部など、なんらかの外部チャネ

ルのエンドポイン トから始ま り、 GTX ト ランシーバ チャネルを通過して元に戻り ます。 この

GTX ト ランシーバ ループバッ ク  モードでは、信号が RX ピンに入力され、PMA 回路を通過し

て TX ピンに戻り ます。

• [Far-End PCS] : 回路は、外部テス ト装置やほかのデバイスの一部など、なんらかの外部チャネ

ルのエンドポイン トから始ま り、 GTX ト ランシーバ チャネルを通過して元に戻り ます。 この

GTX ループバッ ク  モードでは、信号が RX ピンに入力され、PMA、PCS、PMA を通過して TX
ピンに戻り ます。

[DUAL Reset] をク リ ッ クする と、 内部 PMA および PCS 回路に加え関連するファブリ ッ ク  イン

ターフェイスがク リ ア、 リセッ ト され、DUAL に含まれる  GTX ト ランシーバがリセッ ト されます。

[Channel Reset] をク リ ッ クする と、内部 PMA および PCS 回路に加え関連するファブ リ ッ ク  イン

ターフェイスがク リ ア、 リセッ ト され、 GTX ト ランシーバ チャネルがリセッ ト されます。

[TX Polarity Invert] では、 GTX ト ランシーバ チャネルの TX ピンから送信されたデータの極性を

制御します。 GTX ト ランシーバの TX 側の極性を反転するには、このチェッ ク  ボッ クスをオンにし

ます。

[TX Bit Error Inject] をク リ ッ クする と、1 つの送信ワードに含まれる  1 ビッ トの極性が反転されま

す。 この ト ランス ミ ッ タに接続されているチャネルのレシーバ エンドポイン トでは、 1 ビッ ト  エ
ラーが検出されるはずです。

[TX Diff Output Swing] では、ト ランス ミ ッ タの差動振幅を制御します。 値を変更する場合はボッ ク

スに入力します。

[TX Pre-Emphasis] では、送信信号のプリエンファシス量を制御します。 値を変更する場合はボッ ク

スに入力します。

[RX Polarity Invert] では、GTX チャネルの RX ピンから受信したデータの極性を制御します。 GTX
ト ランシーバの RX 側の極性を反転するには、 このチェッ ク  ボッ クスをオンにします。

[RX AC Coupling Enabled] では、 ビルト イン AC カップリ ング キャパシタをイネーブルにするか

ど うかを制御します。

[RX Termination Voltage] では、 RX 終端ネッ ト ワークで使用する電源を制御します。

[RX Equalization] では、 内部 RX イコラ イゼーシ ョ ン回路を制御します。 

[BERT Settings]

[TX Data Pattern] および [RX Data Pattern] は、 ト ランス ミ ッ タのパターン ジェネレータおよびレ

シーバのパターン チェッカで使用されるデータ  パターンを選択するのに使用します。 これらのパ

ターンには、 PRBS7、 15、 23、 31、 および Clk 2x、 10 x が含まれています。

[RX Bit Error Ratio] には、GTX ト ランシーバ チャネルに対して算出されたビッ ト  エラー率が含ま

れています。 この値は指数で表現されます。 たとえば、 1.000E-12 は 1 兆ビッ ト受信するたびに 1
ビッ ト  エラーが発生するこ とを意味します。

[RX Received Bit Cout] には、受信したビッ ト数の総計が示されています。 このカウン トは、[BERT
Reset] をク リ ッ ク したと きに リセッ ト されます。

[RX Bit Error Count] には、検出されたビッ ト  エラー数の総計が示されています。このカウン トは、

[BERT Reset] をク リ ッ ク したと きにリセッ ト されます。
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[BERT Reset] をク リ ッ クする と、ビッ ト  エラー カウンタおよび受信ビッ ト  カウンタが リセッ ト さ

れます。 GTX チャネルがリ ンク され安定したら  BERT カウンタを リセッ ト して ください。

[Clocking Settings]

[TX DCM Reset] では TXOUTCLK 出力を使用して TXUSRCLK および TXUSRCLK2 ク ロ ッ ク

を生成する  DCM を リセッ ト します。

[RX DCM Reset] では RXRECCLK 出力を使用して RXUSRCLK および RXUSRCLK2 ク ロ ッ ク

を生成する  DCM を リセッ ト します。

[TXUSRCLK Freq (MHz)] には、 GTX ト ランシーバの TXUSRCLK ポートのク ロ ッ ク周波数の概

算値が MHz で表示されます。 このステータスの正確度は、 コンパイル時に指定されたシステム ク
ロ ッ クの周波数によって異なり ます。

[XUSRCLK2 Freq (MHz)] には、GTX ト ランシーバの TXUSRCLK2 ポートのク ロ ッ ク周波数の概

算値が MHz で表示されます。 このステータスの正確度は、 コンパイル時に指定されたシステム ク
ロ ッ クの周波数によって異なり ます。

[RXUSRCLK Freq (MHz)] には、GTX ト ランシーバの RXUSRCLK ポートのク ロ ッ ク周波数の概

算値が MHz で表示されます。 このステータスの正確度は、 コンパイル時に指定されたシステム ク
ロ ッ クの周波数によって異なり ます。

[RXUSRCLK2 Freq (MHz)] には、GTX ト ランシーバの RXUSRCLK2 ポートのク ロ ッ ク周波数の

概算値が MHz で表示されます。 このステータスの正確度は、 コンパイル時に指定されたシステム

ク ロ ッ クの周波数によって異なり ます。

[DRP Settings] パネル

このパネルには、複数の列と行を含むテーブルが表示されます。各列では、特定のアクティブな GTX
ト ランシーバが表示されます。 各行では、 特定の DRP 属性またアドレスが表示されます。

パネル下部の [View By Attribute Name] をオンにする と、 すべての DRP 属性がアルファベッ ト順

で表示されます。 [Radix] では [Hex] (16 進数) または [Bin] (2 進数) のいずれかを選択できます。 値
を変更するには、テキス ト  フ ィールドをク リ ッ ク して新しい値を入力してから、Enter キーを押しま

す。 これで新しい値が MGT に反映されます。

パネル下部の [View By Address] がオンになっている と、 行アドレスが数字順に表示されます。

[Radix] では [Hex] (16 進数) または [Bin] (2 進数) のいずれかを選択できます。 値を変更するには、

テキス ト  フ ィールドをク リ ッ ク して新しい値を入力してから、 Enter キーを押します。 これで新し

い値が MGT に反映されます。

[Port Settings] パネル

このパネルには、複数の列と行を含むテーブルが表示されます。各列では、特定のアクティブな GTX
ト ランシーバが表示されます。 各行には、 特定の MGT ポートが表示されます。 一部のポートは

IBERT デザインでデータの送受信に使用されるため、すべてのポートが表示されるわけではあ り ま

せん。

[Radix] では、値の基数に [Hex] (16 進数) または [Bin] (2 進数) を選択できます。 一部のポートは読

み取り専用で編集できません。 これらのセルは、 ラベルのよ うに表示されます。 編集可能な表内の

ポートは、 テキス ト  フ ィールドのよ うに表示され、 カーソルを置く と新しい値が入力でき、 Enter
キーを押すとその値がすぐに反映されます。
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[Sweep Test Settings] パネル

このパネルは、さまざまな ト ランシーバ設定をスイープするチャネル テス ト を設定するのに使用し

ます。 TX および RX 設定は、 同じ  GTX ト ランシーバ向けです。 TX および RX の両方の設定のス

イープは、 ト ランシーバが近端または外部ループバッ ク  モードのいずれかに設定されている と きの

み機能します。 RX パラ メータのスイープは、リ ンクの対応する  TX エンドポイン トが別のデバイス

または同じデバイスに含まれる別のト ランシーバに含まれる と きのみ実行できます。

このパネルは、[Parameter Settings]、[Sampling Point Region]、[Test Controls]、および [Test Results]
セクシ ョ ンの 4 つのセクシ ョ ンから構成されています。

[Parameter Settings]

このセクシ ョ ンでは、 スイープ パラ メータを設定します。

次に、 スイープに使用できる  GTX ト ランシーバのパラ メータを示します。

• [TX Diff Swing]

• [TX Pre-Emphasis]

• [RX EQ]

• [DFETAP1]

• [DFETAP2]

これらのスイープ パラ メータは、 次のいずれかの方法で初期化できます。

• [Clear All Parameters] をク リ ッ ク して [Select] オプシ ョ ンのすべてのパラ メータをク リ アし

ます。

• [Set Parameters to Current Values] をク リ ッ ク して、 [MGT/BERT Settings] パネルの現在の値

にパラ メータを設定します。

[Sweet Parameter] 表のパラ メータの順序は、パラ メータのスイープ順序を示しています。 表上部の

パラ メータの値は、表下部のパラ メータに比べスイープされる頻度が低くなり ます。 つま り、表上部

のパラ メータはスイープ アルゴ リズムの外側ループにあ り、表下部のパラ メータはスイープ アルゴ

リ ズムの内側ループにある という こ とです。 

各パラ メータで開始値と終了値を設定する必要があ り ます。 パラ メータの順序は変更できません。

開始値を選択する と、 その値に対して有効な終了値が自動的に表示されます。 パラ メータでスイー

プの設定を希望しない場合は、 開始値と終了値を同じ値にします。

[Sweep Value Count] 列では、特定のパラ メータでスイープされる値の数が示されます。 すべてのス

イープ パラ メータに有効な開始値と終了値が設定される と、 スイープ実行回数が [Total Iterations]
に表示されます。

パラ メータを表に追加または削除するには、 [Add/Remove Parameters] をク リ ッ ク します。 ダイア

ログ ボッ クスが表示され、左側には使用可能なポート /属性すべて、右側にはスイープするパラ メー

タが表示されます。 スイープするパラ メータを追加するには、 左側のリ ス トからいずれかをク リ ッ

ク して、右方向 (>) ボタンをク リ ッ ク します。 スイープするパラ メータを削除するには、右側のリ ス

トからいずれかをク リ ッ ク して、 左方向 (<) ボタンをク リ ッ ク します。 パラ メータのスイープ順を

指定するには、 右側のリ ス トのいずれかをク リ ッ ク してから  [Up] または [Down] をク リ ッ ク しま

す。 スイープ属性およびその順序をデフォルトの設定に戻す場合は、 [Reset to Default] をク リ ッ ク

します。 [OK] をク リ ッ ク して設定を適用するか、 [Cancel] をク リ ッ ク して保存せずに終了します。
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[Sampling Point Region]

サンプリ ング ポイン トは、 アイ とサンプル間の水平ポイン トです。 左端の遷移領域を視覚化してか

ら、右端を視覚化します。 [RX Sampling Point] は、128 個の不連続のサンプリ ング位置の 1 つです。

このセクシ ョ ンでは、 サンプ リ ング領域の左端および右端を選択します。

[Test Controls]

スイープ テス ト を設定したら、 [Start] をク リ ッ ク してテス ト を開始します。 ク リ ッ ク した後は、 ス

イープ パラ メータ表がディ スエーブルになりテス トが実行されます。

スイープ テス トの実行の過程で現在のスイープ結果ファイル、 現在の実行回数、経過時間、および

概算残り時間ステータスが表示されます。 スイープ結果は、 画面下のテキス ト  エリアに表示されま

す。 スイープ テス トは [Pause] をク リ ッ ク して一時停止したり、[Reset] をク リ ッ ク して完全に停止

するこ とができます。 

スイープテス トの結果は、[Test Results] パネルに表示されます。またスイープ テス ト結果ファイル

に書き出すこ と もできます。 [Log File Settings] をク リ ッ クする と、ダイアログ ボッ クスが表示され

ます。

このダイアログ ボッ クスでは、ファ イルの保存場所と各ファイルに含めるスイープ実行回数を設定

できます。 スイープ実行回数がファイルの制限を越える場合は、 最初の結果ファイルと同じディ レ

ク ト リにベース ファ イル名の開始実行番号が付けられた複数のファイルが作成されます。

[Test Results]

このパネルには、現在の実行、経過時間、および残り時間の概算が表示されます。 このステータス情

報の下には、スイープ テス ト結果の実行ログが表示されています。 この結果もログ ファ イルに保存

されます。

IBERT v2.0 Virtex-5 FPGA GTX ト ランシーバのツールバーおよびメニュー オプ
シ ョ ン

[IBERT Console Options]

[IBERT Console Options] ダイアログ ボッ クスでは、コンソール ウ ィンド ウに表示する列および行

を選択できます。 左側パネルでは、 MGT をロケーシ ョ ンで選択します。 すべて選択する場合は

[Check All]、 すべて選択しない場合は [Uncheck All] をク リ ッ ク します。

右側パネルでは、 [MGT/BERT Settings] パネルに表示される行を選択します。 すべて選択する場合

は [Check All]、すべて選択しない場合は [Uncheck All] をク リ ッ ク します。 [Default] をク リ ッ クす

る と、チャネルの有効性を決定するのに必要な行の基本セッ トがコンソール ウ ィンド ウに表示され

ます。 

[Import/Export] ダイアログ ボックス

このダイアログ ボッ クスでは、特定の MGT の設定を保存して復元したり、デザインの別の MGT に
適用できます。設定をインポート またはエクスポートするには、[IBERT_V5GTX] → [Import/Export
Wizard] をク リ ッ クするか、 またはツールバーの [Import/Export Wizard] をク リ ッ ク します。

ウ ィザードの最初の画面では、MGT 設定のソースに [MGT] または [File] のいずれかを選択します。

[MGT] を選択した場合は、 コンボ ボッ クスに表示される  MGT から選択します。 [File] を選択した

場合は、 [Browse] をク リ ッ ク して設定ファイルを指定します。 [Next] をク リ ッ ク して、次の画面に

進みます。
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次の画面では、 デスティネーシ ョ ンを指定します。 IBERT デザインに含まれる  MGT とファ イルを

自由に組み合わせるこ とができます。 [File] をイネーブルした場合は、 [Browse] をク リ ッ ク して

ファ イル デスティネーシ ョ ンを指定します。

3 番目の画面には、設定のソースとデスティネーシ ョ ンのサマ リが表示されます。 [Apply] をク リ ッ

ク してインポート またはエクスポート します。 この操作は、 元に戻すこ とができません。

[Reset All]

IBERT コアのすべてのチャネルを リセッ トするには、 [IBERT_V5GTX] → [Reset All] をク リ ッ ク

するか、 またはツールバーの [Reset All] をク リ ッ ク します。

[JTAG Scan Rate] および [Scan Now]

ツールバーの [JTAG Scan Rate] および [IBERT_V5GTX] → [JTAG Scan Rate] をク リ ッ クする と、

Analyzer ソフ ト ウェアで IBERT コアのステータス情報を確認する頻度を選択できます。 デフォル

トは [1 s] ですが、[250 ms]、[500 ms]、[2 s]、[5 s]、または [Manual Scan] も選択できます。 [Manual
Scan] を選択した場合、 [IBERT_V5GTX] → [Scan Now] をク リ ッ クするかツールバーの [Scan
Now] ([S!]) をク リ ッ ク して IBERT コアのクエ リ をすぐに実行できます。
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Virtex-6 FPGA GTX ト ランシーバ用 IBERT コンソール ウィンドウ

Virtex-6 LXT/SXT/CXT ファ ミ リの IBERT コアのコンソールを開くには、 [Window] → [New
Unit]  → [Windows] でコアを選択します。 このコア ユニッ ト向けのダイアログ ボッ クスが表示さ

れるので [IBERT V6 GTX Console] を選択します。 このダイアログ ボッ クスからはウ ィンド ウを閉

じるこ とはできません。

プロジェク ト  ツ リーの [IBERT V6 GTX Console] をダブルク リ ッ クするか、 または [IBERT V6
GTX Console] を右ク リ ッ ク して [Open IBERT V6 GTX Console] をク リ ッ ク してもコンソール

ウ ィンド ウを表示できます。

Virtex-6 LXT/SXT/CXT ファ ミ リの GTX ト ランシーバ用 IBERT コンソール ウ ィンド ウは、

「[MGT/BERT Settings] パネル」 、 142 ページの 「[DRP Settings] パネル」 、 142 ページの 「[Port
Settings] パネル」、および144 ページの 「IBERT Virtex-6 FPGA GTX ト ランシーバのツールバーお

よびメニュー オプシ ョ ン」 で構成されています。

[MGT/BERT Settings] パネル

このパネルには、複数の列と行を含むテーブルが表示されます。各列では、特定のアクティブな GTX
ト ランシーバが表示されます。 各行では特定の制御またはステータス設定が表示されます。

[MGT Settings]

[MGT Alias] は、GTX ト ランシーバ MGT 番号に初期設定されていますが、新しい値を入力できます。 

[Tile Location] には、 デバイスに含まれる  GTX ト ランシーバの X/Y 座標が表示されます。

[MGT Link Status] には、特定の GTX ト ランシーバ チャネルのレシーバに接続されている リ ンク検

出ロジッ クのステータスが表示されます。 チャネルがリ ンク されている場合は緑色で計測されたラ

イン レートが表示され、 リ ンク されていない場合は 「NOT LOCKED」 (赤色) と表示されます。

[Edit Line Rate] では、GTX ト ランシーバのライン レートおよびさまざまな PLL 設定に関連するパ

ラ メータを指定します。 REFCLK 周波数および内部 PLL 分周器設定に基づいて現在の設定が表示

されています。 ライン レート を変更する と きは、 MGT の TX および RX の両方に適用されます。

[MGT] では、GTX ト ランシーバ コンポーネン ト を選択します。  [REFCLK Input Freq (MHz)] は読

み取り専用フ ィールドで、 入力リ ファレンス  ク ロ ッ クの周波数が表示されます。 [Target Line Rate
(Mbps)] には、有効なライン レートすべてと  REFCLK 入力周波数から派生した関連する  PLL 設定

([FB]、 [REF]、 および [DIVSEL]) が含まれています。 [Edit Line Rate] ウ ィンド ウ下部には、 GTX
ト ランシーバのライン レートに関するすべての属性が表示されます。

[TX PLL Status] には GTX ト ランシーバに接続されている  TX PLL のロ ッ ク  ステータスが表示さ

れます。このステータス インジケータの有効なステートは、LOCKED (緑色) または NOT LOCKED
(赤色) です。

[RX PLL Status] には GTX ト ランシーバに接続されている  RX PLL のロ ッ ク  ステータスが表示さ

れます。このステータス インジケータの有効なステートは、LOCKED (緑色) または NOT LOCKED
(赤色) です。

[Loopback Mode] 設定は、特定の GTX ト ランシーバ チャネルのループバッ ク  モードを制御するの

に使用します。 次にループバッ ク  モードの選択肢を示します。

• [None] : フ ィードバッ ク  パスは使用されません。

• [Near-End PCS] : 回路は近端 GTX ト ランシーバ チャネルに完全に含まれています。 TX ファ

ブ リ ッ ク  インターフェースから開始して、PCS を通過し、GTX ト ランシーバ チャネルの PMA
側を通過せずに RX ファブリ ッ クに戻り ます。
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• [Near-End PMA] : 回路は近端 GTX ト ランシーバ チャネルに完全に含まれています。 TX ファ

ブ リ ッ ク  インターフェイスから開始して、 PCS、 PMA、 PCS を通過し、 RX ファブリ ッ ク  イ
ンターフェイスに戻り ます。

• [Far-End PMA] : 回路は、 外部テス ト装置やほかのデバイスの一部などの外部チャネルのエン

ドポイン トから始ま り、GTX ト ランシーバ チャネルを通過して元に戻り ます。 この GTX ト ラ

ンシーバ ループバッ ク  モードでは、信号が RX ピンに入力され、 PMA 回路を通過して TX ピ
ンに戻り ます。

• [Far-End PCS] : 回路は、外部テス ト装置やほかのデバイスの一部などの外部チャネルのエンド

ポイン トから始ま り、GTX ト ランシーバ チャネルを通過して元に戻り ます。 この GTX ループ

バッ ク  モードでは、 信号が RX ピンに入力され、 PMA、 PCS、 PMA を通過して TX ピンに戻

り ます。

• [Far-End Fabric] : 回路は、外部テス ト装置やほかのデバイスの一部などの外部チャネルのエン

ドポイン トから始ま り、GTP/GTX ト ランシーバ チャネルおよび関連するファブ リ ッ ク  ロジッ

クを通過して元に戻り ます。 この GTX ト ランシーバ ループバッ ク  モードでは、信号が RX ピ
ンに入力され、PMA、PCS、 ワード数が少ないファブリ ッ ク  ベースの FIFO、PCS、PMA を通

過して TX ピンに戻り ます。

[Channel Reset] をク リ ッ クする と、内部 PMA および PCS 回路に加え関連するファブ リ ッ ク  イン

ターフェイスがク リ ア、 リセッ ト され、 GTX ト ランシーバ チャネルがリセッ ト されます。

[TX Polarity Invert] では、 GTX ト ランシーバ チャネルの TX ピンから送信されたデータの極性を

制御します。 GTX ト ランシーバの TX 側の極性を反転するには、このチェッ ク  ボッ クスをオンにし

ます。

[TX Bit Error Inject] をク リ ッ クする と、1 つの送信ワードに含まれる  1 ビッ トの極性が反転されま

す。 この ト ランス ミ ッ タに接続されているチャネルのレシーバ エンドポイン トでは、 1 ビッ ト  エ
ラーが検出されるはずです。

[TX Diff Output Swing] では、ト ランス ミ ッ タの差動振幅を制御します。 値を変更する場合はボッ ク

スに入力します。

[TX Pre-Emphasis] では、送信信号のプリエンファシス量を制御します。 値を変更する場合はボッ ク

スに入力します。

[RX Polarity Invert] では、GTX チャネルの RX ピンから受信したデータの極性を制御します。 GTX
ト ランシーバの RX 側の極性を反転するには、 チェッ ク  ボッ クスをオンにします。

[RX AC Coupling Enabled] では、 ビルト イン AC カップリ ング キャパシタをイネーブルにするか

ど うかを制御します。

[RX Termination Voltage] では、 RX 終端ネッ ト ワークで使用する電源を制御します。

[RX Equalization] では、 内部 RX イコラ イゼーシ ョ ン回路を制御します。

[BERT Settings]

[TX/RX Data Pattern] は、 ト ランス ミ ッ タのパターン ジェネレータおよびレシーバのパターン

チェッカで使用されるデータ  パターンを選択するのに使用します。これらのパターンには、PRBS7、
15、 23、 31、 および Clk 2x、 10 x が含まれています。 

[RX Bit Error Ratio] には、GTX ト ランシーバ チャネルに対して算出されたビッ ト  エラー率が表示

されます。この値は指数で表現されます。 たとえば、1.000E-12 は 1 兆ビッ ト受信するたびに 1 ビッ

ト  エラーが発生するこ とを意味します。
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[RX Received Bit Count] には、受信したビッ ト数の総計が表示されます。 このカウン トは、 [BERT
Reset] をク リ ッ ク したと きに リセッ ト されます。

[RX Bit Error Count] には、 検出されたビッ ト  エラー数の総計が表示されます。 このカウン トは、

[BERT Reset] をク リ ッ ク したと きにリセッ ト されます。

このボタンをク リ ッ クする と、 ビッ ト  エラー カウンタおよび受信ビッ ト  カウンタが リセッ ト され

ます。 GTX チャネルがリ ンク され安定したら  BERT カウンタを リセッ ト して ください。

[Clocking Settings]

[TXOUTCLK Freq (MHz)] には、 GTX ト ランシーバの TXOUTCLK0 ポートのク ロ ッ ク周波数の

概算値が MHz で表示されます。 このステータスの正確度は、 コンパイル時に指定されたシステム

ク ロ ッ クの周波数によって異なり ます。

[TXUSRCLK Freq (MHz)] には、 GTX ト ランシーバの TXUSRCLK ポートのク ロ ッ ク周波数の概

算値が MHz で表示されます。 このステータスの正確度は、 コンパイル時に指定されたシステム ク
ロ ッ クの周波数によって異なり ます。

[TXUSRCLK2 Freq (MHz)] には、GTX ト ランシーバの TXUSRCLK2 ポートのク ロ ッ ク周波数の

概算値が MHz で表示されます。 このステータスの正確度は、 コンパイル時に指定されたシステム

ク ロ ッ クの周波数によって異なり ます。

[RXUSRCLK Freq (MHz)] には、GTX ト ランシーバの RXUSRCLK ポートのク ロ ッ ク周波数の概

算値が MHz で表示されます。 このステータスの正確度は、 コンパイル時に指定されたシステム ク
ロ ッ クの周波数によって異なり ます。

[RXUSRCLK2 Freq (MHz)] には、GTX ト ランシーバの RXUSRCLK2 ポートのク ロ ッ ク周波数の

概算値が MHz で表示されます。 このステータスの正確度は、 コンパイル時に指定されたシステム

ク ロ ッ クの周波数によって異なり ます。

[DRP Settings] パネル

このパネルには、複数の列と行を含むテーブルが表示されます。各列では、特定のアクティブな GTX
ト ランシーバが表示されます。 各行では、 特定の DRP 属性またアドレスが表示されます。

パネル下部の [View By Attribute Name] をオンにする と、 すべての DRP 属性がアルファベッ ト順

で表示されます。 [Radix] では [Hex] (16 進数) または [Bin] (2 進数) のいずれかを選択できます。 値
を変更するには、テキス ト  フ ィールドをク リ ッ ク して新しい値を入力してから、Enter キーを押しま

す。 これで新しい値が MGT に反映されます。

パネル下部の [View By Address] がオンになっている と、 行アドレスが数字順に表示されます。

[Radix] では [Hex] (16 進数) または [Bin] (2 進数) のいずれかを選択できます。 値を変更するには、

テキス ト  フ ィールドをク リ ッ ク して新しい値を入力してから、 Enter キーを押します。 これで新し

い値が MGT に反映されます。

[Port Settings] パネル

このパネルには、複数の列と行を含むテーブルが表示されます。各列では、特定のアクティブな GTX
ト ランシーバが表示されます。 各行には、 特定の MGT ポートが表示されます。 一部のポートは

IBERT デザインでデータの送受信に使用されるため、すべてのポートが表示されるわけではあ り ま

せん。 

[Radix] では、値の基数に [Hex] (16 進数) または [Bin] (2 進数) を選択できます。 一部のポートは読

み取り専用で編集できません。 これらのセルは、 ラベルのよ うに表示されます。 編集可能な表内の

ポートは、 テキス ト  フ ィールドのよ うに表示され、 カーソルを置く と新しい値が入力でき、 Enter
キーを押すとその値がすぐに反映されます。
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[Sweep Test Settings] パネル

このパネルは、さまざまな ト ランシーバ設定をスイープするチャネル テス ト を設定するのに使用し

ます。 TX および RX 設定は、 同じ  GTX ト ランシーバ向けです。 TX および RX の両方の設定のス

イープは、 ト ランシーバが近端または外部ループバッ ク  モードのいずれかに設定されている と きの

み機能します。 RX パラ メータのスイープは、リ ンクの対応する  TX エンドポイン トが別のデバイス

または同じデバイスに含まれる別のト ランシーバに含まれる と きのみ実行できます。

このパネルは、[Parameter Settings]、[Sampling Point Region]、[Test Controls]、および [Test Results]
セクシ ョ ンの 4 つのセクシ ョ ンから構成されています。

[Parameter Settings]

このセクシ ョ ンでは、 スイープ パラ メータを設定します。

次に、 スイープに使用できる  GTX ト ランシーバのパラ メータを示します。

• [TX Diff Swing]

• [TX Pre-Emphasis]

• [TX Post-Emphasis]

• [RX EQ] 

これらのスイープ パラ メータは、 次のいずれかの方法で初期化できます。

• [Clear All] をク リ ッ ク してすべてのパラ メータをク リ アします。 

• [Set Parameters to Current Values] をク リ ッ ク して、 [MGT/BERT Settings] パネルの現在の値

にパラ メータを設定します。

[Sweet Parameter] 表のパラ メータの順序は、パラ メータのスイープ順序を示しています。 表上部の

パラ メータの値は、表下部のパラ メータに比べスイープされる頻度が低くなり ます。 つま り、表上部

のパラ メータはスイープ アルゴ リズムの外側ループにあ り、表下部のパラ メータはスイープ アルゴ

リ ズムの内側ループにある という こ とです。 

各パラ メータで開始値と終了値を設定する必要があ り ます。 パラ メータの順序は変更できません。

開始値を選択する と、 その値に対して有効な終了値が自動的に表示されます。 パラ メータでスイー

プの設定を希望しない場合は、開始値と終了値を同じ値にします。 [Sweep Value Count] 列では、特

定のパラ メータでスイープされる値の数が示されます。 すべてのスイープ パラ メータに有効な開始

値と終了値が設定される と、 スイープ実行回数が [Total Iterations] に表示されます。

パラ メータを表に追加または削除するには、 [Add/Remove Parameters] をク リ ッ ク します。 ダイア

ログ ボッ クスが表示され、左側には使用可能なポート /属性すべて、右側にはスイープするパラ メー

タが表示されます。 スイープするパラ メータを追加するには、 左側のリ ス トからいずれかをク リ ッ

ク して、右方向 (>) ボタンをク リ ッ ク します。 スイープするパラ メータを削除するには、右側のリ ス

トからいずれかをク リ ッ ク して、左方向 (<) ボタンをク リ ッ ク します。 パラ メータのスイープ順を指

定するには、右側のリ ス トのいずれかをク リ ッ ク してから  [Up] または [Down] をク リ ッ ク します。

スイープ属性およびその順序をデフォルトの設定に戻す場合は、 [Reset to Default] をク リ ッ ク しま

す。 [OK] をク リ ッ ク して設定を適用するか、 [Cancel] をク リ ッ ク して保存せずに終了します。

[Sampling Point Region]

サンプリ ング ポイン トは、 アイ とサンプル間の水平ポイン トです。 左端の遷移領域を視覚化してか

ら、右端を視覚化します。 [RX Sampling Point] は、128 個の不連続のサンプリ ング位置の 1 つです。

このセクシ ョ ンでは、 サンプ リ ング領域の左端および右端を選択します。 
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[Test Controls]

スイープ テス ト を設定したら、 [Start] をク リ ッ ク してテス ト を開始します。 ク リ ッ ク した後は、 ス

イープ パラ メータ表がディ スエーブルになりテス トが実行されます。

スイープ テス トの実行の過程で現在のスイープ結果ファイル、 現在の実行回数、経過時間、および

概算残り時間ステータスが表示されます。 スイープ結果は、 画面下のテキス ト  エリアに表示されま

す。 スイープ テス トは [Pause] をク リ ッ ク して一時停止したり、[Reset] をク リ ッ ク して完全に停止

するこ とができます。

スイープテス トの結果は、[Test Results] パネルに表示されます。またスイープ テス ト結果ファイル

に書き出すこ と もできます。 [Log File Settings] をク リ ッ クする と、ダイアログ ボッ クスが表示され

ます。

このダイアログ ボッ クスでは、ファ イルの保存場所と各ファイルに含めるスイープ実行回数を設定

できます。 スイープ実行回数がファイルの制限を越える場合は、 最初の結果ファイルと同じディ レ

ク ト リにベース ファ イル名の開始実行番号が付けられた複数のファイルが作成されます。 

[Test Results]

このパネルには、現在の実行、経過時間、および残り時間の概算が表示されます。 このステータス情

報の下には、スイープ テス ト結果の実行ログが表示されています。 この結果もログ ファ イルに保存

されます。

IBERT Virtex-6 FPGA GTX ト ランシーバのツールバーおよびメニュー オプシ ョ ン

[IBERT Console Options]

[IBERT Console Options] ダイアログ ボッ クスでは、コンソール ウ ィンド ウに表示する列および行

を選択できます。 左側パネルでは、 MGT をロケーシ ョ ンで選択します。 すべて選択する場合は

[Check All]、 すべて選択しない場合は [Uncheck All] をク リ ッ ク します。

右側パネルでは、 [MGT/BERT Settings] パネルに表示される行を選択します。 すべて選択する場合

は [Check All]、すべて選択しない場合は [Uncheck All] をク リ ッ ク します。 [Default] をク リ ッ クす

る と、チャネルの有効性を決定するのに必要な行の基本セッ トがコンソール ウ ィンド ウに表示され

ます。 [Default] で表示される行は、[Tile Location]、[TX PLL Status]、[RX PLL Status]、[Loopback
Mode]、 [Channel Reset]、 [TX Error Inject]、 [Rx Sampling Point]、 [TX Data Pattern]、 [RX Data
pattern]、 [Rx Bit Error Ratio]、 [Rx Received Bit Count]、 [Rx Bit Error Count]、 [BERT Reset]、
[TXUSRCLK2 Freq]、 および [RXUSRCLK2 Freq] です。

[Import/Export] ダイアログ ボックス

このダイアログ ボッ クスでは、特定の MGT の設定を保存して復元したり、デザインの別の MGT に
適用できます。設定をインポート またはエクスポートするには、[IBERT_V6GTX] → [Import/Export
Wizard] をク リ ッ クするか、 またはツールバーの [Import/Export Wizard] をク リ ッ ク します。

ウ ィザードの最初の画面では、MGT 設定のソースに [MGT] または [File] のいずれかを選択します。

[MGT] を選択した場合は、 コンボ ボッ クスに表示される  MGT から選択します。 [File] を選択した

場合は、 [Browse] をク リ ッ ク して設定ファイルを指定します。 [Next] をク リ ッ ク して、次の画面に

進みます。

次の画面では、 デスティネーシ ョ ンを指定します。 IBERT デザインに含まれる  MGT とファ イルを

自由に組み合わせるこ とができます。[File] をイネーブルした場合は、[Browse] をク リ ッ ク してファ

イル デスティネーシ ョ ンを指定します。

3 番目の画面には、設定のソースとデスティネーシ ョ ンのサマ リが表示されます。 [Apply] をク リ ッ

ク してインポート またはエクスポート します。 この操作は、 元に戻すこ とができません。
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[Reset All]

IBERT コアのすべてのチャネルを リセッ トするには、 [IBERT_V6GTX] → [Reset All] をク リ ッ ク

するか、 またはツールバーの [Reset All] をク リ ッ ク します。

[JTAG Scan Rate] および [Scan Now]

ツールバーの [JTAG Scan Rate] および [IBERT_V6GTX] → [JTAG Scan Rate] メニューをク リ ッ

クする と、Analyzer ソフ ト ウェアで IBERT コアのステータス情報を確認する頻度を選択できます。

デフォルトは [1 s] ですが、 [250 ms]、 [500 ms]、 [2 s]、 [5 s]、 または [Manual Scan] も選択できま

す。 [Manual Scan] を選択した場合、 [IBERT_V6GTX] → [Scan Now] またはツールバーの [Scan
Now] ([S!]) をク リ ッ クする と、 IBERT コアのクエリ をすぐに実行できます。

Virtex-6 FPGA GTH ト ランシーバ用 IBERT コンソール ウィンドウ

Virtex-6 HXT ファ ミ リ  GTH ト ランシーバ用の IBERT コアのコンソールを開くには、[Window] →
[New Unit Windows] でコアを選択します。 このコア ユニッ ト向けのダイアログ ボッ クスが表示さ

れるので [IBERT V6 GTH Console] を選択します。 このダイアログ ボッ クスからはウ ィンド ウを閉

じるこ とはできません。

プロジェク ト  ツ リーの [IBERT V6 GTH Console] をダブルク リ ッ クするか、 または [IBERT V6
GTH Console] を右ク リ ッ ク して [Open IBERT V6 GTH Console] をク リ ッ ク してもコンソール

ウ ィンド ウを表示できます。

Virtex-6 HXT ファ ミ リの GTH ト ランシーバ用 IBERT コンソール ウ ィンド ウは、 「[MGT/BERT
Settings] パネル」、 142 ページの 「[DRP Settings] パネル」、 142 ページの 「[Port Settings] パネル」、

および 144 ページの 「IBERT Virtex-6 FPGA GTX ト ランシーバのツールバーおよびメニュー オプ

シ ョ ン」 で構成されています。

[MGT/BERT Settings] パネル

このパネルには、複数の列と行を含むテーブルが表示されます。各列では、特定のアクティブな GTH
ト ランシーバが表示されます。 各行では特定の制御またはステータス設定が表示されます。

[MGT Settings]

[MGT Alias] は、GTH ト ランシーバ MGT 番号に初期設定されていますが、新しい値を入力できます。 

[Tile Location] には、 デバイスに含まれる  GTH ト ランシーバの X/Y 座標が表示されます。

[MGT Link Status] には、特定の GTH ト ランシーバ チャネルのレシーバに接続されている リ ンク検

出ロジッ クのステータスが表示されます。 チャネルがリ ンク されている場合は緑色で計測されたラ

イン レートが表示され、 リ ンク されていない場合は 「NOT LOCKED」 (赤色) と表示されます。

[PLL Status] には GTH QUAD に含まれている  PLL のロ ッ ク  ステータスが表示されます。 このス

テータス  インジケータの有効なステートは、 LOCKED (緑色) または NOT LOCKED (赤色) です。

[Loopback Mode] では、 特定の GTH ト ランシーバ チャネルのループバッ ク  モードを制御します。

次にループバッ ク  モードの選択肢を示します。

• [None] : フ ィードバッ ク  パスは使用されません。

• [Near-End PCS] : 回路は近端 GTH ト ランシーバ チャネルに完全に含まれています。 TX ファ

ブ リ ッ ク  インターフェースから開始して、PCS を通過し、GTH ト ランシーバ チャネルの PMA
側を通過せずに RX ファブリ ッ クに戻り ます。

• [Far-End PCS] : 回路は、外部テス ト装置やほかのデバイスの一部などの外部チャネルのエンド

ポイン トから始ま り、GTH ト ランシーバ チャネルを通過して元に戻り ます。 この GTH ループ
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バッ ク  モードでは、 信号が RX ピンに入力され、 PMA、 PCS、 PMA を通過して TX ピンに戻

り ます。

[QUAD Reset] をク リ ッ クする と、 内部 PMA および PCS 回路に加え関連するファブ リ ッ ク  イン

ターフェイスがク リ ア、 リセッ ト され、 GTH QUAD ( ト ランシーバ 4 個) がリセッ ト されます。

[TX Bit Error Inject] をク リ ッ クする と、1 つの送信ワードに含まれる  1 ビッ トの極性が反転されま

す。 この ト ランス ミ ッ タに接続されているチャネルのレシーバ エンドポイン トでは、 1 ビッ ト  エ
ラーが検出されるはずです。

[TX Diff Output Swing] では、ト ランス ミ ッ タの差動振幅を制御します。 値を変更する場合はボッ ク

スに入力します。

[TX Pre-Emphasis] では、送信信号のプリエンファシス量を制御します。 値を変更する場合はボッ ク

スに入力します。

[TX Post-Emphasis] では、 送信信号のポス トエンファシス量を制御します。 値を変更する場合は

ボッ クスに入力します。

[RX Equalization] では、 内部 RX イコラ イゼーシ ョ ン回路を制御します。

[BERT Settings]

[TX/RX Data Pattern] は、 ト ランス ミ ッ タのパターン ジェネレータおよびレシーバのパターン

チェッカで使用されるデータ  パターンを選択するのに使用します。これらのパターンには、PRBS7、
15、 23、 31、 および Clk 2x、 10 x が含まれています。 

[RX Bit Error Ratio] には、GTH ト ランシーバ チャネルに対して算出されたビッ ト  エラー率が表示

されます。 この値は指数で表現されます。 たとえば、1.000E-12 は 1 兆ビッ ト受信するたびに 1 ビッ

ト  エラーが発生するこ とを意味します。

[RX Received Bit Count] には、受信したビッ ト数の総計が表示されます。 このカウン トは、 [BERT
Reset] をク リ ッ ク したと きに リセッ ト されます。

[RX Bit Error Count] には、 検出されたビッ ト  エラー数の総計が表示されます。 このカウン トは、

[BERT Reset] をク リ ッ ク したと きにリセッ ト されます。

このボタンをク リ ッ クする と、 ビッ ト  エラー カウンタおよび受信ビッ ト  カウンタが リセッ ト され

ます。 GTH チャネルがリ ンク され安定した後に BERT カウンタを リセッ ト して ください。

[Clocking Settings]

[TXUSERCLKOUT Freq (MHz)] には、 GTH ト ランシーバの TXUSERCLKOUT ポートのク ロ ッ

ク周波数の概算値が MHz で表示されます。 このステータスの正確度は、コンパイル時に指定された

システム ク ロ ッ クの周波数によって異なり ます。

[RXUSERCLKOUT Freq (MHz)] には、 GTH ト ランシーバの RXUSERCLKOUT ポートのク ロ ッ

ク周波数の概算値が MHz で表示されます。 このステータスの正確度は、コンパイル時に指定された

システム ク ロ ッ クの周波数によって異なり ます。

[DRP Settings] パネル

このパネルでは、 DRP 属性またはアドレスを示す表が表示されます。 各列には、特定のアクティブ

な GTH QUAD が表示されます。 各行では、 特定の DRP 属性またアドレスが表示されます。

パネル下部の [View By Attribute Name] をオンにする と、 すべての DRP 属性がアルファベッ ト順

で表示されます。 [Radix] では [Hex] (16 進数) または [Bin] (2 進数) のいずれかを選択できます。 値

http://japan.xilinx.com


ChipScope Pro 12.1 ソフ トウェアおよびコア japan.xilinx.com 147
UG029 (v12.3) 2010 年 9 月 21 日

Analyzer の機能

を変更するには、テキス ト  フ ィールドをク リ ッ ク して新しい値を入力してから、Enter キーを押しま

す。 新しい値が GTH ト ランシーバに反映されます。

パネル下部の [View By Address] がオンになっている と、 行アドレスが数字順に表示されます。

[Radix] では [Hex] (16 進数) または [Bin] (2 進数) のいずれかを選択できます。 値を変更するには、

テキス ト  フ ィールドをク リ ッ ク して新しい値を入力してから、 Enter キーを押します。 新しい値が

GTH ト ランシーバに反映されます。

[Port Settings] パネル

このパネルには、複数の列と行を含むテーブルが表示されます。各列では、特定のアクティブな GTH
QUAD が表示されます。 各行には、 特定のト ランシーバ ポートが表示されます。 一部のポートは

IBERT デザインでデータの送受信に使用されるため、すべてのポートが表示されるわけではあ り ま

せん。 

[Radix] では、値の基数に [Hex] (16 進数) または [Bin] (2 進数) を選択できます。 一部のポートは読

み取り専用で編集できません。 これらのセルは、 ラベルのよ うに表示されます。 編集可能な表内の

ポートは、 テキス ト  フ ィールドのよ うに表示されます。 値を変更する場合は、 これらのフ ィールド

にカーソルを置いて新しい値を入力し、 Enter キーを押します。 新しい値が GTH ト ランシーバに反

映されます。

IBERT Virtex-6 FPGA GTH ト ランシーバのツールバーおよびメニュー オプシ ョ ン

[IBERT Console Options]

[IBERT Console Options] ダイアログ ボッ クスでは、コンソール ウ ィンド ウに表示する列および行

を選択できます。 左側パネルでは、ト ランシーバをロケーシ ョ ンで選択します。 すべて選択する場合

は [Check All]、 すべて選択しない場合は [Uncheck All] をク リ ッ ク します。

右側パネルでは、 [MGT/BERT Settings] パネルに表示される行を選択します。 すべて選択する場合

は [Check All]、すべて選択しない場合は [Uncheck All] をク リ ッ ク します。 [Default] をク リ ッ クす

る と、チャネルの有効性を決定するのに必要な行の基本セッ トがコンソール ウ ィンド ウに表示され

ます。 [Default] で表示される行は、[Tile Location]、[TX PLL Status]、[RX PLL Status]、[Loopback
Mode]、 [Channel Reset]、 [TX Error Inject]、 [Rx Sampling Point]、 [TX Data Pattern]、 [RX Data
pattern]、 [Rx Bit Error Ratio]、 [Rx Received Bit Count]、 [Rx Bit Error Count]、 [BERT Reset]、
[TXUSRCLK2 Freq]、 および [RXUSRCLK2 Freq] です。

[Import/Export] ダイアログ ボックス

このダイアログ ボッ クスでは、 特定の GTH ト ラシーバの設定を保存して復元したり、 デザインの

別の ト ラ ン シーバに適用で き ま す。 設定 を イ ン ポー ト ま た はエ ク ス ポー ト す る には、

[IBERT_V6GTH] → [Import/Export Wizard] をク リ ッ クするか、 またはツールバーの [Import/
Export Wizard] をク リ ッ ク します。

ウ ィザードの最初の画面では、ト ランシーバ設定のソースに [MGT] または [File] のいずれかを選択

します。 [MGT] を選択した場合は、 コンボ ボッ クスに表示される ト ランシーバから選択します。

[File] を選択した場合は、 [Browse] をク リ ッ ク して設定ファイルを指定します。 [Next] をク リ ッ ク

して、 次の画面に進みます。

次の画面では、 デスティネーシ ョ ンを指定します。 IBERT デザインに含まれる  GTH ト ランシーバ

とファ イルを自由に組み合わせるこ とができます。 [File] をイネーブルした場合は、 [Browse] をク

リ ッ ク してファ イル デスティネーシ ョ ンを指定します。

3 番目の画面には、設定のソースとデスティネーシ ョ ンのサマ リが表示されます。 [Apply] をク リ ッ

ク してインポート またはエクスポート します。 この操作は、 元に戻すこ とができません。
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[Reset All]

IBERT コアのすべてのチャネルを リセッ トするには、 [IBERT_V6GTH] → [Reset All] をク リ ッ ク

するか、 またはツールバーの [Reset All] をク リ ッ ク します。

[JTAG Scan Rate] および [Scan Now]

ツールバーの [JTAG Scan Rate] および [IBERT_V6GTH] → [JTAG Scan Rate] メニューをク リ ッ

クする と、Analyzer ソフ ト ウェアで IBERT コアのステータス情報を確認する頻度を選択できます。

デフォルトは [1 s] ですが、 [250 ms]、 [500 ms]、 [2 s]、 [5 s]、 または [Manual Scan] も選択できま

す。 [Manual Scan] を選択した場合、 [IBERT_V6GTH] → [Scan Now] またはツールバーの [Scan
Now] ([S!]) をク リ ッ クする と、 IBERT コアのクエリ を実行できます。

Spartan-6 FPGA GTP ト ランシーバ用 IBERT コンソール ウィンドウ

Spartan®--6 LXT デバイスの GTP ト ランシーバ用の IBERT コアのコンソールを開くには、

[Window] → [New Unit]  → [Windows] でコアを選択します。 このコア ユニッ ト向けのダイアログ

ボッ クスが表示されるので [IBERT S6 GTP Console] を選択します。 このダイアログ ボッ クスから

はウ ィンド ウを閉じるこ とはできません。

プロジェク ト  ツ リーの [IBERT S6 GTP Console] をダブルク リ ッ クするか、または [IBERT S6 GTP
Console] を右ク リ ッ ク して [Open IBERT S6 GTP Console] をク リ ッ ク してもコンソール ウ ィンド

ウを表示できます。

Spartan-6 LXT プラ ッ ト フォームの IBERT コンソール ウ ィンド ウは、 [MGT/BERT Settings] パネ

ル、 [DRP Settings] パネル、 および [Port Settings] パネルで構成されています。

[MGT/BERT Settings] パネル

このパネルには、複数の列と行を含むテーブルが表示されます。 各列では、特定のアクティブな GTP
ト ランシーバが表示されます。 各行では特定の制御またはステータス設定が表示されます。

[MGT Settings]

[MGT Alias] は、GTP ト ランシーバ MGT 番号に初期設定されていますが、新しい値を入力できます。 

[Tile Location] には、 デバイスに含まれる  GTP ト ランシーバの X/Y 座標が表示されます。

[MGT Link Status] には、特定の GTP ト ランシーバ チャネルのレシーバに接続されている リ ンク検

出ロジッ クのステータスが表示されます。 チャネルがリ ンク されている場合は緑色で計測されたラ

イン レートが表示され、 リ ンク されていない場合は 「NOT LOCKED」 (赤色) と表示されます。

[Edit Line Rate] では、GTP ト ランシーバのライン レートおよびさまざまな PLL 設定に関連するパ

ラ メータを指定します。 REFCLK 周波数および内部 PLL 分周器設定に基づいて現在の設定が表示

されています。 ライン レート を変更する と きは、 ト ランシーバの TX および RX の両方に適用され

ます。 [MGT] では、GTP ト ランシーバ コンポーネン ト を選択します。  [REFCLK Input Freq (MHz)]
は読み取り専用フ ィールドで、 入力リ ファレンス  ク ロ ッ クの周波数が表示されます。 [Target Line
Rate (Mbps)] には、 REFCLK 入力周波数から派生した有効なライン レート と関連する  PLL 設定

([FB]、 [REF]、 および [DIVSEL]) がすべて表示されます。 [Edit Line Rate] ウ ィンド ウ下部には、

GTP ト ランシーバのライン レートに関するすべての属性が表示されます。

[PLL Status] では GTP ト ラ ンシーバに接続さ れている  PLL のロッ ク  ステータスが表示さ れま

す。 こ のステータス  インジケータの有効なステート は、 LOCKED (緑色) または NOT LOCKED
(赤色) です。
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[Loopback Mode] では、 特定の GTP ト ランシーバ チャネルのループバッ ク  モードを制御します。

次にループバッ ク  モードの選択肢を示します。

• [None] : フ ィードバッ ク  パスは使用されません。

• [Near-End PCS] : 回路は近端 GTP チャネルに完全に含まれています。 TX ファブリ ッ ク  イン

ターフェースから開始して、PCS を通過し、GTP チャネルの PMA 側を通過せずに RX ファブ

リ ッ クに戻り ます。

• [Near-End PMA] : 回路は近端 GTP チャネルに完全に含まれています。 TX ファブリ ッ ク  イン

ターフェイスから開始して、PCS、PMA、PCS を通過し、RX ファブ リ ッ ク  インターフェイス

に戻り ます。

• [Far-End PMA] : 回路は、 テス ト装置やほかのデバイスの一部などの外部チャネルのエンドポ

イン トから始ま り、 GTP チャネルを通過して元に戻り ます。 この GTP ループバッ ク  モードで

は、 信号が RX ピンに入力され、 PMA 回路を通過して TX ピンに戻り ます。

• [Far-End PCS] : 回路は、テス ト装置やほかのデバイスの一部などの外部チャネルのエンドポイ

ン トから始ま り、GTP チャネルを通過して元に戻り ます。 この GTP ループバッ ク  モードでは、

信号が RX ピンに入力され、 PMA、 PCS、 PMA を通過して TX ピンに戻り ます。

• [Far-End Fabric] : 回路は、テス ト装置やほかのデバイスの一部などの外部チャネルのエンドポ

イン トから始ま り、GTP チャネルおよび関連するファブ リ ッ ク  ロジッ クを通過して元に戻り ま

す。 この GTP ループバッ ク  モードでは、 信号が RX ピンに入力され、 PMA、 PCS、 ワード数

が少ないファブ リ ッ ク  ベースの FIFO、 PCS、 PMA を通過して TX ピンに戻り ます。

[Channel Reset] をク リ ッ クする と、内部 PMA および PCS 回路に加え関連するファブ リ ッ ク  イン

ターフェイスがク リ ア、 リセッ ト され、 GTP チャネルがリセッ ト されます。

[TX Polarity Invert] では、 GTP チャネルの TX ピンから送信されたデータの極性を制御します。

GTP ト ランシーバの TX 側の極性を反転するには、 このチェッ ク  ボッ クスをオンにします。

[TX Bit Error Inject] をク リ ッ クする と、1 つの送信ワードに含まれる  1 ビッ トの極性が反転されま

す。 この ト ランス ミ ッ タに接続されているチャネルのレシーバ エンドポイン トでは、 1 ビッ ト  エ
ラーが検出されるはずです。

[TX Diff Output Swing] では、ト ランス ミ ッ タの差動振幅を制御します。 値を変更する場合はボッ ク

スに入力します。

[TX Pre-Emphasis] では、送信信号のプリエンファシス量を制御します。 値を変更する場合はボッ ク

スに入力します。

[RX Polarity Invert] では、GTP チャネルの RX ピンから受信したデータの極性を制御します。 GTP
ト ランシーバの RX 側の極性を反転するには、 このチェッ ク  ボッ クスをオンにします。

[RX AC Coupling Enabled] では、 ビルト イン AC カップリ ング キャパシタをイネーブルにするか

ど うかを制御します。

[RX Termination Voltage] では、 RX 終端ネッ ト ワークで使用する電源を制御します。

[RX Equalization] では、 内部 RX イコラ イゼーシ ョ ン回路を制御します。

[BERT Settings]

[TX/RX Data Pattern] は、 ト ランス ミ ッ タのパターン ジェネレータおよびレシーバのパターン

チェッカで使用されるデータ  パターンを選択するのに使用します。これらのパターンには、PRBS7、
15、 23、 31、 および Clk 2x、 10x が含まれています。 
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[RX Bit Error Ratio] には、GTP ト ランシーバ チャネルに対して算出されたビッ ト  エラー率が表示

されます。 この値は指数で表現されます。 たとえば、1.000E-12 は 1 兆ビッ ト受信するたびに 1 ビッ

ト  エラーが発生するこ とを意味します。

[RX Received Bit Count] には、受信したビッ ト数の総計が表示されます。 このカウン トは、 [BERT
Reset] をク リ ッ ク したと きに リセッ ト されます。

[RX Bit Error Count] には、 検出されたビッ ト  エラー数の総計が表示されます。 このカウン トは、

[BERT Reset] をク リ ッ ク したと きにリセッ ト されます。

このボタンをク リ ッ クする と、 ビッ ト  エラー カウンタおよび受信ビッ ト  カウンタが リセッ ト され

ます。 GTP ト ランシーバ チャネルがリ ンク され安定した後に BERT カウンタを リセッ ト してくだ

さい。

[Clocking Settings]

[TXUSRCLK Freq (MHz)] には、 GTP ト ランシーバの TXUSRCLK ポートのク ロ ッ ク周波数の概

算値が MHz で表示されます。 このステータスの正確度は、 コンパイル時に指定されたシステム ク
ロ ッ クの周波数によって異なり ます。

[TXUSRCLK2 Freq (MHz)] には、 GTP ト ランシーバの TXUSRCLK2 ポートのク ロ ッ ク周波数の

概算値が MHz で表示されます。 このステータスの正確度は、 コンパイル時に指定されたシステム

ク ロ ッ クの周波数によって異なり ます。

[RXUSRCLK Freq (MHz)] には、 GTP ト ランシーバの RXUSRCLK ポートのク ロ ッ ク周波数の概

算値が MHz で表示されます。 このステータスの正確度は、 コンパイル時に指定されたシステム ク
ロ ッ クの周波数によって異なり ます。

[RXUSRCLK2 Freq (MHz)] には、GTP ト ランシーバの RXUSRCLK2 ポートのク ロ ッ ク周波数の

概算値が MHz で表示されます。 このステータスの正確度は、 コンパイル時に指定されたシステム

ク ロ ッ クの周波数によって異なり ます。

[DRP Settings] パネル

このパネルには、複数の列と行を含むテーブルが表示されます。 各列では、特定のアクティブな GTP
ト ランシーバが表示されます。 各行では、 特定の DRP 属性またアドレスが表示されます。

パネル下部の [View By Attribute Name] をオンにする と、 すべての DRP 属性がアルファベッ ト順

で表示されます。 [Radix] では [Hex] (16 進数) または [Bin] (2 進数) のいずれかを選択できます。 値
を変更するには、テキス ト  フ ィールドをク リ ッ ク して新しい値を入力してから、Enter キーを押しま

す。 これで新しい値が MGT に反映されます。

パネル下部の [View By Address] がオンになっている と、 行アドレスが数字順に表示されます。

[Radix] では [Hex] (16 進数) または [Bin] (2 進数) のいずれかを選択できます。 値を変更するには、

テキス ト  フ ィールドをク リ ッ ク して新しい値を入力してから、 Enter キーを押します。 これで新し

い値が MGT に反映されます。

[Port Settings] パネル

このパネルには、複数の列と行を含むテーブルが表示されます。 各列では、特定のアクティブな GTP
ト ランシーバが表示されます。 各行には、 特定の MGT ポートが表示されます。 一部のポートは

IBERT デザインでデータの送受信に使用されるため、すべてのポートが表示されるわけではあ り ま

せん。 

[Radix] では、値の基数に [Hex] (16 進数) または [Bin] (2 進数) を選択できます。 一部のポートは読

み取り専用で編集できません。 これらのセルは、 ラベルのよ うに表示されます。 編集可能な表内の
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ポートは、 テキス ト  フ ィールドのよ うに表示され、 カーソルを置く と新しい値が入力でき、 Enter
キーを押すとその値がすぐに反映されます。

IBERT S6 GTP のツールバーおよびメニュー オプシ ョ ン

[IBERT Console Options]

[IBERT Console Options] ダイアログ ボッ クスでは、コンソール ウ ィンド ウに表示する列および行

を選択できます。 左側パネルでは、 MGT をロケーシ ョ ンで選択します。 すべて選択する場合は

[Check All]、 すべて選択しない場合は [Uncheck All] をク リ ッ ク します。

右側パネルでは、 [MGT/BERT Settings] パネルに表示される行を選択します。 すべて選択する場合

は [Check All]、すべて選択しない場合は [Uncheck All] をク リ ッ ク します。 [Default] をク リ ッ クす

る と、チャネルの有効性を決定するのに必要な行の基本セッ トがコンソール ウ ィンド ウに表示され

ます。 [Default] で表示される行は、[Tile Location]、[TX PLL Status]、[RX PLL Status]、[Loopback
Mode]、 [Channel Reset]、 [TX Error Inject]、 [Rx Sampling Point]、 [TX Data Pattern]、 [RX Data
pattern]、 [Rx Bit Error Ratio]、 [Rx Received Bit Count]、 [Rx Bit Error Count]、 [BERT Reset]、
[TXUSRCLK2 Freq]、 および [RXUSRCLK2 Freq] です。

[Import/Export] ダイアログ ボックス

このダイアログ ボッ クスでは、特定の MGT の設定を保存して復元したり、デザインの別の MGT に
適用できます。 設定をインポート またはエクスポートするには、[IBERT_S6GTP] → [Import/Export
Wizard] をク リ ッ クするか、 またはツールバーの [Import/Export Wizard] をク リ ッ ク します。

ウ ィザードの最初の画面では、MGT 設定のソースに [MGT] または [File] のいずれかを選択します。

[MGT] を選択した場合は、 コンボ ボッ クスに表示される  MGT から選択します。 [File] を選択した

場合は、 [Browse] をク リ ッ ク して設定ファイルを指定します。 [Next] をク リ ッ ク して、次の画面に

進みます。

次の画面では、 デスティネーシ ョ ンを指定します。 IBERT デザインに含まれる  MGT とファ イルを

自由に組み合わせるこ とができます。 [File] をイネーブルした場合は、 [Browse] をク リ ッ ク して

ファ イル デスティネーシ ョ ンを指定します。

3 番目の画面には、設定のソースとデスティネーシ ョ ンのサマ リが表示されます。 [Apply] をク リ ッ

ク してインポート またはエクスポート します。 この操作は、 元に戻すこ とができません。

[Reset All]

IBERT コアのすべてのチャネルを リセッ トするには、[IBERT_S6GTP] → [Reset All] をク リ ッ クす

るか、 またはツールバーの [Reset All] をク リ ッ ク します。

[JTAG Scan Rate] および [Scan Now]

ツールバーの [JTAG Scan Rate] および [IBERT_S6GTP] → [JTAG Scan Rate] メニューをク リ ッ ク

する と、 Analyzer ソフ ト ウェアで IBERT コアのステータス情報を確認する頻度を選択できます。

デフォルトは [1 s] ですが、 [250 ms]、 [500 ms]、 [2 s]、 [5 s]、 または [Manual Scan] も選択できま

す。 [Manual Scan] を選択した場合、 [IBERT_S6GTP] → [Scan Now] またはツールバーの [Scan
Now] ([S!]) をク リ ッ クする と、 IBERT コアのクエリ を実行できます。

http://japan.xilinx.com


152 japan.xilinx.com ChipScope Pro 12.1 ソフ トウェアおよびコア

UG029 (v12.3) 2010 年 9 月 21 日

第 4 章 : ChipScope Pro Analyzer の使用

ヘルプの表示

Help ページの表示

Analyzer のヘルプ ページには、 現在開いているバージ ョ ンのソフ ト ウェアと コア ユニッ トの情報

のみが表示されます。 [Help] →  [About: ChipScope Software] をク リ ッ クする と、 ソフ ト ウェアの

バージ ョ ンを確認できます。 [Help] → [About: Cores] をク リ ッ クする と、 検出されたコアそれぞれ

のパラ メータの詳細が表示されます。 個々のコアのパラ メータを表示するには、 プロジェク ト  ツ

リーのユニッ トで右ク リ ッ ク し、 [Show Core Info] をク リ ッ ク します。

ChipScope Pro ILA 波形ツールバー機能

Analyzer メ ニュー下のツールバーでは、メ ニュー オプショ ンに加え、Analyzer ILA 波形コマンド を

使用できます。 セカンド  セッ ト のツールバーは、[Trigger Setup] ウィ ンド ウの表示中にのみ使用でき

ます。 サード  セッ ト 、 フォース  セッ ト は、 [Waveform] ウィ ンド ウの使用中にのみ表示されます。

ツールバー ボタンは、 次のメニュー オプシ ョ ンと同等です。

• [Open Cable/Search JTAG Chain] : ケーブルを自動的に検出し、 JTAG チェーンの構成を確認

します。

• [Turn On/Off Auto Core Status Polling] : 緑のアイコンはポーリ ングがオン、 赤のアイコンは

ポーリ ングがオフを示します。 [JTAG Chain] → [Auto Core Status Poll] からも実行できます。

• [Run] : [Trigger Setup] → [Run] (F5) からも実行できます。

• [Stop] : [Trigger Setup] → [Stop Acquisition] (F9) からも実行できます。

• [Trigger Immediate] : [Trigger Setup]  →  [Trigger Immediate] (Ctrl+F5) から も実行できます。

• [Go To X Marker] : [Waveform] → [Go To] → [Go To X Marker] からも実行できます。

• [Go To O Marker] : [Waveform] → [Go To] → [Go To O Marker] からも実行できます。

• [Go To Previous Trigger] : [Waveform] → [Go To] → [Trigger] → [Previous] からも実行できます。

• [Go To Next Trigger] : [Waveform] → [Go To] → [Trigger] → [Next] から も実行できます。

• [Zoom In] : [Waveform] → [Zoom] → [Zoom In] から も実行できます。

• [Zoom Out] :  [Waveform]  → [Zoom]  → [Zoom Out] からも実行できます。

• [Fit Window] : [Waveform] → [Zoom]  → [Zoom Fit] から も実行できます。

Analyzer のコマンド  ライン オプショ ン

Windows システムでは、コマンド  ラインまたは [スタート ] メ ニューから  Analyzer を起動できます。

• 32 ビッ ト  Windows システム上では、 コマンド  ラ インに次のよ うに入力する と  Analyzer を起

動できます。

<XILINX_ISE_INSTALL>\bin\nt\analyzer.exe

• 64 ビッ ト  Windows システム上では、 コマンド  ラ インに次のよ うに入力する と  Analyzer を起

動できます。

<XILINX_ISE_INSTALL>\bin\nt64\analyzer.exe

• 32 ビッ ト  Linux システムでは、コマンド  ラ インに次のよ うに入力する と  Analyzer を起動でき

ます。

<XILINX_ISE_INSTALL>/bin/lin/analyzer
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• 64 ビッ ト  Linux システムでは、コマンド  ラ インに次のよ うに入力する と  Analyzer を起動でき

ます。

<XILINX_ISE_INSTALL>/bin/lin64/analyzer

<XILINX_ISE_INSTALL> は ISE Design Suite ツールのインスト ール ディ レク ト リ を指します。

オプシ ョ ンの引数

コマンド  ラ インから  Analyzer を起動した場合には、 コマンド  ラインで次のオプシ ョ ンが使用でき

ます。

-geometry <width>x<height>+<left edge x coord>+<top edge y coord>

Analyzer プログラム ウ ィンド ウの位置、 幅、 高さを設定します。

-project <path and filename>

起動時に、 特定のプロジェク ト  ファ イルを読み込みます。 デフォルトでは起動時にプロジェク

ト  ファ イルが読み込まれません。

-init <path and filename>

起動時に、指定された init ファ イルを読み込んで、Analyzer の終了時に同じファイルに書き込

みます。 デフォルトは次のとおりです。 %userprofile%\.chipscope\cs_analyzer.ini

-log <path and filename>

-log stdout

メ ッセージ ログを指定のファイルに書き込みます。 stdout を指定した場合、 標準出力に書き込

みます。 デフォルトは次のとおりです。 $HOME/.chipscope/cs_analyzer.log

Windows のコマンド  ライン例

C:\Xilinx\12.3\ISE_DS\ISE\bin\nt\analyzer.exe -log c:\proj\t\t.log -
init C:\proj\t\t.ini -project c:\proj\t\t.cpj -geometry 1000x300+30+600
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ChipScope Engine Tcl インターフェイス

概要

このインターフェイスでは、 Tcl スク リプ ト を使用して、 ChipScope™ Engine 通信ライブラ リ経由

で JTAG ダウンロード  ケーブルにアクセスできます。 CSE/Tcl インターフェイスの目的は、基本的

な JTAG、FPGA、VIO コア ファンクシ ョ ンへアクセスするためのシンプルなスク リプ ト  システム

を提供するこ とです。 数行の Tcl スク リプ ト コマンドを使用するこ とで、 標準的なザイ リ ンクス

ケーブルを使用した JTAG チェーンのデバイスのスキャンおよび操作が可能になり ます。

JTAG の詳細は、 『バウンダ リ  スキャン (JTAG) を使用した Virtex FPGA のコンフ ィギュレーシ ョ

ンと リードバッ ク』 [251 ページのリ ファレンス  14 を参照] を参照してください。 Tcl の詳細は、『Tcl
Developer Xchange』 [252 ページのリ ファレンス  27 を参照] を参照してください。

必要条件

• 『ISE Design Suite 12 : インス トール、ラ イセンス、 リ リース  ノート 』 [251 ページのリ ファレン

ス  15 を参照] に記述されるサポート  OS が使用されたコンピュータ  システム

• プラ ッ ト フォーム ケーブル USB、パラレル ケーブル IV、パラレル ケーブル III などのサポー

ト される  JTAG ケーブル

• Tcl シェル (ChipScope Pro および ISE Design Suite 12.1 ツールのインス トールに含まれる

xtclsh) または ActiveTcl 8.4 シェル [252 ページのリ ファレンス  25 を参照]

• 必要な環境変数は xtclsh.exe (Windows) または xtclsh (Linux) を使用して設定

制限

ChipScope Engine Tcl インターフェイスでは、 パフォーマンスよ り も簡素化が重視されています。

::chipscope::csejtag_tap_shift_chain_ir および

::chipscope::csejtag_tap_shift_chain_dr などのコマンドは、 パッ ク されたバイナリ

データ構造ではなく、16 進数のス ト リ ングと してビッ ト を送信します。 大規模なデータ  ス ト リ ング

を転送する場合は、ある程度パフォーマンスが低下しますが、API (アプリ ケーシ ョ ン プログラ ミ ン

グ インターフェイス) のシンプルなデザインと  Tcl スク リプ ト言語が使用されるため、JTAG チェー

ン接続されたデバイスおよびコアへのアクセスには、 CSE/Tcl インターフェイスを使用するのが便

利です。

メモ : CSE/Tcl インターフェイスは、JTAG ケーブル通信デバイス (ChipScope Pro Analyzer ソフ ト

ウェア ツールおよびザイ リ ンクスの EDK (エンベデッ ド開発キッ ト ) に含まれるデバッガ ツール

など) と インターフェイスする  CSE/Tcl を使用するソフ ト ウェアとのみ互換性があ り ます。 
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CSE/Tcl コマンド  サマリ

CSE/Tcl インターフェイス  コマンドは ::chipscope:: という名前空間に属します。 CSE/Tcl イ
ンターフェイスのコマンドは 4 つのカテゴ リに分類されます (表 5-1 を参照)。

CseJtag Tcl コマンド

CseJtag Tcl コマンドのカテゴ リには、 4 つのコマンドが含まれ (表 5-2 を参照)、 それぞれのコマン

ドに 1 つまたは複数のサブコマンドが含まれます。

表 5-3 は、CseJtag Tcl サブコマンドのサマ リ を示しています。 これらのコマンドに関するその他の

詳細は、 161 ページの 「CseJtag Tcl コマンド」 を参照してください。

メモ : すべての CseJtag Tcl グローバル変数の宣言については、ChipScope Pro ツールのインス トー

ル ディ レク ト リの csejtagglobals.tcl ファ イルを参照して ください。

表 5-1 : CSE/Tcl コマンド  カテゴリ

カテゴリ 説明

CseJtag JTAG インターフェイス ステータスおよび制御コマンド  (「CseJtag Tcl コマンド」

を参照)

CseFpga FPGA ステータスおよびコンフ ィギュレーシ ョ ン コマンド  (159 ページの

「CseFpga Tcl コマンド」 を参照)

CseCore ChipScope Pro コア ステータス  コマンド  (160 ページの 「CseCore Tcl コマンド」

を参照)

CseVIO ChipScope Pro VIO コア ステータス  コマンド  (160 ページの 「CseVIO Tcl コマ

ンド」 を参照)

表 5-2 : CseJtag Tcl コマンド

コマンド 説明

::chipscope::csejtag_session CseJtag セッ ショ ンを管理します。セッショ ンは、JTAG
ターゲッ ト に関するすべてのデータおよびメ ッ セージ

を維持するために使用されます。 このコマンド のサブ

コマンド については、 表 5-3 を参照してく ださい。

::chipscope::csejtag_db CseJtag JTAG データベースにアクセスします。

CseJtag JTAG データベースには、 既知の JTAG デバ

イスに関するすべてのデータが含まれます。 このコマ

ンドのサブコマンドについては、表 5-4 を参照して く

ださい。

::chipscope::csejtag_target JTAG ダウンロード  ケーブル、JTAG エミ ュレータ、そ

の他 JTAG デバイスなどの CseJtag ターゲッ トへの接

続を管理します。 このコマンドのサブコマンドについ

ては、 157 ページの表 5-5 を参照して ください。

::chipscope::csejtag_tap CseJtag ターゲッ トの JTAG テス ト  アクセス  ポート

(TAP) にアクセスします。 TAP ステート  マシンのナ

ビゲーシ ョ ン、TAP のデータのシフ ト などの操作が含

まれます。 このコマンドのサブコマンドについては、

158 ページの表 5-6 を参照して ください。

http://japan.xilinx.com


ChipScope Pro 12.3 ソフ トウェアおよびコア japan.xilinx.com 157
UG029 (v12.3) 2010 年 9 月 21 日

CSE/Tcl コマンド  サマリ

表 5-3 : ::chipscope::csejtag_session サブコマンドのサマリ

サブコマンド 説明

create セッシ ョ ンを作成して初期化します。

destroy 既存セッシ ョ ンで使用されたメモ リ  リ ソースを削除して、 メモ

リ を空にします。

get_api_version CseJtag API ラ イブラ リ  バージ ョ ン情報を取得します。

send_message セッシ ョ ン メ ッセージのルーター機能を使用してメ ッセージを

送信します。

表 5-4 : ::chipscope::csejtag_db サブコマンドのサマリ

サブコマンド 説明

add_device_data JTAG データベースへデバイス  レコードを追加します。

lookup_device JTAG データベースのデバイス情報を検索します。

get_device_name_for_idcode IDCODE を使用して JTAG データベースからデバイス

名を取得します。

parse_bsdl バウンダ リ スキャン記述言語 (BSDL) バッファを解析

して JTAG デバイスのデバイス  データを抽出します。

parse_bsdl_file バウンダ リ スキャン記述言語 (BSDL) ファ イルを解析

して JTAG デバイスのデバイス  データを抽出します。

表 5-5 : :chipscope::csejtag_target サブコマンドのサマリ

サブコマンド 説明

open JTAG ターゲッ トへの接続を開いて、 セッシ ョ ンと関連付けます。

close 開いている  JTAG ターゲッ トへの接続を終了して、セッシ ョ ンから削

除します。

is_connected ターゲッ トの接続ステータスをテス ト して リ ターンします。

lock JTAG ターゲッ トのロ ッ クを取得しよ う と します。

unlock JTAG ターゲッ トのロ ッ クを解除します。

get_lock_status JTAG ターゲッ トのロ ッ ク  ステータスを取得します。

clean_locks すべてのケーブル ロ ッ クを解除し、 ロ ッ クに関連する リ ソースをク

リーンアップします。

flush JTAG ターゲッ トのデータ  バッファをフラ ッシュします。

set_pin JTAG ターゲッ トの TAP ピンの値を設定します。

get_pin JTAG ターゲッ トの TAP ピンの値を取得します。

pulse_pin JTAG ターゲッ トの TAP ピンのパルスを送り ます。

wait_time 指定した時間分待機します。

get_info JTAG ターゲッ トに関連する情報を取得します。
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表 5-6 : :chipscope::csejtag_tap サブコマンドのサマリ

サブコマンド 説明

autodetect_chain 現在ターゲッ トに接続された JTAG チェーンに関する

情報をすべて自動的に検出します。

interrogate_chain JTAG チェーンをスキャンして、 チェーンの長さ と

チェーンの各デバイスの IDCODE 情報を決定します。

get_device_count JTAG チェーン内のデバイス数を取得します。

set_device_count JTAG チェーン内のデバイス数を設定します。

get_irlength デバイスの命令レジスタ  (IR) の長さを取得します。

set_irlength デバイスの命令レジスタ  (IR) の長さを設定します。

get_device_idcode デバイスの IDCODE を取得します。

set_device_idcode デバイスの IDCODE を設定します。

navigate JTAG TAP ステートへナビゲート します。

shift_chain_ir ビッ ト ス ト リームを JTAG チェーンの命令レジスタに

対してシフ ト インおよびシフ ト アウ ト します。

shift_chain_dr ビッ ト ス ト リームを JTAG チェーンのデータ  レジスタ

に対してシフ ト インおよびシフ ト アウ ト します。

shift_device_ir ビッ ト ス ト リームを JTAG チェーンの特定デバイスの

命令レジスタに対してシフ ト インおよびシフ ト アウ ト

します。

shift_device_dr ビッ ト ス ト リームを JTAG チェーンの特定デバイスの

データ  レジスタに対してシフ ト インおよびシフ ト アウ

ト します。
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CseFpga Tcl コマンド

CseFpga Tcl コマンドのカテゴ リには、 複数のコマンドが含まれます (表 5-7 参照)。

メモ : すべての CseFpga Tcl グローバル変数の宣言については、ChipScope Pro ツールのインス トー

ル ディ レク ト リの csefpgaglobals.tcl ファ イルを参照して ください。 
表 5-7 : CseFpga Tcl コマンド

コマンド 説明

::chipscope::

csefpga_configure_device

.bit、 .rbt、 または .mcs ファ イルの内容を含むバイ ト  ア
レイで FPGA デバイスをコンフ ィギュレーシ ョ ンしま

す。

::chipscope::

csefpga_configure_device_

with_file

.bit、 .rbt、 または .mcs ファ イルの内容で FPGA デバイ

スをコンフ ィギュレーシ ョ ンします。

::chipscope::csefpga_get_

config_reg
ターゲッ ト  FPGA デバイスのコンフ ィギュレーシ ョ ン

レジスタ  ビッ ト を読み出します。

::chipscope::

csefpga_get_instruction_

reg

ターゲッ ト  FPGA デバイスの命令レジスタを読み出し

て、コンフ ィギュレーシ ョ ン特有のステータス  ビッ ト を

フォーマッ ト します。

::chipscope::csefpga_get_

usercode
ターゲッ ト  FPGA デバイスの USERCODE レジスタを

読み出します。

::chipscope::

csefpga_get_user_chain_

count

ターゲッ ト  FPGA デバイスの USER チェーン レジスタ

を決定します。

::chipscope::

csefpga_is_config_

supported

ターゲッ ト  FPGA デバイスでコンフ ィギュレーシ ョ ン

がサポート されるかど うかテス ト します。

::chipscope::csefpga_is_

configured
FPGA デバイスのコンフ ィギュレーシ ョ ン ステータス

を リ ターンします。

::chipscope::

csefpga_is_sys_mon_

supported

ターゲッ ト  FPGA デバイスでシステム モニターのコマ

ンドがサポート されるかど うかテス ト します。

::chipscope::

csefpga_run_sys_mon_

command_sequence

システム モニターのレジスタの読み出し と書き込みの

シーケンスを実行します。

::chipscope::csefpga_get_

sys_mon_reg
システム モニターのレジスタから読み出します。

::chipscope::csefpga_set_

sys_mon_reg
システム モニターのレジスタに書き込みます。
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CseCore Tcl コマンド

CseCore Tcl コマンドのカテゴ リには、 複数のコマンドが含まれます (表 5-8 参照)。

メモ : すべての CseCore Tcl グローバル変数の宣言については、ChipScope Pro ツールのインス トー

ル ディ レク ト リの csecoreglobals.tcl ファ イルを参照して ください。 

CseVIO Tcl コマンド

CseVIO Tcl コマンドのカテゴ リには、 複数のコマンドが含まれます (表 5-9 参照)。

メモ : すべての CseVIO Tcl グローバル変数の宣言については、ChipScope Pro ツールのインス トー

ル ディ レク ト リの csevioglobals.tcl ファ イルを参照して ください。

表 5-8 : CseCore Tcl コマンド

コマンド 説明

::chipscope::

csecore_get_core_count

ターゲッ ト  FPGA デバイスの ICON コアと特定の

USER スキャン チェーン レジスタに接続されたコアの

数を取得します。

::chipscope::

csecore_get_core_status

ターゲッ ト  ChipScope Pro コアからスタティ ッ ク  ス

テータス  ワードを読み出します。

::chipscope::

csecore_is_cores_supported

ターゲッ ト  FPGA デバイスで ChipScope Pro コアがサ

ポート されるかど うかテス ト します。

表 5-9 : CseVIO Tcl コマンド

コマンド 説明

::chipscope::csevio_get_core_info ターゲッ ト  VIO コアからスタティ ッ ク  ステー

タス ワードを読み出します。

::chipscope::csevio_is_vio_core ターゲッ ト  コアが VIO コアかど うか判別しま

す。

::chipscope::csevio_init_core ターゲッ ト  VIO コアに関連するグローバル変

数を初期化します。

::chipscope::csevio_terminate_core ターゲッ ト  VIO コアに関連するグローバル変

数を削除してメモリ を解放します。

::chipscope::csevio_define_signal 指定した VIO 信号ビッ トの名前を定義します。

::chipscope::csevio_define_bus VIO 信号ビッ トのグループ (バス) 名を定義し

ます。

::chipscope::csevio_undefine_name VIO 信号/バス名と関連するすべての情報を削

除します。

::chipscope::csevio_write_values ターゲッ ト  VIO コアの指定した信号/バスに値

を書き込みます。

::chipscope::csevio_read_values ターゲッ ト  VIO コアの指定した信号/バスから

値を読み出します。
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CseJtag Tcl コマンド

こ こでは、 次の CseJtag Tcl コマンドの詳細について説明します。

• ::chipscope::csejtag_session create

• ::chipscope::csejtag_session destroy

• ::chipscope::csejtag_session get_api_version

• ::chipscope::csejtag_session send_message

• ::chipscope::csejtag_target open

• ::chipscope::csejtag_target close

• ::chipscope::csejtag_target is_connected

• ::chipscope::csejtag_target lock

• ::chipscope::csejtag_target unlock

• ::chipscope::csejtag_target get_lock_status

• ::chipscope::csejtag_target clean_locks

• ::chipscope::csejtag_target flush

• ::chipscope::csejtag_target set_pin

• ::chipscope::csejtag_target get_pin

• ::chipscope::csejtag_target pulse_pin

• ::chipscope::csejtag_target wait_time

• ::chipscope::csejtag_target get_info

• ::chipscope::csejtag_tap autodetect_chain

• ::chipscope::csejtag_tap interrogate_chain

• ::chipscope::csejtag_tap get_device_count

• ::chipscope::csejtag_tap set_device_count

• ::chipscope::csejtag_tap get_irlength

• ::chipscope::csejtag_tap set_irlength

• ::chipscope::csejtag_tap get_device_idcode

• ::chipscope::csejtag_tap set_device_idcode

• ::chipscope::csejtag_tap navigate

• ::chipscope::csejtag_tap shift_chain_ir

• ::chipscope::csejtag_tap shift_device_ir

• ::chipscope::csejtag_tap shift_chain_dr

• ::chipscope::csejtag_tap shift_device_dr

• ::chipscope::csejtag_db add_device_data

• ::chipscope::csejtag_db lookup_device

• ::chipscope::csejtag_db get_device_name_for_idcode

• ::chipscope::csejtag_db get_irlength_for_idcode

• ::chipscope::csejtag_db parse_bsdl

• ::chipscope::csejtag_db parse_bsdl_file
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::chipscope::csejtag_session create
これは、通常 ChipScope Engine への最初のサブコマンド呼び出しです。 このコマンドで リ ターンさ

れるセッシ ョ ン ハンドルでは、 JTAG ターゲッ ト を開いて制御できます。 また、 このコマンドはデ

フォルト  ディ レク ト リのさまざまなデータ  ファ イルから取得されたデータを使用してセッシ ョ ン

を初期化します。 デフォルト  ディ レク ト リは <LIBCSEJTAG_DLL_PATH>/../../data/cse
(<LIBCSEJTAG_DLL_PATH> は libCseJtag.dll ファ イルの絶対パス  ディ レク ト リ ) です。

構文

::chipscope::csejtag_session create messageRouterFn [opt_args...]

メモ : [opt_args...] は文字列または文字列形式のリ ス トのオプシ ョ ンの引数リ ス トです。

引数

リ ターン

セッシ ョ ン ハンドル。 コマンドがエラーになる と例外になり ます。

例

1. オプシ ョ ンの引数を使用しないで新しいセッシ ョ ンを作成します。

%set handle [::chipscope::csejtag_session create messageRouterFn]

2. ポート  50001 の lab_machine というサーバーにクライアン ト /サーバー ライブラ リ を使用して

新しいセッシ ョ ンを作成します。

%set handle [::chipscope::csejtag_session create messageRouterFn 

-server “lab_machine” -port “50001”]

CseJtag Tcl コマンドの リ ス トに戻る

表 5-10 : ::chipscope::csejtag_session create サブコマンドの引数

引数 タイプ 説明

messageRouterFn 必須

メ ッセージ ルーター関数の名前。 すべてのメ ッセージを

stdout にルートするには値に 0 を使用します。 次は、関数宣

言文の例です。

proc messageRouterFn {handle msgFlags 
msg} { ... }

msgFlags で次のいずれかがリ ターンされます。

$CSE_MSG_ERROR

$CSE_MSG_WARNING

$CSE_MSG_STATUS

$CSE_MSG_INFO

$CSE_MSG_NOISE

$CSE_MSG_DEBUG

-server <host> オプシ ョ ン
<cs_server_host_name> で示される  ChipScope サーバー

ホス ト名に関連するセッシ ョ ンを作成します。

-port <portnum> オプシ ョ ン
<cs_server_port_number> で示される  ChipScope サーバー

ポート数に関連するセッシ ョ ンを作成します。
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::chipscope::csejtag_session destroy
このコマンドは既存セッシ ョ ンを削除して、 そのセッシ ョ ンで前に使用された リ ソースすべてを空

にします。

構文

::chipscope::csejtag_session destroy handle

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

指定したセッシ ョ ンを削除します。

%::chipscope::csejtag_session destroy $handle

CseJtag Tcl コマンドの リ ス トに戻る

表 5-11 : ::chipscope::csejtag_session create サブコマンドの引数

引数 タイプ 説明

handle 必須
::chipscope::csejtag_session create でリ ターンされた

セッシ ョ ンへのハンドル
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::chipscope::csejtag_session get_api_version
このコマンドは CseJtag API ライブラ リのバージ ョ ンを読み出します。

構文

::chipscope::csejtag_session get_api_version

引数

このコマンドには引数はあ り ません。

リ ターン

API バージ ョ ン情報を含む Tcl リ ス ト。 リ ス ト  エレメン ト形式は次のとおりです。

{apiVersion versionString}

apiVersion は API バージ ョ ン番号で versionString はビルド  バージ ョ ン番号です。 コマンドがエ

ラーになる と例外になり ます。

例

API バージ ョ ン番号とビルド番号バージ ョ ンの文字列を含むリ ス ト を取得します。

%set api_info [::chipscope::csejtag_session get_api_version]

CseJtag Tcl コマンドの リ ス トに戻る
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::chipscope::csejtag_session send_message
このサブコマンドは、 CseJtag ライブラ リのメ ッセージ ルーター関数にメ ッセージを送信します。

構文

::chipscope::csejtag_session send_message handle msgType msg

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

メ ッセージ ルーター関数に "Hello World!" メ ッセージを送信します。

%::chipscope::csejtag_session send_message $handle $CSE_MSG_INFO 
"Hello World!"

CseJtag Tcl コマンドの リ ス トに戻る

表 5-12 : ::chipscope::csejtag_session send_message サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッシ ョ ン

へのハンドル

msgType

メ ッセージ タイプは、 次のいずれかに設定する必要があ り ます。

• $CSE_MSG_ERROR

• $CSE_MSG_WARNING

• $CSE_MSG_STATUS

• $CSE_MSG_INFO

• $CSE_MSG_NOISE

• $CSE_MSG_DEBUG

msg メ ッセージ文字列。
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::chipscope::csejtag_target open
このサブコマンドは、 JTAG ターゲッ ト  デバイスを開いて、 セッシ ョ ンと関連付けます。

メモ : 現在のと ころ、 セッシ ョ ンごとに開く こ とのできる  JTAG ターゲッ トは 1 つだけです。

構文

::chipscope::csejtag_target open handle targetName 
progressCallbackFunc [opt_args...]

メモ : [opt_args...] は文字列または文字列形式のリ ス トのオプシ ョ ンの引数リ ス トです。

引数

表 5-14 は、 targetName 引数値とそれらのオプシ ョ ンの引数の有効な組み合わせを示しています。

表 5-13 : ::chipscope::csejtag_target open サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

targetName

開く  JTAG ターゲッ トの名前。 使用可能な targetName と
[optional args...] の組み合わせについては、 表 5-14 を参照

して ください。 targetName が $CSEJTAG_TARGET_
AUTO に設定されている場合、 最初の使用可能な JTAG
ケーブル ターゲッ トが開きます。

progressCallbackFunc

JTAG ターゲッ トの操作の進捗状況を監視するために使用

できるプログレス  コールバッ ク関数です。 この関数の形式

は、 次のよ うにな り ます。

proc progressCallbackFunc (handle 
totalCount CurrentCount progressStatus) 
{...}

プログレス  コールバッ ク関数は $CSE_STOP または

$CSE_CONTINUE を リ ターンします。 プログレス  コール

バッ ク関数が必要でない場合は、 引数に 0 を使用します。

表 5-14 : targetName 引数と  [optional args...] の組み合わせ

targetName [optional args...]

$CSEJTAG_TARGET_AUTO なし

$CSEJTAG_TARGET_PARALLEL "port={LPT1 | LPT2 | LPT3}"

"frequency={5000000 | 2500000 | 200000}"

$CSEJTAG_TARGET_PLATFORMUSB "port=USB2 (aliased to USB21) | USB21 | USB22 |
USB23 | ..."

"ESN=<electronic serial number string>"

"frequency={12000000 | 6000000 | 3000000 | 1500000 |
750000}"
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リ ターン

フォーマッ トの リ ス トは、 次のよ うになり ます。

{target_name plugin_name fw_ver driver_ver plugin_ver vendor frequency 
port full_name target_uid rawinfo target_flags}

説明 :

メモ : コマンドがエラーになる と例外になり ます。

例

1. 自動検出するよ う にし 、 ターゲッ ト  ケーブルを開き、 開いたターゲッ ト の情報をリ ターンし

ます。

%set targetInfo [::chipscope::csejtag_target open $handle 
$CSEJTAG_TARGET_AUTO progressFunc]

2. LPT1 ポートのパラレル ケーブルを周波数 200000 で開き、 開いたターゲッ トの情報を リ ター

ンします。

%set targetInfo [::chipscope::csejtag_target open $handle 
$CSEJTAG_TARGET_PARALLEL progressFunc “port=LPT1” “frequency=200000”]

CseJtag Tcl コマンドの リ ス トに戻る3

値 説明

target_name targetName 文字列と同じ

plugin_name プラグイン ラ イブラ リ名の文字列

fw_ver ファームウェア バージ ョ ンの文字列

driver_ver ド ラ イバ バージ ョ ンの文字列

plugin_ver プラグイン バージ ョ ンの文字列

vendor ベンダー文字列

frequency 周波数文字列。

port ポート文字列

full_name ターゲッ ト名すべての文字列

target_uid ターゲッ ト特有の ID 文字列。 ザイ リ ンクス プラ ッ ト フォーム ケーブル

USB の場合、 これは ESN (Electronic Serial Number) です。

rawinfo そのままのターゲッ ト情報文字列

target_flags ターゲッ ト特有のフラグを含んだ整数
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::chipscope::csejtag_target close
このサブコマンドは、 前に開いた JTAG ターゲッ ト  デバイスを閉じます。

構文

::chipscope::csejtag_target close handle

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

指定したセッシ ョ ンで現在のターゲッ ト を閉じます。

%::chipscope::csejtag_target close $handle

CseJtag Tcl コマンドの リ ス トに戻る

表 5-15 : ::chipscope::csejtag_target close サブコマンドの引数

引数 タイプ 説明

handle 必須
::chipscope::csejtag_session create でリ ターンされた

セッシ ョ ンへのハンドル
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::chipscope::csejtag_target is_connected
このサブコマンドは、 JTAG ターゲッ ト  デバイスの接続ステータスをテス ト します。

構文

::chipscope::csejtag_target is_connected handle

引数

リ ターン

接続ステータスは、 次のよ うに リ ターンされます。

♦ 1 の場合は、 ターゲッ トへの接続が開いていて、 アクティブなこ とを示します。

♦ 0 の場合は、 閉じているこ とを示します。

コマンドがエラーになる と例外になり ます。

例

指定したセッシ ョ ンで現在のターゲッ ト を リ ターンします。

%set isConnected (::chipscope::csejtag_target is_connected $handle)

CseJtag Tcl コマンドの リ ス トに戻る

表 5-16 : ::chipscope::csejtag_target is_connected サブコマンドの引数

引数 タイプ 説明

handle 必須
::chipscope::csejtag_session create でリ ターンされた

セッシ ョ ンへのハンドル
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::chipscope::csejtag_target lock
このサブコマンドは、 前に開いた JTAG ターゲッ ト  デバイスのロッ クを取得します。

構文

::chipscope::csejtag_target lock handle msWait

引数

リ ターン

ロ ッ ク  ステータスの形式は、 次のいずれかになり ます。

- $CSEJTAG_LOCKED_ME 

- $CSEJTAG_LOCKED_OTHER 

- $CSEJTAG_UNKNOWN 

コマンドがエラーになる と例外になり ます。

例

ターゲッ ト  ロ ッ クを取得しよ う と し、 最低 1000ms 待機し、 ロ ッ クのステータスを取得します。

%set lockStatus [::chipscope::csejtag_target lock $handle 1000]

CseJtag Tcl コマンドの リ ス トに戻る

表 5-17 : ::chipscope::csejtag_target lock サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされた

セッシ ョ ンへのハンドル

msWait 停止する前の待機時間 ( ミ リ秒)。 -1 は lock が取得される

まで待機を意味します。
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::chipscope::csejtag_target unlock
こ のサブコマンド は、前に開いたロ ッ ク さ れている  JTAG ターゲッ ト  デバイスのロ ッ ク を解除し

ます。

構文

::chipscope::csejtag_target unlock handle

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

指定したセッシ ョ ンでターゲッ トのロ ッ クを解除します。

%::chipscope::csejtag_target unlock $handle

CseJtag Tcl コマンドの リ ス トに戻る

表 5-18 : ::chipscope::csejtag_target unlock サブコマンドの引数

引数 タイプ 説明

handle 必須
::chipscope::csejtag_session create でリ ターンされた

セッシ ョ ンへのハンドル
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::chipscope::csejtag_target get_lock_status
このサブコマンドは、 ターゲッ ト  デバイスのロッ ク  ステータスを読み出します。

構文

::chipscope::csejtag_target get_lock_status handle

引数

リ ターン

ロ ッ ク  ステータスの形式は、 次のいずれかになり ます。

- $CSEJTAG_LOCKED_ME 

- $CSEJTAG_LOCKED_OTHER 

- $CSEJTAG_UNKNOWN 

コマンドがエラーになる と例外になり ます。

例

現在のロッ クの テータスを取得します。

%set lockStatus [::chipscope::csejtag_target get_lock_status $handle]

CseJtag Tcl コマンドの リ ス トに戻る

表 5-19 : ::chipscope::csejtag_target get_lock_status サブコマンドの引数

引数 タイプ 説明

handle 必須
::chipscope::csejtag_session create でリ ターンされた

セッシ ョ ンへのハンドル
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::chipscope::csejtag_target clean_locks
このサブコマンドは、 すべての JTAG ターゲッ ト  ロ ッ クをク リーンアップします。

メモ : このサブコマンドは、 最後の手段と してのみ使用して ください。 このサブコマンドを実行す

る と、 ほかのプロセスおよびアプリケーシ ョ ンで使用されるものも含め、 すべての共有セマフォが

停止 (kill) されます。 現在のと ころは、JTAG ケーブル ターゲッ トのロ ッ クのみがク リーンアップさ

れます。

構文

::chipscope::csejtag_target clean_locks handle

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

アプリケーシ ョ ンが予期せず閉じたり、::chipscope::csejtag_target open でターゲッ ト を問題なく開

く こ とができなかったりするので、 このコマンドは最後の手段と して使用します。

%::chipscope::csejtag_target clean_locks $handle

CseJtag Tcl コマンドの リ ス トに戻る

表 5-20 : ::chipscope::csejtag_target clean_locks サブコマンドの引数

引数 タイプ 説明

handle 必須
::chipscope::csejtag_session create でリ ターンされた

セッシ ョ ンへのハンドル
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::chipscope::csejtag_target flush
このサブコマンドは、前に開いたロ ッ ク されている  JTAG ターゲッ ト  デバイスに関連するバッファ

をフラ ッシュします。

メモ : JTAG ターゲッ トは、 このサブコマンドを呼び出す前に ::chipscope::csejtag_target lock サブ

コマンドを使用してロ ッ ク されている必要があ り ます。

構文

::chipscope::csejtag_target flush handle

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

開いているロ ッ ク された JTAG ターゲッ トのバッファをフラ ッシュして、データ書き込みがすぐに

できるよ うにします。

%::chipscope::csejtag_target flush $handle

CseJtag Tcl コマンドの リ ス トに戻る

表 5-21 : ::chipscope::csejtag_target flush サブコマンドの引数

引数 タイプ 説明

handle 必須
::chipscope::csejtag_session create でリ ターンされた

セッシ ョ ンへのハンドル
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::chipscope::csejtag_target set_pin
このサブコマンドは、 前に開いたロ ッ ク されている  JTAG ターゲッ ト  デバイスの JTAG TAP ピン

の値を設定します。

メモ : JTAG ターゲッ トは、 このサブコマンドを呼び出す前に ::chipscope::csejtag_target lock サブ

コマンドを使用してロ ッ ク されている必要があ り ます。 

この関数を使用して JTAG TAP ステート を変更する場合、CseJtag Tcl ライブラ リは CseJtag Tcl ス
テート を記録しないこ とに注意してください。 ::chipscope::csejtag_tap サブコマンドのいずれかを

使用する場合は、その前に ::chipscope::csejtag_tap navigate サブコマンドを使用して JTAG TAP ス
テート  マシンを $CSEJTAG_TEST_LOGIC_RESET ステートに設定しておきます。

構文

::chipscope::csejtag_target set_pin handle pin value

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

TMS ピンを 1 に設定します。

%::chipscope::csejtag_target set_pin $handle $CSEJTAG_TMS 1

CseJtag Tcl コマンドの リ ス トに戻る

表 5-22 : ::chipscope::csejtag_target set_pin サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッシ ョ ン

へのハンドル

pin JTAG TAP ピン識別子 {$CSEJTAG_TMS | $CSEJTAG_TCK |
$CSEJTAG_TDI}

value JTAG TAP ピンの値 {1=set, 0=clear}
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::chipscope::csejtag_target get_pin
このサブコマンドは、 前に開いたロ ッ ク されている  JTAG ターゲッ ト  デバイスの JTAG TAP ピン

の値を読み出します。

メモ : JTAG ターゲッ トは、 このサブコマンドを呼び出す前に ::chipscope::csejtag_target lock サブ

コマンドを使用してロ ッ ク されている必要があ り ます。 

構文

::chipscope::csejtag_target get_pin handle pin

引数

リ ターン

JTAG TAP ピンの値 {1=set, 0=clear}

コマンドがエラーになる と例外になり ます。

例

TDO ピンの現在の値を取得します。

%set value [::chipscope::csejtag_target set_pin $handle $CSEJTAG_TDO]

CseJtag Tcl コマンドの リ ス トに戻る

表 5-23 : ::chipscope::csejtag_target get_pin サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッシ ョ ン

へのハンドル

pin JTAG TAP ピン識別子 {$CSEJTAG_TMS | $CSEJTAG_TCK |
$CSEJTAG_TDI | $CSEJTAG_TDO}
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::chipscope::csejtag_target pulse_pin
このサブコマンドは、 前に開いたロ ッ ク されている  JTAG ターゲッ ト  デバイスの JTAG TAP ピン

の値にパルスを送り ます。

メモ : JTAG ターゲッ トは、 このサブコマンドを呼び出す前に ::chipscope::csejtag_target lock サブ

コマンドを使用してロ ッ ク されている必要があ り ます。 

この関数を使用して JTAG TAP ステート を変更する場合、CseJtag Tcl ライブラ リは CseJtag Tcl ス
テート を記録しないこ とに注意してください。 ::chipscope::csejtag_tap サブコマンドのいずれかを

使用する場合は、その前に ::chipscope::csejtag_tap navigate サブコマンドを使用して JTAG TAP ス
テート  マシンを $CSEJTAG_TEST_LOGIC_RESET ステートに設定しておきます。

構文

::chipscope::csejtag_target pulse_pin handle pin count

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

TCK ピンに 5 回パルスを送り ます。

%::chipscope::csejtag_target pulse_pin $handle $CSEJTAG_TCK 5

CseJtag Tcl コマンドの リ ス トに戻る

表 5-24 : ::chipscope::csejtag_target pulse_pin サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッシ ョ

ンへのハンドル

pin JTAG TAP ピン識別子 {$CSEJTAG_TMS | $CSEJTAG_TCK
| $CSEJTAG_TDI}

count JTAG TAP にパルスを送る回数 (パルス とは、 ピンに 0 を駆動

して 1 を駆動してから、 0 を駆動するこ とを意味します)
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::chipscope::csejtag_target wait_time
このサブコマンドは、 指定した時間 (マイク ロ秒) 分待機します。

メモ : JTAG ターゲッ トは、 このサブコマンドを呼び出す前に ::chipscope::csejtag_target lock サブ

コマンドを使用してロ ッ ク されている必要があ り ます。 

構文

::chipscope::csejtag_target wait_time handle usecs

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

JTAG ターゲッ トに別の操作を実行する前に 1000 マイクロ秒待機するよ うに命令します。

%::chipscope::csejtag_target wait_time $handle 1000

CseJtag Tcl コマンドの リ ス トに戻る

表 5-25 : ::chipscope::csejtag_target wait_time サブコマンドの引数

引数 タイプ 説明

handle
必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

usecs 待機するマイク ロ秒
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::chipscope::csejtag_target get_info
このサブコマンドは、 前に開いた JTAG ターゲッ トから情報を読み出します。

メモ : この関数を呼び出す前に JTAG ターゲッ ト  ロ ッ クを取得する必要はあ り ません。

構文

::chipscope::csejtag_target get_info handle

引数

リ ターン

フォーマッ トの リ ス トは、 次のよ うになり ます。

{target_name plugin_name fw_ver driver_ver plugin_ver vendor frequency 
port full_name target_uid rawinfo target_flags}

説明 :

メモ : コマンドがエラーになる と例外になり ます。

例

現在の JTAG ターゲッ トに関する情報を取得します。

%set targetInfo [::chipscope::csejtag_target get_info $handle]

CseJtag Tcl コマンドの リ ス トに戻る

表 5-26 : ::chipscope::csejtag_target get_info サブコマンドの引数

引数 タイプ 説明

handle 必須
::chipscope::csejtag_session create でリ ターンされた

セッシ ョ ンへのハンドル

値 説明

target_name JTAG ターゲッ トの名前

plugin_name プラグイン ラ イブラ リ名の文字列

fw_ver ファームウェア バージ ョ ンの文字列

driver_ver ド ラ イバ バージ ョ ンの文字列

plugin_ver プラグイン バージ ョ ンの文字列

vendor ベンダー文字列

frequency 周波数文字列。

port ポート文字列

full_name ターゲッ ト名すべての文字列

target_uid ターゲッ ト特有の ID 文字列。

rawinfo そのままのターゲッ ト情報文字列

target_flags ターゲッ ト特有のフラグを含んだ整数
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::chipscope::csejtag_tap autodetect_chain
このサブコマンドは、JTAG チェーンの構成を自動的に検出します。 まず、JTAG チェーンに含まれ

るデバイス数とその IDCODE を取得し、 IDCODE を持つ JTAG チェーンのデバイスの命令レジス

タ  (IR) 長を決定します。 デバイスの IR 長に対応する  IDCODE がない場合は、手動で割り当てる必

要があ り ます。 問題なく終了する と、すべての関連するデバイス情報が決定され、セッシ ョ ンで設定

されます。 IEEE 1149.1 と互換性のないデバイスの中には、このサブコマンドを認識せず、チェーン

全体が間違って検出されたり、 全く検出されなかったりするものもあ り ます。

メモ : JTAG ターゲッ トは、 このサブコマンドを呼び出す前に ::chipscope::csejtag_target lock サブ

コマンドを使用してロ ッ ク されている必要があ り ます。 

構文

::chipscope::csejtag_tap autodetect_chain handle algorithm

引数

リ ターン

サブコマンドでチェーンが完全に検出できなかった場合は、 例外になり ます。 このよ う なエラーの

場合、 JTAG チェーンのデバイスを検出し、 手動で割り当てる必要があ り ます。

例

デフォルトのアルゴ リズムを使用してチェーンが自動的に検出されるよ うにします。

%::chipscope::csejtag_tap autodetect_chain $handle 
$CSEJTAG_SCAN_DEFAULT

CseJtag Tcl コマンドの リ ス トに戻る

表 5-27 : ::chipscope::csejtag_tap autodetect_chain サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッシ ョ ンへ

のハンドル

algorithm

JTAG チェーンの構成決定するために使用するアルゴ リズムで、
{$CSEJTAG_SCAN_DEFAULT | $CSEJTAG_SCAN_TLRSHIFT |
$CSEJTAG_SCAN_WALKING_ONES} のいずれかに設定できま

す。

CSEJTAG_SCAN_WALKING_ONES アルゴ リズムでは次を実行

できます。

• 1 の長いス ト リームを IR にシフ ト して、各デバイスを BYPASS 
に設定します。

• DR パターンを TDI にシフ ト し、 TDO のパターンを待ちます。 
シフ ト数によって JTAG チェーン内のデバイス数が決ま り ます。

• CSEJTAG_SCAN_TLRSHIFT アルゴ リズムを実行する と各デ

バイスの IDCODE が取得されます。

CSEJTAG_SCAN_TLRSHIFT アルゴリ ズムでは次を実行できます。

• TLR にナビゲート します。

すべての IDCODE (または BYPASS ビッ ト ) が読み出されるまで

ビッ ト をシフ ト アウ ト します。
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::chipscope::csejtag_tap interrogate_chain
このサブコマンドは JTAG チェーンをスキャンし、 チェーンの IDCODE およびデバイス数を取得

します。 IEEE 1149.1 と互換性のないデバイスの中には、このサブコマンドを認識せず、チェーン全

体が間違って検出されたり、全く検出されなかったりするものもあ り ます。 このコマンドによ り、各

デバイスの命令レジスタ  (IR) はアップデート されません。

メモ : JTAG ターゲッ トは、 このサブコマンドを呼び出す前に ::chipscope::csejtag_target lock サブ

コマンドを使用してロ ッ ク されている必要があ り ます。 

構文

::chipscope::csejtag_tap interrogate_chain handle algorithm

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

デフォルトのアルゴ リズムを使用してチェーンの情報を取得します。

%::chipscope::csejtag_tap interrogate_chain $handle 
$CSEJTAG_SCAN_DEFAULT

CseJtag Tcl コマンドの リ ス トに戻る

表 5-28 : ::chipscope::csejtag_tap interrogate_chain サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッシ ョ ン

へのハンドル

algorithm

JTAG チェーンの構成決定するために使用するアルゴ リズムで、
{$CSEJTAG_SCAN_DEFAULT |
$CSEJTAG_SCAN_TLRSHIFT |
$CSEJTAG_SCAN_WALKING_ONES} のいずれかに設定でき

ます。

CSEJTAG_SCAN_WALKING_ONES アルゴ リズムでは次を実

行できます。

• 1 の長いス ト リームを IR にシフ ト して、 各デバイスを 
BYPASS に設定します。

• DR パターンを TDI にシフ ト し、 TDO のパターンを待ちま

す。 シフ ト数によって JTAG チェーン内のデバイス数が決ま

り ます。

• CSEJTAG_SCAN_TLRSHIFT アルゴ リズムを実行する と各

デバイスの IDCODE が取得されます。

CSEJTAG_SCAN_TLRSHIFT アルゴ リズムでは次を実行でき

ます。

• TLR にナビゲート します。

• すべての IDCODE (または BYPASS ビッ ト ) が読み出される

までビッ ト をシフ ト アウ ト します。
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::chipscope::csejtag_tap get_device_count
このサブコマンドは、 現在の JTAG チェーンに含まれるデバイス数を取得するために使用します。 

メモ : JTAG ターゲッ トは、 このサブコマンドを呼び出す前に ::chipscope::csejtag_target lock サブ

コマンドを使用してロ ッ ク されている必要があ り ます。 

構文

::chipscope::csejtag_tap get_device_count handle

引数

リ ターン

チェーンのデバイス数 

コマンドがエラーになる と例外になり ます。

例

JTAG チェーン内のデバイス数を取得します。

%set deviceCount [::chipscope::csejtag_tap get_device_count $handle]

CseJtag Tcl コマンドの リ ス トに戻る

表 5-29 : ::chipscope::csejtag_tap get_device_count サブコマンドの引数

引数 タイプ 説明

handle 必須
::chipscope::csejtag_session create でリ ターンされた

セッシ ョ ンへのハンドル

http://japan.xilinx.com


ChipScope Pro 12.3 ソフ トウェアおよびコア japan.xilinx.com 183
UG029 (v12.3) 2010 年 9 月 21 日

CseJtag Tcl コマンド

::chipscope::csejtag_tap set_device_count
このサブコマンドは、 現在の JTAG チェーンに含まれるデバイス数を設定するために使用します。 

メモ : JTAG ターゲッ トは、 このサブコマンドを呼び出す前に ::chipscope::csejtag_target lock サブ

コマンドを使用してロ ッ ク されている必要があ り ます。 

構文

::chipscope::csejtag_tap set_device_count handle count

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

JTAG チェーン内のデバイス数を 4 に設定します。

%::chipscope::csejtag_tap set_device_count $handle 4

CseJtag Tcl コマンドの リ ス トに戻る

表 5-30 : ::chipscope::csejtag_tap set_device_count サブコマンドの引数

引数 タイプ 説明

handle
必須

::chipscope::csejtag_session create でリ ターンされ

たセッシ ョ ンへのハンドル

count JTAG チェーン内のデバイス数
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::chipscope::csejtag_tap get_irlength
このサブコマンドは、現在の JTAG チェーンに含まれるデバイスの命令レジスタ  (IR) 長を読み出し

ます。 IR 長は、命令をデバイス  レジスタにシフ トするために必要なパディングの量を指定するため

に使用します。 TAP シフ ト とナビゲートは、すべてのデバイスの IR 長が正し く設定されるまで実行

されません。 ::chipscope::csejtag_tap autodetect_chain サブコマンドを使用する と、 IDCODE コマ

ンドをサポートするチェーンのデバイスすべての IR 長を自動的に設定されます。

メモ : JTAG ターゲッ トは、 このサブコマンドを呼び出す前に ::chipscope::csejtag_target lock サブ

コマンドを使用してロ ッ ク されている必要があ り ます。 また、 デバイス  カウン トはこのサブコマン

ドを呼び出す前に ::chipscope::csejtag_tap set_device_count を使用して設定されている必要があ り

ます。

構文

::chipscope::csejtag_tap get_irlength handle deviceIndex

引数

リ ターン

デバイスの IR 長を指定します。

コマンドがエラーになる と例外になり ます。

例

インデッ クス  0 のデバイスの IR 長を取得します。

%set irLength [::chipscope::csejtag_tap get_irlength $handle 0]

CseJtag Tcl コマンドの リ ス トに戻る

表 5-31 : ::chipscope::csejtag_tap get_irlength サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされた

セッシ ョ ンへのハンドル

deviceIndex n-length の JTAG チェーンのデバイス  インデッ クス

(0 ～ n-1)

http://japan.xilinx.com


ChipScope Pro 12.3 ソフ トウェアおよびコア japan.xilinx.com 185
UG029 (v12.3) 2010 年 9 月 21 日

CseJtag Tcl コマンド

::chipscope::csejtag_tap set_irlength
このサブコマンドは、現在の JTAG チェーンに含まれる  1 つのデバイスの命令レジスタ  (IR) 長を設

定します。 IR 長は、命令をデバイス  レジスタにシフ トするために必要なパディングの量を指定する

ために使用します。 TAP シフ ト とナビゲートは、すべてのデバイスの IR 長が正し く設定されるまで

実行されません。 ::chipscope::csejtag_tap autodetect_chain サブコマンドを使用する と、 IDCODE
コマンドをサポートするチェーンのデバイスすべての IR 長を自動的に設定されます。

メモ : JTAG ターゲッ トは、 このサブコマンドを呼び出す前に ::chipscope::csejtag_target lock サブ

コマンドを使用してロ ッ ク されている必要があ り ます。 また、 デバイス  カウン トはこのサブコマン

ドを呼び出す前に ::chipscope::csejtag_tap set_device_count を使用して設定されている必要があ り

ます。

構文

::chipscope::csejtag_tap set_irlength handle deviceIndex irLength

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

インデッ クス  0 から  11 ビッ トのデバイスの IR 長を設定します。

%::chipscope::csejtag_tap set_irlength $handle 0 11

CseJtag Tcl コマンドの リ ス トに戻る

表 5-32 : ::chipscope::csejtag_tap set_irlength サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされた

セッシ ョ ンへのハンドル

deviceIndex n-length の JTAG チェーンのデバイス  インデッ クス

(0 ～ n-1)

irLength IR の長さ  (ビッ ト )
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::chipscope::csejtag_tap get_device_idcode
このサブコマンドは、現在の JTAG チェーンの中の指定デバイスの 32 ビッ ト  IDCODE を リ ターン

します。 デバイスで IDCODE 命令がサポート されない場合は、 null 文字列がリ ターンされます。

メモ : JTAG ターゲッ トは、 このサブコマンドを呼び出す前に ::chipscope::csejtag_target lock サブ

コマンドを使用してロ ッ ク されている必要があ り ます。 また、 デバイス  カウン トはこのサブコマン

ドを呼び出す前に ::chipscope::csejtag_tap set_device_count を使用して設定されている必要があ り

ます。

構文

::chipscope::csejtag_tap get_device_idcode handle deviceIndex

引数

リ ターン

デバイスの 32 ビッ トの IDCODE を表す 1 と  0 の 32 文字の文字列

コマンドがエラーになる と例外になり ます。

例

インデッ クス  0 のデバイスの IDCODE を取得します。

%set idcode [::chipscope::csejtag_tap get_device_idcode $handle 0]

CseJtag Tcl コマンドの リ ス トに戻る

表 5-33 : ::chipscope::csejtag_tap get_device_idcode サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされ

たセッシ ョ ンへのハンドル

deviceIndex n-length の JTAG チェーンのデバイス  インデッ クス

(0 ～ n-1)
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::chipscope::csejtag_tap set_device_idcode
このサブコマンドは、現在の JTAG チェーンの中の指定デバイスの IDCODE を設定します。 null 文
字列を渡すこ とで、 デバイスで IDCODE 命令がサポート されないこ とが示されます。

メモ : JTAG ターゲッ トは、 このサブコマンドを呼び出す前に ::chipscope::csejtag_target lock サブ

コマンドを使用してロ ッ ク されている必要があ り ます。 また、 デバイス  カウン トはこのサブコマン

ドを呼び出す前に ::chipscope::csejtag_tap set_device_count を使用して設定されている必要があ り

ます。

構文

::chipscope::csejtag_tap set_device_idcode handle deviceIndex idcode

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

インデッ クス  0 ～ 01010101010101010101010101010101 のデバイスの IDCODE を設定します。

%::chipscope::csejtag_tap set_device_idcode $handle 0 
“01010101010101010101010101010101”

CseJtag Tcl コマンドの リ ス トに戻る

表 5-34 : ::chipscope::csejtag_tap set_device_idcode サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされた

セッシ ョ ンへのハンドル

deviceIndex n-length の JTAG チェーンのデバイス インデッ クス

(0 ～ n-1)

idcode デバイスの 32 ビッ トの IDCODE を表す 1 と  0 の 32
文字の文字列
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::chipscope::csejtag_tap navigate
このサブコマンドは、JTAG チェーンに含まれるデバイスの TAP ステート を変更するために使用し

ます。

メモ : JTAG ターゲッ トは、 このサブコマンドを呼び出す前に ::chipscope::csejtag_target lock サブ

コマンドを使用してロ ッ ク されている必要があ り ます。

構文

::chipscope::csejtag_tap navigate handle newState clockRepeat 
microseconds

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

TAP ステートから  Test Logic Reset にナビゲート し、5 クロ ッ ク  サイクル追加でこのステートが維

持されるよ うにします。

%::chipscope::csejtag_tap navigate $handle $CSEJTAG_TEST_LOGIC_RESET 5 
0

CseJtag Tcl コマンドの リ ス トに戻る

表 5-35 : ::chipscope::csejtag_tap navigate サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされ

たセッシ ョ ンへのハンドル

newState ナビゲートする新規ステート

clockRepeat 新規ステートになった後に追加で TCK ピンにパル

スを送る回数

マイク ロ秒
新規ステー ト にナビゲー ト後にス リープ状態にな

るマイ クロ秒数
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::chipscope::csejtag_tap shift_chain_ir
このサブコマンドは、 ビッ ト ス ト リームを JTAG チェーンの命令レジスタに対してシフ ト インおよ

びシフ ト アウ トするために使用します。 デバイス  パディングは実行されません。 デバイス  インデッ

クスの付いた IR シフ トについては、::chipscope::csejtag_tap shift_device_ir サブコマンドを参照し

てください。

メモ : JTAG ターゲッ トは、 このサブコマンドを呼び出す前に ::chipscope::csejtag_target lock サブ

コマンドを使用してロ ッ ク されている必要があ り ます。

構文

::chipscope::csejtag_tap shift_chain_ir handle shiftMode exitState 
progressCallbackFunc bitCount hextdibuf [-hextdimask hextdimaskval] [-
hextdomask hextdomaskval]

引数

リ ターン

JTAG TAP の TDO ピンからシフ ト アウ ト されるデータで一杯になったバッファ。

コマンドがエラーになる と例外になり ます。

表 5-36 : ::chipscope::csejtag_tap shift_chain_ir サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

shiftMode
{CSJTAG_SHIFT_READ | CSJTAG_SHIFT_WRITE |
CSJTAG_SHIFT_READWRITE)

exitState シフ トが完了した後の終了ステート  (ステート を変更しない

場合は CSEJTAG_SHIFT_IR)

progressCallback
Func

JTAG ターゲッ トの操作の進捗状況を監視するために使用で

きるプログレス  コールバッ ク関数です。 この関数の形式は、

次のよ うにな り ます。 

proc progressCallbackFunc (handle totalCount

CurrentCount progressStatus) {...}

プログレス  コールバッ ク関数は $CSE_STOP または

$CSE_CONTINUE を リ ターンします。 プログレス  コール

バッ ク関数が必要でない場合は、 引数に 0 を使用します。

bitCount シフ トするビッ ト数

hextdibuf TDL に書き込むデータ  ビッ ト を維持するデータ  バッファ。

最小位ビッ ト  (LSB) は TDI にまずシフ ト されます。

-hextdimask

hextdimaskval
オプシ ョ ン

データが JTAG TAP の TDI ピンにシフ ト される前にマスク

ワードの hextdimaskval がデータ  バッファのビッ トに適用さ

れるよ うに指定します。

-hextdomask

hextdomaskval

データが JTAG TAP の TDO ピンからシフ ト アウ ト された後

にマスク  ワードの hextdomaskval がデータ  バッファのビッ

トに適用されるよ うに指定します。
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例

命令レジスタに 64 個の 1 をシフ ト インし、その 64 ビッ トの受信データをキャプチャし、終了した

ら  Run Test Idle ステートにナビゲート します。

%set hextdobuf [::chipscope::csejtag_tap shift_chain_ir $handle 
$CSEJTAG_SHIFT_READWRITE $CSEJTAG_RUN_TEST_IDLE progressFunc 64 
“FFFFFFFFFFFFFFFF”]

CseJtag Tcl コマンドの リ ス トに戻る
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::chipscope::csejtag_tap shift_device_ir
このサブコマンドは、 ビッ ト ス ト リームを JTAG チェーン内の特定デバイスの命令レジスタに対し

てシフ ト インおよびシフ ト アウ トするために使用します。 デバイス  パディングは、 その他すべての

デバイスを BYPASS モードにする と実行されます。 このサブコマンドは ::chipscope::csejtag_tap
shift_device_dr よ り も前に呼び出してターゲッ ト以外のデバイスをすべて BYPASS モードにして

おかないと、予測されない、または意図していない結果になる可能性があ り ます。 そのままのデータ

をチェーンの IR にシフ トする場合は、 ::chipscope::csejtag_tap shift_chain_ir サブコマンドを参照

してください。

メモ : JTAG ターゲッ トは、 このサブコマンドを呼び出す前に ::chipscope::csejtag_target lock サブ

コマンドを使用してロ ッ ク されている必要があ り ます。 また、デバイス  IR にシフ ト されるビッ ト数

がデバイスの IR 長と同じでない場合、 このサブコマンドはエラーになり ます。

構文

::chipscope::csejtag_tap shift_device_ir handle deviceIndex shiftMode 
exitState progressCallbackFunc bitCount hextdibuf [-hextdimask 
hextdimaskval] [-hextdomask hextdomaskval]

引数

表 5-37 : ::chipscope::csejtag_tap shift_device_ir サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッシ ョ

ンへのハンドル

deviceIndex n-length の JTAG チェーンのデバイス  インデッ クス (0 ～ n-1)

shiftMode
{CSJTAG_SHIFT_READ | CSJTAG_SHIFT_WRITE |
CSJTAG_SHIFT_READWRITE)

exitState シフ トが完了した後の終了ステート  (ステート を変更しない場

合は CSEJTAG_SHIFT_IR)

progressCallback
Func

JTAG ターゲッ トの操作の進捗状況を監視するために使用で

きるプログレス  コールバッ ク関数です。 この関数の形式は、次

のよ うにな り ます。

proc progressCallbackFunc (handle totalCount CurrentCount
progressStatus) {...}

プログレス  コールバッ ク関数は $CSE_STOP または

$CSE_CONTINUE を リ ターンします。 プログレス  コール

バッ ク関数が必要でない場合は、 引数に 0 を使用します。

bitCount シフ トするビッ ト数

hextdibuf TDL に書き込むデータ  ビッ ト を維持するデータ  バッファ。 
最小位ビッ ト  (LSB) は TDI にまずシフ ト されます。

-hextdimask

hextdimaskval
オプシ ョ ン

データが JTAG TAP の TDI ピンにシフ ト される前にマスク

ワードの hextdimaskval がデータ  バッファのビッ トに適用さ

れるよ うに指定します。

-hextdomask

hextdomaskval

データが JTAG TAP の TDO ピンからシフ ト アウ ト された後

にマスク  ワードの hextdomaskval がデータ  バッファのビッ ト

に適用されるよ うに指定します。
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リ ターン

JTAG TAP の TDO ピンからシフ ト アウ ト されるデータで一杯になったバッファ。

コマンドがエラーになる と例外になり ます。

例

インデッ クス  1 のデバイスの命令レジスタに 11 個の 1 をシフ ト インし、その 11 ビッ トの受信デー

タをキャプチャし、 終了したら  Run Test Idle ステートにナビゲート します。

%set hextdobuf [::chipscope::csejtag_tap shift_device_ir $handle 1 
$CSEJTAG_SHIFT_READWRITE $CSEJTAG_RUN_TEST_IDLE progressFunc 11 “7FF”]

CseJtag Tcl コマンドの リ ス トに戻る
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::chipscope::csejtag_tap shift_chain_dr
このサブコマンドは、ビッ ト ス ト リームを JTAG チェーンのデータ  レジスタ  (DR) に対してシフ ト

インおよびシフ ト アウ トするために使用します。 デバイス  パディングは実行されません。 デバイス

インデッ クスの付いた DR シフ トについては、 ::chipscope::csejtag_tap shift_device_dr サブコマン

ドを参照してください。

メモ : JTAG ターゲッ トは、 このサブコマンドを呼び出す前に ::chipscope::csejtag_target lock サブ

コマンドを使用してロ ッ ク されている必要があ り ます。

構文

::chipscope::csejtag_tap shift_chain_dr handle shiftMode exitState 
progressCallbackFunc bitCount hextdibuf [-hextdimask hextdimaskval] [-
hextdomask hextdomaskval]

引数

リ ターン

JTAG TAP の TDO ピンからシフ ト アウ ト されるデータで一杯になったバッファ。

コマンドがエラーになる と例外になり ます。

表 5-38 : ::chipscope::csejtag_tap shift_chain_dr サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッシ ョ

ンへのハンドル

shiftMode
{CSJTAG_SHIFT_READ | CSJTAG_SHIFT_WRITE |
CSJTAG_SHIFT_READWRITE)

exitState シフ トが完了した後の終了ステート  (ステート を変更しない

場合は CSEJTAG_SHIFT_DR)

progressCallback
Func

JTAG ターゲッ トの操作の進捗状況を監視するために使用で

きるプログレス  コールバッ ク関数です。 この関数の形式は、次

のよ うになり ます。

proc progressCallbackFunc (handle totalCount CurrentCount
progressStatus) {...}

プログレス  コールバッ ク関数は $CSE_STOP または

$CSE_CONTINUE を リ ターンします。 プログレス  コール

バッ ク関数が必要でない場合は、 引数に 0 を使用します。

bitCount シフ トするビッ ト数

hextdibuf TDL に書き込むデータ  ビッ ト を維持するデータ  バッファ。

最小位ビッ ト  (LSB) は TDI にまずシフ ト されます。

-hextdimask

hextdimaskval
オプシ ョ ン

データが JTAG TAP の TDI ピンにシフ ト される前にマスク

ワードの hextdimaskval がデータ  バッファのビッ トに適用さ

れるよ うに指定します。

-hextdomask

hextdomaskval

データが JTAG TAP の TDO ピンからシフ ト アウ ト された後

にマスク  ワードの hextdomaskval がデータ  バッファのビッ

トに適用されるよ うに指定します。
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例

命令レジスタに 64 個の 1 をシフ ト インし、その 64 ビッ トの受信データをキャプチャし、終了した

ら  Run Test Idle ステートにナビゲート します。

%set hextdobuf [::chipscope::csejtag_tap shift_chain_dr $handle 
$CSEJTAG_SHIFT_READWRITE $CSEJTAG_RUN_TEST_IDLE progressFunc 64 
“FFFFFFFFFFFFFFFF”]

CseJtag Tcl コマンドの リ ス トに戻る
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::chipscope::csejtag_tap shift_device_dr
このサブコマンドは、ビッ ト ス ト リームを JTAG チェーン内の特定デバイスのデータ  レジスタに対

してシフ ト インおよびシフ ト アウ トするために使用します。 ターゲッ ト以外のデバイスがすべて

BYPASS モードの場合は、 デバイス パディングが実行され、 必要な立ち上がりおよび立ち下がり

ビッ トが追加され、 チェーン内のターゲッ ト  デバイスの位置が調整されます。 そのままのデータを

チェーンの DR にシフ トする場合は、::chipscope::csejtag_tap shift_chain_dr サブコマンドを参照し

てください。

メモ : JTAG ターゲッ トは、 このサブコマンドを呼び出す前に ::chipscope::csejtag_target lock サブ

コ マ ン ド を 使 用 し て ロ ッ ク さ れ て い る 必 要 が あ り ま す。 こ の サ ブ コ マ ン ド は

::chipscope::csejtag_tap shift_device_dr よ り も前に呼び出してターゲッ ト以外のデバイスをすべて

BYPASS モードにしておかないと、予測されない、 または意図していない結果になる可能性があ り

ます。

構文

::chipscope::csejtag_tap shift_device_dr handle deviceIndex shiftMode 
exitState progressCallbackFunc bitCount hextdibuf [-hextdimask 
hextdimaskval] [-hextdomask hextdomaskval]

引数

表 5-39 : ::chipscope::csejtag_tap shift_device_dr サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

deviceIndex n-length の JTAG チェーンのデバイス  インデッ クス

(0 ～ n-1)

shiftMode
{CSJTAG_SHIFT_READ | CSJTAG_SHIFT_WRITE |
CSJTAG_SHIFT_READWRITE)

exitState シフ トが完了した後の終了ステート  (ステート を変更しない

場合は CSEJTAG_SHIFT_DR)

progressCallback
Func

JTAG ターゲッ トの操作の進捗状況を監視するために使用で

きるプログレス  コールバッ ク関数です。 この関数の形式は、

次のよ うにな り ます。

proc progressCallbackFunc (handle totalCount CurrentCount
progressStatus) {...}

プログレス  コールバッ ク関数は $CSE_STOP または

$CSE_CONTINUE を リ ターンします。 プログレス  コール

バッ ク関数が必要でない場合は、 引数に 0 を使用します。

bitCount シフ トするビッ ト数

hextdibuf TDL に書き込むデータ  ビッ ト を維持するデータ  バッファ。

最小位ビッ ト  (LSB) は TDI にまずシフ ト されます。

http://japan.xilinx.com


196 japan.xilinx.com ChipScope Pro 12.3 ソフ トウェアおよびコア

UG029 (v12.3) 2010 年 9 月 21 日

第 5 章 : ChipScope Engine Tcl インターフェイス

リ ターン

JTAG TAP の TDO ピンからシフ ト アウ ト されるデータで一杯になったバッファ。

コマンドがエラーになる と例外になり ます。

例

インデッ クス  1 のデバイスのデータ  レジスタに 11 個の 1 をシフ ト インし、 その 11 ビッ トの受信

データをキャプチャし、 終了したら  Run Test Idle ステートにナビゲート します。

%set hextdobuf [::chipscope::csejtag_tap shift_device_dr $handle 1 
$CSEJTAG_SHIFT_READWRITE $CSEJTAG_RUN_TEST_IDLE progressFunc 11 “7FF”]

CseJtag Tcl コマンドの リ ス トに戻る

-hextdimask

hextdimaskval
オプシ ョ ン

データが JTAG TAP の TDI ピンにシフ ト される前にマスク

ワードの hextdimaskval がデータ  バッファのビッ トに適用

されるよ うに指定します。

-hextdomask

hextdomaskval

データが JTAG TAP の TDO ピンからシフ ト アウ ト された後

にマスク  ワードの hextdomaskval がデータ  バッファのビッ

トに適用されるよ うに指定します。

表 5-39 : ::chipscope::csejtag_tap shift_device_dr サブコマンドの引数

引数 タイプ 説明
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::chipscope::csejtag_db add_device_data
このサブコマンドは、 ファ イルからデバイス  レコードを読み出し、 それを CseJtag ライブラ リ内の

メモ リ  ベースのルッ クアップ テーブルに追加するために使用します。

メモ : ファ イル形式とデバイス  レコードの構造は、 idcode.lst ファ イルと同じです。 

構文

::chipscope::csejtag_db add_device_data handle filename buf bufLen

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

my_idcode.lst ファ イルから内部デバイス  データベースにデータを追加します。 また、 データ  レ
コード  バッファ とバッファ  サイズをローカル変数に保存します。

%::chipscope::csejtag_db add_device_data $handle “my_idcode.lst” 
$my_idcode_buf $my_idcode_bufLen

CseJtag Tcl コマンドの リ ス トに戻る

表 5-40 : ::chipscope::csejtag_db add_device_data サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッシ ョ

ンへのハンドル

filename デバイス  レコードが読み出されるファ イル名を含む文字列

buf ファ イル形式とデバイス  レコードの構造は、 idcode.lst ファ イ

ルと同じ

bufLen バッファのサイズ (バイ ト または文字数)
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::chipscope::csejtag_db lookup_device
このサブコマンドは、 デバイスの IDCODE を使用してデータベースでデバイスを検索するために

使用します。 

構文

::chipscope::csejtag_db lookup_device handle idcode

引数

リ ターン

フォーマッ トの リ ス トは、 次のよ うになり ます。

{deviceName irlen cmd_bypass}

説明 :

deviceName

デバイス名を含む文字列

irlen

デバイスの IR のビッ ト数

cmd_bypass

デバイスの BYPASS 命令を含む文字列 (通常すべて 1)

コマンドがエラーになる と例外になり ます。

例

IDCODE の 01010101010101010101010101010101 に含まれるデバイス情報をデータベースで検

索します。

%set deviceInfo [::chipscope::csejtag_db lookup_device $handle 
“01010101010101010101010101010101”]

CseJtag Tcl コマンドの リ ス トに戻る

表 5-41 : ::chipscope::csejtag_db lookup_device サブコマンドの引数

引数 タイプ 説明

handle
必須

::chipscope::csejtag_session create でリ ターンされた

セッシ ョ ンへのハンドル

idcode 該当デバイスの IDCODE

http://japan.xilinx.com


ChipScope Pro 12.3 ソフ トウェアおよびコア japan.xilinx.com 199
UG029 (v12.3) 2010 年 9 月 21 日

CseJtag Tcl コマンド

::chipscope::csejtag_db get_device_name_for_idcode
このサブコマンドは、 デバイスの IDCODE を使用してデータベースからデバイス名を取得するた

めに使用します。

構文

::chipscope::csejtag_db get_device_name_for_idcode handle idcode

引数

リ ターン

デバイス名を含む文字列

コマンドがエラーになる と例外になり ます。

例

IDCODE の 01010101010101010101010101010101 に含まれるデバイス名をデータベースで検索

します。

%set deviceName [::chipscope::csejtag_db get_device_name_for_idcode 
$handle “01010101010101010101010101010101”]

CseJtag Tcl コマンドの リ ス トに戻る

表 5-42 : ::chipscope::csejtag_db get_device_name_for_idcode サブコマンドの引数

引数 タイプ 説明

handle
必須

::chipscope::csejtag_session create でリ ターンされた

セッシ ョ ンへのハンドル

idcode 該当デバイスの IDCODE
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::chipscope::csejtag_db get_irlength_for_idcode
このサブコマンドは、デバイスの IDCODE を使用してデータベースからデバイスの IR 長を取得す

るために使用します。

構文

::chipscope::csejtag_db get_irlength_for_idcode handle idcode

引数

リ ターン

IR のサイズ (ビッ ト ) を含む文字列

コマンドがエラーになる と例外になり ます。

例

IDCODE の 01010101010101010101010101010101 に含まれる  IR 長をデータベースで検索し

ます。

%set irlen [::chipscope::csejtag_db get_irlength_for_idcode $handle 
“01010101010101010101010101010101”]

CseJtag Tcl コマンドの リ ス トに戻る

表 5-43 : ::chipscope::csejtag_db get_irlength_for_idcode サブコマンドの引数

引数 タイプ 説明

handle
必須

::chipscope::csejtag_session create でリ ターンさ

れたセッシ ョ ンへのハンドル

idcode 該当デバイスの IDCODE
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::chipscope::csejtag_db parse_bsdl
このサブコマンドは、 バウンダ リ スキャン記述言語 (BSDL) バッファからデバイス情報を抽出する

ために使用します。

構文

::chipscope::csejtag_db parse_bsdl handle filename buf bufLen

引数

リ ターン

フォーマッ トの リ ス トは、 次のよ うになり ます。

{deviceName irlen idcode cmd_bypass}

説明 :

deviceName

デバイス名を含む文字列

irlen

デバイスの IR のビッ ト数

idcode

デバイスの IDCODE

cmd_bypass

デバイスの BYPASS 命令を含む文字列 (通常すべて 1)

コマンドがエラーになる と例外になり ます。

例

bsdl_bufLen サイズの bsdl_buf バッファの device.bsd ファ イルからデバイス情報を抽出します。

%::chipscope::csejtag_db parse_bsdl $handle “device.bsd” $bsdl_buf 
$bsdl_bufLen

CseJtag Tcl コマンドの リ ス トに戻る

表 5-44 : Arguments for Subcommand ::chipscope::csejtag_db parse_bsdl

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされた

セッシ ョ ンへのハンドル

filename ローカル BSDL ファ イルのファイル名 (デバッグの場

合のみ)

buf BSDL ファ イル全体の内容を含むバッファ

bufLen バッファ  buf のサイズ (バイ ト または文字数)
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::chipscope::csejtag_db parse_bsdl_file
このサブコマンドは、 バウンダ リ スキャン記述言語 (BSDL) ファ イルからデバイス情報を抽出する

ために使用します。

構文

::chipscope::csejtag_db parse_bsdl_file handle filename

引数

リ ターン

フォーマッ トの リ ス トは、 次のよ うになり ます。

{deviceName irlen idcode cmd_bypass}

説明 :

deviceName

デバイス名を含む文字列

irlen

デバイスの IR のビッ ト数

idcode

デバイスの IDCODE

cmd_bypass

デバイスの BYPASS 命令を含む文字列 (通常すべて 1)

コマンドがエラーになる と例外になり ます。

例

device.bsd ファ イルからデバイス情報を抽出します。

%::chipscope::csejtag_db parse_bsdl_file $handle “device.bsd”

CseJtag Tcl コマンドの リ ス トに戻る

表 5-45 : ::chipscope::csejtag_db parse_bsdl_file サブコマンドの引数

引数 タイプ 説明

handle
必須

::chipscope::csejtag_session create でリ ターンされ

たセッシ ョ ンへのハンドル

filename ローカル BSDL ファ イルのファイル名

http://japan.xilinx.com


ChipScope Pro 12.3 ソフ トウェアおよびコア japan.xilinx.com 203
UG029 (v12.3) 2010 年 9 月 21 日

CseFpga コマンド

CseFpga コマンド

こ こでは、 次の CseFpga コマンドの詳細について説明します。

• ::chipscope::csefpga_configure_device

• ::chipscope::csefpga_configure_device_with_file

• ::chipscope::csefpga_get_config_reg

• ::chipscope::csefpga_get_instruction_reg

• ::chipscope::csefpga_get_usercode

• ::chipscope::csefpga_get_user_chain_count

• ::chipscope::csefpga_is_config_supported

• ::chipscope::csefpga_is_configured

• ::chipscope::csefpga_is_sys_mon_supported

• ::chipscope::csefpga_run_sys_mon_command_sequence

• ::chipscope::csefpga_get_sys_mon_reg

• ::chipscope::csefpga_set_sys_mon_reg
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::chipscope::csefpga_configure_device
.bit、 .rbt、 または .mcs ファ イルの内容を含むバイ ト  アレイで FPGA デバイスをコンフ ィギュレー

シ ョ ンします。

構文

::chipscope::csefpga_configure_device handle deviceIndex format 
options fileData fileDataByteLen progressFunc

引数

表 5-46 : ::chipscope::csefpga_configure_device サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

deviceIndex n-length の JTAG チェーンのデバイス  インデッ クス  (0 ～
n-1)

format コンフ ィギュレーシ ョ ン ファ イルの形式。 bit、 rbt、 mcs か
ら選択します。

options

次のフラグの 1 つまたは複数を使用します。

$CSE_RESET_DEVICE |

$CSE_SHUTDOWN_SEQUENCE |

$CSE_VERIFY_INTERNAL_DONE | 

$CSE_VERIFY_EXTERNAL_DONE | 

$CSE_VERIFY_CRC |

$CSE_DEFAULT_OPTIONS

推奨されるオプシ ョ ンは $CSE_DEFAULT_OPTIONS です。

fileData

バイ ト  アレイのコンフィ ギュレーショ ン  ファ イルの内

容。 bit ファ イルはバイナリ  モード で読み出す必要があり

ます。ほかのフォーマッ ト はバイナリ  モード またはテキス

ト  モード で読み出すこ と ができます。 fileData から は

Windows/Unix の行末文字を削除しないよ う にしてく だ

さ い。 

fileDataByteLen fileData バイ ト  アレイの長さ  (バイ ト )

progressFunc

コンフ ィギュレーシ ョ ン データをデバイスにシフ ト してい

る間の進捗状況を示す関数。 この関数の形式は、次のよ うに

な り ます。

proc progressFunc (handle totalCount

CurrentCount progressStatus) {...}

プログレス  コールバッ ク関数は次のいずれかを リ ターンし

ます。

$CSE_STOP または $CSE_CONTINUE プログレス  コール

バッ ク関数が必要でない場合は、 引数に 0 を使用します。
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リ ターン

コンフ ィギュレーシ ョ ン結果のステータス。 次のいずれかの値になり ます。

$CSE_INTERNAL_DONE_HIGH_STATUS

$CSE_EXTERNAL_DONE_HIGH_STATUS

$CSE_CRC_ERROR_STATUS

$CSE_BITSTREAM_READ_ENABLED

$CSE_BITSTREAM_WRITE_ENABLED

コマンドがエラーになる と例外になり ます。

例

mydesign.bit ファ イルを使用して JTAG チェーンの 3 つ目のデバイスをコンフ ィギュレーシ ョ ンし

ます。

%set filename "mydesign.bit"

%set fp [open $filename r]

%fconfigure $fp -translation binary -blocking 1

%set fileData [read $fp]

%close $fp

%set configStatus [::chipscope::csefpga_configure_device $handle 2 
"bit" $CSE_DEFAULT_OPTIONS $fileData [file size $filename] 
"progressCallBack"]

CseFpga コマンドの リ ス トに戻る

http://japan.xilinx.com


206 japan.xilinx.com ChipScope Pro 12.3 ソフ トウェアおよびコア

UG029 (v12.3) 2010 年 9 月 21 日

第 5 章 : ChipScope Engine Tcl インターフェイス

::chipscope::csefpga_configure_device_with_file
.bit、 .rbt、 または .mcs ファ イルの内容で FPGA デバイスをコンフ ィギュレーシ ョ ンします。

構文

::chipscope::csefpga_configure_device_with_file handle deviceIndex 
filename options progressFunc

引数

リ ターン

コンフ ィギュレーシ ョ ン結果のステータス。 次のいずれかの値になり ます。

$CSE_INTERNAL_DONE_HIGH_STATUS

$CSE_EXTERNAL_DONE_HIGH_STATUS

$CSE_CRC_ERROR_STATUS

$CSE_BITSTREAM_READ_ENABLED

表 5-47 : ::chipscope::csefpga_configure_device_with_file サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

deviceIndex n-length の JTAG チェーンのデバイス  インデッ クス  (0 ～
n-1)

filename bit、 rbt、 または mcs コンフ ィギュレーシ ョ ン ファ イルの

ファイル名

options

次のフラグの 1 つまたは複数を使用します。

$CSE_RESET_DEVICE |

$CSE_SHUTDOWN_SEQUENCE |

$CSE_VERIFY_INTERNAL_DONE | 

$CSE_VERIFY_EXTERNAL_DONE | 

$CSE_VERIFY_CRC |

$CSE_DEFAULT_OPTIONS

推奨されるオプシ ョ ンは $CSE_DEFAULT_OPTIONS です。

progressFunc

コンフ ィギュレーシ ョ ン データをデバイスにシフ ト してい

る間の進捗状況を示す関数。 この関数の形式は、次のよ うに

な り ます。

proc progressFunc (handle totalCount

CurrentCount progressStatus) {...}

プログレス  コールバッ ク関数は次のいずれかを リ ターンし

ます。

$CSE_STOP または $CSE_CONTINUE プログレス  コール

バッ ク関数が必要でない場合は、 引数に 0 を使用します。
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$CSE_BITSTREAM_WRITE_ENABLED

コマンドがエラーになる と例外になり ます。

例

mydesign.bit ファ イルを使用して JTAG チェーンの 3 つ目のデバイスをコンフ ィギュレーシ ョ ンし

ます。

%set fileName "mydesign.bit"

%set configStatus [::chipscope::csefpga_configure_device $handle 2 
$fileName $CSE_DEFAULT_OPTIONS "progressCallBack"]

CseFpga コマンドの リ ス トに戻る
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::chipscope::csefpga_get_config_reg
ターゲッ ト  FPGA デバイスのコンフ ィギュレーシ ョ ン レジスタ  ビッ ト を読み出します。

構文

::chipscope::csefpga_get_config_reg handle deviceIndex bitCount

引数

リ ターン

フォーマッ トの リ ス トは、 次のよ うになり ます。

{hexReg bitNameBuf}

説明 :

hexReg

レジスタ値を含む文字列 (16 進数)

bitNameBuf

コンフ ィギュレーシ ョ ン レジスタ  ビッ ト名を示す文字列のカンマ区切りの リ ス ト

コマンドがエラーになる と例外になり ます。

例

JTAG チェーンの 3 つ目のデバイスのコンフ ィギュレーシ ョ ン レジスタの内容を読み出します。

%set ConfigReg [csefpga_get_config_reg $handle 2 $DeviceBitCount]

CseFpga コマンドの リ ス トに戻る

表 5-48 : ::chipscope::csefpga_get_config_reg サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

deviceIndex n-length の JTAG チェーンのデバイス  インデッ クス  (0 ～
n-1)

bitCount コンフ ィギュレーシ ョ ン レジスタの長さ  (ビッ ト )
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::chipscope::csefpga_get_instruction_reg
ターゲッ ト  FPGA デバイスの命令レジスタを読み出して、コンフ ィギュレーシ ョ ン特有のステータ

ス  ビッ ト をフォーマッ ト します。

構文

::chipscope::csefpga_get_instruction_reg handle deviceIndex bitCount

引数

リ ターン

フォーマッ トの リ ス トは、 次のよ うになり ます。

{hexReg bitNameBuf}

説明 :

hexReg

レジスタ値を含む文字列 (16 進数)

bitNameBuf

コンフ ィギュレーシ ョ ン レジスタ  ビッ ト名を示す文字列のカンマ区切りの リ ス ト

コマンドがエラーになる と例外になり ます。

例

JTAG チェーンの 3 つ目のデバイスのコンフ ィギュレーシ ョ ン レジスタの内容を読み出します。

%set InstReg [csefpga_get_instruction_reg $handle 2 $DeviceBitCount]

CseFpga コマンドの リ ス トに戻る

表 5-49 : ::chipscope::csefpga_get_instruction_reg サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

deviceIndex n-length の JTAG チェーンのデバイス  インデッ クス  (0 ～
n-1)

bitCount コンフ ィギュレーシ ョ ン レジスタの長さ  (ビッ ト )
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::chipscope::csefpga_get_usercode
ターゲッ ト  FPGA デバイスの USERCODE レジスタを読み出します。

構文

::chipscope::csefpga_get_usercode handle deviceIndex

引数

リ ターン

USERCODE レジスタの内容 (16 進数)

コマンドがエラーになる と例外になり ます。

例

JTAG チェーンの 3 つ目のデバイスの USERCODE レジスタの内容を読み出します。

%set usercode [csefpga_get_usercode $handle 2]

CseFpga コマンドの リ ス トに戻る

表 5-50 : ::chipscope::csefpga_get_usercode サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

deviceIndex n-length の JTAG チェーンのデバイス  インデッ クス  (0 ～
n-1)
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::chipscope::csefpga_get_user_chain_count
ターゲッ ト  FPGA デバイスの USER チェーン レジスタを決定します。

構文

::chipscope::csefpga_get_user_chain_count handle idcode

引数

リ ターン

デバイスの USER スキャン チェーンのレジスタ数 (USER スキャン チェーン レジスタがデバイス

に含まれない場合は 0)

コマンドがエラーになる と例外になり ます。

例

$idcode で指定されたデバイスでサポート される  USER スキャン チェーン レジスタの数を取得し

ます。

%set numUserRegs [csefpga_get_user_chain_count $handle $idcode]

CseFpga コマンドの リ ス トに戻る

表 5-51 : ::chipscope::csefpga_get_user_chain_count サブコマンドの引数

引数 タイプ 説明

handle
必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

idcode 該当デバイスの IDCODE
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::chipscope::csefpga_is_config_supported
ターゲッ ト  FPGA デバイスでコンフ ィギュレーシ ョ ンがサポート されるかど うかテス ト します。

構文

::chipscope::csefpga_is_config_supported handle idcode

引数

リ ターン

idcode で指定されたデバイスのコンフ ィギュレーシ ョ ンが csefpga_configure_device コマンドで

サポート される場合は 1、 されない場合は 0。

コマンドがエラーになる と例外になり ます。

例

$idcode で指定されたデバイスがコンフ ィギュレーシ ョ ン可能かど うかを決定します。

%set isConfigurable [csefpga_is_config_supported $handle $idcode]

CseFpga コマンドの リ ス トに戻る

表 5-52 : ::chipscope::csefpga_is_config_supported サブコマンドの引数

引数 タイプ 説明

handle
必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

idcode 該当デバイスの IDCODE
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::chipscope::csefpga_is_configured
FPGA デバイスのコンフ ィギュレーシ ョ ン ステータスを リ ターンします。

構文

::chipscope::csefpga_is_configured handle deviceIndex

引数

リ ターン

deviceIndex で指定されるデバイスがコンフ ィギュレーシ ョ ンされる場合は 1、 されない場合は 0。

コマンドがエラーになる と例外になり ます。

例

JTAG チェーン内の 3 つ目のデバイスのコンフ ィギュレーシ ョ ン ステータスを取得します。

%set isConfigured [csefpga_is_configured $handle 2]

CseFpga コマンドの リ ス トに戻る

表 5-53 : ::chipscope::csefpga_is_configured サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

deviceIndex n-length の JTAG チェーンのデバイス  インデッ クス  (0 ～
n-1)
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::chipscope::csefpga_is_sys_mon_supported
ターゲッ ト  FPGA デバイスでシステム  モニターのコマンド がサポート さ れるかどう かテスト し

ます。

構文

::chipscope::csefpga_is_sys_mon_supported handle idcode

引数

リ ターン

idcode で指定されるデバイスにシステム モニター ブロ ッ クが含まれる場合は 1、 されない場合は

0。

コマンドがエラーになる と例外になり ます。

例

$idcode で指定されたデバイスにシステム モニター ブロ ッ クが含まれているかを決定します。

%set hasSysMon [csefpga_is_sys_mon_supported $handle $idcode]

CseFpga コマンドの リ ス トに戻る

表 5-54 : ::chipscope::csefpga_is_sys_mon_supported サブコマンドの引数

引数 タイプ 説明

handle
必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

idcode 該当デバイスの IDCODE
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::chipscope::csefpga_run_sys_mon_command_sequence
システム モニターのレジスタの読み出し と書き込みのシーケンスを実行します。

構文

::chipscope::csefpga_run_sys_mon_command_sequence handle deviceIndex 
[list hexAddresses...] [list hexInData...] [list setModes...] 
commandCount

引数

リ ターン

それぞれがレジスタの読み出し値を表す commandCount エレ メン ト を含むリ ス ト 。 対応する

setModes エレ メン トが 0 であれば、 データ  エレ メン トは有効です。

コマンドがエラーになる と例外になり ます。

例

JTAG チェーンの 2 つ目のデバイスで、 システム モニターの DRP レジスタのアドレス 0x10 に
0x55AA を書き込み、 DRP レジスタのアドレス 0x11 から読み出します。

%set hexOutData [csefpga_run_sys_mon_command_sequence $handle 1 [list 
10 11] [list 55AA 0000] [list 1 0] 2]

CseFpga コマンドの リ ス トに戻る

表 5-55 : ::chipscope::csefpga_run_sys_mon_command_sequence サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

deviceIndex n-length の JTAG チェーンのデバイス  インデッ クス  (0 ～
n-1)

[list hexAddresses...]
アクセスするシステム モニターの DRP レジスタ  アドレス

の リ ス ト。 このリ ス トのエレ メン ト数は commandCount で
検出されます。

[list hexInData...]

hexAddresses のリ ス トで指定されるシステム モニターの

DRP レジスタに記述されるデータのリ ス ト。hexInDat エレ

メン トは対応する  setModes エレ メン トが 0 以外の場合に

のみ書 き 込 ま れ ま す。 こ の リ ス ト のエ レ メ ン ト 数は

commandCount で検出されます。

[list setModes...]
setMode フラグのリ スト 。 0 の場合はレジスタからの読み出

しデータ、 0 以外の場合は書き込みデータを示します。 この

リ スト のエレメ ント 数は commandCount で検出されます。

commandCount コマンドの数 (および各リ ス ト引数のエレ メン ト数)
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::chipscope::csefpga_get_sys_mon_reg
システム モニターのレジスタから読み出します。

構文

::chipscope::csefpga_get_sys_mon_reg handle deviceIndex hexAddress

引数

リ ターン

システム モニターの DRP レジスタのアドレス  hexAddress から読み出したデータ値 (16 進数)。

コマンドがエラーになる と例外になり ます。

例

JTAG チェーンの 2 つ目のデバイスでシステム モニターのレジスタのアドレス  0x07 からデータを

読み出します。

%set hexOutData [csefpga_get_sys_mon_reg $handle 1 7]

CseFpga コマンドの リ ス トに戻る

表 5-56 : ::chipscope::csefpga_get_sys_mon_reg サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

deviceIndex n-length の JTAG チェーンのデバイス  インデッ クス  
(0 ～ n-1)

hexAddress 読み出すシステム モニターの DRP レジスタのアドレス
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::chipscope::csefpga_set_sys_mon_reg
システム モニターのレジスタに書き込みます。

構文

::chipscope::csefpga_set_sys_mon_reg handle deviceIndex hexAddress 
hexInData

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

JTAG チェーンの 2 つ目のデバイスでシステム モニターのレジスタのアドレス  0x09 に 0xABCD
を書き込みます。

%csefpga_set_sys_mon_reg $handle 1 9 abcd

CseFpga コマンドの リ ス トに戻る

表 5-57 : ::chipscope::csefpga_set_sys_mon_reg サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

deviceIndex n-length の JTAG チェーンのデバイス  インデッ クス  (0 ～
n-1)

hexAddress 書き込むシステム モニターの DRP レジスタのアドレス

(16 進数)

hexInData システム モニターの DRP レジスタに書き込むデータ値

(16 進数)
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CseCore コマンド

こ こでは、 次の CseFpga コマンドの詳細について説明します。

• ::chipscope::csecore_get_core_count

• ::chipscope::csecore_get_core_status

• ::chipscope::csecore_is_cores_supported

::chipscope::csecore_get_core_count
ターゲッ ト  FPGA デバイスの ICON コアと特定の USER スキャン チェーン レジスタに接続され

たコアの数を取得します。

構文

::chipscope::csecore_get_core_count handle deviceIndex userRegNumber

引数

リ ターン

コアの番号。

コマンドがエラーになる と例外になり ます。

例

JTAG チェーンの 3 つ目のデバイスの USER3 レジスタの ICON コアのコア番号を取得します。

%set coreCount [csecore_get_core_count $handle 2 3]

CseCore コマンドの リ ス トに戻る

表 5-58 : ::chipscope::csecore_get_core_count サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

deviceIndex n-length の JTAG チェーンのデバイス  インデッ クス  
(0 ～ n-1)

userRegNumber BSCAN ブロ ッ クの USER レジスタ番号 (1 から開始)
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::chipscope::csecore_get_core_status
ターゲッ ト  ChipScope Pro コアからスタティ ッ ク  ステータス  ワードを読み出します。

構文

::chipscope::csecore_get_core_status handle [list deviceIndex 
userRegNumber coreIndex] bitCount

引数

リ ターン

ネス ト された リ ス ト 。 外部リ ス トには、内部リ ス ト と コア ステータスを示す文字列 (16 進数) の 2 つ
のエレ メン トが含まれ、 内部リ ス トには、 次のエレ メン トが含まれます。

メモ : コマンドがエラーになる と例外になり ます。

例

2 つ目の USER レジスタの 4 つ目のデバイスの中の ICON コアに接続される最初のコアのステー

タスを取得します。

%set coreRef [list 3 2 0]

%set coreStatus [csecore_get_core_status $handle $coreRef]

CseCore コマンドの リ ス トに戻る

表 5-59 : ::chipscope::csecore_get_core_status サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

[list deviceIndex 
userRegNumber 
coreIndex]

次の 3 つのエレ メン ト を含むリ ス ト  :

• n-length の JTAG チェーンのデバイス  インデッ クス  
(0 ～ n-1)

• BSCAN ブロ ッ クの USER レジスタ番号 (1 から開始)

• コア ユニッ トのインデッ クス。 ICON に接続される最初

のコア ユニッ トのインデッ クスは 0 です。

bitCount ステータス  ワードの長さ  (ビッ ト数)

エレメン ト 説明

manufacturerId Manufacturer ID (整数)

coreType コア タイプ (整数)

coreMajorVersion コアのメジャー バージ ョ ン (整数)

coreMinorVersion コアのマイナー バージ ョ ン (整数)

coreRevision コアのリ ビジ ョ ン (整数)
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::chipscope::csecore_is_cores_supported
ターゲッ ト  FPGA デバイスで ChipScope Pro コアがサポート されるかど うかテス ト します。

構文

::chipscope::csecore_is_cores_supported handle idcode

引数

リ ターン

idcode で指定されるデバイスで ChipScope Pro コアがサポート される場合は 1、されない場合は 0。

コマンドがエラーになる と例外になり ます。

例

$idcode で指定されたデバイスで ChipScope Pro コアがサポート されるかど うかを決定します。

%set supportsCores [csecore_is_cores_supported $handle $idcode]

CseCore コマンドの リ ス トに戻る

表 5-60 : ::chipscope::csecore_is_cores_supported サブコマンドの引数

引数 タイプ 説明

handle
必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

idcode 該当デバイスの IDCODE
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CseVIO コマンド

こ こでは、 次の CseFpga コマンドの詳細について説明します。

• ::chipscope::csevio_get_core_info

• ::chipscope::csevio_is_vio_core

• ::chipscope::csevio_init_core

• ::chipscope::csevio_terminate_core

• ::chipscope::csevio_define_signal

• ::chipscope::csevio_define_bus

• ::chipscope::csevio_undefine_name

• ::chipscope::csevio_write_values

• ::chipscope::csevio_read_values

::chipscope::csevio_get_core_info
ターゲッ ト  VIO コアからスタティ ッ ク  ステータス  ワードを読み出します。

構文

::chipscope::csevio_get_core_info handle [list deviceIndex 
userRegNumber coreIndex] coreInfoTclArray

引数

表 5-61 : ::chipscope::csevio_get_core_info サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

[list deviceIndex 
userRegNumber 
coreIndex]

次の 3 つのエレ メン ト を含むリ ス ト  :

• n-length の JTAG チェーンのデバイス  インデッ クス  
(0 ～ n-1)

• BSCAN ブロ ッ クの USER レジスタ番号 (1 から開始)

• コア ユニッ トのインデッ クス。 ICON に接続される最初

のコア ユニッ トのインデッ クスは 0 です。

coreInfoTclArray
Tcl アレイ名。 このコマンドが問題なく実行される と、アレ

イに次の「リ ターン」セクシ ョ ンに記述される情報が含まれ

ます。
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リ ターン

次のエレ メン ト を含み、 coreInfoTclArray 引数からコア情報を リ ターンします。

メモ : コマンドがエラーになる と例外になり ます。

例

2 つ目の USER レジスタの 4 つ目のデバイスの中の ICON コアの最初の制御ポートに接続される

VIO コアのコア情報を取得します。 VIO コアの非同期入力信号の数を表記します。

%set coreRef [list 3 2 0]

%csevio_get_core_info $handle $coreRef coreInfoTclArray

%puts stdout “$coreInfoTclArray($CSEVIO_ASYNC_INPUT_COUNT)”

CseVIO コマンドの リ ス トに戻る

エレメン ト 説明

manufacturerId Manufacturer ID (整数)

$CSEVIO_MANUFACTURER_ID 製造元の ID。 ザイ リ ンクス社の場合は 1

$CSEVIO_CORE_TYPE コア タイプ フ ィールド。 各 ChipScope コアで異な

り、 VIO の場合は 9

$CSEVIO_CORE_MAJOR_VERSION メジャー リ リース  バージ ョ ン

$CSEVIO_CORE_MINOR_VERSION マイナー リ リース  バージ ョ ン

$CSEVIO_CORE_REVISION リ ビジ ョ ン

$CSEVIO_CG_MAJOR_VERSION CoreGen 用フィールド  (10.1 以降で生成されたコア

の場合)

$CSEVIO_CG_MINOR_VERSION CoreGen 用フィールド  (10.1 以降で生成されたコア

の場合)

$CSEVIO_CG_MINOR_VERSION
_ALPHA

CoreGen 用フィールド  (10.1 以降で生成されたコア

の場合)

$CSEVIO_ASYNC_INPUT_COUNT 使用される非同期入力信号の数

$CSEVIO_SYNC_INPUT_COUNT 使用される同期入力信号の数

$CSEVIO_ASYNC_OUTPUT_COUNT 使用される非同期出力信号の数

$CSEVIO_SYNC_OUTPUT_COUNT 使用される同期出力信号の数
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::chipscope::csevio_is_vio_core
ターゲッ ト  コアが VIO コアかど うか判別します。

構文

::chipscope::csevio_is_vio_core handle [list deviceIndex userRegNumber 
coreIndex]

引数

リ ターン

コアが VIO コアの場合は 1、 それ以外の場合は 0。

コマンドがエラーになる と例外になり ます。

例

2 つ目の USER レジスタの 4 つ目のデバイスの中の ICON コアに接続される最初のコアが VIO コ
アかど うかを決定します。

%set coreRef [list 3 2 0]

%set isVIO [csevio_is_vio_core $handle $coreRef]

CseVIO コマンドの リ ス トに戻る

表 5-62 : ::chipscope::csevio_is_vio_core サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

[list deviceIndex 
userRegNumber 
coreIndex]

次の 3 つのエレ メン ト を含むリ ス ト  :

• n-length の JTAG チェーンのデバイス  インデッ クス  
(0 ～ n-1)

• BSCAN ブロ ッ クの USER レジスタ番号 (1 から開始)

• コア ユニッ トのインデッ クス。 ICON に接続される最初

のコア ユニッ トのインデッ クスは 0 です。
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::chipscope::csevio_init_core
ターゲッ ト  VIO コアに関連するグローバル変数を初期化します。

構文

::chipscope::csevio_init_core handle [list deviceIndex userRegNumber 
coreIndex]

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

2 つ目の USER レジスタの 4 つ目のデバイスの中の ICON コアに接続された VIO コアを初期化し

ます。 

%set coreRef [list 3 2 0]

%csevio_init_core $handle $coreRef

CseVIO コマンドの リ ス トに戻る

表 5-63 : ::chipscope::csevio_init_core サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

[list deviceIndex 
userRegNumber 
coreIndex]

次の 3 つのエレ メン ト を含むリ ス ト  :

• n-length の JTAG チェーンのデバイス  インデッ クス  
(0 ～ n-1)

• BSCAN ブロ ッ クの USER レジスタ番号 (1 から開始)

• コア ユニッ トのインデッ クス。 ICON に接続される最初

のコア ユニッ トのインデッ クスは 0 です。
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::chipscope::csevio_terminate_core
ターゲッ ト  VIO コアに関連するグローバル変数を削除してメモリ を解放します。

構文

::chipscope::csevio_terminate_core handle [list deviceIndex 
userRegNumber coreIndex]

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

2 つ目の USER レジスタの 4 つ目のデバイスの中の ICON コアに接続さ れた  VIO コアを終了し

ます。 

%set coreRef [list 3 2 0]

%csevio_terminate_core $handle $coreRef

CseVIO コマンドの リ ス トに戻る

表 5-64 : ::chipscope::csevio_terminate_core サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

[list deviceIndex 
userRegNumber 
coreIndex]

次の 3 つのエレ メン ト を含むリ ス ト  :

• n-length の JTAG チェーンのデバイス  インデッ クス  
(0 ～ n-1)

• BSCAN ブロ ッ クの USER レジスタ番号 (1 から開始)

• コア ユニッ トのインデッ クス。 ICON に接続される最初

のコア ユニッ トのインデッ クスは 0 です。
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::chipscope::csevio_define_signal
指定した VIO 信号ビッ トの名前を定義します。 csevio_init_core が最初に呼び出される必要があ り

ます。

構文

::chipscope::csevio_define_signal handle [list deviceIndex 
userRegNumber coreIndex] name flags bitIndex

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

2 つ目の USER レジスタの 4 つ目のデバイスの中の ICON コアに接続された VIO コアで、

ASYNC_INPUT ポートのビッ ト  0 に割り当てられた status_bit という信号を定義します。

%set coreRef [list 3 2 0]

%set csevio_define_signal $handle $coreRef “status_bit” 

$CSEVIO_ASYNC_INPUT 0

CseVIO コマンドの リ ス トに戻る

表 5-65 : ::chipscope::csevio_define_signal サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

[list deviceIndex 
userRegNumber 
coreIndex]

次の 3 つのエレ メン ト を含むリ ス ト  :

• n-length の JTAG チェーンのデバイス  インデッ クス  (0 
～ n-1)

• BSCAN ブロ ッ クの USER レジスタ番号 (1 から開始)

• コア ユニッ トのインデッ クス。 ICON に接続される最初

のコア ユニッ トのインデッ クスは 0 です。

name
信号に指定する名前。 すべての入力信号名はほかの入力信

号と異なっている必要があ り、 出力信号名もすべてほかの

出力信号と異なっている必要があ り ます。 

flags

信号のポート  タイプを決定するために使用されるフラグ。

フラグ値は次のいずれかになり ます。

• $CSEVIO_SYNC_OUTPUT

• $CSEVIO_SYNC_INPUT

• $CSEVIO_ASYNC_OUTPUT

• $CSEVIO_ASYNC_INPUT 

bitIndex ポートへのビッ ト  インデッ クス。 どのポート信号を name
に割り当てるか決定するために使用します。
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::chipscope::csevio_define_bus
VIO 信号ビッ トのグループ (バス) 名を定義します。 csevio_init_core が最初に呼び出される必要が

あ り ます。

構文

::chipscope::csevio_define_bus handle [list deviceIndex userRegNumber 
coreIndex] name flags bitIndexArray arrayLen

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

2 つ目の USER レジスタの 4 つ目のデバイスの中の ICON コアに接続された VIO コアで、

SYNC_OUTPUT ポートのビッ ト  3:0 に割り当てられた control_bus とい うバスを定義します。

%set coreRef [list 3 2 0]

%set csevio_define_bus $handle $coreRef “control_bus”

$CSEVIO_SYNC_OUTPUT [list 0 1 2 3]

CseVIO コマンドの リ ス トに戻る

表 5-66 : ::chipscope::csevio_define_bus サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

[list deviceIndex 
userRegNumber 
coreIndex]

次の 3 つのエレ メン ト を含むリ ス ト  :

• n-length の JTAG チェーンのデバイス  インデッ クス  
(0 ～ n-1)

• BSCAN ブロ ッ クの USER レジスタ番号 (1 から開始)

• コア ユニッ トのインデッ クス。 ICON に接続される最初

のコア ユニッ トのインデッ クスは 0 です。

name
バスに指定する名前。 すべての入力バス名はほかの入力バ

スと異なっている必要があ り、 出力バス名もすべてほかの

出力バスと異なっている必要があ り ます。 

flags

バスのポート  タイプを決定するために使用されるフラグ。

フラグ値は次のいずれかになり ます。

• $CSEVIO_SYNC_OUTPUT

• $CSEVIO_SYNC_INPUT

• $CSEVIO_ASYNC_OUTPUT

• $CSEVIO_ASYNC_INPUT 

[list bitIndicies...] バスの信号のビッ ト  インデッ クスを含むリ ス ト 。 リ ス トの

一番左のエレメン トが LSB です。
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::chipscope::csevio_undefine_name
VIO 信号/バス名と関連するすべての情報を削除します。

構文

::chipscope::csevio_undefine_name handle [list deviceIndex 
userRegNumber coreIndex] name flags

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

2 つ目の USER レジスタの 4 つ目のデバイスの中の ICON コアに接続された VIO コアで、

SYNC_OUTPUT ポートのビッ トに割り当てられた control_bus というバスの定義を解除します。

%set coreRef [list 3 2 0]

%set csevio_undefine_name $handle $coreRef “control_bus”

$CSEVIO_SYNC_OUTPUT

CseVIO コマンドの リ ス トに戻る

表 5-67 : ::chipscope::csevio_undefine_name サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッ

シ ョ ンへのハンドル

[list deviceIndex 
userRegNumber 
coreIndex]

次の 3 つのエレ メン ト を含むリ ス ト  :

• n-length の JTAG チェーンのデバイス  インデッ クス  (0 
～ n-1)

• BSCAN ブロ ッ クの USER レジスタ番号 (1 から開始)

• コア ユニッ トのインデッ クス。 ICON に接続される最初

のコア ユニッ トのインデッ クスは 0 です。

name 削除する信号またはバスの名前

flags

信号またはバスのポート  タイプを決定するために使用され

るフラグ。 フラグ値は次のいずれかになり ます。

• $CSEVIO_SYNC_OUTPUT

• $CSEVIO_SYNC_INPUT

• $CSEVIO_ASYNC_OUTPUT

• $CSEVIO_ASYNC_INPUT 
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::chipscope::csevio_write_values
ターゲッ ト  VIO コアの指定した信号/バスに値を書き込みます。

構文

::chipscope::csevio_write_values handle [list deviceIndex 
userRegNumber coreIndex] outputTclArray

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

例では、 次が前提と されています。

• VIO コアには既に coreRef が設定済みです。

• reset という信号が SYNC_OUTPUT ポートのビッ ト と して定義されています。

• instruction というバスが ASYNC_OUTPUT ポートの 8 ビッ ト  バス と して定義されています。

1. reset 信号を 0 に、 instruction バスをフ リ ップフロ ップ (FF) に設定します。

%set outputTclArray(reset) 0

%set outputTclArray(instruction) FF

%csevio_write_values $handle $coreRef outputTclArray

2. 0 の後に 1 つのクロ ッ ク  サイクル パルスの 1 を送信します。

表 5-68 : ::chipscope::csevio_write_values サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッシ ョ ン

へのハンドル

[list deviceIndex 
userRegNumber 
coreIndex]

次の 3 つのエレ メン ト を含むリ ス ト  :

• n-length の JTAG チェーンのデバイス  インデッ クス  
(0 ～ n-1)

• BSCAN ブロ ッ クの USER レジスタ番号 (1 から開始)

• コア ユニッ トのインデッ クス。 ICON に接続される最初のコ

ア ユニッ トのインデッ クスは 0 です。

outputTclArray

Tcl アレイの名前。 アレイへのインデッ クスは csevio_define_
signal で定義された出力信号の名前、 または csevio_define_bus 
で定義されたバスの名前です。 SYNC_OUTPUT ポートの信号

の名前には .pulsetrain を末尾に付けられるほか、 文字列の 16 
進数値が指定できます (LSB は一番右の文字)。 パルス  ト レイン

を使用するには、 最初の値が右側へ送信され、 16 の値が渡され

る必要があ り ます。 値はそれぞれバイ ト  アライ メン ト される必

要があ り ます。 つま り、 1 つの信号は値ごとに 2 つの 16 進数文

字を必要と します。 値が 8 ビッ ト を超える場合は、 値ごとに 2 
つ文字を追加する必要があ り ます。 アレイを再利用するために

このコマンドを呼び出した後は、 アレイの各エレ メン トの設定

を手動で解除する必要があ り ます。
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%set outputTclArray(reset.pulsetrain) 00000000000000000000000000000001

%csevio_write_values $handle $coreRef outputTclArray

CseVIO コマンドの リ ス トに戻る
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::chipscope::csevio_read_values
ターゲッ ト  VIO コアの指定した信号/バスから値を読み出します。

構文

::chipscope::csevio_read_values handle [list deviceIndex userRegNumber 
coreIndex] inputTclArray

引数

リ ターン

コマンドがエラーになる と例外になり ます。

例

例では、 次が前提と されています。

• VIO コアには既に coreRef が設定済みです。

• status とい う信号が SYNC_INPUT ポートのビッ ト と して定義されています。

• data_bus とい うバスが ASYNC_INPUT ポートの 8 ビッ ト  バス と して定義されています。

1. status および data_bus の値を取得して stdout に表示します。

%csevio_read_values $handle $coreRef inputTclArray
% puts stdout “status = $inputTclArray(status.value)”
% puts stdout “data_bus = $inputTclArray(data_bus)”

表 5-69 : ::chipscope::csevio_read_values サブコマンドの引数

引数 タイプ 説明

handle

必須

::chipscope::csejtag_session create でリ ターンされたセッシ ョ ン

へのハンドル

[list deviceIndex
userRegNumber
coreIndex]

次の 3 つのエレ メン ト を含むリ ス ト  :

• n-length の JTAG チェーンのデバイス  インデッ クス  
(0 ～ n-1)

• BSCAN ブロ ッ クの USER レジスタ番号 (1 から開始)

• コア ユニッ トのインデッ クス。 ICON に接続される最初のコ

ア ユニッ トのインデッ クスは 0 です。

inputTclArray

Tcl アレイの名前。 アレイへのインデッ クスは csevio_define_
signal で定義された入力信号の名前、 または csevio_define_bus
で定義された入力バスの名前です。入力信号またはバスのさまざ

まなステート を指定するには、 次のよ う な接尾語を使用します。

• .value は信号/バスの値を指定します (接尾語なし と同じ)。

• .activity_up は非同期の Low から  High の動作を指定します。

• .activity_down は非同期の High から  Low の動作を指定し

ます。

• .sync_activity_up は同期の Low から  High の動作を指定しま

す (SYNC_INPUT 信号/バスの場合にのみ有効)。

• .sync_activity_down は同期の High から  Low の動作を指定

します (SYNC_INPUT 信号/バスの場合にのみ有効)。
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2. status のさまざまなステート を取得して stdout に表示します。

%csevio_read_values $handle $coreRef inputTclArray
% puts stdout “up = $inputTclArray(status.activity_up)”
% puts stdout “dn = $inputTclArray(status.activity_down)”
% puts stdout “sup = $inputTclArray(status.sync_activity_up)”
% puts stdout “sdn = $inputTclArray(status.sync_activity_down)”

CseVIO コマンドの リ ス トに戻る

CSE/Tcl の例

ChipScope Pro をインス トールする と、CseJtag Tcl インターフェイスを使用する  Tcl スク リプ トの

例が含まれます。 この例では、ザイ リ ンクス  パラレル ケーブルまたはザイ リ ンクス  プラ ッ ト フォー

ム USB ケーブルを開いて JTAC チェーンをスキャンし、 チェーンで検出されたデバイスに関する

情報を リ ターンします。 この例のスク リプ トは、 次のディ レク ト リに含まれます。

<XILINX_ISE_INSTALL>\cse\tcl\csejtag_example1.tcl 

このスク リプ トは、 ザイ リ ンクス  ISE Design Suite ソフ ト ウェアに含まれる  Tcl シェル (xtclsh) ま
たは ActiveState Software 社の ActiveTcl 8.4 Tcl シェル (tclsh) で実行できます ([252 ページのリ

ファレンス  25 を参照])。 コマンド  ライン シェルで Tcl 例を実行するには、 csejtag_example1.tcl の
あるディ レク ト リ  (上記参照) に変更し、 OS 別の次の手順に従ってください。

• 32 ビッ ト  Windows の場合 :

♦ ザイ リ ンクス  パラレル ケーブルを使用するには、 次を入力します。

<XILINX_ISE_INSTALL>\bin\nt\xtclsh csejtag_example1.tcl -par

♦ ザイ リ ンクス  プラ ッ ト フォーム ケーブル USB を使用するには、 次を入力します。

<XILINX_ISE_INSTALL>\bin\nt\xtclsh csejtag_example1.tcl -usb

• 64 ビッ ト  Windows の場合 :

♦ ザイ リ ンクス  パラレル ケーブルを使用するには、 次を入力します。

<XILINX_ISE_INSTALL>\bin\nt64\xtclsh csejtag_example1.tcl -par

♦ ザイ リ ンクス  プラ ッ ト フォーム ケーブル USB を使用するには、 次を入力します。

<XILINX_ISE_INSTALL>\bin\nt64\xtclsh csejtag_example1.tcl -usb

• 32 ビッ ト  Linux の場合 :

♦ ザイ リ ンクス  パラレル ケーブルを使用するには、 次を入力します。

<XILINX_ISE_INSTALL>/bin/lin/xtclsh csejtag_example1.tcl -par

♦ ザイ リ ンクス  プラ ッ ト フォーム ケーブル USB を使用するには、 次を入力します。

<XILINX_ISE_INSTALL>/bin/lin/xtclsh csejtag_example1.tcl -usb 

• 64 ビッ ト  Linux の場合 :

♦ ザイ リ ンクス  パラレル ケーブルを使用するには、 次を入力します。

<XILINX_ISE_INSTALL>/bin/lin64/xtclsh csejtag_example1.tcl -par

♦ ザイ リ ンクス  プラ ッ ト フォーム ケーブル USB を使用するには、 次を入力します。

<XILINX_ISE_INSTALL>/bin/lin64/xtclsh csejtag_example1.tcl -usb
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CSE/Tcl の例

その他の Tcl スク リプ ト例 (csevio_example1.tcl とい う  CSE VIO の Tcl スク リプ ト例など) は、

csejtag_example1.tcl と同じディ レク ト リにあ り ます。 これらのスク リプ トは、その他の CSE/Tcl 関
数呼び出しの例です。 
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付録 A

ChipScope Pro ツール ト ラブルシュー
テ ィ ング ガイド

概要

この付録では、 ChipScope™ Pro ツールのインス トールおよび ISE® ソフ ト ウェアとの統合に関す

る ト ラブルシュート方法を説明します。 ChipScope Pro ツールを使用する際によ く発生するエラー

や問題について説明するほか、 ChipScope Pro およびザイ リ ンクス  JTAG ベースのプログラム ケー

ブル インス トールの ト ラブルシュート方法についても説明します。 各問題には、 それぞれ次のよ う

なセクシ ョ ンが含まれます。

• 問題 : このセクシ ョ ンには、 問題が警告メ ッセージや警告の形式で表示される問題と同じもの

かど うかを確認する方法がリ ス ト されます。

• 回避策 : このセクシ ョ ンには、 問題の解決方法がリ ス ト されます。
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ChipScope Pro ツールのインストールに関する ト ラブルシューティング

表 A-1 は、ChipScope Pro ツールのインス トールでよ く発生するエラー メ ッセージや問題について

ま とめたものです。

表 A-1 : ChipScope Pro ツールのインストールに関する ト ラブルシューテ ィング

問題 回避策

Windows または Linux のいずれかの場合、 ISE ツール

で <filename>.cdc ファ イルをダブルク リ ッ ク しても、

ChipScope Pro Core Inserter が起動されず、次のエラー

メ ッセージがコンソールに表示されます。

ERROR: Unable to find the Chipscope 
Exe at NotHere/inserterlauncher.exe

1. 次の 3 つのパラ メータが正し く設定されているかど うか確認

するこ とで、環境が正し く設定されているかど うかを確認して

ください。

♦ CHIPSCOPE 環境変数 : ザイ リ ンクスの ChipScope Pro
ツールのインス トール ディ レク ト リに設定する必要があ

り ます。 

- Windows の場合、[スタート ] → [設定] → [コン ト ロール 
パネル] → [システム] → [詳細設定] タブ → [環境変数] 
ボタンをク リ ッ ク します。 CHIPSCOPE 環境変数がイン

ス トール ディ レク ト リ を指定するよ うにします。 通常、

このディ レク ト リは C:\Xilinx\<version 
number>\ChipScope です。

- Linux の場合、 例のよ うに CHIPSCOPE 環境変数がイ

ンス トール ディ レク ト リ を指定するよ うにします (例 : 
setenv CHIPSCOPE /tools/xilinx/<version 
number>/chipscope)。

♦ XILINX 環境変数 : ChipScope Pro ツールが正し く動作す

るには、 ザイ リ ンクスの ISE ツールのインス トール ディ

レク ト リに設定する必要があ り ます。

- Windows の場合、 [スタート ] → [設定] → [コント ロール 
パネル] → [システム ] → [詳細設定] タブ → [環境変数] ボ
タンをク リ ッ ク します。 XILINX 環境変数がインスト ー

ル ディ レク ト リ を指定するよ う にします。 通常、 この

ディ レク ト リ は C:\Xilinx\<version number>\ISE です。

- Linux の場合、 インス トールが終了する と、 環境変数

ファ イルが自動的に作成されます。 ザイ リ ンクス  ISE ソ
フ ト ウェア インス トール ディ レク ト リに移動し、

source <settings file> を実行します (<settings file> は 
OS およびシェル タイプによって、 settings32.sh、
settings32.csh、 settings64.sh、 または settings64.csh に
な り ます)。

2. ISE ツールで [Edit] → [Preferences] → [ISE General] →
[Integrated Tools] が <install>/bin/<platform> に設定されてい

るかど うか確認します。

♦ <install> は ChipScope Pro ツールのインス トール ディ レク

ト リです。

♦ <platform> は 32 ビッ ト  Linux の場合 lin、64 ビッ ト  Linux の
場合 lin64、 32 ビッ ト  Windows の場合 nt、 64 ビッ ト

Windows の場合 nt64 にな り ます。 ChipScope Pro ツールの

<platform> は ISE ツールのプラ ッ ト フォームと同じである

必要があ り ます。

Windows の [スタート ] メニューから  Core Inserter を
実行する と、スプラ ッシュ画面が表示されるのにツール

が起動されません。

Windows の場合、Core Inserter をコマンド  ラインから

起動する と、 次のメ ッセージを示すポップアップ ダイ

アログ ボッ クスが表示されます。

inserter.exe - entry point not found

Linux の場合、 inserter.sh スク リプ ト を起動して Core
Inserter を実行する と、次のよ うなエラー メ ッセージが

表示されます。

ERROR: Unable to locate Xilinx ISE 
<release number> tools in path!
ERROR: You must set the CHIPSCOPE 
environment variable before running 
this tool
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ザイリンクス JTAG プログラム ケーブルに関する ト ラブルシューテ ィング

このセクシ ョ ンでは、ザイ リ ンクス  JTAG プログラム ケーブルが正し く接続されているかど うか確

認する方法やザイ リ ンクス  JTAG ケーブルのよ くある接続問題を ト ラブルシュートする方法につ

いて説明します。 このセクシ ョ ンで説明される問題は、 次のとおりです。

• ケーブルが正し く接続されているか確認する方法については、 237 ページの表 A-2 を参照して

ください。

• 「INFO: Cable connection failed」 という メ ッセージに関する問題のト ラブルシューティングに

ついては、 237 ページの表 A-2 を参照して ください。

• 「ERROR:iMPACT:2246 - A reference voltage has not been detected...」 という メ ッセージに関

する問題のト ラブルシューティングについては、 239 ページの表 A-3 を参照して ください。

• 「ERROR: No devices detected while scanning the JTAG chain」 、 「ERROR: Failed detecting
JTAG device chain」、または 「ERROR: Opened Xilinx Platform USB Cable but failed to detect
JTAG Chain」 とい うエラー メ ッセージに関する問題の ト ラブルシューティングについては、

240 ページの表 A-4 を参照して ください。

• 「ERROR: Socket Open Failed. localhost/127.0.0.1:50001」 という メ ッセージに関する問題のト

ラブルシューティングについては、 242 ページの表 A-5 を参照して ください。

表 A-2 : プラッ ト フォーム ケーブル USB の接続に関する ト ラブルシューテ ィング

問題 回避策

1. ケーブルに接続しよ う とする と、 次のよ う な

メ ッセージがコンソールに表示されます。

INFO: Cable connection failed.
ERROR: Failed to open Xilinx 
Platform USB Cable. See message(s) 
above.

このメ ッセージは、 ケーブルはインス トール

されているのに接続がされていない場合に表

示されます。 ケーブルが接続されているのに

このメ ッセージが表示される場合は、 ケーブ

ルが破損しているので、 フ ァームウ ェアの

アップデートが必要です。

まず、ケーブルが接続されているかど うか確認します。 問題 2 に進んでく

ださい。

2. ケーブルは適切な USB ポートに挿入されて

いますか。
いいえ : ケーブルを接続し、 ChipScope Pro Analyzer で接続して くださ

い。

はい : 問題 3 に進んでください。

3. 正しいケーブルが接続時に指定されていまし

たか。
いいえ/わからない : Analyzer ツールの [JTAG Chain] メニューで正しい

ケーブルが選択されていたかど うか確認します。 正しいケーブルを選択

し、 接続し直します。

はい : 問題 4 に進んでください。

4. サーバー ホス ト設定は正し く設定されてい

ますか。
いいえ/わからない : ChipScope Pro Analyzer ツールで [JTAG Chain] →
[Server Host Settings] をク リ ッ ク します。 ダイアログ ボッ クスで正しい

サーバー ホス ト名 (または IP アドレス) とポートが使用されているかど

うか確認します。 ローカル システムのケーブルに接続する場合は、

localhost:50001 を使用してください。

はい : 問題 5 に進んでください。
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5. 特定のプラ ッ ト フォーム ケーブル USB に接

続する場合、 正しいポート設定を選択してい

ますか。

いいえ/わからない : ChipScope Pro Analyzer ツールで [JTAG Chain] →
[Platform Cable USB] をク リ ッ ク します。 ダイアログ ボッ クスでポート

設定がそのケーブルの正しいポート数に指定されているかど うか確認し

ます。 たとえば、 最初のケーブルには、 ポート  USB21 を選択します。

はい : 問題 6 に進んでください。

6. ファームウェア アップデートが必要な可能

性があ り ます。
ファームウェアをアップデートするには、 次の手順に従います。

1. DOS シェルを開いて、 次を入力して環境変数を設定します。

SET XIL_IMPACT_ENV_USB2_FORCE_CPLD_UPDATE=TRUE

2. DOS シェルに impact と入力して iMPACT を起動します。

3. [Cable Communication Setup] ダイアログ ボッ クスでザイ リ ンクス

USB ケーブルを選択し、 アップデートが完了するのを待ちます。

4. iMPACT を終了します。

5. DOS シェルに次を入力して環境変数を一掃します。

SET XIL_IMPACT_ENV_USB2_FORCE_CPLD_UPDATE=

環境変数の設定方法の詳細と  Linux ベースの OS での環境変数設定方法

については、 (ザイ リ ンクス  アンサー 11630) を参照して ください。

これで解決しない場合は、ザイ リ ンクス  テクニカル サポートで次の情報

を含めてケースを開いてください。

• XInfo

• cs_analyzer.log

表 A-2 : プラッ ト フォーム ケーブル USB の接続に関する ト ラブルシューテ ィング (続き)

問題 回避策

http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=answer+record&sub=11630
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表 A-3 : ケーブルの参照電圧に関する ト ラブルシューテ ィング

問題 回避策

1. ケーブルに接続しよ う とする と、 ケーブルの 
LED がオレンジになり  (緑にならないで)、 次の

よ うなメ ッセージがコンソールに表示されます。

ERROR: ERROR:iMPACT:2246 - A 
reference voltage has not been 
detected on the ribbon cable 
interface to the target system (pin 
2). Check that power is applied to 
the target system and that the ribbon 
cable is properly seated at both 
ends. The status LED on Platform 
Cable USB will be GREEN if target 
voltage is in the proper range and 
applied to the correct pin.

この問題は、 通常 VCC の電圧が正し くないために発生します。 問題

2 に進んでください。

2. ターゲッ ト  ボード に電源は投入されていますか。 いいえ : ボードに正し く電源が投入されているかど うか確認します。

はい : 問題 3 に進んでください。

3. リ ボン ケーブルがターゲッ ト  ボード  コネクタ

とプラ ッ ト フォーム ケーブル USB コネクタに

しっかり さ さっていますか。

いいえ : リ ボン ケーブルを両方のコネクタにさ し直します。

はい : 問題 4 に進んでください。

4. ケーブルの VCC 電圧のレベルは正しいですか。 いいえ/わからない : テス ト  ツールでボードの電圧を調べて、 電圧が

正しい範囲内にあるよ うにします。

はい : 次の情報を含めてザイ リ ンクス  テクニカル サポートからケー

スを開きます。

• XInfo

• cs_analyzer.log

• 可能であれば、 ターゲッ ト  ボードのケーブル接続時のケーブル

の VCC 電圧レベルのスク リーンシ ョ ッ ト
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表 A-4 : JTAG デバイス検出に関する ト ラブルシューテ ィング

問題 回避策

1. ケーブルに接続しよ う とする と、 次のよ う な

メ ッセージがコンソールに表示されます。

ERROR: No devices detected while 
scanning the JTAG chain
ERROR: Failed detecting JTAG 
device chain
ERROR: Opened Xilinx Platform USB 
Cable but failed to detect JTAG 
Chain.

この問題の原因は、 TDI または TDO が未接

続か High または Low になった場合に発生す

る  JTAG チェーンの問題であるこ とがよ くあ

り ます。 通常はボードに関連する問題である

こ とを示しています。

 問題 2 に進んでください。

2. ケーブル TDI と  TDO はケーブル ヘッダで

正し く接続されていますか。
いいえ/わからない : 可能であれば、別のボード、 ケーブル、 ケーブル コ
ネク タを使用して、 エラーの原因を見つけてください。 有効なチェーン

を含めるよ うに接続を修正します。 リ ボン ケーブルまたはフライ  リード

を変える と、接続できるこ と もあ り ます。 別のボードを使用する と、問題

が発生しないこ と もあ り ます。

はい : 問題 3 に進んでください。

3. ボードのスイ ッチ ノ イズが原因で JTAG 
チェーンが検出されませんか。

はい/わからない : 可能であれば、 ボード  レベルのリセッ ト を使用して、

ほかのデバイスを リセッ ト  ステートにし、 JTAG チェーンを検出し直し

てみます。 この リセッ ト をアサートする と、JTAG 操作中のボードのノ イ

ズが削減されるこ とがあ り ます。

いいえ : 問題 4 に進んでください。

4. ザイ リ ンクス  デバイス以外のデバイスが

JTAG チェーン内にあ り ますか。
はい : ザイ リ ンクス  デバイス以外のデバイスのアクティブ Low の

TRST# ピンが High になっているかど うか確認し、 JTAG チェーンを検

出し直します。

いいえ : 問題 5 に進んでください。

5. JTAG チェーンに含まれる  Virtex®-4、
Virtex、 Virtex-E、 または Spartan®-II/-E デ
バイスのアクティブ Low の PROG# ピンが 
Low に保持されていますか。

はい : これらのデバイスの PROG# ピンは必ず High になるよ うにしま

す。 PROG# のパルスが少ないと、 これらのデバイスの JTAG TAP コン

ト ローラが リセッ ト され、 チェーン上のすべての動作が実行されなくな

り ます。

いいえ : 問題 6 に進んでください。
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6. JTAG チェーンに含まれるデバイスが 5 個よ

り も多く、 バッファを介さない TCK および

TMS ネッ ト を使用していますか。

はい : TCK および TMS 信号にバッファが必要である可能性があ り ま

す。 大まかですが、デバイスの数が 5 個を超える場合は、バッファを使用

する必要があ り ます。 LS244 は、 ザイ リ ンクスのデバイスにバッファを

う ま く追加した、 成功例です。 IEEE 1149.1 規格で定められているよ う

に、TMS および TDI ピンには内部プルアップ抵抗があ り ます。 これらの

50 ～ 150kΩの内部プルアップ抵抗は、 選択されているモードに関係な

くアクティブです。 抵抗値については、該当する  FPGA デバイス  ファ ミ

リのコンフ ィギュレーシ ョ ン ユーザー ガイ ドを参照してください。

• Spartan-3 FPGA コンフ ィギュレーシ ョ ン ユーザー ガイ ド

[251 ページのリ ファレンス  9 を参照]

• Spartan-6 FPGA コンフ ィギュレーシ ョ ン ユーザー ガイ ド

[251 ページのリ ファレンス  10 を参照]

• Virtex-4 FPGA コンフ ィギュレーシ ョ ン ユーザー ガイ ド

[251 ページのリ ファレンス  11 を参照]

• Virtex-5 FPGA コンフ ィギュレーシ ョ ン ユーザー ガイ ド

[251 ページのリ ファレンス  12 を参照]

• Virtex-6 FPGA コンフ ィギュレーシ ョ ン ユーザー ガイ ド  
[251 ページのリ ファレンス  13 を参照]

いいえ : 問題 7 に進んでください。

7. TCK の実行速度が速すぎませんか。 はい/わからない : [JTAG Chain] → [Xilinx Platform USB Cable] →
[Speed] でケーブル速度を削減して、 TCK ピンの周波数を最低速度設定

になるよ うに下げます。

いいえ : 次の情報を含めてザイ リ ンクス  テクニカル サポートからケー

スを開きます。

• XInfo

• cs_analyzer.log

• JTAG 操作中の JTAG ラ イン (TDI、 TDO、 TCK および TMS) のス

ク リーンシ ョ ッ ト  (できれば、ターゲッ ト  FPGA に近く  TCK の立ち

上がりエッジの 1 つに焦点をあてたスク リーンシ ョ ッ ト )

表 A-4 : JTAG デバイス検出に関する ト ラブルシューテ ィング (続き)

問題 回避策
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表 A-5 : サーバー ホスト接続に関する ト ラブルシューテ ィング

問題 回避策

1. ケーブルに接続し よ う とする と、 次のよ う な

メ ッセージがコンソールに表示されます。

ERROR: Socket Open Failed. 
localhost/127.0.0.1:50001 
java.net.ConnectException: 
Connection refused

これらのメ ッセージは、 別のアプリケーシ ョ ン

(たとえば、 iMPACT ソフ ト ウェア ツール) が
ケーブルを制御している場合に表示されます。

また、 システムにある別のデバイスまたはアプ

リ ケーシ ョ ンがそのポート / ソケッ トへのアク

セスを拒否している場合にも表示されます。

問題 2 に進んでください。

2. ChipScope Pro Analyzer ツールが TCP/IP ソケッ

ト へ接続されないよう にするファ イアウォール

アプリ ケーショ ンを実行していますか。

はい : TCP/IP ソケッ トへのアクセスを拒否する可能性のあるアプリ

ケーシ ョ ンをすべてオフにし、 ケーブルを接続し直します。

いいえ : 問題 3 に進んでください。

3. ほかのザイ リ ンクス  ソフ ト ウェア アプリケー

シ ョ ンを使用してケーブルにアクセス し ま し

たか。

はい : そのアプリ ケーシ ョ ンがケーブル ロ ッ クを解除していない可能

性があ り ます。 該当するアプリ ケーシ ョ ンを閉じる と、この問題は回避

できるこ とがほとんどです。 それでも回避できない場合は、 iMPACT
バッチ モードで次のコマンドを実行して、 停止した状態のケーブル

ロッ クを削除します。

> impact -batch
# cleancablelock
# exit

いいえ : 次の情報を含めてザイ リ ンクス  テクニカル サポートからケー

スを開きます。

• XInfo

• cs_analyzer.log
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ChipScope Pro Analyzer コアのト ラブルシューテ ィング

このセクシ ョ ンでは、ChipScope Pro Analyzer ツールからケーブルおよび JTAG チェーンにアクセ

スできるのに、ザイ リ ンクス  FPGA のデバッグ コアを検出できないか、ILA コアを ト リガーできな

いか、 キャプチャされた ILA コア データが表示されないといった問題について説明します。

• 「INFO: Found 0 Core Units in the JTAG device Chain」 という メ ッセージに関する問題のト ラ

ブルシューティングについては、 表 A-6 を参照して ください。

• 「Waiting for upload」 とい う メ ッセージに関する問題の ト ラブルシューティングについては、

246 ページの表 A-7 を参照して ください。

• 「ERROR: Fatal - Did not find trigger mark in buffer. Data buffer may be corrupt!」 という メ ッ

セージに関する問題のト ラブルシューティングについては、248 ページの表 A-8 を参照してく

ださい。

表 A-6 : コア検出に関する ト ラブルシューテ ィング

問題 回避策

1. ケーブルに接続し よ う とする と、 次のよ う な

メ ッセージがコンソールに表示されます。

INFO: Found 0 Core Units in the JTAG 
device Chain

ChipScope Pro Analyzer ツールでコア ユニッ ト

が検出されない場合、 いくつかの原因が考えら

れます。 Analyzer ツールは、 デバイスに含まれ

るコアの数やタイプを示すステータス  ワードを

得るために、 JTAG チェーンをポーリ ングしま

す。 ステータス  ワードを読み込むと、JTAG TAP
信号のノ イズやデザインに含まれるタイ ミ ング

問題のいずれかが原因でデータが破損し、 コア

に影響を与えるこ とがあ り ます。 

問題 2 に進んでください。

2. ChipScope Pro ICON、ILA、VIO、ATC2 デバッ

グ コアはすべて正し く インプ リ メン ト されてい

ますか (デザインに存在はしていますか)。

いいえ/わからない : デザインにこれらのコアが含まれるかど うかは、

次の手順で確認できます。

1. FPGE Editor を開いて、 配置配線済みの NCD ファ イルを編集し

ます。

2. [Tools] から  [ILA] を選択する と、 すべてのプローブ済み信号の

リ ス トが表示されます。 エラー メ ッセージに 「There is no ILA
core」 と表示されている場合は、デザインに ILA デバッグ コアが

含まれていません。 

コアが検出されなかった場合は、デザインに戻って、なぜコアがインプ

リ メン ト されていないのかを確認する必要があ り ます。 ILA コアおよ

び ICON コアを含め、ネッ ト リ ス トすべてが正し く インプリ メン ト さ

れているかど うかは、 合成および変換レポートから確認できます。 コ
アに関連付けられた NCF ファ イルも適用されているかど うか確認し

ます。 コアのネッ ト リ ス ト  ファ イル (*.ngc/ngo) がインプリ メンテー

シ ョ ン中に移動された場合、関連する制約ファイル (*.ncf) が適切に移

動されていない可能性があ り ます。

はい : 問題 3 に進んでください。
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3. プログラム ツールで JTAG ロジッ クを解放しま

したか。
いいえ/わからない : Analyzer ツールの代わりに iMPACT ツールを使

用して FPGA をプログラムする と、 この問題は回避できます。 次を実

行して ください。

1. iMPACT を起動して FPGA をプログラムします。 

2. iMPACT を終了します。 

3. ChipScope Pro Analyzer ツールを実行します。 

はい : 問題 4 に進んでください。

4. ザイ リ ンクス  System ACE™MPM デバイスが

JTAG チェーン内にあ り ますか。
はい : JTAG チェーンに System ACE MPM が含まれている場合、 既

知の問題があ り、 コア ユニッ トが検出されないこ とがあ り ます。 この

問題を回避するには、 ChipScope Pro Analyzer ツールのプロジェク ト

ファ イル (.cpj) に次の行を追加し、 ケーブルをオープンする前に読み

込みます。

avoidUserRegDeviceX=1,2 

「X」 を V50E デバイスの位置指数に置き換えます。 チェーンの最初の

デバイスのインデッ クスは 0 です。 V50E デバイスのスキャンをス

キップするこ とを示すメ ッセージが cs_analyzer.log ファ イルに表示

されます。

アップデート された .cpj ファ イルを使用する場合は、上記の手順に従

います。 ChipScope Pro Analyzer ツールの起動直後に .cpj ファ イルを

まず読み込んでください。 

いいえ : 問題 5 に進んでください。

5. ザイ リ ンクス  デバイス以外のデバイスが JTAG
チェーン内にあ り ますか。

はい : チェーンにザイ リ ンクス以外のデバイスが含まれる場合は、

ChipScope Pro Analyzer の GUI で命令レジスタ長を入力する必要が

あ り ます。 命令レジスタ長は、デバイスに対する  BSDL ファ イルの 次
の行に表示されています。

attribute INSTRUCTION_LENGTH of <entity name> : 
entity is XX;

正しい命令レジスタ長を入力しないと、 ChipScope Pro Analyzer で
JTAG デバイスのオフセッ トが正し く設定できず、 デバイスまたはデ

バッグ コアを識別できなくなり ます。

いいえ : 問題 6 に進んでください。

6. デバイスは、 スタート アップ シーケンスから問

題なく出ましたか。
いいえ : コンフ ィギュレーシ ョ ン オプシ ョ ンが適切に設定されていな

いために、 ChipScope Pro Analyzer ツールでコアを検出できない可能

性があ り ます。 BitGen オプシ ョ ンの LCK_cycle (Project Navigator で
は [Release DLL] オプシ ョ ン) が Nowait に設定されていない場合、

GWE の解放と共に ChipScope Pro コアが初期化されるため、

ChipScope Pro Analyzer でコアが検出されないこ とがあ り ます。 この

オプシ ョ ンを Nowait (デフォルト ) に設定する と、 問題が回避される

こ とがあ り ます。

はい : 問題 7 に進んでください。

表 A-6 : コア検出に関する ト ラブルシューテ ィング (続き)

問題 回避策
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7. FPGA デバイスの DONE ピンはボードで Low
に保持されていますか。

ボードに複数の FPGA があ り  DONE ピンが互

いに接続されていて、 コンフ ィギュレーシ ョ ン

されていないデバイスによ り  DONE が Low に
保持されコンフ ィギュレーシ ョ ンが完了してい

ない場合に、 このエラーが見られるこ とがあ り

ます。

はい : 問題を回避するには、 ボードの FPGA がすべてコンフ ィギュ

レーシ ョ ンされているこ とを確認、 または bitgen オプシ ョ ンの

DriveDONE がターゲッ ト  デバイスに対し設定されているこ とを確認

します。

いいえ : 問題 8 に進んでください。

8. コア制約は正し く適用されていますか。 いいえ/わからない : ILA のクロ ッ ク と して使用されるク ロ ッ クに

PERIOD 制約が追加されているこ とを確認します。 ISE プロジェク ト

でこのネッ トに制約が付けられていない場合、 ChipScope 制約は正し

く適用されず、 コアが認識されないこ とがあ り ます。 コアに関連付け

られた NCF ファ イルも適用されているかど うか確認します。 コアの

ネッ ト リ ス ト  ファ イル (*.ngc/ngo) がインプリ メンテーシ ョ ン中に移

動された場合、関連する制約ファイル (*.ncf) が移動されていない可能

性があ り ます。

はい : 次の情報を含めてザイ リ ンクス  テクニカル サポートからケー

スを開きます。

• cs_analyzer.log

• Inserter プロジェク ト  (<project_name>.cdc) も含めた ISE ソフ ト

ウェア プロジェク ト を圧縮します。

表 A-6 : コア検出に関する ト ラブルシューテ ィング (続き)

問題 回避策
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表 A-7 : LA コアのト リガに関する ト ラブルシューティ ング

問題 回避策

1. ILA コアに ト リガーを付ける と、 次のよ うな

メ ッセージがステータス  バーに表示されます。

Waiting for upload

アップデートの待機中を示すメ ッセージですが、この

後何も発生しません。 この問題には、次のよ うな原因

が考えられます。

• ト リ ガー条件が満たされていない

• ILA コアにマップされた ト リガー ク ロ ッ クが停

止している

• BUFG が ICON の JTAG CLK で使用されてい

ない

問題 2 に進んでください。

2. ト リ ガー条件は満たされていますか。 いいえ/わからない : ChipScope Pro Analyzer ツールのウ ィンド ウ下部

に表示される メ ッセージを確認します。 「Waiting for trigger, Sample
buffer has 0 samples(0%)」 のよ う なメ ッセージが表示されている場合

は、 次の手順に従ってください。

[Trigger Setup] および [Trigger Immediate] ウ ィンド ウを確認します。

ChipScope Pro Analyzer ツールが取得を開始し、サンプルの波形を表示

した場合、デザインには問題あ り ません。 クロ ッ ク信号は入ってきてい

ますが、 ト リガー条件が満たされていません。

イベン ト  ( ト リ ガー条件) が確実にこのデザインで生じている場合、

[Trigger Setup] ウインド ウで、条件が正し く設定されているかを確認し

ます。

はい : 問題 3 に進んでください。

3. ILA コアに接続されているク ロ ッ クは実行され

ていますか。 
いいえ/わからない : ウ ィンド ウ下部に「Waiting for Core to be armed,
slow or stopped clock」 のよ う なメ ッセージが表示された場合、 ト リ

ガー条件は問題の原因ではあ り ません。 ILA コアには有効なクロ ッ ク

がなく、 取得を開始できません。

この問題を修正するには、 ChipScope Pro Core Inserter ツールまたは

RTL コード  (生成したコアを手動で使用する場合) を使用して有効な

クロ ッ クをマップする必要があ り ます。 ILA コアにマップしたクロ ッ

クが動作しているか分からない場合は、 代わりにシステム クロ ッ ク

（または、 確実に動作しているク ロ ッ ク） を接続します。

はい : 問題 4 に進んでください。

4. ICON JTAG ク ロ ッ ク に BUFG を使用しまし

たか。
いいえ : JTAG ク ロ ッ クに BUFG が使用されない場合、 「Waiting for
upload」 とい う メ ッセージが表示されます。 この属性が確実に ICON
コアの生成用に設定されるよ うにするには、 デザインをインプ リ メン

ト し直す必要があ り ます。

はい : 問題 5 に進んでください。
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5. コア制約は正し く適用されましたか。 いいえ/わからない : ILA コアへの CLK 入力と して使用されるクロ ッ

クに PERIOD 制約が追加されているこ とを確認します。 ISE ソフ ト

ウェア プロジェク トでこのネッ トに制約が付けられていない場合、タ

イ ミ ング制約が正し く適用されず、 コアが認識されないこ とがあ り ま

す。 コアに関連付けられた NCF ファ イルも適用されているかど うか

確認します。 コアのネッ ト リ ス ト  ファ イル (*.ngc/ngo) がインプ リ メ

ンテーシ ョ ン中に移動された場合、関連する制約ファイル (*.ncf) が適

切に移動されていない可能性があ り ます。

はい : 問題 6 に進んでください。

6. JTAG TCK ク ロ ッ ク の実行速度が速すぎませ

んか。
はい/わからない : [JTAG Chain] → [Xilinx Platform USB Cable] →
[Speed] オプシ ョ ンでケーブル速度を削減して、TCK ピンの周波数を

最低速度設定になるよ うに下げます。

いいえ : 次の情報を含めてザイ リ ンクス  テクニカル サポートから

ケースを開きます。

• cs_analyzer.log

• Inserter プロジェク ト  (<filename>.cdc) も含めた ISE ソフ ト ウェ

ア プロジェク ト を圧縮します。

表 A-7 : LA コアのト リガに関する ト ラブルシューティ ング (続き)

問題 回避策
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表 A-8 : 破損した ILA コアのデータ  バッファに関する ト ラブルシューテ ィング

問題 回避策

1. ILA コアに ト リガーを付ける と、 次のよ うな

メ ッセージがコンソールに表示されます。

ERROR: Fatal - Did not find trigger 
mark in buffer. Data buffer may be 
corrupt!

サンプ リ ングされるデータに影響するデザイン

またはコアのタイ ミ ング問題である可能性が高

く、 この結果バッファのデータが破損してしま

います。

問題 2 に進んでください。

2. OFFSET IN/OFFSET OUT および PERIOD 制
約を適用しましたか。

はい : タイ ミ ング問題がこの問題を引き起こ さないよ うに、 これらの

制約が適切な信号すべてに適用されているかど うか確認して くださ

い。

いいえ : 問題 3 に進んでください。

3. ICON JTAG ク ロ ッ ク に BUFG を使用しまし

たか。
いいえ : JTAG クロ ッ クが BUFG を使用しない場合、「ERROR: Fatal
- Did not find trigger mark in buffer. Data buffer may be corrupt!」 と

い う メ ッ セージが表示される こ と があ り ます。 この属性が確実に

ICON コアの生成用に設定されるよ うにするには、 デザインをインプ

リ メン ト し直す必要があ り ます。

はい : 問題 4 に進んでください。

4. コア制約は正し く適用されましたか。 いいえ/わからない : ILA コアへの CLK 入力と して使用されるク ロ ッ

クに PERIOD 制約が追加されているこ とを確認します。 ISE ソフ ト

ウェア プロジェク トでこのネッ トに制約が付けられていない場合、タ

イ ミ ング制約が正し く適用されず、 ILA コアの制御ロジッ クが正し く

動作しないこ とがあ り ます。 コアに関連付けられた NCF ファ イルも

適用されているかど うか確認します。 コアのネッ ト リ ス ト  ファ イル

(*.ngc/ngo) がインプリ メンテーシ ョ ン中に移動された場合、関連する

制約ファイル (*.ncf) が適切に移動されていない可能性があ り ます。

はい : 問題 5 に進んでください。

5. デザインおよびコアはタイ ミ ングを満たしてい

ますか。
いいえ : デザインが再びタイ ミ ングを満たすよ うにするには、 ト リ

ガー ポート数、各ポートの ト リガー ビッ ト数、データ幅、データ深さ

などを削減して、 ILA コアを簡素にする必要があ り ます。

はい : 次の情報を含めてザイ リ ンクス  テクニカル サポートからケー

スを開きます。

• cs_analyzer.log

• Inserter プロジェク ト  (<filename>.cdc) も含めた ISE ソフ ト ウェ

ア プロジェク ト を圧縮します。
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ザイリンクス テクニカル サポートに提出する情報の取得方法

Xinfo 情報の取得

Xinfo は、ザイ リ ンクス  ツールで使用されるシステム情報を収集するために使用されるアプ リケー

シ ョ ンで、 インス トール ログおよびデバッグに便利な環境の詳細情報などが入手できます。 

Windows の場合

1. [スタート ] → [ファ イル名を指定して実行] をク リ ッ ク し、 「Xinfo」 と入力します。

2. Xinfo アプリ ケーシ ョ ンで [File] → [Export] → [Save as Text file] をク リ ッ ク します。

Linux の場合

1. シェル プロンプ トから  xinfo を実行します。

2. Xinfo アプリ ケーシ ョ ンで [File] → [Export] → [Save as Text file] をク リ ッ ク します。

ChipScope Pro Analyzer ログ ファイル情報の取得

cs_analyzer.log ファ イルには、最新の ChipScope Pro Analyzer ツール セッシ ョ ンからのコンソール

メ ッセージのログが含まれます。 

Windows の場合

cs_analyzer.log ファ イルは %homepath%/.chipscope ディレク ト リに保存されています。 このディ

レク ト リは、 通常 C:/Documents and Settings/<username>/.chipscope になり ます。

Linux の場合

cs_analyzer.log ファ イルは $HOME/.chipscope ディ レク ト リに保存されています。

ChipScope Pro Core Inserter ツールのログ ファイル情報の取得

cs_inserter.log ファ イルには、 最新の ChipScope Pro Core Inserter ツール セッシ ョ ンからのコン

ソール メ ッセージのログが含まれます。

Windows の場合

cs_analyzer.log ファ イルは %homepath%/.chipscope ディレク ト リに保存されています。 このディ

レク ト リは、 通常 C:/Documents and Settings/<username>/.chipscope になり ます。

Linux の場合

cs_analyzer.log ファ イルは $HOME/.chipscope ディ レク ト リに保存されています。

圧縮された ISE ツール プロジェク トの取得

1. ISE Project Navigator ツールで [Project] → [Archive] をク リ ッ ク します。

2. すべてのプロジェク ト を含む <project_name>.zip ファ イルが作成されます。 プロジェク トで

Core Inserter ツールを使用した場合は、圧縮前にプロジェク トに <filename>.cdc が含まれてい

るかど うか確認してください。

http://japan.xilinx.com


250 japan.xilinx.com ChipScope Pro 12.3 ソフ トウェアおよびコア

UG029 (v12.3) 2010 年 9 月 21 日

付録 A : ChipScope Pro ツール ト ラブルシューテ ィング ガイ ド

http://japan.xilinx.com


ChipScope Pro 12.3 ソフ トウェアおよびコア japan.xilinx.com 251
UG029 (v12.3) 2010 年 9 月 21 日

付録 B

参考資料

ChipScope™ Pro ソフ ト ウェアおよびコアに関する資料 :

1. DS282 : 『ChipScope OPB IBA データシート 』

2. DS283 : 『ChipScope PLB IBA データシート 』

マルチギガビッ ト  シ リ アル ト ランシーバに関する資料 :

3. UG076 : 『Virtex-4 FPGA RocketIO マルチギガビッ ト  ト ランシーバ ユーザー ガイ ド』

4. UG196 : 『Virtex-5 FPGA RocketIO GTP ト ランシーバ ユーザー ガイ ド』

5. UG198 : 『Virtex-5 FPGA RocketIO GTX ト ランシーバ ユーザー ガイ ド』

6. UG366 : 『Virtex-6 FPGA GTX ト ランシーバ ユーザー ガイ ド』

7. UG371 : 『Virtex-6 FPGA GTH ト ランシーバ ユーザー ガイ ド』

8. UG386 : 『Spartan-6 FPGA GTP ト ランシーバ ユーザー ガイ ド』

ザイ リ ンクス  Virtex® FPGA および Spartan® FPGA に関する資料 :

9. UG332 : 『Spartan-3 ジェネレーシ ョ ン コンフ ィギュレーシ ョ ン ユーザー ガイ ド』

10. UG380 : 『Spartan-6 FPGA コンフ ィギュレーシ ョ ン ユーザー ガイ ド』

11. UG071 : 『Virtex-4 FPGA コンフ ィギュレーシ ョ ン ユーザー ガイ ド』

12. UG191 : 『Virtex-5 FPGA コンフ ィギュレーシ ョ ン ユーザー ガイ ド』

13. UG360 : 『Virtex-6 FPGA コンフ ィギュレーシ ョ ン ユーザー ガイ ド』

14. XAPP139 : 『バウンダ リ  スキャン (JTAG) を使用した Virtex FPGA のコンフ ィギュレー
シ ョ ンと リードバッ ク』

ザイ リ ンクスのツールおよびソ リ ューシ ョ ン

15. ISE Design Suite のマニュアル 

16. エンベデッ ド開発キッ ト  (EDK) のマニュアル 

17. ISE Design Suite ソフ ト ウェア マ ト リ ッ クス

18. PlanAhead デザイン解析ツール

19. ザイ リ ンクス サポート  
20. System Generator for DSP 

21. ザイ リ ンクス オンライン ス ト ア

22. シ リ コン ステッピング 

23. UG192 : 『Virtex-5 System Monitor ユーザー ガイ ド』

24. UG370 : 『Virtex-6 System Monitor ユーザー ガイ ド』

http://japan.xilinx.com
http://japan.xilinx.com/publications/matrix/Software_matrix.pdf
http://japan.xilinx.com/planahead
http://www.xilinx.com/planahead
http://japan.xilinx.com/support
http://japan.xilinx.com/support/documentation/ipembedprocess_debugtrace.htm
http://japan.xilinx.com/support/documentation/ipembedprocess_debugtrace.htm
http://japan.xilinx.com/support/documentation/user_guides.htm
http://japan.xilinx.com/support/documentation/user_guides.htm
http://japan.xilinx.com/support/documentation/user_guides.htm
http://www.xilinx.com/support/documentation/user_guides/ug198.pdf
http://japan.xilinx.com/support/documentation/user_guides.htm
http://japan.xilinx.com/support/documentation/user_guides.htm
http://japan.xilinx.com/support/documentation/user_guides.htm
http://japan.xilinx.com/support/documentation/user_guides.htm
http://japan.xilinx.com/support/documentation/user_guides.htm
http://japan.xilinx.com/support/documentation/user_guides.htm
http://japan.xilinx.com/support/documentation/user_guides.htm
http://japan.xilinx.com/support/documentation/user_guides.htm
http://japan.xilinx.com/support/documentation/user_guides.htm
http://japan.xilinx.com/support/documentation/dt_ise.htm
http://japan.xilinx.com/support/documentation/dt_edk.htm
http://japan.xilinx.com/ise/optional_prod/system_generator.htm
http://japan.xilinx.com/onlinestore/index.htm
http://japan.xilinx.com/products/quality/silicon-stepping.htm
http://japan.xilinx.com/support/documentation/user_guides.htm
http://www.xilinx.com/support/documentation/user_guides/ug192.pdf
http://japan.xilinx.com/support/documentation/user_guides.htm
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その他の資料 :

25. ActiveState 

26. Agilent Technologies 

27. Tcl Developer Xchange 

28. ByteTools

http://japan.xilinx.com
http://www.activestate.com
http://www.agilent.com/find/logic
http://www.tcl.tk
http://www.byte-tools.com/index.php?main_page=xilinx
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